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序

　 　 CAE （Computer Aided Engineering） 是结合计算机和计算力学方法求解工程 （产品） 结

构的强度、 刚度、 稳定性、 动力响应、 热传导、 多体接触、 弹塑性变形、 绕流现象、 流固耦

合及性能优化等问题的数值分析方法。 自 20 世纪 60 年代至今， CAE 已历经四十余年的发

展， 并广泛渗透到诸如生物力学、 电子、 机械、 土木工程及油气藏工程等众多领域。 时至今

日， CAE 已经形成了独立的学科范畴， 涵盖了计算数学、 计算力学和计算几何等多个复杂

的学科领域。 从 20 世纪 70 年代开始， 以欧美科技发达国家为首， 逐步发展形成了众多功能

强大的商业化 CAE 软件。 这些软件各具特色， 在连续介质固体力学、 流体力学、 非连续介

质动力学等主要领域大放异彩， ADINA 便是其中的杰出代表之一， 并以其强大的结构非线

性求解能力和独树一帜的流固耦合求解能力享誉全球。 可以预测， 随着科学的发展， CAE
对各行各业的影响将会进一步加大， 并且可能上升到国家科技发展的战略高度。 对广大科技

工作者而言， CAE 工具软件将会成为科研和生产的强大助力。 毫无疑问， CAE 的应用、 研

发水准是科技向生产力转化的强大催化剂， 而本书则以 ADINA 为基础， 深度瞄准 ADINA 的

实际应用， 必将对工程师和科研工作者提供有力的帮助。
就商业化 CAE 软件平台的实际应用而言， 必须纠正一个广泛存在的认识误区———很多

科技工作者把商业化 CAE 软件仅仅视作一种工具。 不可否认， 商业化 CAE 软件确实是一种

集合了多种学科的工具， 但同时， 它也是庞大的科学知识体系的整合， 因此， 对 CAE 商业

化软件的掌握既是对工具的应用， 也是知识深化、 学习的快捷过程， 这点对正在使用 CAE
助推科研、 生产的科技工作者而言是必须明确认识的。

商业化 CAE 软件一般具有固定的功能性结构， 常包括： 几何建模、 物理模型及参数的

定义、 求解算法、 后处理结果的提取及可视化。 因此， 对应用者而言， 要熟练地使用 CAE
商业化软件常需要掌握几个方面的知识体系与技能： 必要的计算几何知识基础 （3D 几何模

型的构建、 网格模型的构建等）、 计算数学 （算法原理等知识体系的掌握）、 计算力学 （将
实际问题提炼为力学模型的能力、 力学概念的综合把握）、 丰富的专业知识和熟练的程序操

作能力。 需要强调的是， 熟悉基本的程序操作并不能拥有高效的操作能力， 而本书的特点则

在于引导 ADINA 的应用者熟练掌握、 灵活运用各项高效的应用技巧， 从而达到提升应用能

力的目的。
从程序应用技巧方面来看， 本书很多内容都是作者多年的使用经验之无私奉献， 这些经

验技巧对提高 CAE 分析的效率具有莫大帮助。 从应用深度来看， 书中多个专题均为实际科

研、 生产中的常遇难题， 本书提供的解决思路既有利于应用者快速解决问题， 同时还能触类

旁通， 为扩展应用提供方法和原理层面的参考模板。 从应用范围的宽度及完备性而言， 本书

几乎提供了 ADINA 所有应用领域关键问题的基本求解方案， 以及对应关键输入参数的设置
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思路。 难能可贵的是， 针对输入参数的选取本书还做出了原理性的揭示， 思路简洁， 阐述清

晰， 非常适合 ADINA 的使用者进阶学习。
本书作者长期应用 ADINA 进行实际工程问题的分析， 并结合工作需要为众多 ADINA 用

户提供了广泛的技术支持， 具有丰富的软件使用经验、 娴熟的应用技巧和扎实的理论功底。
同时， 本书作者还长期担任 SIMWE （仿真科技论坛） ADINA 版块的版主， 为广大 ADINA
的使用者提供了热心无私的帮助。

本书是国内针对 ADINA 应用与深入扩展学习的集大成之作， 可作为广大 ADINA 用户和

爱好者的重要参考书。 本书的出版必将推动 ADINA 在国内的进一步应用， 也必将对提高

CAE 工程师和相关学者在结构非线性问题和流固耦合问题等领域进行数值仿真求解的能力

起到强大的助推作用。

西南交通大学土木工程学院

余志祥
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前 言

　 　 ADINA 软件以其卓越的非线性计算能力及先进的流固耦合技术闻名于世。 对于广大的

中国用户而言， 资料的匮乏已经成为学习 ADINA 软件的最大障碍。 已有的学习资料及出版

物大多以介绍软件的基础操作为主， 而对软件操作和应用技巧讲解得不够详细和透彻， 这样

就很难满足用户向更高层次学习的愿望和进阶要求。
本书另辟蹊径， 不仅介绍了 ADINA 软件操作涉及的背景知识， 而且还介绍了笔者在多

年的软件使用过程中总结出的常用操作方法和实用技巧， 并提供了很多行业 ADINA 软件的

经典分析实例。 通过学习这些知识、 方法和技巧， 再配合本书经典实例的建模及分析过程，
相信读者的软件应用水平一定能够达到一个新的高度。 通过阅读本书， 笔者衷心希望ADINA
用户能够少走弯路， 快速掌握 ADINA 软件的建模方法和分析技巧。

本书主要面向 ADINA 软件的初级用户和中级用户， 对于高级用户也有一定的参考价值。
本书还可以作为理工科院校师生学习 ADINA 软件的参考书， 也可以为科研工作者和工程技

术人员提供有价值的参考。
本书的编写得到了西南交通大学余志祥老师、 长江勘测规划设计研究际熊堃博士的支持

和帮助， 以及笔者家人的支持和谅解， 在此表示感谢！ 另外， 在编写本书的过程中， 笔者还

参考了仿真互动网 SIMWE 论坛 （www. simwe. com） A03： ADINA 版的大量提问帖， 并通过

论坛中广大网友的问题及时了解读者的需求， 并得到了很多建议， 在此， 向提供资料和信息

的 SIMWE 仿真论坛及论坛会员表示感谢！ 本书的写作与出版还得到了国家自然科学基金项

目 （50979037）、 山东省自然科学杰出青年基金项目 （JQ 201017） 和山东省高等学校科技

计划项目 （J11LE04） 的资助， 在此表示衷心感谢。
鉴于编者水平有限， 书中难免会有错误和纰漏之处， 敬请各位专家和广大读者批评

指正！

编　 者
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本章首先对 ADINA 有限元软件进行了概述， 然后对 ADINA 软件的功能模块进行了介

绍， 最后介绍了本书的内容及特色。

1. 1　 概述

ADINA 软件的英文全称为 “ automatic dynamic incremental nonlinear analysis” ， 中文

翻译为 “自动动态增量非线性分析” 。 ADINA 软件是美国 ADINA R & D 公司的产品，
拥有国际上先进的大型通用有限元计算分析仿真平台， 能够广泛应用于各行各业和研

究、 教育机构。 ADINA 一直致力于优秀的计算仿真能力， 可用于固体分析、 流体分析、
热分析， 以及流固耦合、 热力耦合和多物理场耦合等分析中， 并能够为用户提供复杂

问题的解决方案。
ADINA 软件的创始人 K. J. Bathe 博士为麻省理工学院教授， 他与其带领的研发团队于

1975 年开发了 ADINA 软件。 刚开始的几年 （1975 ～ 1984）， ADINA 软件并不是商业产品，
其源代码传播到全球各个领域， 后来的很多商业有限元程序的开发都参考了 ADINA 软件的

源代码。 由于其优秀的非线性功能， 当时就被欧美的工程界、 教育界及科研院所广泛采用。
我国于 1981 年引入了非线性分析程序 ADINA， 这为有限元程序的工程应用带来了新的发展

和动力， 工程界中许多无法解决的难题都可以迎刃而解。 经过三十多年的不断发展， ADINA
软件以其领先的计算理论、 稳定的非线性问题求解专利技术、 强大而广泛的多物理场仿真功

能， 获得了全球用户的好评， 被誉为 “有限元软件中不可多得的精品”。

图 1-1　 ADINA 多物理场求解功能

ADINA 软件的技术优势不仅在于其优秀

的单物理场计算能力， 更在于其强大的多物

理场耦合计算能力。 实际工程和科学研究中

的问题大多为多场耦合问题， 而 ADINA 软件

可以直接求解多物理场耦合问题， 它能够求

解的问题类型如图 1-1 所示。 ADINA 软件考

虑了耦合因素的影响， 能够更深入地分析设

计产品的性能， 帮助用户更深刻地理解物理

现象的产生和发展的规律， 从而有助于生产

出更经济、 安全、 实用有效的产品。 ADINA
软件能够求解下列多物理场：

1） 流固耦合 （FSI）。
2） 热力耦合 （TMC）。
3） 流固热三场耦合。
4） 结构-孔隙水压力耦合 （多孔介质）。
5） 结构和电场耦合 （压电）。
6） 热电耦合 （焦耳热）。
7） 声流体和结构耦合。
8） 流体-传质耦合 （质量扩散）。
ADINA 软件求解领域广泛， 在全球拥有众多的客户， 包括： 材料加工业、 机械制造业、
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航空航天、 船舶工程、 汽车工业、 石油化工、 土木工程、 岩土及地下工程、 水利水电、 核工

业、 能源、 交通、 生物力学等。 ADINA 软件一直致力于求解计算技术的创新， 追求卓越的

品质 （Focused on excellence）， 并不断地在发展完善。

1. 2　 功能模块介绍

ADINA 软件提供了完整的有限元系统， 用于结构、 热、 流体及多物理场耦合分析。 很

多有限元软件进行结构分析时， 往往包含两个独立的有限元程序： 一个用于线性静态及动力

学分析； 另一个则用于非线性分析。 而 ADINA 软件只包含一个统一的结构模块， 能够求解

线性静态、 动力学及非线性问题， 另外两个模块分别为热分析模块和流体分析模块。 ADINA
软件在计算流固耦合分析及多物理场分析方面是国际上领先的有限元分析软件。

ADINA 软件包含三个版本， 分别是： UNIX 版、 Windows 版和 Linux 版， 适用于微机、
工作站及巨型机， 它还包含多节点并行计算版本。 ADINA 软件中包含的主要模块如表 1-1
所示。

表 1-1　 ADINA 软件的功能模块

功 能 模 块 介　 　 绍

ADINA- Structures 　 用于固体和结构的线性分析、 高度非线性分析

ADINA- CFD 　 用于可压缩流体及不可压缩流体分析， 包含先进的移动壁面及动网格技术

ADINA- Thermal 　 用于固体和场的热传递分析

ADINA- FSI 　 用于流场及结构的完全耦合分析

ADINA- TMC 　 用于热力耦合分析， 包括接触生热

ADINA-User Interface （AUI） 　 ADINA 软件的前后处理 （包含 ADINA-M）

下面将详细介绍 ADINA 软件的各个功能模块：
1. ADINA- Structures 模块

ADINA- Structures 是结构模块， 用于求解线性、 非线性、 稳定性、 动力学等问题， 尤其

在处理非线性及动力学问题等方面具有明显的优势。 它能够有效地考虑各种非线性效应， 包

括几何非线性、 材料非线性、 接触非线性等。
ADINA 软件的材料模式非常丰富， 包括： 弹塑性、 黏弹性、 蠕变、 生物肌体材料模式、

损伤材料模式等。 在 ADINA 软件中开发材料也非常方便， 而且任何材料模式都可以考虑破

坏效应。 ADINA 软件还提供了最大主应力、 最大切应力、 塑性应变等多种常规破坏判断准

则和七种专用的复合材料失效准则。 土木工程中使用的材料 （例如， 混凝土、 黏土、 岩石

等） 一般均为非线性材料， ADINA- Structures 模块中提供了多种专门用于土木工程方面的材

料； 曲线描述的地质材料、 Drucker- Prager 材料、 Cam- clay 材料、 Mohr- Coulomb 材料、 混凝

土材料、 LUBBY2 徐变模型、 多孔介质材料等。 因此， ADINA 软件被公认为是包含土木工程

建设所需材料模式最多的有限元软件。
为了更好地解决土木工程中遇到的问题， ADINA- Structures 还提供了多种特殊处理方
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法： Rebar 单元可以处理混凝土中的钢筋、 钢筋预应力及预应力损失等问题； 单元生死功能

可以模拟模型中物质的增添或删除， 多用于隧道开挖、 桥墩浇注、 沉管施工等施工过程分

析； 多孔介质算法则专门用来求解固结沉降问题； 高效的非线性求解算法则保证了求解的快

速性及准确性。
ADINA- Structures 模块还提供了多种非线性接触处理技术， 包括： 约束函数法、

Lagrangian乘子法、 刚性目标面算法等。
对于动力学分析， ADINA- Structures 模块提供了瞬态动力学分析、 模态分析、 谐波响应

分析、 响应谱分析、 随机振动分析。 不仅可以考虑整个部件级的接触模态， 还可以分析固液

耦合体的特征模态和频率 （例如， 考虑水的附加质量对水中结构振动频率的影响）。 此外，
该模块还可以同时进行显式和隐式时间积分算法， 这两种算法既可以独立分析不同的问题，
又可以联合求解同一复杂问题的不同工序。

2. ADINA-CFD 模块

ADINA- CFD 是流体模块， 该模块包含两种离散方法： 有限元法和控制体积法 （也称为

有限体积法）， 使用这两种方法可以求解各种流体动力学问题 （例如， 2D 或 3D， 牛顿流或

非牛顿流， 不可压缩流体、 微可压缩流体、 完全可压缩流体、 层流或湍流、 稳态流动或瞬态

流动、 传热分析等）。
ADINA- CFD 模块能够处理各种流体力学问题， 例如， 模拟水的流动过程、 明渠流动计

算， 以及模拟波浪等。 此外， 还能够解决传质、 移动壁面、 自由表面、 表面张力、 VOF、 特

殊边界以及多孔介质中的流动等问题。
3. ADINA- Thermal 模块

ADINA- Thermal 是温度模块， 能够解决固体和结构的温度和热流分析问题。 分析过程

中， 该模块可以解决 2D / 3D 导热、 辐射换热、 对流换热问题， 也可以进行稳态和瞬态分析，
而且可以考虑与时间和温度相关的材料特性、 潜热效应、 单元生死等功能。 此外， 该模块还

可以与 ADINA- Structures 联合进行热力耦合分析。
4. ADINA- FSI 模块

ADINA- FSI 模块是全球领先的流固耦合求解器， 它能够将 ADINA 软件中的结构模块和

流体模块的功能完全耦合起来， 计算速度也很快。 由于 ADINA 软件的结构求解器和流体求

解器是同一个公司研发的产品， 因此， ADINA- FSI 能够很容易地将 ADINA- Structures 与

ADINA- CFD 的功能融合在一起， 实现流体和结构的耦合分析， 并且兼具迭代耦合和直接耦

合两种算法。 在 ADINA 软件的流固耦合分析中， 流体和结构的网格可以独立划分， 界面

上的网格也不需要一致， 可以考虑自由液面运动、 移动壁面， 以及耦合现象中的气蚀、
相变等极为复杂的工程问题， 也可以考虑空气中或水下结构物的运动、 接触、 碰撞甚至

材料破坏等现象， 如果流体区域发生变化还可以考虑网格重划分或跟随网格等动网格处

理技术。
5. ADINA- TMC 模块

ADINA- TMC 是热力耦合模块， 主要用于单、 双向热力耦合问题。 对于双向热力耦合，
热分析的结果将影响结构分析， 结构分析的计算结果也将影响传热计算。 对于热力耦合问

题， 分析时兼具迭代耦合和直接耦合两种算法。
解决热力耦合问题时， ADINA- TMC 模块可以考虑下列影响因素： 由于材料塑性变
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形引起的内部热生成、 相互接触物体之间的热交换、 接触面之间由于摩擦引起的表面

热生成等。
6. ADINA-AUI 模块

该模块对 ADINA 分析程序提供统一的前后处理功能。 ADINA- AUI 采用友好的交互式图

形界面来实现所有建模和后处理功能， 并提供 Undo 和 Redo 功能。 ADINA- AUI 还提供了多

种网格划分器， 不仅能够对常见的网格进行划分， 还能够对复杂模型进行自动六面体网格划

分， 它提供的 Glue Mesh 功能可以将不同的网格粘结在一起。
ADINA- AUI 还提供了与 CAD 软件进行交互的接口， 它能够直接读入各种 CAD 系统生

成的几何模型， 例如， Pro / ENGINEER 和基于 Parasolid 核心的实体 （ Unigraphics、 Solid-
Works 和 SolidEdge 等软件）。 为了便于用户操作， ADINA- AUI 不但可以与 AutoCAD、 Pro /
ENGINEER、 UG 等软件实现无缝链接， 还可以与 PATRAN、 MSC. Nastran 等有限元软件交换

模型数据。

1. 3　 本书内容及特色

本书面向初级和中级用户， 主要面向中级用户， 对于高级用户也有一定的参考价值。 编

写本书时， 编著者假定读者对 ADINA 软件有一定的应用基础， 对 ADINA 软件的窗口、 菜

单、 图标等均已掌握， 熟悉 ADINA 软件的基本操作， 并已做过 primer 手册中的部分例题。 对

于初次接触 ADINA 软件的读者， 建议首先熟悉其操作界面， 并尝试学习、 操作 primer 手册中

的例题。
本书共分 3 篇： 基础篇、 提高篇及实例篇。 简要介绍如下：
第 1 篇为基础篇， 共包含 3 章内容 （第 1 章 ～第 3 章）： 第 1 章介绍了 ADINA 软件及其

主要的功能模块； 第 2 章介绍了 ADINA 软件的基础知识， 包括： ADINA 软件的文件类型、
调整 AUI 界面、 Zone 的使用和用户手册等内容； 第 3 章介绍了软件接口和求解设置等内容，
包括： 与其他软件的接口、 批处理提交计算、 内存分配和硬盘要求、 结果文件的保存及读入

等。 第 1 篇的内容强调 ADINA 软件的应用基础知识， 读者可以把该篇作为工具篇， 当遇到

问题时可以参考查阅。
第 2 篇为提高篇， 共包含 4 章内容 （第 4 章 ～ 第 7 章）： 第 4 章是本书最重要的一章，

详细介绍了 ADINA 软件的各个模块、 许多重要的概念， 以及编著者总结的常用操作方法和

使用技巧， 建议读者认真学习并能够熟练掌握。 第 5 章介绍了土木工程分析中常用的处理方

法和操作技巧。 第 6 章介绍了结构场建模基础和步骤， 本章包含两部分内容： 1） 结构场建

模基础与模型设定， 包括有限元中常见的基本概念及软件的常用求解设定； 2） 结构场建模

过程及注意事项。 第 7 章详细介绍了流场建模基础和步骤， 包括 6 部分内容： 流体建模基

础、 建立流体模型、 特殊的分析类型、 运动网格的控制、 促进收敛的方法及流固耦合分析。
该篇内容以易于理解、 注重基本概念、 注重操作性和实用性为原则， 即使读者没有很深的有

限元理论基础， 也可以读懂， 并可以通过实际操作模型来逐步掌握建模技巧。 掌握本篇介绍

的各种方法和技巧， 对第 3 篇的学习将大有裨益。
第 3 篇为实例篇， 共包含 3 章内容 （第 8 章 ～第 10 章）： 分别通过 4 个机械实例、 5 个

耦合场 （多物理场） 实例和 6 个土木实例详细介绍了使用 ADINA 软件分析不同问题的操作
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步骤。 该篇精选了 ADINA 软件在不同行业中的经典例题， 编著者尽量选取简单有效、 注重

实用、 注重方法的实例。 为便于读者学习、 比较和借鉴， 每个实例都给出详细的操作步骤、
命令流文件及相关文件。 对于非关键的操作步骤， 将简单介绍或一笔带过。 因此， 学习本篇

时， 要求读者具有一定的软件应用基础。
本书中所有实例的命令流文件均在 ADINA 8. 6. 3 版本下生成， 且均经过测试验算。

如果 ADINA 软件版本较低， 读取命令流文件时可能会出现问题， 甚至无法计算， 请予以

注意。



本章内容：

■ 2.1 ADINA的文件类型

■ 2.2 AUI 界面的调整

■ 2.3 Zone的使用

■ 2.4 ADINA 的用户手册

软件基础知识
第 2章
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　 　 本章将介绍 ADINA 软件的基础知识， 包括： ADINA 的文件类型、 AUI 界面调整、 Zone
的使用、 ADINA 的用户手册。 本章是后面其他章节学习的基础， 建模时遇到问题可以在本

章中进行查阅。

2. 1　 ADINA 的文件类型

ADINA 软件在前处理、 分析计算及后处理的过程中将生成许多不同功能的文件， 这些

文件的类型和说明如表 2-1 所示。

表 2-1　 ADINA 的文件类型及说明

文 件 类 型 说　 　 明

*. in
　 前处理命令流文件。 AUI 中的每一步操作都将转化为命令流， 并可以将其保存为命令流文件。 该文

件为文本格式， 可以用记事本打开、 编辑、 修改等

*. idb
　 数据库文件。 该文件包含完整的模型信息， 为二进制格式文件。 在 AUI 中可以打开， 如果模型比较

大， 打开数据库文件要比打开前处理命令流文件更快

*. dat
　 求解文件。 该文件为文本格式文件， 它记录了求解计算所需的模型数据信息， 包括单元、 载荷、 约

束等。 读者虽然可以对文件中的信息进行编辑修改， 但是一般不推荐这样做

*. por
　 结果文件。 该文件用来记录指定时间步下的分析结果， 可以保存为二进制格式或十进制格式， 默认

情况下保存为二进制格式

*. res
　 重启动文件。 当模型需要重启动计算时， 必须指定该文件。 默认情况下， 只保留分析计算最后一步

的重启动信息。 如果计算程序异常退出或中止， 重启动文件则保留当前计算步的信息

*. ses
　 工作记录文件。 该文件可以在 AUI 中打开， 用于记录求解过程中产生的信息， 可以使用文本编辑器

打开

*. pdb 　 后处理数据库文件。 该文件与*. idb 文件类似， 一般不经常使用

*. plo
　 后处理命令流文件。 后处理过程中的所有操作都可以记录为命令流， 读者也可以把这些操作保存为

命令流文件。 该文件可以使用记事本打开， 也可以进行编辑、 修改操作

*. map 　 结果映射 （传递文件）

*. tem 　 温度结果文件 （传递文件）

*. out
　 结果输出文件。 该文件主要记录各分析步的迭代收敛情况， 当计算模型出现不收敛时， 可以通过查

看该文件来查找原因

*. log 　 结果消息文件

*. x_t
　 几何输入文件。 对于 Parasolid 生成的几何输入文件， 可以通过 UG、 SolidWorks、 Solidedge 等软件转

换为此格式后导入 ADINA

*. igs 　 几何输入文件。 主要用于二维几何模型， 三维几何模型主要由*. x_t 文件导入

*. dxf 　 几何输入文件。 主要用于二维几何模型

*. nas 　 有限元格式的输入输出文件

*. unv 　 ADINA 输出的 I- deas 结果文件

*. stl 　 扫描体文件

*. op2 　 ADINA 输出的 Nastran 结果文件

*. ens 　 ADINA 输出的 ensight 结果文件
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　 　 表 2-1 中所列出的文件类型中， 建模时经常需要对前、 后处理命令流文件 （*. in、
*. plo）， 尤其是前处理文件进行查看和编辑， 本书 4. 1 节 “活学活用命令流文件” 将详细

介绍命令流文件的使用方法。
在分析计算和后处理的过程中， 经常需要查看*. out 文件和*. log 文件， 这两个文件记

录了计算的详细信息和收敛情况。 如果模型出现错误而中止， 调试模型时可以通过查看

*. out文件及*. log 文件来获得必要的信息。
重启动文件 （*. res） 也经常会用到。 很多计算问题都要基于前一步的计算结果继续进

行分析， 此时就必须使用重启动文件。 关于设定重启动分析的详细介绍， 请参看 4. 12 节

“设定重启动分析”。
在 ADINA 软件的求解过程中， 还会生成许多其他的过程文件。 计算正常结束后， 这些

过程文件将由系统自动删除。 如果计算非正常退出或中止， 过程文件则将保留在工作目录

下， 请读者注意。

2. 2　 AUI 界面的调整

ADINA 软件默认的 AUI 界面如图 2-1 所示， 包括： 主菜单、 主菜单工具条、 显示工具

条、 建模工具条、 后处理工具条、 ADINA-M 工具条、 模块工具条、 模型树、 图形区、 命令

图 2-1　 AUI 的默认界面
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图 2-2　 AUI 中的工具条

行窗口及信息窗口。 默认情况下， AUI 界面中并不显示

ADINA-M工具条。 在工具条右侧的空白处单击鼠标右键， 将

弹出工具条选择菜单， 选中 ADINA-M Toolbar 可以在 AUI 中
显示 ADINA-M 工具条， 如图 2-2 所示。

如果不希望显示某个工具条和窗口， 在图 2-2 中退选对

应的标签即可。 例如， 退选消息窗口和命令行窗口可以使得

图形区更大。 通常情况下， 建议在 AUI 界面中显示所有的工

具条和窗口。
用户可以根据自己的喜好来调整工具条的位置， 操作方

法是： 单击鼠标左键的同时， 按住工具条进行拖动。 笔者喜

欢的一种调整方式是： 将显示工具条拖到模型树的左边， 将

后处理工具条拖到图形区的右侧， 这样做可以增加图形区的高度， 如图 2-3 所示。

图 2-3　 调整 AUI 后的界面

调整后将使得带有下拉三角形的 4 个多重选择图标无法打开， 此时， 可以将它们拖动到

图形区的上边， 如图 2-3 中的方框所示。 单击菜单 View→Customize， 将弹出 Customize 对话

框， 选择 Commands 标签页下的 Display， 并查找图标 、 和 ， 然后选择 Com-

mands 标签页下的 Results， 并查找图标 ， 将这 4 个图标拖到图形区的上面， 为后面的建

模分析提供方便。
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2. 3　 Zone 的使用

为便于建立有限元模型， 应熟悉 Zone （区域） 的定义、 操作和显示方法。 AUI 中与

Zone 对应的默认图标为 ， 该图标的功能是： 改变 Zone， 表示在当前图形区只能显示这一

个 Zone。 单击该图标右侧的三角形， 将显示其他 Zone 的图标， 含义分别如下： 图标的功

能是显示 Zone， 表示当前图形区还可以显示其他 Zone， 可以根据需要使用鼠标拖动至适当

位置； 图标的功能是定义 Zone， 可以根据需要定义区域中的内容； 图标的功能是设定

Zone 的颜色， 可以根据需要定义区域的显示颜色； 图标的功能是激活 Zone， 如果激活了

某个区域， 则 AUI 中生成的几何和单元都将放入该区域。
默认情况下， 当前显示区域为整个模型 （WHOLE_MODEL）。 此外， ADINA 软件将为每

个程序模块对应的模型单元建立区域。 例如， 结构场模型的单元区域名为 ADINA、 热场模

型的单元区域名为 ADINA- T、 流场模型的单元区域名为 ADINA- F。
对于不同的单元组， ADINA 软件也将自动生成对应的区域。 建模时建立的分组情况越

详细， 就越有利于查看分析模型。 在学习和使用 ADINA 软件的过程中， 建议对所有关心的

区域都定义为独立的单元组， 以便查看模型和分析结果。
对于不同的接触组及接触组中的接触面， ADINA 软件也将自动生成对应的区域， 以便

查看模型中的接触定义情况、 检查模型中接触面的分布及接触定义是否正确等。

图 2-4　 定义区域对话框

在几何建模方面， 默认情况下，
对于原始 （ native） 建模方式， ADI-
NA 软件不会为其自动建立区域， 所

有的几何信息都保存在整个模型

（WHOLE_MODEL） 区域下， 读者可

以根据需要定义更详细的几何区域；
对于 Parasolid 建模方式， ADINA 将

为每个体都建立区域， 以便于查看。
单击定义区域图标 ， 将弹出定

义区域对话框， 如图 2-4 所示。 单击

Add 图标， 在弹出的对话框中输入新

区域的名称 V， 并在 Picking Filter 中

选择目标对象的类型， 双击下部表格

中的绿色 （在电脑界面下） 图框， 并

到图形区拾取或框选目标， 选定目标

后按下 Esc 键返回。 如果希望选取其

他目标， 则可以重复上述步骤。 Pick-
ing Filter 上方的 Object 及 Keyword 主

要为方便手动输入选取目标而设定， 单击 Enter 按钮就可以输入 Object 中对应的内容， 而无

须手动输入， 读者只需输入对应的目标编号即可。 如果目标编号是连续的， 则可以输入 to，
例如， 图 2-4 中的 “geometry volumes 1 to 11”， 其中， geometry volumes 为 Object （目标）， 1
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和 11 为目标编号， 读者可以先单击相应的图标， 则图形区会显示目标编号， 然后根据需要

来定义区域。
单击图标 可以自定义区域的显示颜色。 如果设定的区域位于模型内部， 默认情况下将

无法显示， 此时可以单击图标 （modify mesh plot）， 在弹出的 Modify Mesh Plot 对话框中单

击 Rendering 按钮， 将弹出 Define Mesh Rendering Depiction 对话框， 选中 Display Internal
Mesh Lines， 如图 2-5 所示， 单击 OK 按钮两次即可退出对话框设置。 此时， 图形区中将显

示内部区域的颜色， 也可以拖动鼠标旋转模型来查看其大致位置。 使用这种方法也可以对模

型内部的单元进行高亮显示， 并确定其大致位置。 在主菜单下单击 Display→Highlight. . . ，
可以对区域进行高亮显示 （对应的图标为 ）， 单击图标 可以取消高亮显示。

图 2-5　 显示内部网格线

2. 4　 ADINA 的用户手册

在 ADINA 软件安装目录的 Docs 文件夹下， 包含多个 pdf 格式的用户手册。 以笔者使用

的 ADINA 8. 6 版本为例， 简要介绍各个用户手册的功能及使用方法。
1. AUI 命令手册： ADINA User Interface Command Reference Manual
1） aui- ref1_86. pdf 　 Volume Ⅰ： ADINA Solids & Structures Model Definition （固体模型

定义）
2） aui- ref2 _86. pdf Volume Ⅱ： ADINA Heat Transfer Model Definition （热传递模型

定义）
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3） aui- ref3_86. pdf Volume Ⅲ： ADINA CFD & FSI Model Definition （流场和流固耦合

模型定义）
4） aui- ref4_86. pdf Volume Ⅳ： Display Processing （显示处理过程）
该手册主要介绍了 AUI 的命令语法， 便于理解及编写命令文件。
2. AUI 入门手册

primer_86. pdf ADINA User Interface Primer （ADINA 用户入门手册）
ADINA 8. 6 版本的 primer 手册中共包括 49 个例题， 每个例题中都有详细的 （ Step by

Step） 步骤， 是系统学习 ADINA 软件基础操作的手册， 非常适合初学者使用。 所有例题的

输入文件都保存于 ADINA 安装目录下的文件夹 \ ADINA 86 \ Samples \ primer 中。
3. 版本发布说明： Release Note
relnotes_86. pdf　 　 ADINA System 8. 6 Release Notes （ADINA　 8. 6 版本发布说明）
该手册主要介绍了 ADINA 8. 6 版本的更新及改进内容。
4. 理论手册： Theory and Modeling Guide
1） tmg- a_86. pdf　 　 Volume Ⅰ： ADINA （ADINA 结构场部分）
2） tmg- t_86. pdf Volume Ⅱ： ADINA Heat Transfer （ADINA 热传导部分）
3） tmg- f_86. pdf Volume Ⅲ： ADINA CFD & FSI （ADINA 流场和流固耦合部分）
该手册共包含 3 个文件， 分别介绍了 ADINA 软件在结构、 热、 流体分析中所涉及的求

解理论。 热力耦合、 流固耦合的计算理论分别包含在热和流体理论手册中。 在流体手册中还

介绍了建立正确分析模型的建议， 以及 ADINA 软件求解过程中常见错误代码的详细解释，
出现错误时可以根据错误代码查找出错原因。

5. 校验手册

verify_86. pdf　 ADINA Verification Manual （ADINA 校验手册）
该手册共分 3 篇， 分别包括结构、 热、 流体等方面的例题。 手册中详细介绍了下列

内容： 问题的详细物理描述、 ADINA 软件中求解问题的关键点、 ADINA 软件计算结果

与试验或理论解的误差比较等。 所有例题的输入文件均保存于 ADINA 安装目录下的文

件夹 \ ADIAN 86 \ Samples \ a、 b、 t、 f \ 中。 读者可以直接读入命令流文件*. in 来求解

并查看求解结果。 分析实际问题时， 也可以参考校验手册中的例题来建模。
另外， 在 ADINA- AUI 的窗口中单击菜单 Help→Online manuals （pdf） 也可以打开用户

手册。





本章内容：

■ 3.1 与其他软件的接口

■ 3.2 内存分配与硬盘要求

■ 3.3 结果文件的保存及读入

■ 3.4 批处理提交计算

接口与求解
第 3章
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本章介绍了 ADINA 软件与其他软件的接口、 内存分配与硬盘要求、 结果文件的保存及

读入和批处理提交命令。 这些都是软件涉及的基础知识， 需要时可以进行查看。

3. 1　 与其他软件的接口

3. 1. 1　 前处理的接口

ADINA 软件前处理接口支持输入几何和有限元模型。 ADINA Modeler （ADINA-M） 和

很多 CAD 软件 （例如， NX、 SolideEdge、 SolidWorks 等） 都是以 Parasolid 作为几何建模内

核， 这些 CAD 软件创建的几何模型可以很容易地读入到 ADINA-M 中， 然后继续在 AUI 中
建立有限元模型。 单击菜单 ADINA-M→Import Parasolid Model. . . 或图标 （Import Parasolid
Model）， 将弹出如图 3-1 所示的对话框， 可以读入格式为*. x_t 或*. x_b 的 Parasolid 文件。

图 3-1　 导入 Parasolid 格式文件

对于不能导出为 Parasolid 模型的 CAD 软件， 可以首先导出格式为 IGES 的文件， 然后再

导入到 ADINA 软件中。 IGES 文件中的模型由面组成， 在 ADINA-M 中可以通过 “缝合” 面

来创建实体模型。 单击菜单 File→Import IGES 可以导入 IGES 格式的文件， 图 3-2 中给出了

ADINA 软件导入 Parasolid 格式和 IGES 格式文件的流程示意图。

图 3-2　 导入几何模型
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ADINA 软件还能够导入扩展名为 . dxf 的文件， 但是， 目前仅支持命令流读入的方式。
例如， 读入 try. dxf 文件的命令为： loaddxf try. dxf。 读者可以把该命令写入到 in 文件中， 然

后读入即可； 也可以在命令行中输入该命令来直接执行， 但要保证导入的文件应该保存在当

前的工作目录中。
ADINA 软件还可以导入扩展名为 . stl 的文件， 这一接口方便了 ADINA 软件与很多软件

间的数据交换， 操作方法如下： 单击菜单 Meshing→STL Body→Import STL 可以导入*. stl 文
件； 单击菜单 Meshing→STL Body→Export STL 可以导出*. stl 文件。

ADINA 软件前处理接口中还提供了另外一个重要的功能， 即： 导入 Nastran 格式文

件。 读者可以在其他软件 （例如， NX、 Femap、 Ansa、 Hypermesh、 Patran 等） 中创建有

限元模型， 并导出为 Nastran 格式的文件， 然后由 ADINA- AUI 导入该文件， 并自动创建

施加载荷和边界条件的区域。 除了结构分析之外， Nastran 格式的文件还可以导入到 ADINA
软件中进行流体的 CFD 分析和 FSI 分析。 单击菜单 File→Import NASTRAN 可以导入 Nastran
格式的文件， 图 3-3 中给出了将其他软件生成的 Nastran 格式文件导入到 ADINA 软件的示

意图。

图 3-3　 导入 Nastran 格式的文件

I- deas 与 ADINA 软件之间存在一个完全整合的接口程序， 该接口允许在 I- deas 环境中

完成前后处理， 并通过 ADINA 求解器进行求解分析。 图 3-4 给出了 I- deas 前后处理器与

ADINA 求解器相互导入的示意图， 可以看出在 I- deas 前处理器中建立的有限元模型可以导

入到 ADINA 求解器进行分析， ADINA 求解器得到的分析结果还可以再导入到 I- deas 的后处

理中进行各种结果的显示。

图 3-4　 I- deas 前后处理器与 ADINA 求解器的相互导入

3. 1. 2　 后处理的接口

使用 ADINA 软件进行结构分析的结果可以导出为 Nastran op2 或 I- deas universal 格式的

文件。 因此， ADINA 软件的计算结果可以在多个后处理器 （例如， NX、 Femap、 mETA 或

FEMFAT 等） 中进行处理。 需要注意的是： 有限元模型既可以在 AUI 中建立， 也可以通过

前处理接口导入其他软件建立的模型。 例如， 对于图 3-5 中显示的计算结果， 可以使用

I- deas 软件建立有限元模型， 使用 ADINA 软件进行求解， 导出为 Nastran op2 格式的文件后，
在 Femap 软件中进行后处理。

单击菜单 Control→Miscellaneous Options， 将弹出如图 3-6 所示的杂项控制对话框， 在

Results 下拉式菜单中可以选择结果文件的输出格式。 默认情况下， 结果文件的输出格式为
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图 3-5　 将 ADINA 软件的求解结果导入到 Femap 中进行后处理

ADINA Porthole Only 格式， 读者还可以选择输出为 Nastran OP2 File Only 格式、 I- deas UNV
File Only 格式、 OP2 and Porthole 格式和 UNV and Porthole 格式 （图 3-6 中方框）。

图 3-6　 选择输出结果文件格式 （Results）

对于 Ensight 下拉式菜单的输出 （如图 3-7 所示）， 如果模型很大， 在同一个后处理软

件中查看结果会非常方便。 ADINA 流体分析结果和结构分析结果都可以输出为 Ensight 格
式。 Ensight 下拉式菜单包含 3 个选项， 分别为： No、 Unformatted 和 Formatted， 一般情况下

选择 Unformatted 即可。 分析结果将导出 Ensight 能够导入的文件格式。
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图 3-7　 选择 Ensight 下拉式菜单

3. 2　 内存分配与硬盘要求

3. 2. 1　 内存分配

ADINA- AUI 的内存也就是 ADINA 软件进行前后处理时使用的内存， 默认值为 16MB。
前后处理过程中的某些操作 （例如， 划分网格、 制作动画等） 都非常占用内存， 默认的内

存设置往往不能够满足要求， 此时需要读者自行设定 AUI 使用的内存大小。 对应的操作如

下： 单击菜单 Edit→Memory Usage， 在弹出的对话框中输入设定的内存值， 单击 OK 按钮即

可。 该内存设置是 ADINA 软件进行前后处理时允许使用的最大内存， 可以根据模型规模及

操作来设置。 如果没有退出 ADINA- AUI， 将一直占用该内存。 如果计算机的内存较小， 而

且已经成功生成了求解文件， 此时就可以退出 AUI 来释放内存， 为将来的求解计算作准备。
对于 64 位的 ADINA 软件， AUI 的内存设置没有限制； 对于 32 位的 ADINA 软件， 默认

情况下， AUI 允许设置的最大内存值为 512MB， 如果希望设置的内存值超过该值， 只能手动

来修改注册表项， 操作步骤如下：
1） 关闭 ADINA- AUI。
2） 在开始菜单下单击运行 （R. . . ）， 在弹出的对话框中输入 REGEDIT， 如图 3-8 所示，

图 3-8　 运行 REGEDIT 命令

然后单击确定按钮。 此时将弹出注册表窗口，
单击 HKEY _ CURRENT _USER→ Software→
ADINA R&D， Inc→aui→ settings→Memory，
双击 Memory 根键， 选择十进制基数， 并输

入希望设置的内存值 （例如， 800）， 如图

3-9所示， 单击确定按钮， 并退出注册表编

辑器。
3） 此时， 在 ADINA- AUI 中单击菜单
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图 3-9　 在注册表编辑器中修改默认内存值

Edit→Memory Usage， 将发现内存值已经修改为指定值 800。
如果结果文件较大， 在 ADINA 的后处理器中打开该结果文件将需要花费较长的时间，

建议将 AUI 的内存设置为较大值， 以减少读取结果文件的时间。

3. 2. 2　 结构场分析时的内存分配

单击菜单 Solution→DataFile / Run 或图标 （Data File / Solution）， 将弹出如图 3-10 所示

的对话框， 选择文件的保存位置， 并在文件名 （N） 中输入文件名， 如果没有选中 Run
Solution， 则只生成求解文件而不进行计算； 如果选中 Run Solution， 成功生成求解文件后将

直接进行计算。 需要注意的是： 此时并未释放 ADINA- AUI 所占用的内存。
根据需要， 读者也可以设定分析计算的处理器个数， 在 Number of Processors [1 to 4]

中输入处理器的个数即可。 虽然窗口中给出的处理器个数为 [1 to 4]， 但是也可以将其设置

为大于 4 的整数， 增加处理器的个数能够加快计算的求解速度。
默认情况下都会选中 Automatic Memory Allocation 选项， 表示 ADINA 软件可以自动确定

计算所需的内存。 绝大多数情况下， 选择默认的设置就能够保证计算的正常进行。 但在有些

情况下， 如果计算机内存比较小， 则可能需要手动修改内存的设置； 对于流固耦合分析， 有

时候也不允许自动分配内存， 此时只能手动进行设置。
不选中 Automatic Memory Allocation 选项前面的√， 就可以手动设定内存， 如图 3-10 所

示。 编号 [A] 表示求解的最大内存 （Maximum Memory for Solution）， 该内存是 ADINA 求解

所使用的最大内存， 它包含 [B] 所使用的内存， 默认值 0 表明 ADINA 可以自动确定所需

的内存； 编号 [B] 表示保存模型数据的内存 （Memory for Storing Model Data）， 该内存用于
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图 3-10　 生成并运行求解文件

ADINA 来存储矩阵和单元信息等模型数据， 也可以称它为 “基本内存”。 对于一个有限元分

析， 如果计算机的内存不能够满足基本内存的需要， 计算将无法进行。
如图 3-11 所示， 假设设置的求解最大内存 [A] 为 200MB， 模型存储内存 [B] 为

50MB。 在计算运行窗口中可以查看内存的分配情况： 对于手动分配的内存， 要求 [b]≤
[B]， [a]≤[A]。 通过观察， 还将发现它们满足下列关系： [a] = [b] + [c]，可知求解内存

等于求解器 （此处的求解器为 Sparse） 所占内存加上模型存储所占内存。

图 3-11　 计算过程中 Message 窗口的信息

如果求解文件已经存在， 此时可以直接进入求解器中进行求解。 例如， 对于结构场分
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析， 单击菜单 Solution→Run ADINA Structures 将弹出求解器窗口， 此时可以关闭 ADINA- AUI
来释放部分内存。 单击 Start 按钮， 选择将要计算的求解文件， 并设置内存及计算核数， 就

可以提交分析了。 对于这种提交求解文件的方式， 其内存的设置窗口与图 3-1 有少许不同，
如图 3-12 所示， 此处允许选择设置求解最大内存 [A] 或 Sparse 求解器内存 [C]。 实质

上， 设置 [A] 和设置 [C] 都相同， 如果设置的是 [C]， 则需要保证 [c]≤[C] 就好，
如图 3-12 所示。

图 3-12　 设置内存

提交计算时， 如果计算机的内存不够用， 则应该按照下面介绍的方法来手动修改内存并

提交计算； 如果计算机的内存足够大， 则无须采取这种方法。 手动修改内存的操作步骤

如下：
1） 首先使用自动分配内存进行试算， 如果能够弹出计算窗口， 则记住 [b] 值， 如果

[b] 值超过了计算机的物理内存， 表示计算将无法进行。
2） 退出 ADINA- AUI， 使用求解器窗口来自动分配内存， 并提交计算。
3） 如果第 2 步操作不能顺利进行， 则应该采用手动调节内存设置， 设置时应满足：

[B]≥[b] 和 [A] = 0， 然后再提交计算。 希望 ADINA 软件能够自动寻找内存来进行 in-
core （完全在实际内存或虚拟内存中进行） 计算。

4） 如果第 3 步操作不能顺利进行， 分析时应关注计算信息中的 [c] 值， 即： in- core
计算所需的内存值。 如果计算机的物理内存小于该值， 就只能进行 out- of- core （计算过程中

需读、 写硬盘文件） 计算， 此时可以直接为 [C] （Memory for Sparse Solver） 进行赋值。
一般情况下， 按照第 4 步操作进行设置就可以进行计算， 但可能出现计算较慢的问题。

对于 32 位的 ADINA 软件， 虽然计算机的物理内存很大， 但由于软件自身的原因， 所能够使

用的最大内存仅为 2G 多 （内存的理论最大值为 232）； 对于 64 位的 ADINA 软件， 允许使用

的最大内存几乎没有限制条件， 因此， 大型计算一般都需用使用 64 位版本的 ADINA 软件进

行求解。

3. 2. 3　 流场分析时的内存分配

ADINA- CFD 模块将可供调用的内存分为两部分： 基本内存 （basic memory） 和附加内

存 （additional memory）。 存储输入、 输出数据的内存为基本内存， 一些特定的求解器所需的

求解内存为附加内存。 ADINA- CFD 以字节的方式输出调用的内存 （对于 32 位机器是 4B， 对

于 64 位机器是 8B）。 下面将简单介绍 ADINA- CFD 中的基本内存和求解内存 （附加内存）。
基本内存： 这部分内存主要用于存储求解变量、 单元组数据和边界条件等信息。 显然基

本内存的绝大部分都用于存储矩阵。 基本内存可以分为两部分： 1） 矩阵存储内存 m1；
2） 矩阵计算内存 m2。 显然对于大多数问题， 矩阵计算内存 m2远远大于矩阵存储内存 m1，
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因此在计算时 ADINA 软件规定计算机的内存要大于矩阵存储内存 m1。 关于基本内存更详细

的介绍， 请读者参看 ADINA 流场理论手册第 13. 5. 1 节。
当矩阵计算内存 m2不够时， SKYLINE 直接求解器、 RPBCG 和 RPGMRES 迭代求解器会

自动把硬盘作为核外内存 （out- of- core） 来调用， 这在一定程度上将降低计算速度； 如果选

用了 sparse 求解器， 初始的组集矩阵必须在核内 （in- core） 进行。
求解内存 （附加内存）： 这部分内存为求解方程所需要的内存。 所有的迭代求解器 （例

如， RPBCG、 RPGMRES 等） 都不需要附加内存， 但是对于 sparse 求解器则需要附加内存。
更详细的介绍， 请读者参看 ADINA 流场理论手册 13. 5. 1 节。

关于 ADINA- CFD 模块中内存的使用， 建议如下：
1） 如果计算机的内存足够大， 而且在核内进行计算， 仅需要指定基本内存即可。
2） 如果计算机的内存只能够满足基本内存需要， 则应该使用 out- of- core 计算的 sparse

求解器， 而且必须指定附加内存的大小。
3） 如果计算机的内存连基本内存都无法满足， 则不能够使用 sparse 求解器， 而应该选

用核外计算的迭代求解器。
4） 当考虑流体传质和网格移动时， 流动方程、 传质方程和移动网格方程三者共同分配

内存。
5） 对于流固耦合问题、 双向迭代耦合和单向直接耦合问题， 它们所需要的内存都相

同， 均等于附加内存加上两倍的基本内存。
6） 对于直接的双向流固耦合问题， 内存的大小则与节点数、 单元数和方程数等因素

有关。

3. 2. 4　 硬盘要求

在求解过程中， ADINA 软件得到的计算结果和求解过程中生成的临时文件都将占用磁

盘空间。 因此在求解计算之前， 首先应该确保硬盘具有足够大的剩余空间， 如果硬盘空间不

足， 可以考虑移动或移除一些文件来增大硬盘的剩余空间。 对于瞬态动力学分析， 在计算完

成第 1 步后， 可以查看生成结果文件的大小， 然后再乘以所需的计算时间步数， 可以估计出

所需要的空间大小。
在计算过程中， 如果硬盘空间不足将给出错误信息， 并中止计算。 还有一点需要读者注

意： ADINA 软件在后处理读取结果文件时， 会在当前目录下生成一个与结果文件大小差不

多的临时文件， 如果读取过程中硬盘空间不足将会报错， 且不能完成结果文件的读入。 例

如， 结果文件为 1G， 硬盘剩余空间至少为 1G 才能够读取成功。

3. 3　 结果文件的保存及读入

3. 3. 1　 结果文件的保存

在默认设置下， 如果模型的规模较大， 计算的结果文件也会非常大 （有些结果文件甚

至达到几十 GB）， 在对结果进行后处理时将非常麻烦。 因此， 对于庞大的模型， 应该根据

实际情况来调整结果文件的输出方案。 以结构场为例加以说明， ADINA 软件主要包含下列
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几种调节结果文件大小的方法：
1. 方法 1： 单击菜单 Control→Porthole （. por）→Volume. . .
单击菜单 Control→Porthole （. por）→Volume. . . ， 将弹出如图 3-13 所示的 Porthole Vol-

ume 对话框。 默认情况下结果文件的保存格式 （File Format） 为二进制 （Binary）。 对于二进

制格式， 32 位的 ADINA 版本与 64 位的 ADINA 版本生成的结果文件不能够相互打开。 如果

将保存格式选择为 Text 格式， 则 32 位的 ADINA 版本与 64 位的 ADINA 版本生成的结果文件

是兼容的。
如果结果文件较大， 则可以将其分开并保存为多个文件， 单个结果文件最大分析步数目

（Max. Number of Steps in a Single Porthole） 的默认值为 0， 即将结果文件保存为一个文件。
如果某个模型在计算过程中共包含 5000 个时间步， 就可以将其分开保存为 5 个文件， 此时

可以将单个文件最大分析步数目 （Max. Number of Steps in a Single Porthole） 的值设置为

1000， 即每隔 1000 个时间步保存为一个结果文件。
如果希望减小结果文件的大小， 则可以退选 Individual Element Results 选项， 默认设置

是保存单元的计算结果。 虽然不保存单元的计算结果结果文件会小很多， 但会丢失某些变量

的计算结果。
2. 方法 2： 单击菜单 Control→Porthole （. por）→Results at Nodes. . .
单击菜单 Control→Porthole （. por）→Results at Nodes. . . ， 将弹出如图 3-14 所示的对话

框， 可以用来保存部分节点的计算结果。 表格中的第 1 列用来输入块 （Block#） 的序号， 一

般情况下按照 1、 2、 3、 . . . 的顺序输入； 第 2 列用来输入起始节点号 （Start Node#）； 第 3
列用来输入结束节点号 （End Node #）； 第 4 列用来输入节点号增量 （Node # Increment）。
由于不同行可以输入不同的起始节点号、 结束节点号和节点号增量， 将三者组合起来设置将

十分灵活。 例如， 1 ～ 1001 号节点每隔 5 个节点输出计算结果， 1001 ～ 2001 号节点每隔 10
个节点输出计算结果等。

图 3-13　 Porthole Volume 对话框

　

图 3-14　 保存节点结果
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3. 方法 3： 单击菜单 Control→Porthole （. por）→Time Steps
单击菜单 Control→Porthole （. por）→Time Steps （Nodal Result）， 将弹出如图 3-15 所示

的对话框， 可以用来保存指定时间步下模型节点的计算结果。 单击菜单 Control→Porthole
（. por）→Time Steps （Element Results）. . . ， 将弹出如图 3-16 所示的对话框， 可以用来保存

指定时间步下模型单元的计算结果。 读者只需要输入起始时间步 （Initial Time Step）、 终止

时间步 （Finial Time Step） 和时间步增量 （Increment） 即可。 例如， 在 1 ～ 1001 时间步中每

隔 40 步保存一次计算结果。 在对话框的底部， 还可以选择是否将保存结果的时间步设置应

用于单元结果保存中。 如果选择 No， 则表明不应用； 如果选择 Copy over if it is Empty， 则表

明 “如果单元结果保存列表为空， 则将当前节点的时间步保存设置应用于单元的时间步保

存设置； 如果单元结果保存列表不为空， 则不覆盖单元结果保存列表”； 如果选择 Overwrite
Any Existing Blocks， 则表明 “无论单元结果保存列表是否为空， 都将覆盖单元结果保存列

表”。 在 Specify Element- Results Saving Time Steps 对话框中也有类似的设置。

图 3-15　 保存指定时间步下模型节点的计算结果

图 3-16　 保存指定时间步下模型单元的计算结果
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在定义单元组 （单击菜单 Meshing→Element Groups 或单击图标 来打开） 的过程

中， ADINA 软件也可以定义单元组计算结果的输出状态， 如图 3 -17 所示。 例如， 定

义 3D Solid 单元组时， 在 Element Result Output 选项下可以定义是否输出单元组的计

算结果， 默认设置为输出单元组的计算结果， 选择 No 则表明不输出单元组的计算

结果。

图 3-17　 定义单元组的结果输出

根据上面介绍的 3 种方法， 就可以有效地控制结果文件的大小。 在实际建模时， 设置的

原则是： 保存关心区域的分析结果， 远离关心区域的分析结果可以不保存或少保存。

3. 3. 2　 结果文件的读入

在第 3. 3. 1 节 “结果文件的保存” 中已经介绍过， 保存文件时可以将较大的结果文件

分割为几个文件进行保存。 例如， 保存为 prob. por、 prob_1. por、 prob_2. por、 prob_3. por
等。 下面介绍将这些结果文件读入到 ADINA 软件的操作步骤和方法。

1） 单击菜单 File→Open， 读入第 1 个结果文件 prob. por。
2） 单击菜单 File→Open Porthole， 将弹出如图 3-18 所示的对话框。 在 Action for First

Porthole File 选项下选择 Add to Current Database， 并在 Porthole Type 选项下选择 Append Port-
holes 来打开文件 prob_1. por。

3） 采用与步骤 2 相同的方法， 依次打开结果文件 prob_2. por、 prob_3. por。 需要注意的

是： 也可以只打开保存结果文件中的几个 （文件可以有间隔）， 但前提是必须首先打开结果

文件 prob. por。
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图 3-18　 读入多个结果文件

此外， 在读入结果文件的过程中， 读者还可以选择求解时间、 时间步和周期对称的

结果范围， 如图 3-18 方框中所示。 例如， 如果希望读入时刻 2 ～ 时刻 7 的结果， 则应该

在 Start Time 对话框中输入 2， 在 End Time 对话框中输入 7， 此时， 将不会读入其他时刻

的结果。

3. 4　 批处理提交计算

通常情况下， ADINA 软件在人机交互方式下运行。 如果希望连续运行几个分析作业，
则必须在批处理方式下运行。 读者可以将批处理命令写入一个记事本文件， 然后将记事本文

件的扩展名修改为批处理文件的扩展名*. bat， 双击该文件即可运行批处理命令。 本节将详

细介绍批处理提交计算的各个命令。

3. 4. 1　 批处理方式运行 ADINA-AUI 的命令

批处理方式运行 ADINA- AUI 的命令如下：
. . . \ aui. exe- b- m < MTOT > [b | w] < file > . [in | plo]
其中：
1）. . . \ 指的是 aui. exe 的完整路径。 例如， 笔者的路径为 c： \ adina \ bin \ aui. exe。
2） 选项- b 表示将使用 ADINA- AUI 来读取命令流， 但不打开 ADINA- AUI。 如果命令流

中包含生成*. dat 文件的命令行， 则会自动生成一个*. dat 文件。 如果命令中不包含- b 选

项， 将看到打开 ADINA- AUI 的同时来打开模型。
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3） 选项- m 的含义是设置内存， 可以使用 bytes （b） 或者 words （w） 来定义 < MTOT >
值， word 与 bytes 的关系为： 1word = 4bytes。 < file > . [ in | plo] 表示代前、 后处理命令流

文件。
例如， 在批处理方式下运行 prob01. in 文件， 并且分配 20MB 内存 （假设 aui. exe 安装在

c： \ adina \ bin）， 对应的命令行如下：

c： \adina \bin \aui. exe- b- m 20mb prob01. in

需要注意的是： 在定义 < MTOT >值时， 20MB 中的 M 可以是 M （Mega）、 K （Kilo） 或

G （Giga）。 其中， 最经常使用的是 MB。

3. 4. 2　 批处理方式下运行 ADINA 求解器的命令

批处理方式运行 ADINA- AUI 的命令如下：

. . . \ < prog > . exe- b- s- m < MTOT > [b | w]-M < MSPR > [b | w]- t < #cpu > < file > . dat

其中：
1）. . . \ 指的是 < prog > . exe 的完整路径， < prog > . exe 指代 ADINA 软件的求解器， 包

含 adina、 adinaf、 adinat、 adfsi 或者 adtmc。
2） 选项- b 和- s 表示求解完成后将自动关闭求解器窗口。
3） 选项- M < MSPR >表示分配给 sparse solver 的内存值。
4） 选项- t < #cpu >表示计算时使用的 cpu 个数。
例如， 在批处理方式下运行 prob01. dat 文件， 并为 ADINA 分配 10Mw 内存， 为 sparse

求解器分配 100Mw 内存， 使用的 cpu 个数为 2， 对应的命令行如下 （假设 adina. exe 安装在

目录 c： \ adina \ bin \ 下）。

c： \adina \bin \adina. exe- b- s- m10mw-M 100mw- t 2 prob01. dat

假设 ADINA 安装在目录 c： \ adina 下， 下面将介绍顺序求解模型 prob01. in 和 prob02. in
的批处理文件 （采用自动分配内存）。 该批处理文件保存的路径应该与 prob01. in 和

prob02. in 相同。 批处理文件的扩展名为 . bat， 读者只需把批处理的命令写入到该文件中，
双击该文件即可运行命令。

c： \adina \bin \aui. exe- b prob01. in
c： \adina \bin \adina. exe- b- s prob01. dat
c： \adina \bin \aui. exe- b prob02. in
c： \adina \bin \adina. exe- b- s prob02. dat

默认情况下， ADINA 8. 6 版本的安装路径为 C： \ ADINA86 \ ， 如果软件安装在其他目录

下 （例如， C： \ Program Files \ ADINA8. 6 \ ）， 运行命令时， 可以使用带引号的长路径名或短

路径名， 分别如下所示：
使用长路径名 （包含引号）：
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＂ C： \Program Files \ADINA8. 6 \bin \aui. exe＂ - b. . .

使用短路径名：

C： \PROGRA ～1 \ADINA8. 6 \bin \aui. exe- b. . .

需要注意的是： 使用 dir / x 命令可以查看文件或目录的短路径名。
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本章内容：

■ 4.1 活学活用命令流文件

■ 4.2 划分网格

■ 4.3 时间函数、时间步与空间函数

■ 4.4 约束方程与刚性连接

■ 4.5 子模型与子结构

■ 4.6 设定特殊边界

■ 4.7 设定单元属性

■ 4.8 设定初始条件

■ 4.9 设定单元生死

■ 4.10 设定接触

■ 4.11 设定阻尼

■ 4.12 设定重启动分析

■ 4.13 ADINA 的坐标系

ADINA 软件建模技
巧及提高

第 4章
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　 　 本章是本书内容最为丰富的一章， 共包含 13 个小节， 详细介绍了 ADINA 软件的各个模

块、 许多重要的概念， 以及编著者总结的常用操作方法和实用技巧， 这些方法和技巧在

ADINA 软件中是通用的， 适用于软件每一个模块， 建议读者认真学习并能够熟练掌握。

4. 1　 活学活用命令流文件

命令流文件 （前处理命令流文件的扩展名为*. in， 后处理命令流文件的扩展名为

*. plo） 是文本文件， 虽然占用空间很小， 但功能强大。 活学活用命令流文件往往可以事半

功倍， 本节将主要介绍 ADINA 软件前处理和后处理命令流的用法。

4. 1. 1　 前处理命令流

命令流指的是一条条命令， 与鼠标在 AUI 对话框中的点选操作相对应。 虽然在对话框

中进行操作更直观、 易懂， 但是往往需要重复操作导致建模效率大大降低。 虽然命令流不如

对话框直观， 但是编辑、 修改模型中的参数和设置都非常方便， 可重复操作性强。
对于较大的模型， 如果保存为*. idb 格式， 占用硬盘空间较大， 但是打开速度较快；

如果保存为*. in 格式， 则占用硬盘空间很小， 更易于保存， 但是打开并执行文件需要较长

时间， 主要原因是读入几何、 划分网格需要花费较长的时间。
对话框操作比较繁琐， 且可重复性差， 修改过程中需要重新定义许多参数， 而修改命令

流将更方便快捷。 举个简单的例子， 图 4-1 所示的几何体由 3 个基本几何体进行布尔运算得

到。 如果希望改变两个孔的内径， 可以采取下列两种方法之一来实现：

图 4-1　 布尔运算后的体

1） 在 AUI 中操作。 可以先单击后退按钮， 重新定义两个圆柱， 重新做布尔运算， 操作

比较繁琐。 由于默认情况下后退按钮只能后退 5 步操作， 如果后退不能成功， 则必须首先删

除该体， 并重新定义 3 个基本几何体， 然后做布尔运算， 这样将更加麻烦。
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2） 在命令流中操作。 生成该体的命令流文件如图 4-2 所示， 第 1 条命令表示生成一个

块体 （block）， 第 2 条和第 3 条命令则表示生成两个圆柱体 （cylinder）， 第 4 条命令表示用

块体减去两个圆柱体的布尔运算。 修改图 4-2 方框中的数值并保存命令流文件， 重新读入该

文件即可修改两个孔的半径， 操作起来十分方便。

图 4-2　 生成布尔体的命令流

下面分 6 点来介绍前处理命令流的应用。
（1） 常用的命令　 ADINA 中的命令和关键字非常多， 读者不可能将它们全部记住， 这

并不表明学习命令流很困难。 实质上， 常用的命令流关键字并不是很多， 而且规律性很强，
稍微学习就可以很快上手。 建议采用 “边做边学” 的方法来学习命令流， 而无须特意去学

习。 首先在 AUI 中进行操作， 生成对应的命令流文件， 然后将 AUI 中的操作与命令流比较

来学习， 就可以很容易理解每条命令的含义， 并迅速掌握命令和关键字。 下面将简单介绍一

些最常用的命令：
1） 定义点： （生成 4 个点）。

*
COORDINATES POINT SYSTEM =0
@ CLEAR
1 0. 00000000000000 0. 00000000000000 0. 00000000000000 0
2 0. 00000000000000 1. 00000000000000 0. 00000000000000 0
3 0. 00000000000000 0. 00000000000000 1. 00000000000000 0
4 0. 00000000000000 1. 00000000000000 1. 00000000000000 0
@

2） 定义线： （点 1 和点 3 生成一条直线）。

*
LINE STRAIGHT NAME =1 P1 = 1 P2 = 3

3） 定义面： （点 1、 2、 3 和 4 生成一个面）。
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*
SURFACE VERTEX NAME =1 P1 = 1 P2 = 2 P3 = 4 P4 = 3

4） 定义体： （由面 1 拉伸成体及定义 parasolid 块体）。

*
VOLUME EXTRUDED NAME =1 SURFACE =1 DX =1. 00000000000000，
　 　 DY =0. 00000000000000 DZ =0. 00000000000000 SYSTEM =0 PCOINCID = YES，
　 　 PTOLERAN =1. 00000000000000E-05 NDIV =1 OPTION = VECTOR，
　 　 RATIO = 1. 00000000000000 PROGRESS = GEOMETRIC CBIAS = NO
*
BODY BLOCK NAME = 1 OPTION = CENTERED POSITION = VECTOR ORIENTAT = SYS-

TEM，
　 　 CX1 = 0. 00000000000000 CX2 = 0. 00000000000000 CX3 = 0. 00000000000000，
　 　 SYSTEM =0 DX1 =1. 00000000000000 DX2 = 1. 00000000000000，
　 　 DX3 = 1. 00000000000000

5） 定义材料： （定义杨氏模量为 2 e11， 泊松比为 0. 3， 密度为 7800 的线弹性材料）。

*
MATERIAL ELASTIC NAME =1 E =2. 00000000000000E + 11 NU =0. 300000000000000，
　 　 DENSITY =7800. 00000000000 ALPHA =0. 00000000000000 MDESCRIP = ′NONE ′

6） 定义和施加约束： （定义了名为 FIX- X 的约束， 并将其施加在面 1 上）。

*
FIXITY NAME = FIX- X
@ CLEAR
′X- TRANSLATION ′
′OVALIZATION ′
@
*
FIXBOUNDARY SURFACES FIXITY = ALL
@ CLEAR
1　 ′FIX- X ′
@

7） 定义和施加载荷： （定义大小为 100 沿 Z 轴负方向的力， 并将其施加在点 3 处）。

*
LOAD FORCE NAME =1 MAGNITUD =100. 000000000000 FX =0. 00000000000000，
　 　 FY = 0. 00000000000000 FZ = -1. 00000000000000
*
APPLY- LOAD BODY =0
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@ CLEAR
1　 ′FORCE ′1　 ′POINT ′3 0 1 0. 00000000000000 0 -1 0 0 0　 ′NO ′，
　 　 0. 00000000000000 0. 00000000000000 1 0　 ′MID ′
@

8） 定义和施加初始条件： （定义 Y 向初始速度为 100 的名为 INI 的初始条件， 并将其施

加在体 1 上）。

*
INITIAL- COND NAME = INI INITIALS = NO
@ CLEAR
′Y- VELOCITY ′100. 000000000000
@
*
SET- INITCOND VOLUMES CONDITIO = INI
@ CLEAR
1　 ′INI ′0
@

9） 定义单元组： （定义 3D 固体单元组）。

*
EGROUP THREEDSOLID NAME =1 DISPLACE = DEFAULT STRAINS = DEFAULT MATE-

RIAL =1　 RSINT =DEFAULT TINT =DEFAULT RESULTS = STRESSES DEGEN =YES，
FORMULAT =0　 STRESSRE = GLOBAL INITIALS = NONE FRACTUR = NO，
CMASS = DEFAULT　 STRAIN- F = 0 UL- FORMU = DEFAULT LVUS1 = 0 LVUS2 = 0，
SED =NO　 RUPTURE =ADINA　 INCOMPAT =DEFAULT TIME- OFF =0. 00000000000000，
POROUS = NO　 WTMC =1. 00000000000000 OPTION =NONE DESCRIPT = ′NONE ′，
PRINT = DEFAULT　 SAVE = DEFAULT TBIRTH =0. 00000000000000，
TDEATH =0. 00000000000000　 TMC-MATE =1 RUPTURE- = 0

10） 指定网格密度： （为体 1 指定网格密度）。

*
SUBDIVIDE VOLUME NAME =1 MODE = DIVISIONS NDIV1 = 10 NDIV2 = 5 NDIV3 = 8，
　 　 RATIO1 = 1. 00000000000000 RATIO2 = 1. 00000000000000，
　 　 RATIO3 =1. 00000000000000 PROGRESS =GEOMETRIC EXTEND =NONE CBIAS1 =NO，
　 　 CBIAS2 = NO CBIAS3 = NO

11） 划分网格： （为体 1 划分网格）。

*
GVOLUME NODES =8 PATTERN =0 NCOINCID =BOUNDARIES NCFACE =123456 NCEDGE =，
′123456789ABC ′NCVERTEX =12345678 NCTOLERA =1. 00000000000000E-05，
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SUBSTRUC =0 GROUP =1 MESHING =MAPPED PREFSHAP =AUTOMATIC DEGENERA =NO，
　 　 COLLAPSE = NO MIDNODES = CURVED METHOD = DELAUNAY BOUNDARY =

ADVFRONT
@ CLEAR
1
@

划分网格的命令包括： GPOINT （为离散点划分网格）、 GLINE、 GSURFACE、 GVOL-
UME （为 native 建模方式的线、 面、 体划分网格）、 GEDGE、 GFACE、 GBODY （为 parasolid
建模方式的线、 面、 体划分网格）。 虽然两种几何建模方式的划分网格命令有所不同， 但在

同一模型中可以混合使用， 详见第 4. 2. 3 节 “网格的连续与不连续”。
12） Master 命令。

*
MASTER ANALYSIS = DYNAMIC- DIRECT- INTEGRATION MODEX = EXECUTE，
　 　 TSTART =0. 00000000000000 IDOF =0 OVALIZAT = NONE FLUIDPOT = AUTOMATIC，
　 　 CYCLICPA =1 IPOSIT = STOP REACTION =YES INITIALS = NO FSINTERA =YES，
　 　 IRINT = DEFAULT CMASS = NO SHELLNDO =AUTOMATIC AUTOMATI = ATS，
　 　 SOLVER = SPARSE CONTACT- = CONSTRAINT- FUNCTION，
　 　 TRELEASE =0. 00000000000000 RESTART- = NO FRACTURE =NO LOAD- CAS = NO，
　 　 LOAD- PEN =NO MAXSOLME =0 MTOTM =2 RECL =3000 SINGULAR =YES，
　 　 STIFFNES =0. 000100000000000000 MAP- OUTP = NONE MAP- FORM =NO，
　 　 NODAL- DE = ′′POROUS- C = NO ADAPTIVE =0 ZOOM- LAB =1 AXIS- CYC =0，
　 　 PERIODIC = NO VECTOR- S = GEOMETRY EPSI- FIR = NO STABILIZ = NO，
　 　 STABFACT =1. 00000000000000E-10 RESULTS = PORTHOLE FEFCORR =NO，
　 　 BOLTSTEP =1 EXTEND- S = YES CONVERT- = NO DEGEN =YES TMC-MODE =NO，
　 　 ENSIGHT- = NO

命令流中， Master 命令是参数最多、 最为复杂的一条命令， 它可以设置模型的计算模

块、 各种求解参数、 单元算法等。 一般情况下很少手工修改 Master 命令。 此外， 除了上

面所列举的命令之外， 命令流中还包括很多其他命令 （例如， 设定接触、 设定特殊边界

条件、 设定运动假设、 设定迭代收敛准则等）， 读者可以在 “边做边学” 中不断地理解和

掌握。
13） 生成求解文件 （*. dat） 命令。

ADINA FILE = ′prob01_a. dat ′OVERWRITE = YES

该语句的功能是： 让 ADINA Structures 在当前文件夹中输出文件名为 prob01_a. dat 的求

解文件。 如果当前文件夹中包含同名文件， 则将其覆盖。

ADINA- F FILE = ′prob01_f. dat ′OVERWRITE = YES

该语句的功能是： 让 ADINA- CFD 在当前文件夹中输出文件名为 prob01_f. dat 的求解文

件。 如果当前文件夹中包含同名文件， 则将其覆盖。
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（2） 整理命令流文件　 保存的命令流文件能够将 AUI 中的所有操作按照顺序一一记录

下来， 如果在 AUI 中操作错误而反复修改过， 生成的命令流文件中也会包含对应的重复命

令。 重新读取命令流文件时， 也会重复操作这些命令， 这不但增加了程序的执行时间， 而且

降低了命令流文件的可读性， 使得命令流看起来非常无条理。 一般情况下都需要经常整理命

令流文件， 并删掉重复的命令， 这是建模分析的好习惯。 对于 ADINA 软件的初学者， 盲目

地删除命令流可能出现各种意想不到的问题， 为了避免出现错误， 建议初学者在修改命令流

时不要覆盖原始文件。
在创建模型的过程中， 覆盖保存命令流文件时可能会出现下列命令行 （人工编辑命令

流时可以删除这些命令行）：

*
FEPROGRAM PROGRAM = ADINA
*
CONTROL PLOTUNIT =PERCENT VERBOSE =YES ERRORLIM =0 LOGLIMIT =0 UNDO =5，
　 　 PROMPTDE = UNKNOWN AUTOREPA = YES DRAWMATT = YES，
　 　 DRAWTEXT =EXACT DRAWLINE =EXACT DRAWFILL =EXACT AUTOMREB =YES，
　 　 ZONECOPY = NO SWEEPCOI = YES SESSIONS = YES DYNAMICT = YES，
　 　 UPDATETH = YES AUTOREGE = NO ERRORACT = CONTINUE FILEVERS = V85，
　 　 INITFCHE = NO SIGDIGIT = 6 AUTOZONE = YES PSFILEVE = V0

定义边界条件时经常会遇到多个线、 面的边界条件相同的情况， 下列是定义流固耦合界

面的命令， 面 1 ～面 20 表示流固耦合界面。 保存命令流文件时， 每个面都会占据 1 行， 20
个面将占据 20 行， 如果包含上百个面则将占据上百行， 使得命令流文件较长， 阅读和修改

都很麻烦。

*
FSBOUNDARY FACES NAME =1 BODY =1
@ CLEAR
1
2
3
……
20
@

如果定义的流固耦合界面的面号连续， 在编辑修改命令流文件时， 可以将其修改为下列

形式， 不仅节省了存储空间， 而且增加了命令流文件的可读性。

*
FSBOUNDARY FACES NAME =1 BODY =1
@ CLEAR
1
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to
20
@

也可以整理为一行， 如下所示。

*
FSBOUNDARY FACES NAME =1 BODY =1
@ CLEAR
1 to 20
@

如果定义的流固耦合界面的面号不连续， 例如， 面 8 和面 9 不属于流固耦合面， 则可以

将该命令修改为如下所示 （定义其他边界条件、 指定网格密度及划分网格时， 也可以采用

“to” 的方法）：

*
FSBOUNDARY FACES NAME =1 BODY =1
@ CLEAR
1
to
7
10
to
20
@

（3） “*” 的含义　 在命令流文件中， “*” 表示注释， 无实际意义。 为了便于他人读

懂命令流文件， 可以在 “*” 的后面添加说明语句。 例如：

*定义面 1 ～面 20 为流固耦合边界条件

FSBOUNDARY FACES NAME =1 BODY =1
@ CLEAR
1
to
20
@

（4） 活用 read end 命令　 read end 是一条命令， 允许手动添加到命令流文件中的适当位

置。 当程序执行到该关键字时将暂停， 读者可以根据需要在 AUI 中进行各种操作， 操作完

成后， 可以单击图标 继续读取命令流文件。 例如， 如果对当前模型指定的网格密度和网

格划分效果不满意， 此时可以打开命令流文件， 找到指定网格密度及网格划分的语句， 将这

些语句删除， 并使用 read end 命令代替， 保存命令流文件后重新读入该文件。 程序暂停后就
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可以在 AUI 中手动操作网格密度和划分网格。 操作完成后， 单击 图标来执行剩余的命令，
然后重新保存命令流文件。 这样做不仅可以指定满足要求的网格密度和网格划分， 同时也可

以得到修改后的命令流文件。 如果读者希望在模型中修改或插入某些命令， 就可以使用 read
end 语句来灵活地修改模型。

（5） 定义参数化变量 　 整理好的命令流文件相当于一个可参数化修改的文件。 例如，
当希望修改网格密度时， 只要打开命令流文件查找到对应的语句， 修改网格密度参数后保存

文件， 然后重新读入该文件即可。 同时， ADINA 软件还允许在命令流中自定义参数化变量，
格式可参考如下示例：

* = = = = = = = = = = = = = = = = = = = = = = = =
PARAMETER length ′1 ′
PARAMETER width ′4*$ length ′
PARAMETER height ′sqrt（$ width） ′
* = = = = = = = = = = = = = = = = = = = = = = = =
*
BODY BLOCK NAME =1 OPTION =CENTERED POSITION =VECTOR ORIENTAT =SYSTEM，
　 　 CX1 = 0. 00000000000000 CX2 = 0. 00000000000000 CX3 = 0. 00000000000000，
　 　 SYSTEM =0 DX1 =$ length DX2 =$ width DX3 =$ height

这段命令流定义了 3 个变量， 分别是 length、 width 和 height。 其中， length 等于 1，
width 等于 length 的 4 倍， height 等于 width 的平方根。 然后定义了 block， 它的长 （DX1）、
宽 （DX2） 和高 （DX3） 分别等于 length、 width 和 height。 需要注意的是： 定义变量时需要

使用 PARAMETER 关键字， 为变量赋值时需要使用 “ ′′”， 引用其他变量时则需要在变量前

加 “$”。
（6） 简化命令流文件　 ADINA- AUI 自动生成的命令行非常长， 读者可以根据需要对这

些命令进行简化， 简化后的命令行看起来非常简单， 可读性更强。 例如， 系统默认生成的二

维单元组的命令如下：

*
EGROUP TWODSOLID NAME =2 SUBTYPE = STRAIN DISPLACE = DEFAULT，
　 　 STRAINS = DEFAULT MATERIAL =2 INT = DEFAULT RESULTS = STRESSES，
　 　 DEGEN =YES FORMULAT =0 STRESSRE =GLOBAL INITIALS =NONE FRACTUR =NO，
　 　 CMASS =DEFAULT STRAIN- F =0 UL- FORMU =DEFAULT PNTGPS =0 NODGPS =0，
　 　 LVUS1 = 0 LVUS2 = 0 SED = NO RUPTURE = ADINA INCOMPAT = DEFAULT，
　 　 TIME- OFF = 0. 00000000000000 POROUS = NO WTMC =1. 00000000000000，
　 　 OPTION = NONE DESCRIPT = ′NONE ′THICKNES = 1. 00000000000000，
　 　 PRINT = DEFAULT SAVE = DEFAULT TBIRTH =0. 00000000000000，
　 　 TDEATH =0. 00000000000000 TMC-MATE =1 RUPTURE- = 0

上述命令共包含 9 行代码。 定义单元组时只改变了应变状态及材料， 其他均采用默认设

置， 因此， 可以将该命令行简化为如下所示：
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*
EGROUP TWODSOLID NAME =2 SUBTYPE = STRAIN MATERIAL =2

ADINA 安装目录的 Samples 文件夹中提供了 primer 手册和 verify 手册的例题命令流文

件， 它们均经过了简化和整理 （尤其是 verify 手册， 需要有一定的 “功底” 才能够

看懂）。
需要注意的是： 简化命令流需要一定的基础， 读者一定不要将需要的某些命令删掉， 否

则可能会出现一些问题。

4. 1. 2　 后处理命令流

后处理时， ADINA 软件也可以生成命令流文件 （*. plo）， 以便对分析结果进行各种后

处理。 在默认情况下， 在 File 菜单中保存*. plo 文件时不会保存所有操作对应的命令流。 如

果希望保存所有的后处理命令， 则需要在 AUI 的命令行中输入下列命令：

COMMANDFILE post. plo OPTION = SESSION GRAPHICS = YES

其中， post. plo 为自定义文件名， 读者也可以修改为其他名字。 执行完这条命令后， 在

当前工作目录中就可以查找到保存的 post. plo 文件。 *. plo 文件可以使用记事本等文本编辑

工具打开， 读者也可以根据需要来编辑、 修改或删除命令。 需要注意的是： 上面这条命令应

该在所有操作都完成后再在命令行中输入。

4. 2　 划分网格

有限元法的核心是通过离散化的网格来实现数值模拟计算， 因此， 网格质量将直接决定

有限元计算的准确度。 在 ADINA 软件中划分网格时需要注意的问题、 划分网格的方法和应

用技巧比较多， 本节将详细介绍下列内容： 指定网格密度、 映射网格与自由网格、 网格的连

续与不连续、 其他网格功能。

4. 2. 1　 指定网格密度

在划分网格之前需要首先指定网格密度。 对于 native 建模方式， 可以对 line、 surface 及

volume 指定网格密度； 对于 Parasolid 建模方式， 可以对 edge、 face 及 body 指定网格密度；
ADINA 软件还可以为整个模型指定网格密度。

ADINA 软件包含 3 种指定网格密度的方法， 如表 4-1 所示。

表 4-1　 指定网格密度的 3 种方法

方　 　 法 介　 　 绍

Use End- Point Sizes 　 指定几何点处的网格尺寸。 例如， 0. 5 表示在此点处的单元大小为 0. 5

Use Length 　 指定单元尺寸。 例如， 0. 5 表示单元的大小为 0. 5

Use Number of Divisions 　 指定网格细分份数。 例如， 10 表示分为 10 份

对于 native 建模方式， 当为 surface 和 volume 指定网格密度时， 将要求指定网格密度的



第 4 章　 ADINA 软件建模技巧及提高

Focused on Excellence　 45　　　

方向， 此时可以单击显示工具条的图标 （ Surface / Face Labels） 和 （ Volume / body
Labels） 来显示面和体的方向， 如图 4-3 所示， 旗面的方向为 u， 旗杆的方向为 v， 垂直于旗

面的方向为 w。

图 4-3　 指定网格密度的方向

一般情况下， 复杂模型应该遵循 “先整体后局部、 先大后小” 的原则来指定网格密度。
“先整体后局部” 指的是先为整体设定网格密度， 然后再修改局部的网格密度； “先大后小”
指的是先为体设定网格密度， 再为面设定网格密度， 最后为线设定网格密度。

对于循环对称结构， 可以先为一个循环基本体设定网格密度， 然后再进行 Transforma-
tion 操作， 此时其他体的网格密度也同时设定好， 可以节省很多时间。

关于指定网格密度的详细介绍， 请参见 《ADINA 应用基础与实例详解》 第 4. 7 节， 本

书不再赘述。
关于网格密度的合理分配： 网格密度设定得越密， 单元数量就越多， 计算结果将越精

确， 但求解问题所需的资源也越多； 反之， 如果网格密度设定得越稀疏， 单元数量就越少，
计算结果误差就越大， 求解所需资源越少。 因此， 设定网格密度时需要考虑其合理分配， 在

保证计算精度的前提下尽量减小网格数量， 以达到节约资源， 加快求解速度的目的。 一般情

况下， 在应力集中区域、 结果梯度变化较大的区域， 以及所关心的计算区域， 都应该设定较

密的网格； 在结果梯度变化不大的区域则设置较稀疏的网格密度。 究竟设定多大的网格密度

才是最合适的， 往往需要具体问题具体分析， 不可一概而论。
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4. 2. 2　 映射网格与自由网格

ADINA 软件中包含两种划分网格的方式： 映射网格 （Rule- Based） 和自由网格 （Free-
Form）。 映射网格指的是有规律的网格划分方式； 自由网格则是无规律的网格划分方式。 映

射网格对划分实体的形状有特殊要求， 自由网格对划分实体的形状无要求。
此处所说的实体形状泛指几何拓扑形状。 对于二维实体， 四边形 （包括曲边四边形） 和三角形

（包括曲边三角形） 能够划分为映射网格； 其他不规则实体则只能采用自由网格划分方式。 例如，
圆面分别由3 条曲边和4 条曲边构成， 映射网格划分和自由网格划分的情况比较如图4-4 所示。

对于三维实体， 空间四面体、 空间五面体和空间六面体都可以划分映射网格， 其基本的

实体结构如图 4-5 所示。 例如， 圆柱体无法直接划分为映射网格， 它只能够划分自由网格。
如果希望为圆柱体划分映射网格， 则需要将圆柱沿着两个直径面切开为 4 个体 （4 个空间五

面体）， 如图 4-6a 所示。 空间四面体、 五面体和六面体结构的映射网格划分如图 4-6b 所示，
其中右下方的 3 个实体结构划分采用了退化网格 （degenerate）。

图 4-4　 二维实体映射网格与自由网格划分情况的比较 图 4-5　 能够划分映射网格的三维实体结构

图 4-6　 划分映射网格
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　 　 众所周知， 网格质量对于有限元计算的结果有很大影响， 某些情况下网格的划分将占据

工作的绝大部分时间， 因此很多 CAE 工程师在建模时都追求高质量的网格。 划分映射网格

不仅美观、 单元数量少， 而且计算精度高， 也自然成为有限元软件和工程师们关注的焦点。
能否划分出映射网格和如何划分出高质量的映射网格， 其关键在于有限元软件的 “切功”。
对于复杂的三维实体， 很难直接划分出映射网格， 必须将其 “切开” 分解为图 4-5 和图 4-6
所示的基本实体结构及衍生结构， 才能够划分出映射网格。

ADINA-M 模块可以对 Parasolid 格式的几何模型进行处理及分割操作。 图 4-7 给出了

ADINA 软件对球体划分映射网格的一种方法， 基本的操作步骤如下：
1） 分别建立球体和块体， 并通过定义 Transformation 来调节二者之间的对应位置。
2） 建立切平面， 进行切割操作。
3） 删掉不符合要求的体 （body）。
4） 通过定义 Transformation 对体 （body） 进行复制。
5） 继续复制体 （body）， 并设定网格密度。
6） 定义单元组， 划分网格。

图 4-7　 球体映射网格的划分

对于更复杂的几何实体， 使用 ADINA 软件进行切割操作可能比较费事， 或者不能够成

功切割。 如果希望划分出映射网格， 建议采用 SolidWorks 等专业的 CAD 软件对几何模型进

行加工及切割， 然后将其导入到 ADINA 软件中， 指定网格密度后再来划分映射网格， 图4-8
给出了一个实例。

如果希望对复杂的曲面壳结构划分映射网格， 首先需要将体切分为标准几何体 （如图

4-5 所示， 也可能需要其他 CAD 软件辅助来完成）， 然后为体 （body） 划分映射网格， 然后

采用节点拟合的方式为面划分壳网格， 此时得到的壳网格将为高质量的映射网格， 然后再删

除体网格， 这种方法也称为 “借体生壳法”。
作为一种数值算法， 有限元法存在计算误差很正常， 只要计算精度能够达到容许要求

（详细介绍请参见第 6. 1 节 “建模基础与模型设定”）， 采用什么样的网格形式是次要的， 因

此不必不惜一切代价地过分追求高质量的映射网格， 自由网格划分也依然能够完成计算任务

（甚至可以出色地完成任务）， 剖分高质量的映射网格往往需要花费大量的建模时间。 很多
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图 4-8　 对 SolidWorks 导入 ADINA 的几何体划分映射网格

计算即使采用高质量的映射网格也不可能完全胜任计算的全过程， 仍可能出现单元过度扭

曲、 过度变形等情况， 此时往往需要重新划分网格。 对于需要网格重构的模型， 初始网格的

划分质量相对来说并不是非常重要。

4. 2. 3　 网格的连续与不连续

在 ADINA 软件中， 网格的连续性与节点是否拟合有关。 所谓 “节点拟合” 指的是同一

几何位置处或其相邻区域内的两个或多个节点是否合并为一个节点。 如果合并为一个节点，
则称为节点拟合； 否则， 则称为节点不拟合。 对于模型的边界 （二维模型为线， 三维模型

为线和面）： 如果节点都拟合， 则网格连续； 如果部分节点没有拟合， 则网格在不拟合处不

连续。
下面将详细介绍检查模型网格连续性的方法。 对于二维和三维模型的外边界， 单击

显示工具条中的 （Node Labels） 图标和 （Node Symbols） 图标， 如图 4-9a 所示， 如

果边界上存在重合的节点， 则表明节点没有拟合 （网格不连续）； 图 4-9b 中的上半部分

使用高阶单元， 下半部分使用低阶单元， 在交界处节点没有拟合 （网格不连续）， 即使下

半部分在水平方向的网格密度缩小一倍， 使边界处的节点全部拟合， 网格也依然不连续，
原因是： 低阶和高阶单元在边界处的形函数不一致。 此时， 可以采用 Glue Mesh （参看本节

后面的介绍） 将网格粘结在一起。 如果希望生成连续网格， 同一模型中应该采用相同节点

数的单元。

图 4-9　 检查模型网格的连续性
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检查三维模型内部网格连续性的方法如下： 首先退出几何显示状态， 检查 （ Show
Geometry） 图标是否按下， 如果按下则单击该图标， 让图形区退出几何显示状态。 此时， 图

形区将只包含有限元模型信息。 单击 （Model Outline） 图标只显示有限元模型的外边界，
然后再单击 （Wire Frame） 图标查看图形区， 如果图形区模型的内部包含虚线面， 则表明

模型在此虚线面处网格不连续； 如果模型内部为空白， 则表明模型内部节点都连续， 如图

4-10 所示。

图 4-10　 检查模型内部网格的连续性

如果图形区中包含一些比较乱的线， 不一定表明网格不连续， 有些情况下可能是网格单

元显示角度不当出现的错觉。 单击 （Modify Mesh Plot） 图标将弹出 modify mesh plot 对话

框， 单击 Rendering 按钮将弹出 Define Mesh Rendering Depiction 对话框， 将 Element Face
Angle修改为一个较大值 （例如， 45°）， 如图 4-11 所示， 单击两次 OK 按钮退出对话框， 此

时图形区的杂线将会消失。

图 4-11　 消除图形区中的杂线
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划分网格时进行节点重合性检查的设置是保证网格连续的关键。 下面以 Mesh Volumes
对话框为例 （如图 4-12 所示） 加以说明： 在 Nodal Coincidence 标签页下单击 Check 下拉菜

单， 可以选择如表 4-2 所示的 6 种节点检查方式。 读者可以根据模型的实际情况选择适当的

节点重合性检查方式来确定网格的连续与否。 实现网格不连续的方法很多， 例如， 图 4-10b
所示的网格不连续实例， 可以将网格不连续的面设定为一个域， 划分网格时选择 Exclude
Surfaces in Domain 即可。

图 4-12　 网格划分的节点重合性检查

表 4-2　 节点重合性检查说明

方　 　 式 说　 　 明

All Generated Nodes 对所有节点检查重合性

Nodes Generated at Boundaries 对边界上节点检查重合性

Boundary Nodes against Domain 对域内边界节点检查重合性

Exclude Surfaces in Domain 对域内面处节点不检查重合性

Against Same Element Group Only 对属于同一单元组节点检查重合性

No Checking 不对节点检查重合性

节点重合性检查的默认方式是 Nodes Generated at Boundaries， 因此， 默认状态下生成的

网格都是连续的。 如果发现生成的网格不连续， 而几何方面没有问题， 则可以调大图 4-12
所示的 Tolerance 值 （例如， 修改为 1e-3）， 然后划分网格并检查网格是否连续。 如果不连

续， 则应继续增大 Tolerance 值， 直到网格连续为止。
通常情况下， 希望模型中生成的网格都连续。 但是， 当模型中包含接触、 断裂及其他边

界条件 （例如， 膜结构的流固耦合界面、 流场滑移壁面等） 时， 则不要求网格连续。 图

4-13给出了两个网格不连续的实例， 图 4-13a 的两个几何面共用 1 条几何边 L3， 且 L3 处网

格不连续， 该不连续网格可以用于计算裂纹； 图 4-13b 的两个几何面在交界处有两个边

（L3 和 L5， L3 属于面 S1， L5 属于面 S2）， 网格在交界处不连续， 该不连续网格可以用于计
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算接触， 而且面 S1 和面 S2 在交界处的网格密度也可以不一致。 需要注意的是： 图 4-13a 所

示的网格不能用于计算接触， 原因是无法指定接触面， 初学者很容易犯这种错误。

图 4-13　 不连续的网格

实现不连续网格的方法也有很多， 以包含 6 个面的图 4-14 为例来说明， 如果希望黑色

边的网格不连续， 实现方法如下：
第 1 种方法： 首先为面 2 和面 5 划分网格， 节点检查方式选择为 No Check， 然后为面

1、 3、 4、 6 划分网格， 节点检查方式选择为 Nodes Generated at Boundaries。
第 2 种方法： 首先为面 1、 2、 3 划分网格， 节点检查方式选择 Nodes Generated at Bound-

aries， 然后为面 5 划分网格， 节点检查方式选择 No Check， 最后再为面 4 和面 6 划分网格，
节点检查方式选择 Nodes Generated at Boundaries。

图 4-14　 不连续网格划分示例

对于包含多个体 （body） 的三维结构， 如果希望保证网格连续， 最好的做法是首先定

义 face link， 对应的菜单操作为 Geometry→Faces→Face link。 face link 定义完毕再划分网格

时， ADINA 软件将让 body 交界处的网格自动保持连续。 如果不定义 face link， 出现网格不
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连续的可能性就非常大。
有些情况下， 采用 ADINA 软件默认的 Tolerance （1e-5） 无法成功地进行 Face Link， 对

于由其他 CAD 软件导入的几何体更是如此。 此时， 可以尝试将 Tolerance 值设置的大些， 如

图 4-15 中方框所示， 以便能够成功地进行 Face Link。

图 4-15　 定义 Face Link

如果相邻的两个 body 连接面形状不同 （如图 4-16 所示）， 则不能直接设定 face link，
必须首先做印记， 做印记时需要用到 ADINA-M 模块的布尔运算命令， 保留被减体 （勾选

Keep the Subtracting Bodies）， 并保留印记 （勾选 Keep the Imprinted Edges Created by the Sub-
traction）， 如图 4-17 所示。 做好印记后单独显示 body1 （见图 4-16）， 可以发现 body1 的上

表面多了一个圆面。 有了这个圆面就可以做 Face Link。 另外， 做印记的另一个作用是便于

在选定的区域施加载荷， 例如， 在图 4-16 所示的圆面加载， 此时往往不保留被减体。

图 4-16　 不同性质的 body 进行连接
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图 4-17　 印记示例

设定 Face Link、 指定网格密度和定义单元组结束即可划分网格。 不同的 body 可以划分

为不同节点数的单元， 且在边界处保持网格连续。 例如， 图 4-18 下部的块体选用六面体单

元， 上部的圆柱体选用四面体单元。 此时， 如果查看节点编号将会发现边界处无重节点。

图 4-18　 做好 Face Link 后划分的连续网格

如果模型中包含多个 body， 做 Face Link 时可以将 type 选择为 Create For All Faces / Sur-
faces， 如图 4-15 所示， 此时就可以将所有可能相连的面一次性都做好 Face Link， 节省很多

时间。
如果执行上述操作时包含了并不希望做 Face Link 的区域， 此时可以查看 Face Link， 并手
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动删除不想要的 Face Link。 只要剩余 face- link 的数目大于删除的数目， 该操作就是合适的。

4. 2. 4　 其他网格功能

本节将介绍划分网格的其他功能， 包括： 粘结网格、 壳单元和实体单元的连接、 边界

层、 狭窄处的分层和其他说明等内容。
1. 粘结网格

ADINA 软件中还提供了一种不连续网格的粘结功能 （Glue Mesh）， 可以用于循环对称

结构的静力分析、 动力分析和模态分析等。 对于如图 4-19 所示的循环对称分析示例， 通过

网格粘结功能将叶片连接到圆柱形的基座上。 Glue Mesh 功能可以在菜单 Meshing→Glue
Mesh 中进行设定， 详细介绍请参见第 8. 4 节 “周期对称结构的力学分析”。

如果模型两边的网格密度和网格类型不一致， 则可以使用网格粘结功能。 在后处理中，
可以看到网格粘结处能够很好地保证变量的连续性。 如果模型的两个面之间存在小的间隙，
在设置网格粘结时可以调大 Extension Factor （默认为 0. 01）， 此时， Extension Factor 范围内

的区域都会建立网格粘结。 需要注意的是： 网格粘结功能不能用于显式计算。 关于网格粘结

功能更详细的介绍， 请参见 ADINA 8. 6 版 《结构理论手册》 第 5. 16 节。

图 4-19　 网格的粘结功能 （Glue Mesh）

2. 壳单元与实体单元的连接

ADINA 软件中还提供了壳单元和实体单元的连接功能， 单击菜单 Meshing→Create
Mesh→Shell Transition 可以定义壳单元与实体单元的连接 （如图 4-20 所示）， 选择对应的边

和面即可 （注： Body 编号为 0 表示没有 Body， 用于 native 几何建模方式）。
单击菜单 Display→Geometry / Mesh Plot→Modify 或单击图标 （Modify Mesh Plot）， 在打

开的窗口中单击 Element Depiction 选项， 然后在弹出的 Define Element Depiction 窗口中的

Appearance of Shell Element 标签页下选择 Top / Bottom 进行壳单元的修改， 如图 4-21 所示。
单击两次 OK 按钮退出对话框， 此时图形区将显示出壳单元的实体效果， 如图 4-20b 右图所

示。 通过这种方法可以检查模型中壳单元与实体单元的连接是否定义正确。
3. 边界层

边界层的功能主要用于流场网格的再划分。 流场分析中， 流场边界处的变量往往梯度变

化最大， 所以流场边界处使用粗糙的网格通常不能够满足计算要求， 因此需要将网格细化成
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图 4-20　 定义壳单元与实体单元的连接

图 4-21　 修改壳单元的显示
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多层。 在定义边界层之前， 需要事先划分好网格， 对应的操作如下： 单击菜单 Meshing→
Create Mesh→Boundary Layer。 关于边界层应用的详细介绍， 请参见 ADIAN 86 版本中 Primer
手册的第 39 题， 此处不再赘述。

4. 狭窄处的分层

除了边界层功能之外， ADINA 软件还提供了一种适用于狭窄处网格分层的技术。 对于

图 4-22 所示的 Mesh Bodies 对话框， 在 Advanced 标签页下可以定义 Min. # of Elements Across
Thin Sections 的值， 如果值为 3， 表明模型最狭窄处网格的层数不少于 3 层。 此外还可以定

义 Layer Table 和 Size Function， 请读者自己尝试使用。 关于为狭窄处分层的详细介绍， 请参

见 Primer 手册第 38 题。

图 4-22　 狭窄处的网格划分设置

5. 其他说明

单击菜单 Meshing→Create Mesh→Brick Dominant 可以设置以 Brick 单元为主的网格。 此

外， 菜单 Meshing→Copy Mesh 中包含两种复制网格的技术供使用， 请读者自行尝试体会该

功能。

4. 3　 时间函数、 时间步与空间函数

时间函数、 时间步与空间函数是 ADINA 软件中最基本、 最重要的 3 个概念， 初学者往

往对这 3 个概念理解不透彻， 造成建模困难， 正确理解它们是成功建模的第一步。

4. 3. 1　 时间函数与时间步

载荷的大小往往随着时间发生变化， ADINA 软件使用时间函数来描述载荷的大小随时
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间的变化情况。 不论是静态问题还是动态问题， 都必须为任何载荷指定时间函数。 单击菜单

Control→Time Function 可以定义时间函数， ADINA 软件默认的时间函数 1 是一个不随时间变

化的常量， 如图 4-23 所示， 它表明载荷的大小不随时间发生变化。

图 4-23　 ADINA 默认的时间函数

读者不仅可以修改默认的时间函数 1， 而且可以定义其他的时间函数。 图 4-24 所示的

时间函数表明： 在 40 个单位时间内， 载荷由 0 线性增加到 400。 如果定义的位移载荷大小

为 1， 则在 0 时刻， 位移载荷为 0； 在 40 时刻， 位移载荷线性增加到 400。

图 4-24　 时间函数示例

时间步用来描述计算所需的步数及对应的步长。 在菜单 Control→Time Step 下可以定

义计算时间步， ADINA 软件默认的时间步设置通常不能够满足要求， 因此需要修改。 时

间步的定义情况决定了计算求解的总时间。 对于如图 4-25 所示的时间步， 总时间为 25 个

时间单位 （ t = 10 × 1. 0 + 5 × 2. 0 + 50 × 0. 1 = 25）。 计算时间步的总时间可以由 ADINA 软

件自动算出， 对应的操作如下： 单击菜单 Model→Rebuild， 在图形区的左上角将显示总的

计算时间。
任意时间步的载荷增量由时间函数和时间步长共同确定。 如图 4-26 所示， 载荷的变化

趋势由给定的时间函数确定， 给定时间增量 Dt 后就能够确定载荷增量 DF。
对于隐式 （Implicit） 计算， 时间增量按时间步中定义的 Constant Magnitude 计算， 如果

在给定的时间增量下计算没有收敛， 计算将会中止。 为了让计算能够顺利进行， 读者可以通

过改变 Constant Magnitude 来调整时间步的定义， 但这种方法并非是最好的方法。 ADINA 软

件还提供了一个非常好的工具———自动时间步长 （ATS）， 提交计算前可以打开自动时间步

长， 并进行相关设置。
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图 4-25　 时间步示例

　 　

图 4-26　 载荷增量的确定

对于非线性计算 （静态问题和动态问题）， 最好打开自动时间步长， 在模型的调试阶段

更是如此。 程序模块工具条中包含设置自动时间步长的图标 ， 其对话框如图 4-27 所示，
各参数的含义如表 4-3 所示。 自动时间步长是非线性分析的重要工具。 在模型调试阶段， 读

者往往并不清楚将时间步长设置为多大才合适， 此时可以打开自动时间步长， 并将 Maxi-
mum Subdivisions Allowed 参数设置为较大值， 提交计算并观察计算的收敛情况， 如果时间步

长非常小时都不能够收敛， 往往说明模型本身可能存在问题。 需要注意的是： 对于线性问

题， 设置自动时间步长对分析毫无意义。

图 4-27　 设定自动时间步长

表 4-3　 设定自动时间步长

符　 　 号 相 关 设 置 描　 　 述

[A] 　 Maximum Subdivisions Allowed
　 最大细分比例： 如当前时间步长为 0. 1， 则细分后的最小时间步

长为 0. 01， 如果还不收敛， 则不能继续细分， 将退出求解， 并输出

求解无法收敛的信息

[B] 　 Maximum Time Step Factor
　 时间步长放大比例因子： 当求解非常容易收敛时， ADINA 自动增

大时间步长， 输入 3 表示最大时间步长是当前时间步长的 3 倍， 此

参数一般保持默认设置即可
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（续）

符　 　 号 相 关 设 置 描　 　 述

[C] 　 Factor for Dividing Time Step

　 时间步长细分因子： 当前时间步长没有收敛时， 输入 2 表示下一

步计算所取的时间步长为当前时间步长的二分之一， 输入 3 表示下

一步计算所取的时间步长为当前时间步长的三分之一， 默认值为 2，
一般可不做修改

　 Determined by the ADI-
NA Program

　 由 ADINA 程序根据收敛的情况自动放大和

缩小计算时间步长 （一般情况下推荐使用）

[D]
For Nest
Time Step

　 Same as the Time Step
that Gave Convergence

　 下一步时间步长

大小： 如果当前时

间步结果收敛， 程

序提供四种方式确

定下一步时间步长

大小

　 与最后收敛的时间步长大小相同

　 Same as the Time Step
Prior to the Subdivision

　 与细分前的时间步长相同

　 Return to Original Time
Step Specified

　 与读者指定的时间步长相同

[E]
　 Low- Speed Dynamics Option （Static
Analysis Only）

　 仅适用于静态分析， 是有利于促进收敛的一种技术， 适用于屈

曲、 后屈曲及接触问题， 相关理论可参考结构理论手册 7. 2

当模型计算不收敛时， 可以利用自动时间步长 Automatic Time- Stepping （ATS） 来控制

时间步的大小以得到收敛解。 当使用 ATS 时， 如果给定的时间步长不能使计算收敛， 程序

会自动细分时间步。 如果细分后仍然不收敛， 该细分过程将会继续下去， 直到找到合适的时

间步长， 或者达到了允许的最大细分次数为止。 如果达到了规定的最大细分次数， 计算还不

收敛， ADINA 将会退出计算， 并告知读者计算无法收敛。 在 ATS 过程中， 如果收敛很顺利，
时间步长可能会增大， 以加快求解速度， 节省求解时间。

ATS 在以下两种情况下会帮助读者得到收敛结果：
1） 载荷是逐渐增长的， 这种情况下， 更小的时间步意味着每一步将施加更小的载荷

增量。
2） 在瞬态分析中， 更小的时间步长会提高矩阵稳定性。
但是， 即使选择了 ATS 技术， 读者也应该尽量指定合理的时间步长， 否则在细分时间

步长的过程中会浪费过多的计算时间。 注意： ADINA 只会输出指定时间步的结果， 而不输

出细分时间步的结果。
对于显式 （Explicit） 计算， 定义的时间步长往往不是计算中的的真实步长， ADINA 软

件会根据模型的实际情况自动判断计算时间步长的大小。 尽管如此， 读者在时间步中定义的

步长仍然有意义， ADIAN 将按照该时间间隔来保存计算结果。
静态问题中的时间为伪时间， 主要作为计数器来使用； 动态问题中的时间为真实时间，

用于计算速度、 加速度、 应变率等物理量。
需要注意的是： 时间函数中定义的时间要不小于时间步中定义的时间总和。 如果时间步

中定义的时间总和超过了时间函数中定义的时间， 提交计算时将无法生成求解文件

（*. dat）， 并给出出错信息。
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4. 3. 2　 空间函数

载荷的大小不仅与时间有关， 而且与空间的相对位置有关。 如果载荷的分布不均匀， 就

需要用到空间函数。 在 ADINA 软件中， 空间函数用来描述载荷的大小随空间位置的变化情

况。 在菜单 Geometry→Spatial Functions 下可以定义空间函数， 包括： 线空间函数、 面空间函

数及体空间函数， 其中前两者最为常用。

图 4-28　 线空间函数

有 3 种可以控制空间函数加载的几何

分布类型， 分别是： 线性、 二次和表格输

入。 如图 4-28 所示的线空间函数， 曲线分

别表示线性加载、 二次曲线加载及样条曲

线加载， 右侧的载荷表示载荷最大值。 在

定义线空间函数时， 单击显示线号工具条

（Line / Edge Labels） 图标可以显示线的

编号， 在图形区可以显示出几何线的方向，
箭头所指的方向即为 u = 0 到 u = 1 的方向。
对于表格输入方式， ADINA 软件采用等分

插值的方法定义空间函数加载。 为面和体

施加空间函数时也将遇到方向问题。 只有

弄清楚面和体的方向， 才能够正确定义空

间函数， 关于确定几何体方向的详细介绍，
请参见第 4. 2. 1 节 “指定网格密度”。

ADINA 软件允许直接为 Native 建模方

式的几何施加空间函数； 对 Parasolid 几何

施加空间函数时， 则需要指定参考线、 参

考面或参考体以确定空间函数的加载几何

分布方向， 这些参考线、 参考面及参考体

要与施加载荷的 Parasolid 几何对象平行

（或重合）。 对于图 4-29 所示的面空间函

数， 图中的参考面与加载面重合。 施加载

荷时， 需要同时指定空间函数和参考面。 对于 Parasolid 体， 在施加空间函数时， 方向以定

义的参考面的几何坐标架为准， 这也是指定参考几何线、 几何面和几何体的原因所在。

4. 3. 3　 载荷与时间函数、 空间函数的关系

读者在定义载荷时输入的载荷值并非计算时的真实载荷值。 真实载荷值的计算表达式

如下：
真实载荷值 =定义载荷值 ×时间函数因子 ×空间函数因子

其中：
1） 时间函数因子指的是计算当前时间对应的函数因子， 而计算中间时刻的时间函数因

子可以由时间函数按线性插值算法得到。
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图 4-29　 指定 Parasolid 几何的面空间函数

2） 空间函数因子指的是对应空间点的函数因子， 各点的空间函数可以由空间函数插值

得到。
由于计算时的实际载荷值受到时间函数和空间函数的共同控制， 因此可以通过调整时间

函数和空间函数来调整真实载荷值。 其中， 时间函数是最常用的调整方式。 理解并掌握时间

函数、 时间步、 自动时间步长和空间函数等概念对于分析计算将大有裨益。

4. 4　 约束方程与刚性连接

4. 4. 1　 约束方程

ADINA 软件中的约束方程用于描述主体 （Master） 与从体 （Slave） 之间的运动关系。
设定约束方程时需要指定主体、 从体及相关自由度。 单击菜单 Model→Constraints 可以定义

约束方程。 为了便于理解， 可以将约束方程比作一列火车， 主体是火车头， 从体是列车的各

节车厢， 火车头的运动情况决定了车厢的运动情况， 这就是约束方程的基本思想。 主体和从

体可以是几何实体 （点、 线、 面、 体）、 节点集 （Node Set） 或节点 （Node）。 在 ADINA 软

件中， 可以是多个主体对应一个从体 （One Slave to Multiple Masters）， 此时主体对象只能选

择点或者节点集。 一个从体对应多个主体对象的约束方程不太容易理解， 现实生活中也很难

找到对应的实例； 而一个主体对应多个从体 （One Master to Multiple Slaves） 的约束方程很好

理解， 例如， 火车头带领多节车厢。
对于桥梁及建筑结构模型， 有些情况下需要保证两个或多个节点在某一自由度方向上运

动关系一致， 此时可以使用约束方程来处理。 如图 4-30 所示的示例是一个常用的约束方程：
P5 是一个离散点， 将其作为主点， L3 作为从边。 在 P5 点处可以施加载荷 （例如， 力或者

位移） 和约束， 在从体 L3 上也可以施加约束， 只要不和主体发生矛盾即可。 这样 P5 就可

以带动下部块体一起运动。
如果没有划分网格， 即使约束方程定义完毕也不能在图形区正常显示出来。 如果定义的
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图 4-30　 约束方程示例

约束方程中包含离散点， 不要忘记也要为该离散点划分网格， 此时约束方程 （和刚性连接）
才能够正常显示出来。 单击菜单 Meshing→Create Mesh→Point 可以为离散点划分网格。 单击

显示工具条的 （ Show Rigid Links and Constraints） 图标设置是否显示约束方程和刚性

连接。
当为模型施加约束方程时， 将导致模型在施加约束方程处增加了外力 （或者力矩）， 计

算支反力时也将考虑这些增加的外力影响， 但这些外力是 “隐身” 的， 核对模型力矩平衡

时如果不考虑这些力， 力矩将不平衡。
需要注意的是： 如果某个节点是约束方程的主节点， 则该节点就不能再作为其他约束方

程的从节点。 ADINA 8. 6 版 《结构理论手册》 第 5. 15 节给出了这种问题间接地解决方法，
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请读者查阅。

4. 4. 2　 刚性连接

与约束方程类似， 刚性连接也是一种特殊的约束方程。 默认情况下， 刚性连接约束了从

体的所有自由度。 单击菜单 Model→Constraints→Rigid Links 可以定义刚性连接， 选择适当的

主体和从体即可完成定义。 需要注意的是： 主体只能够是点、 节点或者节点集。
刚性连接常用来模拟工程中零件之间的焊接、 螺栓连接等约束或加筋壳结构 （当加强

筋选用梁单元定义时）。 例如， 梁单元与体单元之间的连接就可以选用刚性连接。 刚性连接

有时可以用来实现模型中的物理条件， 例如， 对于轧辊、 齿轮的平移或旋转分析， 使用辅助

节点和刚性连接来实现沿轴线平动、 转动等运动情况。 对于模拟旋转结构的有限元分析， 需

要采用刚性连接来实现， 如图 4-31 所示的涡轮结构， 可以把某点作为主点， 该主点可以是

体内的点或者体外的离散点 （需要为该离散点划分网格， 切记！）， 但一定要位于旋转轴上

（如果不在轴线上， 则成为偏心旋转）， 这样结构就可以绕着旋转轴旋转。 如果结构主动旋

转， 可以为该主点施加载荷和约束； 如果结构被动旋转 （例如， 流固耦合问题， 流体驱动

结构旋转）， 可以为该主点施加约束， 但不要约束绕旋转轴的转动自由度。 可以选择面和体

作为从体。 需要注意的是： 约束从体后， 后处理中得到的从体的应力场是不准确的， 因此定

义刚性连接时， 应该将不关心的计算区域作为从体。 此外， 旋转体分析一般都是大位移分

析， 定义刚性连接时应将 Displacements 选择为 Large； 如果不是大位移分析， 可以保存默认

的设置， 详细实例介绍见 8. 2 节 “齿轮接触传动分析”。

图 4-31　 采用刚性连接的涡轮结构

在 ADINA 软件中， Rigid Links 的另一个重要功能是设置刚体。 顾名思义， 刚体指的是
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刚性体、 不变形体， 即： 运动过程中结构不会发生形变。 对于刚体而言， 无论是平动还是转

动， 体内任意一点的运动都相同。 刚体的运动可以看做是平动和转动的复合运动。
ADINA 软件中使用 Rigid Links 来定义刚体， 即： 把整个体的自由度缩聚到一点， 该点

就是 Rigid Links 中的主点。 换句话说， 整个体的运动情况与主点的运动情况完全相同。 对

于二维模型， 如果 Rigid Links 的从体类型 （ Slave Entity Type） 选择为面 （ Surface 或者

Face）， 该面等同于刚性面， 原因是整个面的自由度都缩聚到主点上； 对于三维模型， 如果

Rigid Links 的从体类型 （Slave Entity Type） 选择为体 （Volume 或者 Body）， 则该体等同于

刚体， 原因是整个体的自由度都缩聚到主点上。
需要注意的是： 使用 Rigid Links 后， 约束只能够施加在主点上， 不能够为从体再设定

任何约束。

4. 5　 子模型与子结构

4. 5. 1　 子模型

AIDNA 软件中称子模型为分析区域 （Analysis Zooming）， 用于分析初始网格划分较粗糙

时模型中的应力集中区域， 或关心求解区域的一些细节， 由于初始网格划分往往不能满足计

算精度要求， 此时可以将这些区域的网格细化， 通过对子模型分析来得到所关心区域更精确

的求解结果。
子模型方法也称为切割边界位移法或特定边界位移法。 切割边界指的是子模型从较粗糙

的整体模型中分割边界。 整体模型在切割边界处的计算位移值即为子模型的边界条件。
ADINA软件中只有 ADINA- STRUCTURES 模块允许使用子模型。

子模型的理论基础是圣维南原理： 实际分布载荷被等效载荷 （在子模型中即边界位移）
代替后， 得到的应力和应变与实际载荷一致， 但在载荷施加的位置附近计算结果会有改变。
选用子模型分析时， 应该让子模型区域的选定范围大于重点关心区域的范围， 原因是子模型

边界处求得的结果不精确， 但对于距离边界较远处则没有影响。
选用子模型进行分析具有下列优点：
1） 可以只考虑所关心的模型区域， 而不必考虑不关心的模型区域。 对于不关心区域只

需用总体模型的初始网格分析一次即可。
2） 可以改变子模型的计算区域， 可以计算多个子区域， 对于每个子模型区域的计算仍

使用总体模型的初始计算结果。 因此， 子模型允许在感兴趣的区域就不同设计 （如不同圆

角半径） 进行分析。
3） 子模型方法可以验证网格细化的准确性。
4） 必要时， 可以在已经进行过子模型分析的区域继续分析， 每次子模型分析都会产生

新的 map 文件 （覆盖原有 map 文件）， 可以用于下一步子模型分析。
下面详细介绍子模型分析的基本步骤：
1. 为整个模型划分较为粗糙的网格并输出 map 文件

为模型划分网格这里不再解释。 在模型提交计算之前， 单击菜单 Control→Mapping
（. map） 设置输出 map 文件， 便于下一步子模型分析， 如图 4-32 所示， 在 Option 选项下选
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择 Create Mapping File for Zoom Analysis， 如果勾选 Create Mapping File as Text File 选项， 表示

可以打开查看则输出的 map 文件。

图 4-32　 设置输出 map 文件

2. 计算整体模型

如果整体模型的结果文件名为 analysis-1. por， 计算正常结束后， 打开该文件所在文件

夹并查找 analysis-1. map 文件， 将该文件复制并粘贴在同一目录下， 然后将文件名改为 anal-
ysis-2. map （这里假定下一步子模型计算的求解文件为 analysis-2. dat， 只要该 map 文件的文

件名与下一步子模型计算文件同名即可）。
3. 创建子模型

子模型可在整体模型的基础上修改得到， 然后设置子模型几何区域并重新划分网格。 提

交计算之前， 应该单击菜单 Control→Mapping （. map） 来读入指定的 map 文件， 如图 4-33
所示， Option 选项应选择 Read Mapping File for Zoom Analysis， 单击 Zoom Boundary 按钮可以

指定切割边界。 如果没有指定边界， 则所有边界都默认为在原来模型的内部。

图 4-33　 设置读入 map 文件

4. 提交计算

需要注意的是， 提交计算的文件名要与步骤 2 中的文件名一致。
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5. 分析计算结果， 验证切割边界和应力集中区域的距离是否足够远

关于子模型分析算例的详细介绍， 请参见 《ADINA 应用基础与实例详解》 的第 8 章

“实例 21： 受均匀拉力的中心开孔板”。 关于子模型的详细介绍， 请参见 ADINA 8. 6 版 《结
构理论手册》 第 11. 14 节 “Analysis Zooming”。

4. 5. 2　 子结构

图 4-34a 所示的模型包含很多重复部分， ADINA 软件允许将该模型分为两部分： 一部

分为 master structure （主结构）； 另一部分为 substructure / reuse （子结构）， 其中， 子结构指

的是模型中相同且可以重复利用及装配的部分。

图 4-34　 子结构

ADINA 软件要求主结构必须存在， 主结构主要用于确定子结构的搭接装配关系。 子结

构可以重复使用多次， 图 4-34 所示的模型中包含两个子结构。 子结构的节点也包含两种情

况： condensed 节点和 retained 节点。 condensed 节点与主结构的节点不相连， 而 retained 节点

则至少与 1 个主结构节点相连。
主结构和每个子结构都可以使用几何模型来定义。 定义子结构的操作为： 单击菜单

Model→Substructures→Define / Set， 然后输入子结构号。 后面定义的有限元设置都将隶属于子

结构。
单击菜单 Model→Substructures→Reuse 可以指定重复使用子结构、 指定重复使用连接子

结构的几何元素号和主结构的几何元素号。 子结构重用时将被平移， 因此主、 子结构中几何

元素上的节点将重合。 这样， 可以指定多个几何元素联合， 但要求每个几何元素的平移相

同。 也可以指定依据节点的子结构重用， 指定子结构重用节点数和主结构节点数。 子结构重

用平移后两节点将重合。
还可以将单元组 （必须已经存在） 定义成子结构。 这样做的原因之一是提高求解效率。
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如果将全部线性单元组并入某个子结构， 则自由度方程仅包含线性单元， 而不会进入整体单

元刚度矩阵。 操作如下： 单击菜单 Model→Substructures→From Element Group。
子结构可用于线性问题的静态分析和动态分析。 对于模型规模比较大的线性问题， 采用

子结构方法通常能够节省大量计算资源， 且减少计算准备时间； 对于非线性问题， 包含子结

构的模型只能考虑局部非线性， 即子结构部分只能是线性自由度， 非线性自由度可以施加于

主结构， 这种方式下系统平衡迭代的求解效率会显著提高。
需要注意的是： ADINA 软件的周期对称分析与子结构分析看上去非常类似， 但二者并

非同一个问题。
使用子结构的过程中还会受到很多限制， 详细介绍请参见 ADINA 8. 6 版 《结构理论手

册》 11. 1 节 “Substructuring”。

4. 6　 设定特殊边界

4. 6. 1　 设定流固耦合边界

ADINA 软件处理流固耦合问题时需要在结构场和流场分别设定流固耦合边界 （势流体

除外）。 默认情况下， ADINA Structures 模块的 FSI 选项并未激活， 此时不能够设定流固耦合

边界条件。 单击菜单 Control→Analysis Assumptions→Fluid Structure Interaction， 将弹出 Fluid
Structure Interaction 对话框， 勾选 Fluid Structure Interaction 选项， 如图 4-35a 所示， 单击 OK
按钮即可激活 FSI。 也可以单击模块工具条 图标右侧的下三角按钮选择 FSI 来激活 FSI，
如图 4-35b 所示。 这两种方法可达到相同的效果， 但后者操作更快捷。

图 4-35　 激活 FSI 的两种方法

激活 FSI 选项后， 单击菜单 Model→Boundary Conditions→FSI Boundary 可以设定流固耦

合边界， 设定时需要注意下列问题：
1） 二维问题的流固耦合边界应该选择线 （Line 或 Edge）， 三维问题的流固耦合边界应

该选择面 （Surface 或 Face）。 如果流固耦合边界同时包含 Native 建模方式和 Parasolid 建模方
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式的几何， 定义流固耦合边界时 Apply to 应该选择 Edges / Lines （或 Faces / Surfaces）。 在

ADINA- CFD 模块中设置流固耦合边界时也是如此。
2） 任何可能与流体发生相互作用的边界都需要定义为 FSI 边界。 例如， 有些边界在计

算开始时可能并没有流固耦合作用， 一段时间后将发生流固耦合作用， ADINA 软件规定在

可能发生流固耦合作用的边界都需要定义为流固耦合边界。
3） 同一组 FSI 边界可以包括多条线 （或多个面）， 但必须要求几何相互连接。 如果几

何元素分散， 则需要定义多组 FSI 边界条件， 对于 ADINA- CFD 模块也是相同的要求。
ADINA Structures 模块能够将定义好的 FSI 边界自动高亮显示， 以便查看。 如果不希望

高亮显示 FSI 边界， 可以单击菜单 Display→Geometry / MeshPlot→Define Style， 在 Define Mesh
Plot Style 对话框的 Mesh Attributes 对话框中将 Frontier Depiction 选项设置为 OFF， 如图 4-36
所示， 单击 OK 按钮退出对话框。 单击 （Clear） 图标和 （Mesh Plot） 图标， 这时图形

区将取消 FSI 边界的高亮显示。
ADINA- CFD 模块中定义流固耦合边界的操作如下： 单击菜单 Model→Boundary Condi-

tions→Special Boundary Conditions 或 图标。 与结构场中的定义类似， 定义流固耦合边界时

也需要事先激活 FSI 选项， 可以单击菜单 Model→Flow Assumptions 来实现， 也可以单击模块

工具条图标 右侧的下三角按钮选择 FSI 来激活。
定义流场流固耦合边界的过程中， 应该注意流场与结构场流固耦合边界的一一对应关

系。 在几何空间位置上， 流场与结构场的流固耦合边界应该重合， 它们构成相互作用对。 如

图 4-37 中方框所示， 定义流场流固耦合边界时需要输入与对应的结构场流固耦合边界编号，
默认情况下， 该编号为 1， 实际情况不一定是 1， 需根据模型的实际情况进行调整， 否则提

交计算时将会报错。

图 4-36　 取消结构场 FSI 边界的高亮显示

　 　

图 4-37　 输入结构场流固耦合边界编号

4. 6. 2　 设定势流体边界

势流体属于 ADINA- Structures 模块， 单击菜单 Model→Boundary Conditions→Potencial
Interface可以定义势流体边界条件。 势流体边界包括： Fluid- Structure （流固耦合）、 Free Sur-
face （自由表面）、 Fluid- ADINA- Fluid （与 CFD 模块中的流体耦合）、 Fluid- Infinite Region
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（无限远边界）、 Inlet- Outlet （入口-出口）、 Fluid- Fluid （不同介质界面）、 Fluid- Rigid Wall
（刚性壁面）。 3 种最常用的边界为： 流固耦合边界、 自由表面边界和无限远边界。

也可以不定义势流体的流固耦合边界条件， ADINA 软件在求解初始化时能够自动确定

势流体单元与结构单元的所有边界， 而且边界上也无需势流体单元和结构单元保持连续。 需

要注意的是： 流固耦合边界处的势流体单元与结构单元的节点要一一对应 （虽然网格可以

不连续， 但是节点要对应）， 因此， 界面处的网格密度应该设置为一致。 常用的做法是： 在

势流体流固耦合界面处采用 Face Link， 划分网格时选择 No Check 的节点检查方法， 保证流

固耦合边界处生成的网格节点都一一对应。
在分析储液罐、 管道、 水坝等固液耦合模态分析时， 需要经常采用自由表面边界条件；

无限远边界可以用于模拟无反射边界。 关于势流体边界条件的实例， 请参见 Primer 手册第

15 题和本书 9. 3 节 “储液罐流固耦合模态及动力响应分析”。

4. 6. 3　 Moving Wall 与 Rigid Motion （ADINA- CFD）
ADINA- CFD 模块中的 Moving Wall 为特殊边界条件， Rigid Motion 为载荷条件， 广义上，

二者都属于流场边界条件， 因为两者具有一定类比性， 故放在同一章节中进行介绍。
顾名思义， Moving Wall 指的是可以移动的壁面， 但是， 在 ADINA 软件中这种边界只允

许平动， 而不允许转动。 操作如下： 单击菜单 Model→Boundary Conditions→Special Boundary
Conditions 或者 图标来定义。

图 4-38　 设定 Moving Wall 边界

定义 Moving Wall 时可以指定移动的起始和

终止时间， 也可以定义 X 向、 Y 向及 Z 向的时

间函数， 该时间函数用来控制壁面移动的位移，
如图 4-38 所示。

有时可以用单流场分析 （非流固耦合分析）
来模拟旋转机械等的纯流场响应， 此时需要定

义壁面的旋转边界条件， 该旋转边界条件无法

通过 Moving Wall 实现 （ADINA 软件不支持）， 但可以通过流场的载荷条件 Rigid Motion 来变

通实现 （可以选择平移或者旋转）。 对应的操作如下： 单击菜单 Model→Usual Boundary Con-
ditions / Loads→Apply 或单击 （Apply Load） 图标来定义。 之所以说可以变通实现， 原因

是： Rigid Motion 无法施加在边界上， 只能施加在整个模型或者施加在单元组上， 因此需要

将旋转部分的单元定义为一个单元组， 然后将定义好的 Rigid Motion 施加在该单元组上， 以

实现单流场模拟旋转。 如果想了解这部分内容， 可以参见 ADINA 8. 6 版 Primer 手册第 37 题

将其稍微修改下就可以实现单流场模拟旋转。 需要注意的是： 虽然旋转的是整个单元组， 但

效果与壁面旋转相同。

4. 6. 4　 设定 Leader- Follower （ADINA- CFD）
ADINA 软件中的 Leader- Follower 指的是 Follower 点的位移由 Leader 点带动， 它们构成

一个作用对， 该法实质上强制规定了某些节点的位移规律。 设定 Leader- Follower 是 ALE
（Arbitrary- Lagrangian- Eulerian） 网格控制的一个重要功能。 对于动网格问题， 合理控制网格

移动是保证计算顺利进行的关键。 如果模型设计不合理， 网格很容易发生扭曲 （overlap），
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计算将被迫中止。 关于 Leader- Follower 的原理介绍， 请参见流体理论手册第 12. 10 节 “ALE
formulation and leader- follower option”， 本节将只介绍设定 Leader- Follower 的操作方法。

单击菜单 Meshing→ALE Mesh Constraints→Leader- Follower 可以定义 Leader- Follower， 如

图 4-39 所示。 对话框中需要定义以下内容： 1） Lable #编号， 一般情况下按顺序输入即可；
2） Leader Point #和 Follower Point #： 可以使用鼠标双击绿色表格， 然后到图形区依次单击

Leader Point 和 Follower Point， 按 Esc 键返回即可， 在拾取点的过程中可以连续单击多对

Leader- Follower 点； 3） Relative Disp. Factor 指的是位移因子， 对于平动则位移因子就是 1，
如果是转动则位移因子， 应输入 Leader 点及 Follower 点相对于旋转中心的半径比。

图 4-39　 设定 Leader- Follower

定义 Leader- Follower 时应注意下列几个问题：
1） Leader 点应该位于移动边界上， 例如， 流固耦合边界、 移动壁面边界等。
2） 同一个 Leader 点可以带动多个 Follower 点， 但 Follower 点不能定义为 Leader 点。
3） Leader 点和 Follower 点应为几何点， 计算时 ADINA 软件自动将条件转化到距离几何

点最近的节点上。

4. 6. 5　 设定 Sliding Mesh （ADINA- CFD）
滑移网格 （Sliding Mesh） 用于处理界面两侧网格运动趋势不同的物理问题。 对于图

4-40a所示的旋转结构， 滑动界面内部的网格可以旋转， 而滑动界面外部的网格则固定不动；
对于图 4-40b 所示的平动结构， 界面上部和下部的网格运动趋势不同。 因此， 滑移网格既可

以模拟旋转机械 （例如， 涡轮机、 搅拌器、 水轮机等）， 也可以模拟相对移动问题 （例如，
两辆相向行驶的汽车）。 为了控制动网格的运动情况， Sliding Mesh 要与 Leader- Follower 一起

配合使用。
定义的滑移网格是一对边界条件， 因此指定的几何界面也不是一个界面， 而是同一空间

不同位置的两个几何界面， 如图 4-41 所示。 这两个界面可以重合， 也可以有小的间隙， 还

可以有小的重叠， 所以需要定义两个滑移网格边界条件， 并构成一个边界条件相互作用对。
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图 4-40　 Sliding Mesh 的应用

对于二维模型， 滑移网格边界是某条线； 对于三维模型， 滑移网格边界则是某个面。 可单击

菜单 Model→Boundary Conditions→Special Boundary Conditions 或 图标进行定义。 关于滑移

网格及 Leader- Follower 应用的二维实例， 请参见 Primer 手册的例题 37， 三维实例请参见本

书第 9. 4 节 “风车流固耦合分析”。

图 4-41　 滑移网格界面处的网格

需要注意的是： 滑移网格界面处网

格必须不连续 （如果连续， 定义的滑移

网格将不起作用， 即无法实现沿界面滑

动）， 如图 4-41 所示， 因此， 划分网格

时滑移网格界面两侧的网格密度可以不

同。 如果滑移网格界面的一侧属于非结

构性网格， 建议界面两侧的单元尺寸不

要相差太多 （通常情况下， 两侧单元的

尺寸比不要超过 2）， 否则将影响计算的收敛和计算结果的连续性， 采用 FCBI- C 单元时更应

如此。 在滑移网格界面处生成不连续网格的方法有多种， 例如， 划分网格时选择 No Check
的节点检查方式， 或者应用不同的单元组划分网格， 节点检查时选择在单元组内连续等。

虽然滑移网格界面处网格不连续， 但计算后的结果变量都是连续的。 滑移网格界面处的

数值格式要满足质量、 动量和能量守恒定律。 简单起见， 下面仅讨论二维情况， 如图 4-42
所示。 点 M 与 S1、 S2 分别位于滑动界面的两侧， M 点处的控制体积由上、 下两个控制体积

组成， 如果希望计算 M 点处控制体积的通量和作用力， 对于下半部分来说， 利用节点 M 处

的信息求出通量并不困难； 但对于上半部分， 由于网格在界面处没有连接在一起， 因此得不

到直接信息， 上半部分控制体积的通量则利用相邻点 S1 和 S2 计算得到， 可以通过对节点

M、 S1 和 S2 处的控制体积的相对位置线性插值得到。
需要注意的是： 滑移网格界面只是一个网格界面， 经过该界面的物理量是连续的， 所以

在滑移网格界面边缘处的物理条件也必须连续， 即： 滑动界面两侧的物理条件应该相同， 如

图 4-43 所示。
使用滑动界面时还应注意下列限制条件：
1） 适用于 FCBI 和 FCBI- C 单元。
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图 4-42　 滑移网格界面的耦合计算

图 4-43　 滑动界面两侧的物理条件

2） 对于 FCBI 单元， 只能使用 sparse 求解器进行计算。
3） 不适用于求解高速可压缩流体。
4） 不允许使用直接的 FSI 耦合方法进行计算。

4. 6. 6　 设定 Gap 边界 （ADINA- CFD）
ADINA 软件中的 Gap 边界用于控制两个流体区域间的连通与闭合， 可以模拟流场域中

的开关、 阀门等结构。 关于 Gap 边界应用实例的详细介绍， 请参见本书第 9. 2 节 “阀门流

固耦合分析” 和 《ADINA 流体和流固耦合功能的高级应用》 第 9 章的实例 9 和实例 14。
ADINA 软件只允许对二维模型内部的线或三维模型内部的面施加 Gap 边界条件。 使用

Gap 边界时可能需要对流场作特殊处理： 真实情况是流场在闭合后， 两个流场区域不连通，
阀门结构的间隙为 0。 但在 ADINA 软件中， 设计流场域时不能让该间隙为 0。 否则流场将无

法连通， 在流场中可以预留出一个很小的间隙来描述该间隙的线或面是 Gap 边界施加的几

何区域。 以二维模型为例 （如图 4-44 所示）， A、 B 为流场域， 二者的公共边界可以作为

Gap 边界条件。 实际分析表明： 这种小间隙的存在并不影响计算结果的准确性。
Gap 的状态将随两个区域连接或不连接的变化而变化。 当两个区域连接在一起时 （Gap

状态为开启）， 流体可以流过界面， 此时流体变量在界面上连续。 当两个区域没有连接在一

起时 （Gap 状态为关闭）， 流体不能流过界面， 此时对两侧的流体区域而言， 流体方程中的

Gap 边界条件相当于无滑移边界条件， 对于热方程相当于热通量为零。 因此这种情况下的解

通常不连续 （速度为零且连续）。
图 4-45 是 Gap 条件的一个典型应用， 放大的图中给出当 Gap 开启或关闭时单元的连接

情况。 当 Gap 关闭时， 流场不连接， 表示两个流体区域不连接。 为了实现这种计算功能，
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图 4-44　 Gap 边界条件

ADINA 软件会在原始节点的相同位置再自动生成一些节点 （图中显示的节点稍微分开， 目

的只是为了表明不连接）。 当 Gap 开启时， 后来生成节点上解的值等于对应原始节点上的

值， 这样将得到连续解。

图 4-45　 Gap 的开启与关闭

ADINA 软件可以通过 3 个物理条件来控

制 Gap 的开启或关闭状态， 即： Gap 的大小、
时间和平均压力差， 分别介绍如下：

1） Gap 的状态可以由 Gap 的大小 G㊀ 来

控制。 如果 Gap 初始时关闭， 当 G > 给定值

Gopen时才会开启； 相反； 如果 Gap 初始时开

启， 当 G <给定值 Gclose时才会关闭。 对于二维

区域， 大小指的是边界线的长度； 对于三维区

域， 大小指的是边界面的面积。 因此， 这种类

型的 Gap 条件通常与移动网格边界条件一起

使用。

㊀　 G 是代表不同值和函数的变量。

2） Gap 的状态可以由时间函数 G 来控制。 如果 Gap 初始时关闭， 当时间函数值超过给

定值 Gopen时才会开启； 相反； 如果 Gap 初始时开启， 当时间函数值小于给定值 Gclose时才会

关闭。 这种类型的 Gap 条件通常用于 Gap 开启闭合的时间规律已知的情况。

图 4-46　 设定 Gap 的开启值与关闭值

3） Gap 的状态可以由平均压力差 G = pu - pd
控制， 其中， pu 和 pd 分别表示 Gap 上游和下游的

压力。 如果 Gap 初始时关闭， 当压力差超过给定

值 Gopen时才会开启， 但是， Gap 一旦开启就不会

关闭， 因为在后边的求解时间内压力差始终为零。
设定 Gap 边界条件时， 为了避免改变 Gap 状

态引起的数值震荡， 开启值 Gopen要比关闭值 Gclose

稍大一些， 如图 4-46 所示。

求解包含 Gap 边界的问题时， 时间步长应该足够小 （这个问题需要读者测试， 有的例

题的时间步长只有小于 1e-5 才能正常计算）。 在 Gap 开关的瞬间， 流场状态变化非常大，
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因此需要使用小步长来保证计算收敛。

4. 7　 设定单元属性

4. 7. 1　 定义单元组

划分单元之前必须首先定义单元组。 在 ADINA 软件中， 单元组是一个核心纽带， 其作

用不仅是 “容纳单元”， 而且包含单元类型 [A]、 材料类型 （确定材料编号） [B]、 几何

非线性开关 [C]、 单元算法 [D]、 输出结果控制 [E]、 单元积分点数量 [F]、 单元生死

[G]、 应力参考系 [H]、 失效准则 [ I] 及初始应变施加 [ J] 等信息。 图 4-47 中给出了

2D Solid 单元组的详细信息， 其他单元类型的对话框与此类似。 由此可知， 定义单元组时可

以确定单元组的很多共同属性， 因此， 定义单元组后就可以控制组内的所有单元。 单击菜单

Meshing→Element Groups 或 图标可以定义单元组。
ADINA- Structures 模块中的单元组支持下列单元类型： 杆单元 （ truss）、 2- D 实体单元

（2- D solid）、 3- D 实体单元 （3- D solid）、 梁单元 （beam）、 等参梁单元 （ iso- beam）、 板单

元 （plate）、 壳单元 （ shell）、 管单元 （ pipe）、 弹簧单元 （ spring）、 通用单元 （ general）、
2- D 流体单元 （2- D fluid）、 3- D 流体单元 （3- D fluid）。 需要注意的是： ADINA 结构场的流

体是势流体， 对应的材料是 Potential- Based Fluid。
ADINA- Thermal 模块中的单元组支持下列单元类型： 1- D 单元、 2- D 热传导单元 （2- D

conduction）、 3- D 热传导单元 （3- D conduction）、 壳热传导单元 （shell conduction）、 边界对

流单元 （boundary convection）、 边界辐射单元 （boundary radiation）。
ADINA- CFD 模块中的单元组支持下列单元类型： 2- D 流体单元 （2- D fluid）、 3- D 流体

单元 （3- D fluid）。 定义流体单元组时， Element Option 选项可以选择 Solid 单元。 需要注意

的是： 此处的 Solid 单元与 ADINA- Structures 的 Solid 单元并非同一概念， 前者可以用于热-
流分析及流-固-热三场耦合分析。

定义 ADINA- CFD 模块中的 Solid 单元材料时， 可以输入热相关参数， 这些参数用来模

拟固体的热参数， 这样仅使用 ADINA- CFD 模块就能够模拟热-流分析。 对于热-流-固三场

耦合分析， ADINA- CFD 模块的 Solid 单元要与 ADINA- Structures 模块中的 Solid 单元对应，
计算过程中， ADINA- Structures 与 ADINA- CFD 的 Solid 单元温度保持一致。 关于热-流-固三

场耦合的分析实例， 请读者到 ADINA 软件中国网站 （网址为 http： / / www. adina. com. cn）
下载相关资料。

4. 7. 2　 设定单元属性

通过定义单元组可以确定一组单元的属性。 但是， 如果同一单元组内的部分单元具有不

同的属性， 此时应该如何设置这些单元的属性呢？
以 ADINA- Structures 模块为例， 菜单 Model→Element Properties 中包含下列单元类型：

Truss、 Beam、 Isobeam、 Pipe、 Plate、 Shell、 2- D Solid、 3- D Solid、 2- D Potential- Based Flu-
id、 3- D Potential- Based Fluid、 1- D General Element、 2- D General Element、 3- D General
Element。 划分为某一单元类型后， 读者就可以打开菜单并设定每个单元的属性。
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图 4-47　 设置单元组
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　 　 以 Truss 单元为例， 单击菜单 Model→Element Properties→Truss， 将弹出 Assign Truss
Property 设定单元属性对话框， 如图 4-48 所示。 对话框中包含所有 Truss 单元的信息 （这些

Truss 单元可能属于不同的单元组）， 包括材料、 截面积、 间隙、 单元生时间、 单元死时间、
初始应变等。 可以根据模型的实际情况来编辑修改这些信息， 如果需要修改的数据量比较

大， 在对话框中修改可能不太方便， 此时， 可以单击 Export 按钮将表格导出， 然后使用

Excel编辑后保存， 再单击 Import 按钮， 将编辑好的文件导入即可。

图 4-48　 设定单元属性

对于其他的单元类型， 修改单元属性的方法类似。 ADINA- Thermal 模块中修改单元属性

的操作步骤也相同， 但对于 ADINA- CFD 模块， 由于只包含两个单元类型， 因此 Model 菜单

下没有包含 Element Properties 选项， 但可以通过 Element Data （单元数据） 选项修改单元

属性。
下面将介绍 Element Data 表格的使用方法， 仍然以 ADINA- Structures 模块为例来说明。

单击菜单 Meshing→Elements→Element Data 将弹出 Element Data 表格框， 如图 4-49 所示。
Element Data 表格按照单元组进行分类， 单击表格上部 Element Group 右侧的下三角按钮， 可

以选择需要修改的单元组。 同时， 该表格中还包含许多单元属性， 例如， 材料、 横截面属

性、 单元生死时间等。 读者可以根据实际的模型情况来设定和修改单元属性。
按照相同的操作方法， 也可以为 ADINA- Thermal 模块和 ADINA- CFD 模块中的 Element

Data 表格修改设定单元属性。
Element Properties （单元属性） 菜单和 Element Data 菜单下也都包含单元属性， 某些选

项是重复的 （例如， 材料、 单元生死、 初始应变等）。 读者设定单元属性时究竟应该以哪个

菜单为准， 它们是否矛盾呢？
提交计算时， ADINA 软件将以 Element Data 菜单为准， 如果修改了 Element Properties 菜

单下的属性， Element Data 属性也会随之改变， 所以二者并不矛盾， 在两个菜单下设定都能

实现最终目的。 需要注意的是： 如果修改了 Element Data 表格， Element Properties 菜单中的
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图 4-49　 设定 Element Data 表格框中的单元属性

属性不会发生改变， 但这不会影响计算结果， 原因是： 计算准备数据以 Element Data 为准。

4. 7. 3　 势流体单元

符合下列假定的流体可以使用基于势的流体单元来模拟：
1） 无黏性、 没有漩涡、 没有热传递的流体。
2） 可压缩或几乎不可压缩流体。
3） 流体边界包含相对较小的位移或没有位移。
4） 流体流速小于声速或没有流体流动等。
ADINA 软件基于势流体的单元具有如下特点：
1） 基于势流理论的流固耦合分析支持静力分析、 瞬态分析和频域分析。
2） 基于势的流体单元可以用于二维和三维分析， 二维单元可以用于平面模型和轴对称

模型中， 且二维模型必须定义在 YZ 平面内。 对于轴对称模型， 则应该定义在 Y 轴正方向，
且关于 Z 轴对称。

3） 基于势的流体单元可以与 ADINA 软件中的结构单元耦合， 结构的运动将使流体产生

沿边界法向的相对运动， 流体则对结构产生附加压力。
4） 基于势的流体单元可以与压力边界条件耦合 （即： 结构和基于势的流体单元边界没

有相连）， 该特点可以用于模拟自由液面。
5） 基于势的流体单元可以直接与 ADINA- CFD 中的流体单元耦合。 ADINA- CFD 流体单

元的运动将使势流体产生沿 ADINA- CFD 边界的法向运动， 势流体则对 ADINA- CFD 的边界

产生附加的压力。
6） 基于势的流体单元可以使用特殊的无限远边界单元 （infinite element） 来处理无限远

边界问题。
7） 势流体单元包含两种算法： 非线性亚声速速度公式和线性无穷小速度公式。
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某些分析可以使用 ADINA- CFD / AIDINA- FSI， 或基于势的流体单元来分析， 而 ADINA-
CFD / ADINA- FSI 要比基于势的流体单元应用更广。 对于 ADINA- FSI 分析， 流体网格和结构

网格在边界上可以不协调。 如果模型满足本节开始提到的 4 个假定条件， 采用基于势的流体

单元来模拟将更有效。

4. 8　 设定初始条件

4. 8. 1　 施加初始条件

在 ADINA 软件中， 初始条件一般可以分为两类： 一类是施加常规初始条件 （例如， 位

移、 速度、 加速度、 应力、 应变等）， 用来确定求解基本方程必需的 t = 0 时刻的初始值 （默
认值为 0）； 另一类初始条件是施加初始缺陷， 仅适用于 ADINA- Structures 模块。 下面将分

别介绍这两种初始条件的施加方法。
1. 施加常规初始条件

单击菜单 Model→Initial Conditions→Define 可以定义初始条件， 如图 4-50 所示。 定义

时， 首先应该为定义的初始条件命名， 然后单击表格左侧的下拉式菜单选择定义初始条件的

变量， 主要包括： 位移、 速度、 加速度、 温度、 应变等， 可以在该表格中编辑这些变量。 下

面只介绍初始应变的定义方法： 图 4-50 对话框下部的 Initial Strains are Interpreted as 标签中

包含有 3 个选项： Initial Strains、 Initial Stresses 和 Initial Stresses Causing Deformations。 默认选

择为 Initial Strains （初始应变）， 后两者表示输入初始应力。 例如， 默认情况下， 变量

Strain-11 的含义为 11 方向的应变， 如果选择后两者， 则 Strain-11 的含义将改为 Stress-11。
需要注意的是： 此处虽然名字没有改变， 但含义已变 （与 ADINA 定义斜坐标系类似， 定义

斜坐标系后， 载荷的方向将变为斜坐标系中的对应方向， 而不再是以前的含义， 请读者注

意）。 选择输入应力时通常选择第 3 项， 即： Initial Sresses Causing Deformations， 这种方法只

适用于简单的定义初始应力和应变的情况。 如果模型的初始应变和初始应力比较复杂， 则应

该选用其他方法进行定义， 详见 4. 8. 2 节 “施加初始应变和应力”。
初始条件定义完毕， 单击菜单Model→Initial Conditions→Apply 可以将初始条件施加在模

型上。 定义的多个初始条件可以通过名字来区分， 读者可以根据具体问题具体分析， 将初始

条件施加到模型对应的区域。 需要注意的是： 模型的初始条件也可以施加在节点上， 通过菜

单 Model→Initial Conditions→Apply on Nodes 来定义， 这种方法通常用于施加初始应变场或初

始应力场。 施加初始条件时也可以使用空间函数， 用来描述复杂的基于几何的初始条件。
定义初始条件的一些说明：
1） 对于时域瞬态动力分析， 必须指定必要的初始条件才能求解。 常用的初始条件与运

动相关， 例如， 初始速度。
2） 对于静力问题分析， 也可能需要定义初始条件。 但由于静态求解过程在伪时间内进

行， 几乎不采用与运动相关的初始条件， 但仍然可以采用初始应力、 初始应变等条件。
3） 对于频域动力学分析， 则不能够定义初始条件。 所有涉及特定状态的频域计算都必

须以预应力模态方式处理， 例如， 进行重启动分析。
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图 4-50　 施加初始条件

2. 施加初始缺陷

一般情况下， 初始缺陷主要用于非线性屈曲分析。 主要包含 3 种定义初始缺陷的方法：
1） 定义几何点和节点的偏移 （Point / Node offset）。
2） 直接读入模态分析结果， 并设置初始缺陷 （Mode Shape）。
3） 直接调整单元参数。 例如， Truss 单元的截面积、 Shell 单元的厚度等。
对于第 1 种方法： 如果将初始缺陷定义在几何点上， 可以单击菜单 Geometry→Points 或

单击定义点的图标 来修改几何点坐标， 坐标的改变量即偏移量； 如果将初始缺陷定义在

节点上， 可以通过单击菜单 Meshing→Nodes→Define 来定义节点偏移量。 通常情况下， 建模

时一般采用定义节点偏移量的方法。
对于第 2 种方法： 分析前需要预先进行线性屈曲 （Linearized Buckling） 分析， 单击菜单

Model→Initial Conditions→Imperfection， 将节点位移输出到 mod 文件， 如图 4-51 所示， 将

Initial Condition Type 选择为 Shape， 将 Imperfection Shape I / O 选择为 Export Nodal Displace-
ments （to file. mod）。

在进行屈曲分析之前， 单击菜单 Model→Initial Conditions→Imperfection， 将 Initial Condi-
tion Type 选择为 Shape， 将 Imperfection Shape I / O 选择为 Import Initial Nodal Displacements
（from file. mod）， 然后将 Initial Condition Type 选择为 Point， 在表格中输入屈曲模态、 几何

点、 自由度及偏移位移， 如图 4-52 所示。 需要注意的是： 每种模态只能对应输入 1 个几何

点， 原因是： 只要确定了 1 个点， 模型中所有点的位移均可以确定。
对于第 3 种方法： 直接调整单元参数 （例如， 修改 Truss 单元的截面积）， 可以单击菜

单 Model→Element Properties→Truss 或单击 Meshing→Elements→Element Data 来设定， 详细

介绍请参见 4. 7. 2 节 “设定单元属性”。 如果希望修改 Shell 单元的厚度， 可以单击菜单
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图 4-51　 输出节点位移到 mod 文件

图 4-52　 定义初始缺陷

Meshing→Elements→Shell Thickness 来设定。 需要注意的是： 此时壳的厚度与每个节点的厚

度都有关系。
注意： 通常情况下选择基于结构固有的低阶屈曲模态来施加初始缺陷， 因此， 即使手动

进行节点偏移也要参考模态分析的结果。
屈曲分析施加初始缺陷的必要性： 施加初始缺陷即增加了结构扰动的初始状态， 使结构

更容易沿着扰动的方向发生屈曲变形。 对于某些沿载荷方向刚度对称的结构 （例如， 等截

面圆杆受到均匀压力作用）， 如果不施加初始缺陷， 结构不会发生屈曲变形。

4. 8. 2　 施加初始应变和应力

4. 8. 1 节介绍的方法只适用于为简单的初始应变和应力状态施加初始应变和应力， 但无

法实现复杂的初始应力和应力状态的施加。 本节将介绍一般情况下初始应变和应力的施加

方法。
与定义初始条件时相同， 在施加初始应变和应力之前应该先确定 Initial Strains are Inter-
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preted as 标签。 单击菜单 Control→Miscellaneous Options 将弹出杂项控制对话框 （如图 4-53
所示）， 默认状态下 Initial Strains are Interpreted As 标签选择为 Intitial Strains。 如果需要施加

初始应力， 则应该将其修改为后两项， 但通常情况下选择第 3 项。 在杂项控制对话框中选择

的初始应变 /应力输入状态 （Initial Strains are Interpreted As） 将控制整个模型的输入状态。
为线单元 （例如， Truss、 Beam 等） 和面、 体单元 （2- D Solid、 3- D Solid 等） 施加初

始应变及应力的方法不同， 下面将分别介绍。

图 4-53　 杂项控制对话框 （设置初始应变）

为线单元 （例如， Truss 单元） 定义单元组时， 在 Advanced 标签下将 Initial Strains 选择

为 Nodal Only、 Element Only 或 Nodal and Element。 在 Element Properties 下 （菜单 Model→
Element Properties） 可以施加初始应变 /应力， 也可以在 Element Data （菜单 Meshing→Ele-
ments→Element Data） 下设定， 详细介绍请参见 4. 7. 2 节 “设定单元属性”。 为 Truss 单元施

加初始应变的设置见图 4-48。
为面和体单元定义单元组的方法与线单元相同， 也需要首先修改 Advanced 标签下的 Initial

Strains 选项， 如图 4-54 所示。 施加在面和体单元上的初始应变 /应力往往是模型上一步的计

算结果， 因此应该在结果文件中输出这些单元的应变 /应力结果， 读者可以编辑它们， 并将

其作为初始条件施加在单元上， 具体的操作过程和方法， 请参见 5. 6 节 “初始地应力的

处理”。
注意： 施加在面和体单元上的初始应变 /应力的方向以初始应变轴为基准， 一般情况下，

初始应变轴不能够满足模型的要求， 因此需要首先定义一个正交轴系来调整初始应变轴的方

向。 关于坐标轴的详细介绍， 请参见 4. 13. 4 节 “正交轴系、 材料轴、 初始应变轴”。

4. 9　 设定单元生死

模拟过程中， 如果有新的物质生成或移除， 则需要用到单元的生死功能。 单元生死功能

主要用于模拟施工过程 （例如， 模拟焊接过程、 地下隧道的开挖与支护、 桥梁的维修支护
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图 4-54　 设置单元组 （施加初始应变）

过程、 建筑结构施工过程等）， 属于典型的非线性问题。 单元生死一般都由时间来控制。
ADINA 软件中还包含一种与材料参数相关的单元 “死”， 将在本节末尾处介绍。

如果模型中包含新单元生成， 则新生单元的质量矩阵、 刚度矩阵和载荷向量将被填加到

模型的总质量矩阵、 总刚度矩阵及总载荷向量中。 与此类似， 如果模型中的单元被移除

（死掉）， 则被移除单元的质量矩阵、 刚度矩阵及载荷向量将会从模型的总质量矩阵、 总刚

度矩阵及总载荷向量中移除。
定义单元组时可以设置单元的生死时间 （如果该单元组中的单元同生死， 这种情况很

少遇到）， 也可以在 Element Properties 菜单或 Element Data 菜单下定义， 通常情况下， 后两

者是常用的设置方法。
单元生死时间的设置如图 4-55 所示， 单元生时间 Tbirth 应选择在 （ t， t + Δt） 的范围

内， 其中 t 为单元激活的时刻， 对应时间步的某个时间计算点， Δt 为 t 时刻对应的下一步计

算的时间步长， 在 t 时刻单元处于应力自由状态， 在 t + Δt 时刻单元被激活； 单元死时间

Tdeath 应选择在 （ t - Δt， t） 的范围内， 其中 t 为单元死去的时刻， 对应时间步的某个时间

计算点， Δt 为 t 时刻对应的上一步计算的时间步长， 在 t - Δt 时刻单元正常存在， 在 t 时刻

单元死掉。 如果模拟中某个单元同时使用了单元生死功能， 则单元死的时间一定要大于单元

生的时间， 即： Tdeath > TBirth。
ADINA 软件还允许读者设置单元死的延迟时间， 该参数可以使单元刚度矩阵在一段时

间内逐渐变为 0， 而不是立刻变为 0。 在单元死时刻， 单元刚度矩阵开始线性减少， 到达延

迟时间后单元刚度矩阵才变为 0， 此时单元才彻底死掉。 这样设置的好处是： 1） 可以有效

处理由于单元突然死掉而产生的不连续问题； 2） 有利于结果的收敛。 在杂项控制对话框中
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图 4-55　 设定单元生死时间

可以定义单元死的延迟时间， 对应的操作为： 在菜单 Control→Miscellaneous Options 下的

Element Death Decay time 中输入单元死的延迟时间， 默认值为 0。
ADINA 软件中还包含一种因单元失效而死掉的情况， 例如， 单元的最大应变达到材料

设置的最大值。 在 ADINA 软件中， 只要单元内的一个积分点达到失效判据条件， 单元将立

刻死掉， 单元的刚度矩阵、 质量矩阵将在总刚度矩阵、 总质量矩阵中被移除。 需要注意的

是： 这种单元是瞬时死掉而不是延迟死掉。 目前， ADINA 软件中还没有包含损伤模型， 如

果读者希望考虑单元损伤的渐进失效， 则可以通过二次开发来实现。 这种单元的死与前面介

绍的单元生死不是同一个概念， 请读者加以区别。 相关例题的详细介绍， 请参考本书 8. 3 节

“钢球撞击薄板分析” 和 ADINA 8. 6 版 《结构理论手册》 11. 4 节。

4. 10　 设定接触

接触分析是最常见的非线性分析之一。 ADINA 软件的接触算法基本可以分为两大类：
非刚性接触算法和刚性接触算法。 本节将介绍下列内容： 设定接触控制和接触组、 设定接触

面和接触对、 设定刚性接触、 接触分析特征、 注意事项和促进接触收敛的方法。 其中，
4. 10. 1 ～ 4. 10. 2 节将介绍非刚性接触算法， 4. 10. 3 节将介绍刚性接触算法， 4. 10. 4 节将介

绍接触分析特征、 注意事项及促进接触收敛的方法。

4. 10. 1　 设定接触控制和接触组

单击菜单 Model→Contact→Contact Control 或在 图标右侧的下拉菜单中选择 Contact
Control， 将弹出如图 4-56 所示的设定接触控制对话框 （以隐式算法为例来说明）。 可以看

出： 在该对话框中可以设定默认的接触算法 （可以在接触组内修改）、 默认的接触位移算法
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（可以在接触组内修改）、 摩擦算法、 一些修正选项和接触阻尼效应等。 一般情况下， 不需

要读者修改接触控制， 采取默认状态即可， 相关介绍请参见 4. 10. 4 节 “接触分析特征、 注

意事项和促进接触收敛的方法”。

图 4-56　 设定接触控制对话框

单击菜单 Model→Contact→Contact Group 或单击 图标， 将弹出如图 4-57 所示的设定

接触组对话框 （以隐式接触算法为例）。 该对话框共包含 4 个标签， 分别为 Basic、
Advanced、 Rigid Target Algorithm 和 Node- to- Node， TMC， 本节只详细介绍前两个标签。
Rigid Target Algorithm 用来定义刚性接触标签， 将在 4. 10. 3 节 “设定刚性接触” 中加以介

绍， Node- to- Node， TMC 用来定义点对点接触及热力耦合。
以二维接触为例， 下面将详细介绍图 4-57 中各个标签的功能和用法。
1. Basic 标签

1） 编号 [A] 指的是选择接触算法， 隐式和显式计算都包含 3 种接触算法。 隐式接触

算法包括 Constraint Function、 Segment Method 和 Rigid Target。 其中， Constraint Function 为默

认算法。 显式接触算法包括 Kinematic Constraint、 Penalty 和 Rigid Target。 其中， Kinematic
Constraint 为默认算法。 关于各种接触算法的详细介绍， 请参见 ADINA 8. 6 版 《结构理论手

册》 4. 2 节和 4. 3 节， 此处不作详细介绍。 需要注意的是： 如果在接触计算中选择默认接触

算法不能够收敛， 改变接触算法可能使计算结果达到收敛。
2） 编号 [B] 指的是选择接触位移算法， 默认选项为 Large。 如果接触位移属于小变形

时 （这种情况很常见）， 则应该将其选择为 Small， 可以使得计算迅速收敛， 如果不修改，
将出现收敛困难甚至不收敛的情况。

3） 编号 [C] 指的是设定库伦摩擦系数。 需要注意的是： 此处所输入的摩擦系数为常

数， 它不能随着其他物理变量 （例如， 接触压力、 时间等） 的改变而改变， 如果读者希望

输入变化的摩擦系数， 则应该在编号 [H] 中进行设置。
4） 编号 [D] 指的是设定 Compliance 系数， 默认值为 0， 表明接触面不允许穿透， 如
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图 4-57　 设定接触组对话框

果该系数大于 0， 则表明接触面为柔性。 对于隐式接触分析， 存在振荡的速度和加速度将不

利于接触收敛， 此时可以调节 Compliance 系数以促进收敛， 详细介绍请参见 ADINA 8. 6 版

《结构理论手册》 4. 4 节。
5） 编号 [E] 指的是与接触面相关的设置。 对于一般接触问题， 接触面为单面接触。
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对于壳单元接触问题， 有些情况下可能出现双面接触 （例如， 冲压分析、 压溃分析等）， 这

时应该选择 Double Side， 默认情况为 Single Side。 Penetration Depth 用来设置接触面相互侵入

的深度， 一般情况下， Target Surface 比较刚硬， 它会侵入 Contactor Surface。 接触面偏移

（Contact Surface offset） 用来设定接触面的偏移距离， 默认值为 0， 表明接触面未发生偏移，
也可以设定为一个大于 0 的值 （例如， 0. 002）， 表明实际接触面与设定接触面偏移距离为

0. 002， 如图 4-58 所示 （解释了接触面的单面偏移及双面偏移）。 该法常用于包含结构接触

的流固耦合分析、 要求流场网格连续 （流场域不间断） 的分析等， 所以设定接触时需要设

定接触偏移， 如果接触偏移很小， 计算误差完全可以接受。 如果接触偏移选择 Shell Thick-
ness， 则实际接触面相对于定义接触面偏移了半个壳的厚度； 如果接触偏移选择 None， 则不

设置接触偏移。 读者还可以设置 Tied Contact， 默认情况下接触设置为非 Tied。 Tied Contact
采用约束方程的形式将接触面约束在一起， 因此某些很难收敛的非 Tied 接触调整为 Tied
Contact 将很快收敛。 关于 Tied Contact 的详细介绍， 请参见 ADINA 8. 6 版 《结构理论手册》
4. 1 节。

图 4-58　 接触偏移

2. Advanced 标签

1） 编号 [F] 用来设置接触面延伸系数。 当两个接触面有相对滑动趋势时， 可以调大

该延伸系数 （例如， 0. 1）， 此时滑动距离在 0. 1 范围内的接触都认为存在， 其默认值

为 0. 001。
2） 编号 [G] 用来设定初始接触穿透的处理方法， 主要包含 Eliminate、 Ignore 及 Override

等处理方法， 默认值为 Eliminate。 如果模型中的接触网格划分存在初始穿透 （如图4-59所
示）， 默认情况下 ADINA 软件将尝试在计算的第 1 步消除该初始穿透， 对于较大的初始穿透

量， 在第 1 步消除初始穿透往往非常困难， 此时可以与 Time to Eliminate Initial Penetration 联

合使用， 输入消除初始穿透的时间， 程序将在该时间内逐步消除初始穿透。
如果处理方法选择为 Ignore， ADINA 将忽略接触网格的初始穿透量， 该法可以用于初始

几何无穿透， 但划分网格后出现穿透的情况， 如图 4-59 所示。 该穿透网格通常出现在几何

有弧度处， 同时与指定网格密度及 Target Surface 的选择有关系。
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图 4-59　 初始穿透

Override 处理方法经常用于设置间隙接触或

过盈接触。 如果输入正值， 则表明模拟是间隙接

触； 如果输入负值， 则表明模拟是过盈接触。 使

用这种方法时， 初始几何的接触面可以正好吻合

在一起， 即： 初始几何并没有间隙或重叠 （过

盈）， 设置接触时只需在 Initial Gap （ + ） / Pene-
tration （ - ） Value 中输入相应的数值即可， 该处

理方法与初始几何存在间隙或重叠的计算结果

一致。
如果希望消除这类初始网格形成的穿透， 可

以采取下列解决方法：
① 采用较密网格能够有效减少网格的初始穿透量， 但计算成本将增加。
② 采用匹配网格 （matching mesh） 的划分方法， 即： 在接触界面上指定相同的网格密

度， 网格节点一一对应， 但节点不拟合， 这种网格没有初始穿透。
③ 采用 Override 方法， 将 Initial Gap （ + ） / Penetration （ - ） Value 的值保持为 0 即可。
提示： 接触分析中， 穿透刚性接触面的节点数量、 初始接触的节点数量、 接触间隙的节〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

点数量及接触间隙大小等信息都将在结果输出文件 （*. out） 中列出， 读者可以查看结果输〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
出文件中的接触信息， 对照结果文件 （*. por） 的结果来判断接触分析的计算结果是否有〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
效、 可信。〰〰〰〰

3） 编号 [H] 用来设定可变摩擦系数。 如果希望输入可变的摩擦系数， 则应该勾选

Use标签， 然后单击对话框上部的 Set 按钮， 即可激活 User- Supplied Friction。 单击 User-
Supplied Friction 按钮将弹出 User- Supplied Friction Constant 对话框， 该对话框中的数据与

读者提供的摩擦程序有关 （不适用于显式分析）。 ADINA 软件提供了 12 种摩擦模型供选

用， 根据模型的需要， 也可以修改 ADINA 软件提供的源程序或进行二次开发来实现可变

摩擦系数。 相关内容的详细介绍， 请参见 ADINA 8. 6 版 《结构理论手册》 4. 5 节。 ADINA
软件中国网站上 （网址为： www. adina. com. cn） 也提供了可变摩擦系数的实例， 供读者下

载学习。
4） 编号 [I] 用来设置摩擦延迟开关， 可以将摩擦计算延迟 1 个时间步长， 该技术有

利于非线性接触计算的收敛。 相关内容的详细介绍， 请参见 ADINA 8. 6 版 《结构理论手册》
4. 4 节。

5） 编号 [J] 用来设定接触生死时间。 可以根据模型的需要来设定接触生效和失效时

间， 默认值为 0， 表明接触从计算开始时刻生效一直到计算结束为止。 设定接触生死时间可

以参考 4. 9 节 “设定单元生死”。
关于设定接触组的更详细介绍， 请参见 ADINA 8. 6 版 《结构理论手册》 4. 4 节。

4. 10. 2　 设定接触面和接触对

接触组定义完毕， 单击菜单 Model→Contact→Contact Surface 或 图标右侧的下拉菜单

按钮， 单击 Define Contact Surface 图标后将弹出定义接触面对话框， 如图 4-60 所示。
可以选择 4 种定义接触面的方式： Surfaces、 Faces of a Body、 All Faces of a Body 和
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图 4-60　 定义接触面对话框

Surface sand / or Faces， 如图 4-60 中编号 [A] 所示。 如果定义接触面的几何为 Native 建模

方式， 则可以选择 Surfaces， 双击表格的绿色图框然后到图形区拾取几何面， 也可以手动输

入几何面编号； 如果定义的接触面都属于一个 Body， 则可以选择 Faces of a Body， 在 Body #
中选择 Body 编号， 也可以单击按钮 到图形区拾取， 然后在表格中双击绿色图框选择几何

面或直接输入几何面编号即可； 如果定义的接触面包含一个 Body 的所有面， 则可以选择 All
Faces of a Body， 在 Body #中选择 Body 编号即可； 如果定义的接触面既包含 Native 建模方式

几何。 又包含 Parasolid 建模方式几何， 则可以选择 Surface sand / or Faces， 该方式不受几何

限制。
图 4-60 中的编号 [B] 用来定义接触面的方向。 对于三维实体几何 （3D Solid） 上的面

及二维实体 （2D Solid） 上的线， ADINA 软件能够自动正确判断接触面的方向， 而无须人为

修改， 让 Orientation Determined 保持为 Automatically 即可。 对于梁、 杆和壳单元， 定义好接

触后需要检查接触法向的方向， 在图标 按下时， 单击图标 可以检查接触面的方向是否

正确， 如图 4-61 所示 （需要注意的是： 只有划分好网格后， 模型才会显示接触方向）， 正

确的接触面方向应该是箭头背对背指向各自面内。 但对于壳单元， 当选择双面接触时， 背对

背的检查方式只适合一对接触面， 此时可忽略另一对接触面； 对于单独的面 （三维） 或线

（二维）， 定义接触面后应该检查接触面的方向是否正确， 如果不正确， 则需要将 Orientation
Determined 选择为 From Table Input， 然后在表格的 Orientation 纵列选择需要修改的几何面，
将 Follow Geometry 修改为 Opposite to Geometry， 单击 OK 按钮后， 再检查接触面的方向是否

正确， 如果不正确则按上述方法再进行调节。
上面介绍的定义接触面的方法是针对于有几何存在的情况， 对于从外部导入的网格， 定义

接触面时应该单击菜单 Model→Contact→Contact Surface （Element Set）， 或单击菜单 Model→
Contact→Contact Surface （Node）， 或单击菜单 Model→Contact→Contact Surface （Face Node）
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图 4-61　 检查接触面的方向

进行设定。 如果脱离了几何存在， 定义接触面将变得非常困难， 建议将需要定义为接触面的

导入网格事先定义为 Element Face Set， 然后选择 Contact Surface （Element Set） 来定义接

触面。
定义好接触面后， 单击菜单 Model→Contact→Contact Pair 或图标 右侧的下拉菜单按钮

选择 （Define Contact Pairs）， 将弹出定义接触对对话框， 如图 4-62 所示。

图 4-62　 定义接触对对话框

定义接触对的对话框中包含 3 个标

签： Basic、 Advanced 和 TMC。 其 中，
Basic标签用于设定接触对的 Target Surface、
Contactor Surface 和 库 伦 摩 擦 系 数；
Advanced标签用于设定接触对偏置量及接

触生死时间等； TMC 标签用于设定热力耦

合相关的参数。 此处的很多参数在定义接

触组对话框中都已经介绍过， 但并不矛

盾， 接触组中定义的参数对于整个接触组

都有效， 在一个接触组下可能包含很多接

触对， 但接触对中定义的参数仅对该接触

对有效。
在 ADINA 软件中， 接触对中接触面

的选择需要满足一定规则， Target Surface
一般应该选择刚度大 （硬度高）、 面积大、
网格相对粗糙、 自由度相对少的接触面；
而对于刚度小、 面积小、 网格相对细密、 自由度相对多的接触面则要作为 Contactor Surface。
实际建模时， 有些情况将很难选择接触面， 原因是很难同时满足上述所有规则。 此时， 应该

根据模型的实际情况来调整接触面或改变网格密度等， 如果必要还可以进行试算。 ADINA
软件对于 Target Surface 及 Contactor Surface 的选择没有硬性规定， 即使选错了接触面的对应

关系， 程序也能够计算， 甚至得到结果， 但迭代次数会增加， 有时计算结果是正确的， 但有

时计算结果的正确性有待商榷。
此外， ADINA 软件还允许定义接触面的自接触， 这里的自接触与定义接触组时的壳单

元双面接触不是一个概念。 自接触指的是可以将模型中可能发生接触的面都定义为一个接触

面， 定义接触对时将 Target Surface 和 Contactor Surface 都选择定义的这个接触面， 这种接触

的定义为复杂的接触碰撞分析提供了可行性。
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对于 Parasolid 几何建模方式 （三维模型）， ADINA 软件还提供了一种快速建立接触面及

接触对的方法， 单击菜单 Model→Contact→Contact Search， 将弹出 3D 接触搜索对话框， 如

图 4-63 所示。 接触搜索是基于位移的方法， 可以选择基于 Closest Point 或基于 Face Centers
的方法， 只需设定两个 Body 的编号和接触组、 接触面及接触对的编号， 接触搜索可以自动

完成接触定义。 举个简单的例子， 图 4-63a 中两个 Body 的最近距离为 0. 5， 如果 3D 接触搜

索对话框按照图 4-63b 所示输入时 （选择 Face Centers 方法， 最大距离输入 0. 51）， 则两个

Body 最近的两个面 （B1 的 F6 面和 B2 的 F3 面） 将自动定义好接触面及接触对， 接触搜索

有时可以减少建立接触的时间。

图 4-63　 3D 接触搜索对话框

4. 10. 3　 设定刚性接触

刚性接触多用于金属成型分析， ADINA 软件的隐式和显式算法都可以设定刚性接触。
在定义接触组时需要设定刚性接触， 并选择刚性接触算法； 定义接触面与定义普通接触完全

相同， 定义过程中需要注意接触面法向的正确性； 定义接触对时， Target Surface 要选择刚性

面， Contactor Surface 要选择柔性体。 然后单击菜单 Model→Contact→Mesh Rigid Contact Sur-
face 或图标 右侧的下拉菜单， 选择图标 将弹出 Mesh Contact Surface 对话框， 选择希望

设定为刚性面的接触面和刚性接触组， 其余选项可保持默认值， 单击 OK 按钮即可完成刚性

接触的定义。
需要注意的是： ADINA 软件中定义了刚性接触后， 刚性接触面的默认状态为全约束，

即： 如果刚性面为静止状态， 则无须施加任何约束。 刚性面也可以平移、 旋转或同时平移和

旋转， 此时需要定义 Rigid Links， 将刚性面与面外一点 （主点） 连接起来， 刚性面的平移及

旋转载荷通过主点来施加， 刚性面随主点一起运动。 关于刚性面接触的例题， 请参考 primer
手册第 33 题。

关于刚性接触参数设置的一些说明、 建模特征、 建模技巧以及调整接触收敛的一些方
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法， 请读者参见 ADINA 8. 6 版 《结构理论手册》 4. 9 节。

4. 10. 4　 接触分析特征、 注意事项和促进接触收敛的方法

本节将介绍接触分析特征、 一些注意事项和促进接触收敛的方法， 以帮助读者顺利完成

接触分析。
1. 接触分析特征

（1） 隐式动力分析 　 对于隐式接触分析， 速度和加速度的振荡将不利于接触的收敛，
尤其是对于高速冲击问题。 采用下列方法可以有效减少振荡的影响：

1） 应用冲击后修正。 在接触控制中可以设定冲击后修正， 如图 4-56 所示。 采用冲击后

修正后， 接触面上节点的速度和加速度将被修正， 以满足收敛的需要。 此外， 冲击后修正将

需要一些额外的内存和计算量。
2） 设置 Newmark 参数 α = 0. 5。 在模块工具条中可以设置 Newmark 参数 α， 如图 4-64

所示。 单击图标 将弹出 Implicit Transient Dynamics 对话框， 将 Alpha 参数修改为 0. 5， 其

默认值为 0. 25。 对刚性体冲击问题， 调节 Alpha 参数可以获得准确结果， 对于柔性体冲击问

题也能有效地减少数值振荡现象。

图 4-64　 设置 Alpha 参数

3） 设置接触面的 Compliance 参数。 设置接触面的 Complicance 参数可以显著减小接触

计算的数值振荡。 Complicance 参数的选择要参考式 （4-1）， 设置这个参数可以使接触计算

不会产生过大的接触穿透。 一般情况下， 接触穿透为单元尺寸的 1%时可以有效减少计算中

的数值振荡。
穿透量 = εp ×法向接触压力 （4-1）

更详细的介绍， 请参阅 ADINA 8. 6 版 《结构理论手册》 4. 7. 1 节。
（2） 显式动力分析　 在显式接触分析中， 如果速度和加速度存在振荡也同样不利于接

触收敛， 对于高速冲击问题更是如此， 这种数值振荡在罚接触算法 （ penalty contact
algorithm） 中普遍存在， 可以采用下列方法来减少振荡的影响：

1） 减小法向的罚刚度。
2） 设置罚接触算法阻尼。
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在定义接触组对话框中， 当接触算法选择为 Penalty 时， 在 Advanced 标签下可以设置罚

刚度及罚接触算法的阻尼。 一定要选择正确的罚刚度， 过小的罚刚度值将导致过大的穿透

量， 过大的罚刚度值将导致过大的振荡和不稳定的时间积分。 详细介绍请参阅 ADINA 8. 6
版 《结构理论手册》 4. 3. 2 节。

2. 接触振荡的压制 （隐式）
对于某些问题， Contactor 面上的节点将会在 Target 面之间振荡， 为了避免这种振荡， 可

以在接触控制中设定 NSUPPRESS 参数 （见图 4-56， 对应于对话框 Number of Iterations for
Pairing Contactor Node to Target Segment）， 一般建议将这个参数设置为大于等于 5， 启用该参

数后， 程序会记录接触点及接触位置， 因此会增加内存的使用量。 更详细的介绍， 请参阅

ADINA 8. 6 版 《结构理论手册》 的 4. 7. 4 节。
3. 接触阻尼 （隐式）
隐式分析中还可以设置接触阻尼。 无论是静态分析还是动态分析， 设置接触阻尼都有利

于接触分析的收敛。
可以在接触控制中设置接触阻尼的法向和切向黏性阻尼系数， 该阻尼的设置针对于模型

中所有接触面的节点， 每个节点的阻尼力如式 （4-2） 所示：
FDamp = CNu

·
N + CTu

·
T （4-2）

式中， u·N和 u·T分别表示法向和切向速度； CN和 CT为接触阻尼参数， 它们的值与模型有关。
式 （4-3） 给出计算这两个参数估计值的方法；

CN = CT = RΔt
Ng （4-3）

式中， R 表示第 1 个时间步施加载荷之和； Δt 表示时间步的大小； N 表示无约束接触面上接

触点的数量 （接触面可以承受力、 力矩和压力载荷）； g 表示接触面的初始间隙。 虽然该值

是估计值， 但一般情况下是可以接受的。
接触阻尼可以设定为仅在时间步开始时刻有效， 或在整个接触分析过程中都有效。 对于

前者， 其含义是在第 1 个时间步开始时刻考虑接触阻尼的影响。 迭代过程中阻尼会逐渐减

小， 第 1 个时间步结束时刻阻尼将变为 0。 因此， 第 1 个时间步最后时刻的结果没有受阻尼

影响。 对于后者， 接触阻尼力的合力将在*. out 文件中输出， 需要查看该文件以确定接触力

合力是否远小于支反力合力。 关于接触阻尼的更详细介绍， 请参看 ADINA 8. 6 版 《结构理

论手册》 4. 7. 6 节和 4. 8. 6 节。
4. 注意事项

1） 对于初始状态已经接触的接触面， 在设计几何时需要注意， 同一位置处要有两个几

何面 （可以是重合的两个面， 一个设为 Target， 另一个设为 Contactor）。 划分网格时， 两个

接触面的网格一定不能拟合 （可以共节点， 但节点不要拟合）。
2） 如果 Target 和 Contactor 是刚性的， 允许它们作为从面 （Slave） 与之外的主点 （Master）

采用 Rigid Links， 可以通过设定主点的自由度来控制接触面的自由度。
3） 同一接触组中建议不要同时包含考虑摩擦及无摩擦的接触对； 同一个接触点不建议

属于不同的接触面。
4） 对于摩擦效应不重要的接触， 建议采用无摩擦接触分析。
5） 重启动分析不允许接触状态从无摩擦到有摩擦， 反之亦然。 但是重启动分析允许改
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变接触的摩擦系数， 因此可以给定一个非常小的摩擦系数来代替无摩擦分析。
6） 如果初始接触面很近， 且在整个分析过程中接触面的相对滑动非常小， 而且又不包

含大的振动， 则可以采用小位移接触算法， 计算结果往往能够很快达到收敛。
7） 如果重启动分析中包含接触时， 则不能进行刚性接触与非刚性接触间的重启动， 但

刚性接触之间和非刚性接触之间都可以进行重启动， 还可以进行隐式算法和显式算法之间的

重启动。
8） 如果模型中包含尖角和曲率较大的面， 尖角及大曲率面处的网格划分一定要细密

些， 细密的网格有利于接触收敛及保证计算结果的准确。 此外， 对于刚性接触分析， 模型中

的尖角最好使用圆角来代替， 否则可能会出现收敛困难。
9） 显式接触分析时， 无论是 Kinematic Constraint 算法， 还是 Penalty 算法， 接触面的质

量一定要匹配 （质量不能相差太多）， 否者会导致接触收敛困难或错误的计算结果。
5. 促进接触收敛的方法 （隐式）
导致接触不收敛的原因有很多， 但是很多情况都是由于模型设置错误造成的， 例如， 边

界、 载荷等设置不合理， 建模时应该具体问题具体分析。 调试模型的方法也有很多， 本节将

介绍促进接触收敛的常用方法。
1） 接触问题属于高度非线性计算问题， 在模型调试阶段和计算过程中， 建议打开 ATS

（详见 4. 3. 1 节 “时间函数与时间步”）。

图 4-65　 设置非线性迭代对话框

2） 有些情况下， 使用线性搜索可以加快

接触收敛的速度。 单击菜单 Control→Solution
Process， 单击 Iteration Method 按钮将弹出设置

非线性迭代对话框， 如图 4-65 所示， 可以选

择使用线性搜索， 默认设置为不使用线性

搜索。
3） 在设置非线性迭代对话框中还可以设

定每个时间步内的计算迭代次数， 默认为 15
次。 对于一般计算， 15 次迭代经常无法达到

收敛， 此时可以适当增加迭代次数 （例如，
设置为 25 或 30）， 究竟迭代次数设为多少才

是合适的， 在模型没有经过试算之前往往无法知道准确的答案。 如果增加了迭代次数后， 计

算仍然不能够收敛， 应该观察计算过程中的迭代结果收敛趋势来判断是否应该再次增加迭代

次数。
以结构场为例加以说明： 在求解器运行窗口中单击 Nolinear Convergence 标签可以查看

当前计算步下的迭代收敛情况， 如图 4-66 所示， 图中曲线段表示接触， 直线段表示能量。
如果在默认的迭代次数下没有收敛 （图 4-66 已经收敛）， 则应该观察接触曲线是否有收敛

趋势， 如果接触曲线有收敛趋势， 增大迭代次数往往能达到接触收敛。
也可以单击 View Output 按钮， 在当前计算目录中找到结果输出文件， 通过查看结果输

出文件 （*. out） 来获取计算收敛信息。 流固耦合计算无法在求解器运行窗口中查看如

图 4-66所示的曲线收敛情况， 此时只能通过查看结果输出文件来确认计算收敛信息。
结果输出文件中将记录每个时间步内的迭代收敛情况， 如图 4-67 所示。 box　 a 表示能
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图 4-66　 查看计算的迭代收敛情况

量收敛准则， box　 b 和 box　 c 分别表示力和力矩收敛准则， box　 d 和 box　 e 分别表示位移

和转动收敛准则， 以上 5 项为非接触相关项。 box　 f 为接触相关项， CFORCE 指的是接触力

的变化项， CFNORM 为接触力的向量项。 依据式 （4-4） 所示的准则可以判断接触力是否

收敛：
CFORCE

max （CFNORM， RCONSM）≤RCTOL （4-4）

式中， RCTOL 表示接触力收敛容差； RCONSM 则表示参考接触力， 以避免分母为 0。
如果接触不收敛且相关项的数值变化非常剧烈， 通常表明载荷施加过快或者计算时间步

过大。 如果平衡迭代过程中 CFNORM 项变化平稳， 而 CFORCE 项变化剧烈， 则说明接触出

现了振荡， 此时应尝试改变时间步长或使用接触振荡的压制功能。
对于某些静态接触问题， 当力、 力矩和压力等载荷作用于接触面时， 模型的刚度矩阵经

常出现非正定情况， 此时可以采用矩阵稳定、 接触阻尼及限制增量位移的方法进行模型调

整。 在杂项控制对话框中可以设定矩阵稳定选项， 对应的操作如下： 单击菜单 Control→Mis-
cellaneous Options， 将 Matrix Stabilization 选择为 Yes （默认值为 No）， Stabilization Factor 的取

值一般较小， 可以选择 10 - 12 ～ 10 - 9。 在迭代容差对话框中设置限制增量位移选项， 对应的

操作如下： 单击菜单 Control→Solution Process， 单击 Iteration Tolerances 按钮将弹出 Iteration
Tolerances 对话框， 在对话框的底部可以设置限制的位移增量。

需要注意的是： 矩阵稳定、 接触阻尼和限制增量位移这 3 种方法可以联合起来使用。
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图 4-67　 查看结果输出文件

4. 11　 设定阻尼

阻尼指的是材料的耗能能力。 一般情况下， 结构的阻尼只与结构的材料特性、 固有频率

与边界条件有关。 在进行结构的动力学分析时， 一般假设结构的阻尼矩阵是质量矩阵和刚度

矩阵的线性组合， 而所求得的模态阻尼指的是结构解耦后的模态阻尼， 其与结构的质量矩阵

和刚度矩阵有关， 也就是说结构的阻尼和结构的边界有关。
阻尼不仅是材料特性， 而且是系统的固有特性。 振动系统中将所有消耗系统机械能的因

素都定义为阻尼。 一般来说， 实际阻尼包括线性阻尼和非线性阻尼。 例如， 当物体速度较

慢、 受到空气等黏性流体衰减时， 则认为是线性阻尼； 而对于摩擦， 通常认为是非线性阻

尼。 为了工程应用方便， 常用的做法是将非线性阻尼线性化。 因此， 工程计算中使用的阻尼

大都是线性阻尼。
线性化的基本思想是： 让系统线性化阻尼系数和实际的非线性阻尼系数在一个周期内消
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耗的能量相等。 基于该思想， 就可以大胆和正确地使用线性阻尼进行计算。 ADINA 软件中

可以指定下列几种阻尼： 1） Alpha 和 Beta 阻尼 （Rayleigh 阻尼）； 2） 振型阻尼比； 3） 弹簧

单元阻尼； 4） 集中阻尼， 下面将分别详细介绍。
1. Alpha 和 Beta 阻尼 （Rayleigh 阻尼）
Alpha 和 Beta 阻尼 （Rayleigh 阻尼） 用于定义瑞利阻尼常数 α （Alpha） 和 β （Beta）。

图 4-68　 设置 Rayleigh 阻尼

阻尼矩阵则通过将这些常数乘以质量矩阵

M 和刚度矩阵 K 后计算得到。
设定 Alpha 和 Beta 阻尼选项的操作如

下， 单击菜单 Control → Analysis Assump-
tions → Rayleigh Damping， 将 弹 出 设 置

Rayleigh阻尼对话框， 如图 4-68 所示。 在

该对话框内可以输入整个模型的 Alpha 和

Beta 阻尼常数， 也可以为不同材料对应的

不同单元组输入不同的 Alpha 和 Beta 阻尼

常数。
通常无法直接得到 α 和 β 的值， 而是

通过使用振型阻尼比 ξi计算得来。 ξi指的

是某个振型 i 的实际阻尼和临界阻尼之比。
如果 ωi是模态 i 的固有角频率， 则 α 和 β
满足式 （4-5）：

ξi =
α

2ωi
+
βωi

2 （4-5）

2. 振型阻尼比

阻尼比表示实际阻尼与临界阻尼之比， 用于给不同的振动模态指定不同的阻尼比。
在前处理时， 菜单 Control→Analysis Assumptions→Modal Damping 下的阻尼设置对话

框主要用于设置模态叠加法来进行瞬态动力学分析， 如图 4-69 所示。 在后处理时， 菜单

图 4-69　 前处理时的阻尼设置对话框
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Definitions→Spectrum Definitions→Damping Table 下的阻尼设置对话框主要用于谱分析、 谐响

应分析和随机振动分析， 如图 4-70 所示。

图 4-70　 后处理时的阻尼设置对话框

3. 弹簧单元阻尼

弹簧单元阻尼主要用于包含黏弹性阻尼特征的单元类型， 也可以模拟岩土的黏弹性边界

来处理截断边界处的吸波消能效应。 弹簧单元阻尼在定义弹簧单元组时设置， 设置方法如图

4-71 所示。

图 4-71　 设置弹簧单元阻尼

4. 集中阻尼

集中阻尼的应用范围更为广泛， 可以模拟任意部位、 任意材料的阻尼作用。 对应的操作

如下： 单击菜单 Model→Element Properties→Concentrated Dampers， 将弹出设置集中阻尼对话
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框 （如图 4-72 所示）， 它主要用来为几何模型施加阻尼。

图 4-72　 设置集中阻尼

4. 12　 设定重启动分析

重启动分析是 ADINA 软件的一个非常重要的功能。 读者可以对 1 个已经完成计算的模

型继续进行重启动分析， 例如， 增加计算时间、 改变分析类型、 改变载荷与约束条件等， 因

此重启动分析的应用范围非常广泛。

4. 12. 1　 适用范围

重启动分析中可以修改下列内容：
1） 分析类型。 例如， 将静态分析修改为动态分析， 反之亦然。
2） 求解类型。 例如， 从静态分析到频域分析， 从隐式分析到显式分析， 反之亦然。
3） 求解控制变量。 例如， 迭代方法的常数及容差、 收敛准则、 时间积分、 自动时间

步、 载荷—位移控制等。
4） 外部载荷及强迫位移。
5） 修改材料参数。 需要注意的是： 材料的作用范围不能改变。
6） 边界条件。
7） 约束方程及刚性连接等。
8） 设置接触， 请参见 4. 10. 4 节 “接触分析特征、 注意事项和促进接触收敛的方法”。
9） 瑞利阻尼系数。
10） 时间步和时间函数。
需要注意的是： 当重启动从隐式到显式 （或从显式到隐式） 分析时， 应该查看是否包

含不适于这两种分析的特征存在， 另外还要注意 AUI 中分析类型的默认设置情况。 例如，
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对于隐式分析， 默认情况下 AUI 选择为非协调模式； 而显式分析则不选择非协调模式， 重

启动分析时需要确认是否都采用非协调模式或者均不采用。 再例如， 对于大应变问题的

ULH 及 ULJ 算法， 默认情况下隐式分析的 AUI 中选择 ULH 算法， 而显式分析选择 ULJ
算法。

表 4-4 中给出了重启动分析时分析类型的可能转换。

表 4-4　 重启动分析时分析类型的可能转换

至
从 静 态 分 析 隐式动力分析 显式动力分析 频 域 分 析 模 态 分 析

静态分析 √ √ √ √ × ①

隐式动力分析 √ √ √ √ × ①

显式动力分析 √ √ √ √ × ①

频域分析 √ √ √ × √②

模态分析 √ √ √ × ×

　 　 ① 必须先进行频域分析。
② 可以不重启动分析。

4. 12. 2　 设定重启动分析

不同重启动分析的设置过程也不完全相同。 本节仅简单介绍设置重启动分析的大致步

骤。 需要注意的是， 有些操作步骤并没有先后顺序之分， 只要在提交计算之前都设定完毕

即可。
1） 如果重启动分析需要修改分析类型和求解类型， 即： ADINA 的模块工具条， 则应该

首先设置更改。
2） 设定重启动选项。 单击菜单 Control→Solution Process 将弹出 Solution Process 对话框，

选择 Restart 标签， 并设定重启动时间。
3） 检查时间函数。 如果时间函数中设置的最大时间没有超出重启动分析希望计算的时

间， 则需要修改时间函数。 例如， 前面的分析计算到 2s， 现在希望重启动分析计算到 5s，
因此， 模型时间函数的最大时间应至少为 5s， 时间函数中的前 2s 无须改动， 而只改动后 3s
时间函数的设置即可。

4） 设置时间步， 该时间步的设置指的是重启动开始时刻的时间步设置。 例如， 前面的

分析计算到 2s， 如果现在时间步的设置情况为计算 10 步， 每步 0. 1s， 则计算正常结束后将

计算到 3s。
5） 修改模型的其他设置。 例如， 载荷、 边界条件、 材料参数、 收敛准则、 阻尼、 约束

方程等， 应该具体问题具体分析。

4. 12. 3　 注意事项

对于重启动分析， 设置过程中应该注意下列几个问题：
1） ADINA 软件不允许修改几何和大部分的单元数据 （element data）， 允许修改的参数

请参见 4. 12. 1 节 “适用范围”。
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　 　 2） 重启动分析时， 需要指定前一步分析的重启动文件 （*. res）。 如果不希望指定重启

动文件， 也可以将前一步分析的重启动文件复制到当前工作目录， 并将该重启动文件名修改

为与重启动分析的求解文件同名。 例如， 重启动分析求解文件名为 temp2. dat， 则重启动文

件名必须修改为 temp2. res。

图 4-73　 设定重启动选项对话框

3） 默认情况下， 在每一时间步求解

完成后， 重启动文件 （* . res） 将自动覆

盖保存， 所以重启动分析的起始时间只能

是上一步分析的终止时刻。 也可以设定与

前一分析步不同的时间点来进行重启动分

析， 此 时 单 击 菜 单 Control → Restart
（*. res）Options 将弹出设定重启动选项对

话框 （如图 4-73 所示）， 将图中 DEFAULT
修改为希望保存重启动文件的时间步间隔

即可 （例如， 5、 10、 50 等）。 这样操作，
将使重启动文件变大。

4） 重启动分析时， 新分析步也将产生新的重启动文件， 如果读者希望重新进行这一步

重启动分析时， 需要首先删除新产生的重启动文件， 然后再提交计算， 否则， 程序将自动按

照新的重启动文件进行计算， 往往导致错误的计算结果。
5） 流固耦合问题也可以进行重启动分析， 设置方法与一般重启动分析相同， 操作步

骤可参见 4. 12. 2 节 “设定重启动分析”， 此时需要在流场和结构场中分别设定重启动分

析。 提交重启动计算时， 往往需要先指定流场的重启动文件， 然后指定结构场的重启动

文件。

4. 13　 ADINA 的坐标系

在 ADINA 软件中建模、 设定载荷、 设定边界条件及结果后处理时， 坐标系都起着非常

重要的作用， 读者应该重点学习并掌握。 学习过程中， 有些内容可能不太容易理解， 需要具

备一定的有限元理论知识， 可以在不断地学习中逐渐掌握。
ADINA 软件中主要包含下列 9 种坐标系， 分别是：
1） 全局坐标系 （Global System）。
2） 几何坐标架 （Geometry Triads）。
3） 单元局部坐标系 （Element Local Coordinate System）。
4） 局部坐标系 （Local Coordinate System）。
5） 结果转换坐标系 （Result Transformation System）。
6） 斜坐标系 （Skew System）。
7） 正交轴系 （Orthotropic Axes System）。
8） 材料轴 （Material Axes）。
9） 初始应变轴 （Initial Strain Axes）。
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4. 13. 1　 全局坐标系、 几何坐标架、 单元局部坐标系

本节将介绍全局坐标系、 几何坐标架和单元局部坐标系的用法和注意事项。
1. 全局坐标系

全局坐标系是 ADINA 软件默认的坐标系， 无须定义， 也不允许修改， 它的坐标系编号

为 0。 全局坐标系是建模分析时统一的度量标准， 前、 后处理均以它为基础。
2. 几何坐标架

几何坐标架是依附于几何实体的局部坐标系。 在指定网格密度及定义空间函数时， 要求

根据不同的方向来分别指定， 因此， 往往需要知道几何实体局部的定义方向， 此时可以打开

依赖于面或体的坐标架来查看几何方向。 单击显示工具条图标 （Surface / Face Labels） 和

图标 （Volume / body Labels）， 就可以显示面和体的方向。

图 4-74　 定义几何

坐标架的方向

几何坐标架方向的定义如图 4-74 所示。 一般情况下， 选择 Vertex
方式建立面时， 所选择的从第 1 点到第 2 点的方向即为 u 方向； 选

择 Patch 方式建立面时， 第 1 条线的方向为 u 方向； 选择 Extrude 方

式建立体时， 拉伸的方向即为 w 方向， 拉伸面则为 u- v 平面。
3. 单元局部坐标系

单元局部坐标系是针对单元的一种局部坐标系， 它依赖于所生

成的单元。 每个单元均包含一个单元局部坐标系， 在前处理、 求解和后处理过程中， 单元局

部坐标系的方向是固定不变的。 在求解过程 （例如， 形成单元刚度矩阵）、 定义梁截面和输

出分析结果时， 一般都需要使用单元局部坐标系。 单元局部坐标系方向的定义如图 4-75
所示。

图 4-75　 定义单元局部

坐标系的方向

在主菜单下单击 Display→Geometry / Mesh Plot→Modify 或单击

图标 （Modify Mesh Plot）， 将弹出 Modify Mesh Plot 对话框， 单

击 Element Depiction 按钮， 在弹出的 Define Element Depiction 窗口

中勾选 Display Local System Triad 选项， 并选择局部坐标系的类型

为 Element Coordinate System， 单击 OK 按钮两次即可退出对话框，
同时图形区中将显示单元局部坐标系， 如图 4-76 所示。

提示： ADINA 软件中单元的初始应变 （或者以初始应变形式〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
而施加的初始应力） 并非根据单元局部坐标系施加， 而是基于单元的另外一种局部坐〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
标———初始应变轴施加的； 同理， 正交各向异性材料的材料特性则是基于单元的另一种局部〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
坐标———材料轴施加的。 相关内容的详细介绍， 请参见 4. 13. 4 节 “正交轴系、 材料轴、 初〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
始应变轴”。〰〰〰〰〰

单元局部坐标系的方向与单元形状有关， 并非一定要与全局坐标系平行。 另外， 对于二

维实体 （2D Solid） 单元， 外法线方向 （t 方向） 可能与生成单元几何面的外法线方向不同。
默认情况下， 壳 （shell） 单元的外法线方向与几何面的外法线方向相同， 划分壳单元时可

以反向。
对分析结果进行后处理时， STRESS （RST） 与 STRAIN （RST） 分别表示基于单元局部

坐标系的应力和应变结果。 需要注意的是： 单元局部坐标系中不包含位移计算结果。 对于三

维平面应力单元 （3D Plane Stress）， 如果标有 YY、 ZZ， 则表示计算结果基于单元局部坐标
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图 4-76　 设置并显示单元局部坐标系

系得到。 壳单元的局部坐标系如图 4-75 所示， 查看壳单元局部坐标系的操作如下： 在Define
Element Group 对话框中单击 Advanced 标签页， 选择应力参考系 （默认为 Global）， 如图4-77
所示， 选择应力参考系 （Stress Reference System） 为 Local 或者 Mid- Surface 时， 后处理中将

得到结果 STRESS （RST） 和 STRAIN （RST）， 而不会出现全局坐标系的 STRESS （XYZ）、
STRAIN （XYZ）。 对于大位移 /大应变的 ULH 计算， 应力参考系选择 Local 和 Mid- Surface 的

效果相同。 更详细的介绍请参见结构理论手册 2. 7. 9 节 “Element Output”。

图 4-77　 设置壳单元坐标系
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4. 13. 2　 局部坐标系、 结果转换坐标系

本节将介绍局部坐标系和结果转换坐标系的用法和注意事项。
1. 局部坐标系

为了方便建立几何模型， 前处理时可以选择直角坐标系、 柱坐标系或球坐标系。 在主菜

单下选择 Geometry→Coordinate Systems （或单击图标 ）， 将弹出定义局部坐标系对话框，
如图 4-78 所示， 单击 Add 按钮可以定义局部坐标系。 定义局部坐标系的方法有 3 种， 详细

介绍如表 4-5 所示。 对结果进行后处理时， 局部坐标系也可以作为结果转换坐标系来使用。

图 4-78　 定义局部坐标系

表 4-5　 定义坐标系的 3 种方式

定义坐标系的方式 描　 　 述

　 原点和方向向量 （ Origin and
Direction Vectors）

　 通过指定坐标原点、 X 方向向量 （Vector A） 和 Y 方向向量 （Vector B） 来确定

X-Y 平面， 所有的值均相对于全局坐标系

　 原点和欧拉角 （Origin and Euler
Angles）

　 在相对全局坐标系的基础上指定欧拉角来确定， 欧拉角如图 4-79 所示， 此方

法不常使用

　 3 个 几 何 点 （ Three Geometry
Points）

　 通过指定 3 个点 （P1、 P2、 P3） 来定义坐标系。 其中， P1 为原点， 由 P1 与 P2
的连线来确定 X 方向， 由 P1、 P2 和 P3 来确定 X-Y 平面， Y 轴与 X 轴垂直并指向

P3 点， 并按照右手螺旋法则来确定 Z 轴

关于局部坐标系， 说明如下：
1） ADINA 软件默认的坐标系是笛卡儿直角坐标系， 坐标系的编号为 0。
2） 在建立几何模型时， 默认坐标系一般均能满足需要。 如果建模时使用局部坐标系更

加方便， 才有必要定义局部坐标系。 例如， 需要按角度输入几何点时， 就可以建立柱坐标系

或球坐标系； 如果需要输入螺旋线， 定义柱坐标系将更加方便。
3） 在分析过程中可以根据需要定义多个局部坐标系， 并使用 Set 功能来激活已创建的

坐标系。
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4） 建立几何模型时输入的坐标值以及各种复制 （Copy）、 映射 （Reflection） 等的转换

操作都基于被激活的坐标系。

图 4-79　 欧拉角

定义几何点的过程中往往需要输入点的坐标， 对于不同的坐标系， X1、 X2 及 X3 的含

义各不相同， 如表 4-6 所示。 柱坐标系及球坐标系的定义如图 4-80 所示。

表 4-6　 不同坐标系下点坐标的含义

坐　 标　 系
坐　 　 标

X1 X2 X3

默认坐标系 X Y Z

直角坐标系 XL YL ZL

柱坐标系 R THETA XL

球坐标系 R THETA PHI

图 4-80　 定义柱坐标系和球坐标系

2. 结果转换坐标系

图 4-81　 结果转换坐标系

的坐标架

对计算结果进行后处理时， 可以将全局坐标系中得到的应力、
应变结果转换到结果转换坐标系中， 其坐标架如图 4-81 所示。 默

认情况下， 结果转换坐标系指的是全局坐标系， 也可以是自定义

坐标系 （直角坐标系、 柱坐标系或球坐标系）。 此外， 局部坐标系

也可以用做结果转换坐标系。
后处理时， 在主菜单下选择 Display→Band Plot→Create 或单击

图标 （Create Band Plot）， 在弹出的 Create Band Plot 窗口中单击 Result Control 选项右侧的
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按钮， 将弹出 Define Result Control Depiction 窗口， 单击该窗口 Coordinate System 项右侧的

按钮， 在弹出的 Define Coordinate System 对话框中设置结果转换坐标系。 如果图形区中已

经给出了显示结果， 可以单击菜单 Display→Band Plot→Modify 或单击图标 （Modify Band
Plot）， 在弹出的 Modify Band Plot 窗口中单击 Result Control 按钮， 也可以弹出 Define Coordi-
nate System 对话框。 结果转换坐标系的定义方法与局部坐标系的定义方法完全相同。 定义完

成后， 在 Define Result Control Depiction 窗口中可以选择将要使用的结果转换坐标系 （默认

为全局坐标系）， 如图 4-82 所示。

图 4-82　 定义结果转换坐标系

另外， 也可以将前处理中定义的局部坐标系用做后处理中的结果转换坐标系。 进入后处

理模块时， 需要首先打开 *. idb 文件 （前处理时需要保存 *. idb 文件）， 然后打开 *. por
文件。 结果转换坐标系的显示设置如下： 在后处理中选择主菜单 Display→Geometry / Mesh
Plot→Modify 或单击图标 （Modify Band Plot）， 然后单击 Element Depiction 按钮， 在弹出的

Define Element Depiction 对话框中选中 Display Local System Triad 标签， 并将 Type 选择为 Re-
sult Transformation System， 单击 OK 按钮两次即可退出对话框， 并显示各个单元的结果转换

坐标系。 需要注意的是： 在前处理中也可以显示结果转换坐标系， 操作方法与刚才介绍的完

全相同， 但只能显示默认的全局坐标系。
提示： 后处理中， STRESS （123）、 STRAIN （123） 表示结果转换坐标系中的分析结果。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

结果转换坐标系中不包含位移结果。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

4. 13. 3　 斜坐标系

在前处理中， 斜坐标系的主要作用是便于施加载荷或节点自由度约束。 斜坐标系可以是

直角坐标系， 也可以是柱坐标系或球坐标系， 它只用于表示节点自由度的局部方向， 而不能
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用于建立几何模型。
在菜单中选择 Model→Skew Systems→Define， 将弹出如图 4-83 所示的定义斜坐标系对

话框， 定义斜坐标系的方法非常多， 包括： Vectors、 Euler Angles、 Normal、 Nodes、 Cylindri-
cal、 Spherical， 这些方法比较简单， 本书不做详细介绍。 斜坐标系定义完成后， 选择菜单

Model→Skew Systems→Apply， 就可以将斜坐标系应用在几何实体上。

图 4-83　 定义斜坐标系对话框

需要注意的是： 定义斜坐标系时， 如果将 Type 选择为 Normal， 则只需要给出斜坐标系

的编号即可， 指定某一几何对象后， 斜坐标系的坐标轴将垂直于该几何对象。 另外， 当两个

体 （面、 线） 共用一个面 （线、 点） 时， 如果为两个体 （面、 线） 分别指定了不同的斜坐

标系， 则必须明确指定共用面 （线、 点） 的斜坐标系。
斜坐标系定义完后， 如果不敢保证斜坐标系的定义是否正确， 则应该检查其定义方向，

有两种检查方法： 1） 定义一个矢量载荷。 例如， 力 （Force） 载荷， 将该力施加在基于斜坐标

系作用几何上； 2） 单击图标 （Load Plot）， 在图形区检查力的方向与定义的斜坐标系方向

是否一致， 如果不一致则说明定义错误。
提示： 使用斜坐标系后， 在几何体上显示力的方向不一定正确， 而应在单元上显示力的〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

方向。 为避免干扰可以先消去几何体显示， 并以施加在单元上的力方向为准。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
在后处理过程中， 打开结果文件将得到与斜坐标系对应的下列位移结果： A- DISPLACE-

MENT、 B- DISPLACEMENT 和 C- DISPLACEMENT， 对于没有指定斜坐标系的其他区域， 默

认显示的位移结果则基于全局坐标系。
注意： 斜坐标系中不包含应力和应变的结果。

4. 13. 4　 正交轴系、 材料轴、 初始应变轴

本节将介绍正交轴系、 材料轴和初始应变轴的用法和注意事项。
1. 正交轴系

正交轴系主要用于将初始应变轴或材料轴与定义的正交轴系对齐， 用来调整单元的初始

应变轴或材料轴方向。 与直角坐标系类似， 正交轴系由 3 个互相正交的向量组成。
在主菜单下选择 Model→Orthotropic Axes Systems→Define， 将弹出如图 4-84 所示的对话
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框。 定义正交轴系的方法非常多， 本书将不作详细介绍。 正交轴系定义完后， 应该将几何的

初始应变轴或材料轴与所定义的正交轴系对齐， 即： 调整几何体上单元的初始应变轴或材料

轴的方向， 操作方法如下： 选择菜单 Model→Orthotropic Axes Systems→Assign （Material），
就可以将面、 体或单元集的材料轴与定义的正交轴系对齐； 选择菜单 Model→Orthotropic
Axes Systems→Assign （ Initial Strain）， 可以将面、 体或单元集的初始应变轴与正交轴系

对齐。

图 4-84　 定义正交轴系对话框

对于二维 （2D） 单元、 板 （Plate） 单元和

壳 （Shell） 单元 （注意： 不包含 3D 单元）， 使

用下面的方法定义正交轴的同时， 可以将单元

的材料轴或初始应变轴与正交轴对齐， 对应的

操作如下： 选择菜单 Model→Orthotropic Axes
Systems→Specify to Elements （Material） 可以设

定材料轴； 选择菜单 Model→Orthotropic Axes
Systems→Specify to Elements （ Initial Strain）
可以设定初始应变轴。

对于几何体 （非几何面）， 将其材料轴

或初始应变轴与定义好的正交轴系对齐的方法如下： 选择菜单 Model→Element Properties→
3D- Solid 来指定材料轴及初始应变轴， 如图 4-85 所示。

图 4-85　 设定几何体的材料轴及初始应变轴

提示： 正交轴系的三个坐标轴表示为 Local X、 Local Y、 Local Z。 初始应变轴或材料轴〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
的三个坐标轴表示为 a、 b、 c。〰〰〰〰〰〰〰〰〰〰〰〰〰

2. 材料轴

在 ADINA 软件中材料轴已经默认存在， 它与每个单元有关。 材料轴的坐标架如图 4-86
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图 4-86　 材料轴的

坐标架方向

所示。 在大多数情况下， 材料轴需要与定义的正交轴系 （Orthotropic Axes
System） 对齐， 以便调整材料轴的方向。

只有在定义单元组时选择正交各向异性材料 （例如， Elastic- Orthotro-
pic、 Plastic- Orthotropic 或 Thermo- Orthotropic 等） 才可以显示单元的材料

轴。 显示正交各向异性材料正交方向的方法为： 选择菜单 Display→Geome-
try / Mesh Plot→Modify 或单击 （Modify Mesh Plot） 图标， 在弹出的对话

框中单击 Element Depiction 选项， 将弹出 Define Element Depiction 对话框，
选中 Display Local System Triad 选项， 并将 Type 选择为 Material Axes， 单击 OK 按钮两次即可

退出对话框， 并可以显示单元的材料轴， 如图 4-87 所示。

图 4-87　 显示单元的材料轴

需要注意的是： 默认情况下， 单元的材料轴与单元坐标系可能不对齐。 默认的各单元材

料轴方向与单元形状有关， 也不一定与全局坐标系对齐。 定义并使用各向异性材料时应注

意： 对于平面问题， 材料轴的 a- b 平面指的是全局坐标系的 YZ 平面， 轴 a 和轴 b 的方向应

根据需要进行调整。 如果单元组中使用了各向异性材料， 应力输出的参考轴可以为材料轴

（默认为全局坐标系）， 分别如图 4-88 和图 4-89 所示。 图 4-88 中设定二维实体 （2D- Solid）
单元组的应力参考系为材料轴； 图 4-89 则设定壳 （Shell） 单元组的应力参考系为材料轴。

注意： 如果单元组中没有使用各向异性材料， 该选择将不起作用， 仍然选用全局坐标系

（Global）。
后处理中， STRESS （ABC） 和 STRAIN （ABC） 表示基于材料轴得到的计算结果。 此

时， 全局坐标系下的 STRESS （XYZ） 和 STRAIN （XYZ） 将不再输出。 另外， 材料轴中不

包含位移结果。 读者应该注意它与斜坐标系 （Skew System） 中位移结果 （标号为 A、 B、
C） 的区别。
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图 4-88　 设置二维实体单元的材料轴

图 4-89　 设置壳单元的材料轴

3. 初始应变轴

初始应变轴也与每个单元有关， 在 ADINA 软件中已经默认存在， 初始应变轴的坐标架

与图 4-86 所示的方向一致。 在大多数情况下， 初始应变轴需要与定义的正交轴系 （Ortho-
tropic Axes System） 对齐， 以便调整初始应变轴的方向。

只有在定义单元组时选择包含初始应变 （在 Advanced 标签页下）， 才可以显示单元的
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初始应变轴， 如图 4-90 所示。 显示初始应变方向 （或以初始应变方式施加初始应力） 的方

法为： 选择菜单 Display→Geometry / Mesh Plot→Modify 或单击图标 （Modify Mesh Plot）， 在

弹出的窗口中单击 Element Depiction 按钮， 将弹出 Define Element Depiction 对话框， 选中

Display Local System Triad 按钮， 并将 Type 设置为 Initial Strain Axes， 单击 OK 按钮两次退出

对话框并显示单元的初始应变轴， 如图 4-91 所示。

图 4-90　 在定义单元组对话框中设置初始应变

注意： 默认情况下， 单元的初始应变轴与单元坐标系不一定对齐。 各个单元初始应变轴

的默认方向与单元形状有关， 也不一定与全局坐标系对齐。 一般情况下， 初始应力场取自于

上次计算结果的全局坐标系， 计算本次初始应力时， 则施加初始应变轴方向， 因此应该判断

是否需要对初始应变轴的方向进行调整。 对于平面问题， 初始应力场的顺序为 （YY、 ZZ、
XX、 YZ、 XY、 XZ）， 可以显示各单元的初始应变轴， 并查看单元 a 和单元 b 的正方向是否

与全局坐标系下 Y 和 Z 的正方向对齐。 如果对齐， 则不需调整； 否则， 则应该进行调整。
对于三维问题， 初始应力场的顺序为 （XX、 YY、 ZZ、 XY、 XZ、 YZ）， 可以显示各单元的

初始应变轴， 并查看 a、 b 和 c 三个单元的正方向是否与全局坐标系下的 X、 Y、 Z 的正方向

分别对齐。 如果对齐， 则不需调整； 否则， 则应该进行调整。 土木工程分析中施加初始地应

力场经常采用这种方法。
STRESS （IJK） 中的 IJK 并不代表某一坐标系。 如果单元应力在全局坐标系下输出，

STRESS （IJK） 应力分量等同于全局坐标系中的应力分量； 如果单元应力在结果转换坐标系

下输出， STRESS （IJK） 应力分量等同于结果转换坐标系中的应力分量； 如果单元应力在材

料坐标系下输出， STRESS （IJK） 应力分量等同于材料轴中的应力分量。 STRESS （IJK） 主

要用于计算结果不变量 （即不依赖于坐标系方向）。 例如， 有效应力 （ EFFECTIVE _
STRESS） 是在应力分量 STRESS （II）、 STRESS （JJ） 等的基础上计算得到的。
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图 4-91　 显示初始应变轴
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　 　 本章将介绍下列内容： 梁单元的端点释放、 梁单元的刚性区域、 无限远边界的处理、 设

定弹簧约束边界、 渗流问题和初始地应力的处理。 其中， 5. 1 节、 5. 2 节、 5. 4 节和 5. 6 节

都将给出详细的操作步骤， 5. 3 节和 5. 5 节仅列出了处理问题的方法， 实际应用时需要具体

问题具体分析。

5. 1　 梁单元的端点释放

梁单元的端点释放指的是在梁单元的端点释放节点力或节点力矩， 使梁单元之间的连接

关系由固定连接变成铰接等形式， 因此， 梁单元的端点释放可以用来模拟铰接结构， 例如，
桁架结构、 铰杆结构等。

如图 5-1a 所示， 将刚架结构的 3 条线共划分为 15 个梁单元， 底部节点 P1 和 P2 为固定

端约束， 点 P4 处作用一水平方向集中力。 如果不定义端点释放， 计算结果如图 5-1b 所示；
如果在点 P4 处定义了端点释放， 计算结果将如图 5-1c 所示。

定义梁单元的端点释放之前， 需要首先确定端点释放处的梁单元编号、 节点编号和梁单

元方向， 如图 5-1a 所示。 对应的操作如下： 单击显示工具条的 （Element Lables） 图标来

显示单元编号， 获取点 P4 处的梁单元编号分别为 5 和 6。 单击显示工具条的图标 （Node
Lables） 来显示节点编号， 获取点 P4 处的节点编号为 6。 单击菜单 Display→Geometry / Mesh
Plot→Modify 或单击 （Modify Mesh Plot） 图标， 在弹出的窗口中单击 Element Depiction 选

项， 并在 Define Element Depiction 窗口中勾选 Display Local System Triad 选项， 选择 Type 为

Element Coordinate System， 单击 OK 按钮两次即可显示单元坐标系 （请参见 4. 13. 1 节中图

4-76）， 设置完毕将如图 5-1a 所示。
如果希望为点 P4 （节点 6） 定义端点释放来释放 t 方向的力矩 （即： 垂直于纸面方向的

力矩， 请参见 4. 13. 1 节图 4-75）。 可以在单元 5 和单元 6 中选择其一来定义端点释放即可

（注意： 无需定义两个）。 每个梁单元都包含两个端点， 分别定义为 Node1 和 Node2 （从
Node1 指向 Node2 为梁单元方向）， 因此定义时需要事先清楚哪个端点对应 Node1， 哪个端

点对应 Node2。 假定读者希望为单元 5 （分别为节点 5 和节点 6） 定义端点释放， 可以单击

菜单 Meshing→Elements→Element Nodes， 在弹出的 Element Nodes 图框中找到单元 5 所在行，
将找到节点 5 对应 Node1， 节点 6 对应 Node2 （如图 5-2 所示）， 因此可以判断应该释放单元

5 在 Node2 的 t 方向力矩。
单击菜单 Model→Boundary Conditions→Define End Release， 将弹出定义端点释放对话

框， 如图 5-3 所示。 单击 Add 按钮来定义端点释放 1， 将 Identifier 1 选择为 Moment （ t） at
Node 2， 单击 OK 按钮即可。 定义其他端点释放时， 应该具体问题具体分析。 ADINA 软件最

多允许释放 6 个端点自由度， 从 Identifier 1 到 Identifier 6。
单击菜单 Meshing→Elements→Element data， 将弹出 Element Data 图框， 查找单元 5 所在

的行， 并将 End- Release 列修改为 1， 即： 刚才定义的端点释放， 将其作用于单元 5， 此时端

点释放才定义完毕， 如图 5-4 所示。
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图 5-1　 端点释放示例

图 5-2　 显示梁单元信息
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图 5-3　 定义端点释放对话框

图 5-4　 定义端点释放作用域

5. 2　 梁单元的刚性区域

土木工程领域中经常要用到框架梁结构， 对于某些分析问题往往需要将梁单元端部的部

分区域假设为刚性区域， 本节将介绍在 ADINA 软件中定义梁单元刚性区域的方法。
如图 5-5a 所示， 将简单框架结构共划分为 3 个梁单元， 每个梁单元的长度为 1， 假设

希望将单元 1 的节点 2 附近长度为 0. 5 的区域设定为刚性区域， 将单元 2 节点 2 附近长度为

0. 3 的区域设定为刚性区域， 设定完毕的效果如图 5-5b 所示。
详细的定义步骤如下：
1） 定义梁单元组时， 应该设定刚性区域选项 （如图 5-6 所示）。 操作方法是： 在

Advanced标签页下的 Rigid End- Zones 中选择 Defined by Length with Infinite Stiffness。
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图 5-5　 梁单元刚性区域示例

2） 与定义端点释放相同， 读者应该知道节点 2 （对于单元 1 和单元 2） 分别属于 Node1
还是 Node2， 其中 Node 1 指的是单元始点 （Start）， Node 2 指的是单元终点 （End）。 单击菜

单 Meshing→Elements→Element Nodes 可以查看梁单元的节点 （如图 5-7 所示）， 可知： 对于

单元 1， 节点 2 为 Node2； 对于单元 2， 节点 2 为 Node1。

图 5-6　 在设定梁单元组对话框中设定刚性区域选项

3） 单击菜单 Meshing→Elements→Element Data 可以定义梁单元刚性区域的长度。 使用
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图 5-7　 查看单元节点

鼠标拖动水平滚动条查找与单元 1 和单元 2 对应的 Rigid End- Zone 列。 在单元 1 和单元 2 的

Rigid End- Zone （Length from End） 中分别输入 0. 5 和 0. 3， 如图 5-8 所示， 此时梁单元的刚

性区域定义完毕。

图 5-8　 设定梁单元刚性区域的长度

5. 3　 无限远边界的处理

在分析工程问题时还经常遇到模拟无限远边界的情况， 本节将介绍在 ADINA 软件中处

理无限远边界的 3 种方法。

5. 3. 1　 使用弹簧单元定义黏性或黏弹性的接地弹簧边界

对于如图 5-9 所示的结构， 图中大片区域网格表示地基， 读者可以在地基的左右边界和

下边界定义弹簧单元 （Spring） 来模拟无限远边界。
定义方法如下：
1） 定义单元组时选择 Spring 单元类型， 单击 Default Property Set 右侧的 按钮， 将弹

出设定弹簧属性对话框， 如图 5-10 所示， 在此对话框中可以定义黏性或黏弹性弹簧参数

（弹簧单元的参数可按相关规定取值）。
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图 5-9　 定义弹簧边界

图 5-10　 定义 Spring 单元组

　 　 2） 单击菜单 Meshing→Elements→Spring 将弹出 Define Spring Elements 对话框， 在 Define
by 中选择 Lines， 然后选择定义弹簧单元的边界 （线）、 指定自由度的方向和弹簧属性， 并

将 Line 2 （0 for Ground） 设定为 0， 表明线上的弹簧单元均为接地弹簧， 如图 5-11 所示。
同理， 也可以将 Define by 选择为 Points 来定义点对点弹簧单元。

需要注意的是： 刚才介绍的操作方法仅对二维模型有效， 对于三维模型的面则是无效

的， 原因是： 定义弹簧单元 （见图 5-11） 时并未包含基于面的方法。 如果需要为面定义弹

簧单元， 可以参考 5. 4 节 “设定弹簧约束边界”。
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图 5-11　 定义弹簧单元

5. 3. 2　 使用 Glue Mesh 功能

Glue Mesh 功能可以让模型模拟尽量大的边界范围， 而单元和节点的数量并没有显著增

加， 可以在保证精度的前提下节省计算时间。 该法主要适用于难以确定接地弹簧参数的情

况。 当图 5-12 所示中的模型选取为 20 × 20 倍时， 共使用了 3 次 Glue Mesh 功能。

图 5-12　 使用 Glue Mesh 定义无限远边界

5. 3. 3　 使用势流体单元的无限远边界

ADINA 软件的结构场可以模拟势流体 （基于势的流体单元）， 它没有黏性、 没有漩涡、
没有热传递， 但是包含无限远边界条件。 因此， 分析时可以使用势流体的无限远边界来处理
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问题。 这种处理方式和直接在结构边界处施加一个非常大的黏性阻尼是相同的， 应该可以算

作是一种黏性边界。
对于如图 5-13 所示的模型， 地震波为水平方向的地震波， 故其底边应该约束竖向位移，

两侧设置为势流体单元， 并在势流体单元边界上设置 Fluid- infinite Region 边界， 在结构与势

流体的边界处让网格保持连续。 操作方法如下： 单击菜单 Model→Boundary Conditions→
Potential Interface， 在弹出的对话框中可以定义无限远边界的势流体边界条件。

图 5-13　 势流体单元的无限远边界

ADINA- CFD 模块的流体边界条件中不包含无限远边界。 如果希望使用流体模型来模拟

无限远边界效应， 则应该通过设定流固耦合的方法来实现， 即： 在流场和结构场中分别建立

模型并设定流固耦合边界， 则结构场中的结构就是势流体。 关于这种方法的详细介绍， 请参

见 ADINA 8. 6 版 primer 手册中的例题 15。

5. 4　 设定弹簧约束边界

二维模型的边界为线， 定义弹簧约束边界的方法请参见 5. 3. 1 节 “使用弹簧单元定

义粘性或粘弹性的接地弹簧边界”， 此处不再赘述。 对于土木工程或生物力学中的三维模

型， 读者将经常遇到为整个面施加弹簧约束的情况， 此时可以采用下面介绍的两种方法

来设置。 需要注意的是： ADINA 8. 7 新版本中可以直接为 Node Set 施加 Spring 单元， 使设

置更加方便。

5. 4. 1　 使用节点组提取节点号并转换到弹簧单元组中

对于如图 5-14 所示的简单实例， 划分好单元的体如图 5-14a 所示， 现在希望为该体的

面 F1 和面 F4 施加弹簧约束， 如图 5-14b 所示。 为了一次得到面 F1 和面 F4 的节点号， 应该

首先定义一个节点组， 对应的操作如下： 单击菜单 Meshing→Nodes→Node Set 将弹出 Define
Node Set 对话框， 如图 5-15 所示。 单击 Add 按钮来定义节点组， 并将 Method 选择为 From
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Geometry Surface / Face， 双击表格的绿色图框并到图形区拾取面 F1 和面 F4， 按下 Esc 键返回

定义节点组对话框。 单击对话框顶部的 Save 按钮， 对话框中的表格将如图 5-16a 所示， 表

格中的节点即为面 F1 和面 F4 上的节点。 单击第 1 行第 1 列， 并按住鼠标向下拖动到最后一

行， 然后单击鼠标右键， 选择 Copy Selected， 并记住最后一行的行号 （例如， 本例为 352），
如图 5-16b 所示。

图 5-14　 施加面弹簧约束示例

图 5-15　 定义 Node Set
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图 5-16　 复制表格中的节点

单击菜单 Meshing→Elements→Element Nodes 将弹出 Element Nodes 对话框。 单击 Auto 按

钮可以设置单元参数 （如图 5-17 所示）。 其中， 在 Node1 栏中输入 1， Node2 中输入 0 来表

示地弹簧， 并单击 OK 按钮， 对话框将如图 5-17 所示。 单击 Node 1 的第 1 行， 然后单击鼠

标右键， 并选择 Paste Selected， 将刚才定义的节点复制到该位置， 拖动表格右侧的滚动条来

检查表格是否定义完好。 如果还需要定义其他自由度， 可以重复上述操作步骤直至完成。 需

要注意的是： 单元的编号应该顺序增加 （不再从 1 开始）， 直到定义完毕。
单击菜单 Meshing→Elements→Element Data 将弹出 Element Data 对话框 （如图 5-18 所

示）， 拖动表格右侧的滚动条可以查看定义的弹簧单元属性。 该表格中的 Property Set 均为 0，
这一般不是所希望设置的状态， 往往需要将其修改为 1 或其他已经定义的弹簧属性。 修改表

格弹簧属性的方法非常多， 最好的操作方法是借助于 Excel 来完成。 例如， 可以首先单击

Export 按钮来导入某个文本文件， 然后使用 Excel 编辑该文本文件 （编辑 Property Set 所在

列） 并保存。 单击 Element data 对话框的 Clear 按钮， 再单击 Import 按钮， 并选择刚才编辑

的文本文件。 读者也可以直接新建一个 Excel 文件， 并编辑 Excel 文件中的内容 （Property
Set 所在列）， 复制 Excel 表格， 并将其粘贴到 Element data 对话框所在的 Property Set 列， 也

可以修改弹簧属性。 弹簧单元定义完毕， 图形区将如图 5-19 所示。



第 2 篇　 提　 高　 篇

124　　 　 Focused on Excellence

图 5-17　 定义弹簧单元对话框

图 5-18　 设定弹簧单元属性 （未修改 Property Set）

图 5-19　 图形区显示效果
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5. 4. 2　 借用壳单元提取节点号转换到弹簧单元组中

使用该法时需要在划分实体网格之前定义一个壳单元组来生成壳单元， 仍以方法 1 中介

绍的例题来介绍该方法， 生成的壳单元如图 5-20 所示。

图 5-20　 生成的壳单元

对应的操作如下：
1） 单击菜单 Meshing→List F. E. Model 将弹出 Model Information 提示框 （如图 5-21 所

示）， 可以查看模型的总节点数 （本例为 352 个节点， 也可以单击菜单 Meshing→Node→
Define来查看节点的定义情况）。 这些节点都属于 shell 单元， 且节点号码连续 （1 ～ 352）。

图 5-21　 查看总节点数

2） 单击菜单 Meshing→Elements→Element Nodes 将弹出 Element Nodes 对话框。 单击

Auto按钮， 并按照图 5-22 所示的设置来定义弹簧单元， 其余工作与方法 1 完全相同， 此处
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不再赘述。 需要注意的是： 在定义弹簧单元之前需要首先定义 Spring 单元组和弹簧属性。

图 5-22　 定义弹簧单元

图 5-23　 删除壳单元组

3） 弹簧单元定义完毕就可以为实体划分网格， 节点检查选

择默认的拟合状态即可。 划分好三维实体网格后， 定义的 Shell
单元将不再有用， 因此应该删掉该单元组及其包含的所有单元。
在模型树的 Shell 单元组处单击鼠标右键， 然后选择 Delete 即可

删除该单元组和单元， 如图 5-23 所示。

5. 5　 渗流问题

实际工程中， 往往比较关心下列渗流问题： 自由面问题和动态渗流模拟， 二者均可以在

ADINA 软件中进行模拟。 需要注意的是： 此处提到的渗流问题 （不仅包括土木专业的渗流

分析） 指的是广义上的渗流， 根据所关心的问题不同， 可以采用 4 种方法：
1） 如果只关心稳态渗流速度和浸润面形状， 可以采用 ADINA- Thermal 模块求解， 如图

5-24 所示。 这种方法是根据渗流方程与温度方程相同的原理， 用温度场的求解方法， 采用

热传导单元来求解渗流问题。

图 5-24　 温度场模拟渗流
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2） 利用 ADINA- CFD 模块中的多孔介质材料来分析渗流问题， 利用求解流体控制方程

的方法得到瞬态渗流速度、 流网分布等， 如图 5-25 所示。

图 5-25　 流场模拟渗流

3） 采用 ADINA- Structures 模块的 porous 材料特性来求解渗流问题 （如图 5-26 所示），
其特点是可以得到土中孔隙水压力与土体本身应力场耦合的结果， 但是无法得到水的渗流速

度等结果。

图 5-26　 结构场模拟渗流

4） 可以综合上述第 2 种和第 3 种方法， 采用流固耦合， 既可以得到瞬态渗流速度、 流

网分布等， 又可以得到土中孔隙水压力与土体本身应力场耦合的结果 （PFSI）， 如图 5-27
所示。

在第 1 种模拟方法中， 总水头是高度水头与压力水头之和。 因此， 水压作用边的总水头

为高度水头与压力水头之和， 其值为常数。 而在自由出流边没有压力水头， 只有位置水头，
因此其总水头为随高度变化的倒三角形载荷。 高度水头指的是高度 Z 坐标为 0 的面 （浸润

面）； 水压力为零的线则称为浸润线。 需要注意的是： 应该在 Z 轴的正半轴建立几何模型，
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图 5-27　 流固耦合模拟渗流

并且一定要包含 Z = 0 的位置； 定义的初始温度值应该大于或等于渗流水头的最大值。 关于

渗流分析的详细实例， 请参见 10. 1 节 “沥青心墙坝渗流分析”。

5. 6　 初始地应力的处理

土木工程中经常需要施加初始地应力场， 其主要目的在于消除重力使土体产生的初始变

形。 对于地下开挖支护的模拟， 通常不设置初始地应力场， 可以通过重力加载得到开挖前的

地应力分布， 但是重力引起的变形仍然存在。 由于初始衬砌的单元与围岩边界共节点， 围岩

的变形将导致支护边界单元出现零应力变形而改变衬砌的形状。 如果模型中施加了初始地应

力场， 由于初始地应力场与重力平衡， 则计算的平衡状态中就不包含重力引起的变形， 因此

可以彻底消除支护单元出现前的扰动变形， 在很多涉及开挖的分析中都需要输入初始地应

力场。
在 ADINA 软件中， 主要有 3 种施加初始地应力场的方法， 下面将分别详细介绍。

5. 6. 1　 直接导入初始地应力法

这种方法适用于线性材料和非线性材料的线弹性阶段， 而不适用于非线性材料部分单元

进入塑性的情况， 也不适用于非线性弹性材料和用户开发的材料。
导入初始地应力法的基本思路是： 首先将前一步施加重力得到的应力结果从结果文件

（Por） 中提取出来， 然后通过前处理的 Initial Condition 窗口施加到模型上。 详细的操作步骤

如下：
1） 首先对模型施加重力载荷并进行计算， 计算完毕后进入后处理模块， 并读入结果文

件。 对应的操作如下： 单击菜单 List→Value List→Zone 将弹出 List Zone Values 对话框， 将

Zone Name 选择为 Whole Model， 将 Smoothing Technique 选择为 Averaged， 在 Response Option
标签下选择 Single Response， 将 Response 选择为 LASTEST （即： 最后时刻的结果）， 将 Vari-
ables to List 选择为 Stress； 对于 3- D Solid 单元， 6 个应力分量依次选择如下： STRESS-11、
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STRESS-22、 STRESS-33、 STRESS-12、 STRESS-13、 STRESS-23， 单击 Apply 按钮可以列出

所有节点的应力值， 如图 5-28 所示。 对于 2- D Solid、 Plate 及 Shell 单元， 则要求初始应力

轴的 1-2 轴必须位于平面内， 3 轴位于平面外， 因此， 这些单元的 6 个应力分量依次为

STRESS-22、 STRESS-33、 STRESS-11、 STRESS-23、 STRESS-12、 STRESS-13。

图 5-28　 列出节点应力

2） 单击 Export 按钮将这些节点的应力结果保存为 txt 文件， 进入工作目录， 并打开该

文件 （见图 5-29）， 编辑该文件并删除文件中的说明部分 （掐头去尾）， 然后保存文件。
3） 使用 Excel 打开刚编辑的文本文件， 选择 Tab 加空格作为分隔符号， 打开后的效果

如图 5-30 所示。 继续编辑文件， 删掉前两列不相关数据而只保留节点号和应力值， 保存 txt
文件， 然后退出 Excel。 编辑好后的 txt 文件如图 5-31 所示， 此时就已经将 txt 文件整理为

ADINA 软件可以读入的数据表格式。
4） 返回到 ADINA- AUI， 并打开原来的模型文件来施加初始地应力场。 操作方法为：

单击菜单 Model→Initial Conditions→Apply on Nodes 将弹出 Apply Initial Conditions to Nodes
对话框， 如图 5-32 所示。 将 Initial Condition Type 选择为 Strain 选项 （此处的 Strain 也就是

Stress， 请参看第 5 步的设置）， 单击 Import 按钮导入编辑好的 txt 文件， 单击 OK 按钮

即可。
5） 单击菜单 Control→Miscellaneous options， 在 Initial Strains are Interpreted as 标签下选

择 Initial Stress that Cause Deformation 选项。 并修改所有单元组中 Advanced 标签下的 Initial
Strain： 选项， 将其选择为 Nodal Only。 此时， 初始地应力定义完毕。
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图 5-29　 编辑输出的文本文件

图 5-30　 用 Excel 编辑
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图 5-31　 整理好的文本文件

图 5-32　 施加初始地应力场条件

5. 6. 2　 采用相对位移抵消地应力引起的变形 （可能需要重启动）
采用相对位移抵消地应力引起的变形主要用于模拟不存在单元生死的模型， 这种方法逻

辑性强， 方便而且准确， 而且可以通过载荷控制方式来加载。 例如， 对于固结沉降分析， 在

0 ～ 100 时间内施加重力， 从 100 时间开始施加压力载荷， 整个过程中不需要重启动； 也可

以使用重启动分析， 例如， 对于大坝的抗震分析， 则应该首先进行静力 （重力载荷） 分析，
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然后重启动， 并进行瞬态非线性抗震分析。
使用这种方法处理问题时， 关键在于获取任意状态相对于重力平衡状态的位移或变形。

ADINA 软件提供下列两种方法来处理该问题：
1. 观察相对变形

单击 （Modify Mesh Plot） 图标将弹出 Modify Mesh Plot 对话框， 单击 Model Depiction
按钮， 将弹出 Define Model Depiction 对话框， 在 Option for Plotting Original Mesh 标签下选择

Use Configuration at Reference time， 并输入 Reference Time for Original Mesh 的对应时间， 如图

5-33 所示。 单击 OK 按钮两次退出对话框， 此时图形区将显示网格的相对变形， 如图 5-34
所示。 需要注意的是： 此时只有网格变形是相对值， 云图中的数值显示仍然是真实值 （相
对于零时刻）， 因此， 这种方法不能够完全解决问题， 需要与下面的第 2 种方法联合使用。

图 5-33　 设定参考构型

图 5-34　 图形区
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2. 使用云图显示相对位移

在后处理模块中单击菜单 Definitions→Response 将弹出 Define Response 对话框， 单击

Add 按钮将弹出 New Name 对话框， 并输入 t1 （小写输入即可）， 在 Solution Time 中输入对

应的时间 （见图 5-35）， 然后单击 Save； 同理， 单击 Add 按钮来定义 t2， 并输入对应时间，
单击 Save。

图 5-35　 定义 Response

定义完时间响应后再定义相对响应。 单击 Add 按钮， 将 Response Name 选择为 DE-
FAULT_RESPONSE- COMBINATION， 并在表格的第 1 行选择 T1， 在 Weight 中输入 - 1， 将

Method 设为 Sum of Algebraic Values； 在表格的第 2 行选择 T2， Weight 输入 1， 将 Method 选

择为 Sum of Algebraic Values， 如图 5-36 所示。 该操作的目的是将 T2 与 T1 的差值作为一个

响应， 并对该响应进行各种结果后处理 （例如， 列表、 云图等）。

图 5-36　 定义相对响应
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使用相对响应绘制云图的方法 （以位移云图为例）： 单击菜单 Display→Band Plot→Cre-
ate 或单击 （Create Band Plot） 图标， 将弹出 Create Band Plot 对话框， Band Plot Variable
选择 Displacement， Z- DISPLACEMENT， 单击 Band Plot Style 右侧的 按钮， 在弹出的

Define Band Plot Style 对话框中 （如图 5-37 所示） 将 Response 设为 DEFAULT_RESPONSE-
COMBINATION， 单击 OK 按钮两次退出对话框， 此时相对响应的位移云图将如图 5-38 所

示。 按照相同的操作方法可以显示其他变量。

图 5-37　 定义 Band Plot

图 5-38　 相对响应的位移云图
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5. 6. 3　 施加初始地应力场

该法通过 ADINA 软件提供的 Initial Geological Stress 功能来施加初始地应力， 适用于模

拟土体地表面水平的结构。
施加初始地应力场的操作步骤如下： 单击菜单 Model→ Initial Conditions→Geological

Strain Field， 将弹出定义初始地应力场对话框， 如图 5-39 所示。

图 5-39　 定义初始地应力场对话框

其参数设定按照下面的公式进行推导：
对于 2D Solid 单元： e22 = A + Bz， e11 = Ce22 + D， e33 = Ee22 + F
对于 3D Solid 单元： e33 = A + Bz， e11 = Ce33 + D， e22 = Ee33 + F

式中， z 是整体坐标系中的 z 坐标； B = ρ × g （ρ 为密度， g 为重力加速度）； C 为侧压力系

数， 通常取 0. 3 ～ 0. 4。
此处可以确定 B、 C 的值， A、 D、 F 指的是土体先期固结压力， 一般情况下假定水平土

体正常固结， 所以可以令 A、 D、 F 等于 0。 在土体为各向同性时， C 与 E 可以取相同值。
对于 2D 单元， 通常只需要指定 A、 B、 C 的值即可。 图 5-39 中的 A、 B 计算过程如下：

B = ρ × g = 2700 × 10 = 27000
A + Bz = e22 = 0⇒A = e22 - Bz = - 27000 × 60 = - 1620000

上式中取值 z = 60， 表示在地表处的 z 向应力为 0 （对于 2D 单元， 2 方向即为 z 方向）。
由于初始地应力场基于单元坐标系加载， 而用户设定的应力则基于整体坐标系下， 因此

还需要定义一个正交轴系将其与整体坐标系对齐。 需要注意的是： 对于第一种直接导入初始

地应力的方法也需要进行该操作。
单击菜单 Model→Orthotropic Axes Systems→Define 来定义正交轴系 1， 如图 5-40 所示。
单击菜单 Model→Orthotropic Axes Systems→Assign （ Initial Strain） 将弹出施加正交轴系

对话框， 如图 5-41 所示。 对于二维模型， a- direction 指的是 Local Y， b- direction 指的是

Local Z； 三维模型采用默认值即可， a- direction 指的是 Local X， b- direction 指的是 Local Y。
单击菜单 Control→Miscellaneous options， 在 Initial Strains are Interpreted as 标签下选择Initial

Stress that Cause Deformation 选项。 还需要将单元组 Advanced 标签下的 Initial Strain 选项修改为

Element Only， 并在Element Strain Field 中输入1 （注意： 这里的1 与图5-39 中的定义相对应， 如

果模型中定义了很多的初始地应力场， 也应该注意相互对应关系）， 如图 5-42 所示。



第 2 篇　 提　 高　 篇

136　　 　 Focused on Excellence

图 5-40　 定义正交轴系

　

图 5-41　 施加正交轴系

图 5-42　 修改单元组属性



本章内容：

■ 6.1 建模基础与模型设定

■ 6.2 建立结构场模型

结构场建模基础
第 6章
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　 　 本章是结构场建模专题。 介绍了在 ADINA 软件中进行结构场建模的一些方法和建议，
主要包括下列内容： 有限元分析介绍、 理解非线性概念、 隐式积分与显式积分、 选择求解

器、 选择迭代方法和收敛准则、 促进收敛的设置方法、 建模前的准备和诊断错误模型等， 下

面将分别详细介绍。

6. 1　 建模基础与模型设定

6. 1. 1　 有限元分析介绍

随着计算机软、 硬件的发展， 线性问题的计算已经成为非常简单的事情。 过去由于计算

机的计算能力有限， 大规模的线性问题在微型机上很难求解， 而非线性问题一直是工程问题

仿真中的难点， 由于非线性的存在， 需要先进的求解方法和不断更新的求解技术。 有限元方

法 （FEM） 可以求解线性问题和非线性问题， 图 6-1 总结了有限元分析的流程。 物理问题

中通常包含承受一定载荷的实际结构， 将物理问题简化为数学模型往往需要做出部分假设，
这些假设也就是数学模型的控制方程。 有限元求解技术是一个数值计算的过程， 因此评估结

果的准确性很有必要， 如果不能够满足计算结果的准确性判据， 则需要优化参数重新进行数

值求解， 直到有限元计算满足要求为止。
显而易见， 有限元方法不是万能的， 它仅能解决选定数学模型下的物理问题， 超出数学

模型假设之外的物理现象不能得到合理解释。 因此， 选择适当的数学模型是非常重要的， 它

直接决定了实际物理问题分析结果的本质。
近年来， CAD 及 CAE 软件虽有整合之势， 但二者却有着本质的区别， 它们对使用者的

要求也大不相同。 有限元分析是 CAE 分析中一个重要的内容， 因此学习 CAE 的读者很有必

要了解有限元分析的过程， 以解答下列问题： 解决问题的范围； 解决问题的途径和过程； 求

解结果是否可靠、 是否需要进行后续优化分析等， 从而从整体上清楚地认识物理问题的有限

元求解过程。 对于初学者， 在不断学习有限元分析的过程中将体会到理解该流程的重要性。

6. 1. 2　 理解非线性

所有不属于线性分析的问题都可以理解为非线性分析问题。 所谓线性问题可以简单地理

解为载荷与变形 （或者应力与应变） 之间是正比关系 （相关理论请查看 《材料力学》 中胡

克定律的相关内容）。 实际工程中的问题大多属于非线性问题， 非线性主要包括： 几何非线

性、 材料非线性及状态非线性， 下面将分别介绍。
1. 几何非线性

如果在分析过程中可能出现大位移 （或大转动）、 突然翻转、 初始应力或载荷引起的结

构刚度变化导致的变形， 这就是几何非线性问题。 在 ADINA 软件中通过菜单 Control→Anal-
ysis Assumptions→Kinematics 来设定， 如图 6-2 所示。 读者可以根据模型的实际情况来选择

不同的几何非线性计算状态， 例如， 小位移小应变、 大位移小应变或大位移大应变， 需要注

意的是： 实际问题中不包含小位移大应变这种状态。 图 6-2 所示的对话框用来设定整个模型

的几何非线性状态， 在设定单元组及接触组时也可以设定几何非线性状态， 但该状态仅应用

于该单元组或接触组。
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图 6-1　 有限元分析问题的流程

图 6-2　 设定几何非线性



第 2 篇　 提　 高　 篇

140　　 　 Focused on Excellence

2. 材料非线性

如果材料的应力-应变关系 （σ- ε） 曲线是非线性关系、 模型中涉及材料失效或出现与

应变率相关的材料属性， 则属于材料非线性问题。 常见的非线性材料包括： 超过屈服极限的

金属材料 （金属进入塑性）、 超弹性材料 （例如， 橡胶）、 黏弹性材料等。 在 ADINA 软件中

设置材料非线性的操作方法如下： 单击菜单 Model→Material→Manage Material， 或单击管理

材料图标 ， 在弹出的材料对话框中选择相应材料， 并进行设置即可。
3. 状态非线性

如果在分析工程中边界条件发生变化 （例如， 接触）， 或出现刚度矩阵的突变 （例如，
单元生死、 相变等）， 则属于状态非线性问题。

实际工程中的非线性问题可能是上述三种非线性的组合。 例如， ADINA 8. 6 版 primer 手
册的第 22 题， 分析中使用了橡胶材料 （材料非线性）， 涉及大变形 （几何非线性） 和接触

（状态非线性）， 因此属于典型的非线性组合问题。 该问题虽然看似模型简单、 过程也不复

杂， 但实际上非线性问题的求解要比线性问题复杂得多。 再复杂的线性问题， 也仅体现在求

解规模上， 而非线性问题则体现在软件的求解能力、 求解设置和建模经验等多个方面。 因此

平时学习过程中， 要注重基础知识的学习， 并逐渐积累软件使用经验。

6. 1. 3　 隐式积分与显式积分

对于 ADINA- Structure 程序模块， 如图 6-3 所示， 分析类型可以选择 Dynamics- Implicit
（隐式积分） 或 Dynamics- Explicit （显式积分）， 它们是 ADINA 软件处理动力学问题的两种

不同积分方法， 二者各有不同的适用范围和求解特点。 在某些情况下， 同一个问题可以分别

使用这两种方法进行求解。 本节将介绍隐式积分和显式积分的概念， 而不详细介绍具体算法。

图 6-3　 ADINA- Structure 程序模块

隐式积分和显式积分是有限元软件在求解数值方程时采用的两种不同的数学方法， 分别

对应于隐式方程和显式方程。 隐式方程的形式类似于 f （x， y） = 0， 即： y 无法由 x 来显式

表达， 如果希望求出 y 值， 则只能够求解该隐式方程。 显式方程的形式类似于 y = f （ x），
即： y 可以由 x 来显式表达， 因此可以直接求解。 有限元软件的隐式积分算法包括： 牛顿-
莱弗森方法 （Newton- Raphson method）、 切向刚度法 （Tangetial stiffness method） 等； 显式积

分算法包括中心差分法 （Central difference method） 等。
隐式积分与显式积分算法的特点分别是：
1） 隐式积分算法能够提供更有力的整体逼近， 需要经过反复迭代尝试才能够达到收敛
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（对于非线性分析）， 计算代价比较大； 显式积分算法不需要迭代计算， 计算代价较小。
2） 隐式积分算法适用于分析结构的瞬态响应等问题； 显式积分算法适用于求解冲击、

爆炸等问题。
3） 隐式积分算法是无条件稳定， 求解过程中需要对刚度矩阵 K 求逆； 显式积分算法是

条件稳定， 求解过程中不需要对刚度矩阵求逆， 质量矩阵需要进行简单转置。
4） 在时间步长方面： 对于线性问题， 隐式积分算法的时间步长值可以任意； 对于非线

性问题， 为了保证分析收敛， 通常需要较小的时间步。 显式积分算法的时间步长要小于临界

时间步长。 由于显式计算的时间步较小， 因此适用于分析瞬态问题， 对于非瞬态问题， 理论

上可以求解， 但代价巨大， 建议不要采用。 ADINA 软件的显式积分算法可以自动确定计算

时间步长， 一般建议不要对其进行调整。

6. 1. 4　 选择求解器

单击菜单 Control→Solution Process 将弹出选择求解器对话框， 如图 6-4 所示， 在此对话

框中 可 以 选 择 求 解 器。 ADINA 软 件 中 主 要 包 括 下 列 求 解 器： Sparse、 3D- Iterative、
Nonsym. Sparse、 Multigrid、 Iterative、 Direct。 关于选择求解器的详细介绍， 请参见 ADINA
8. 6 版 《结构理论手册》 7. 1 节， 本节将简单介绍这些求解器的适用范围。

图 6-4　 选择求解器对话框

1） ADINA 软件默认的求解器为稀疏矩阵 （Sparse） 求解器， 它能够求解绝大多数问

题， 且求解效率高、 可靠性高， 占用内存少， 一般情况下无需改动求解器。
2） 大规模的分析问题通常需要占用大量内存， 此时可以选择迭代 （ Iterative） 求解器。

需要注意的是： 迭代求解器不能用于频域分析和线性屈曲分析， 也不能处理刚度矩阵非正定

的问题。
3） 多网格 （Multigrid） 求解器也适用于求解大型问题， 对于包含 3- D tetrahedral Solid

单元的模型十分有效， 且该网格由 ADINA 软件自动划分得到。
4） 对于包含三维高阶单元的大型模型， 选用 3D 迭代 （3D- Iterative） 求解器将提高求

解效率， 模型中也可以包含其他类型的单元。 该求解器适用于静力分析和动力学分析。
5） 非对称稀疏矩阵 （Nonsym. Sparse） 求解器主要用于土力学分析， 也适用于求解过程
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中可能会出现刚度矩阵非对称的问题。 采用非对称稀疏矩阵求解器往往可以使模型达到收

敛， 例如， M- C 材料等。
6） 直接 （Direct） 求解器的原理基于高斯消去法， 适用于规模较小的分析问题。

6. 1. 5　 选择迭代方法和收敛准则

单击菜单 Control→Solution Process 将弹出 Solution Process 对话框 （见图 6-4）， 单击 Iter-
ation Method 按钮将弹出非线性迭代设置对话框， 如图 6-5 所示， 读者可以选择适当的迭代

方法。 ADINA 软件中包含下列迭代方法： Full Newton Method、 Modified Newton Method 和

BFGS Matrix Update Method， 默认方法为 Full Newton Method， 本节将简单介绍这 3 种方法。

图 6-5　 非线性迭代设置对话框

1） Newton- Raphson 迭代法 （即 Full Newton Method） 是求解非线性有限元方程的最常

用、 最基本方法。 主要的求解过程如式 （6. 1）、 式 （6. 2） 和式 （6. 3） 所示。
ΔR（ i - 1） = t + ΔtR - t + ΔtF（ i - 1） （6. 1）
t + ΔtK （ i - 1）ΔU（ i） = ΔR（ i - 1） （6. 2）

t + ΔtU （ i） = t + ΔtU（ i - 1） + ΔU（ i） （6. 3）
在每个迭代步中， 上述 3 个方程将有限元的求解进行线性化处理。 式 （6. 1） 中的 R 表示

外载荷， F 表示节点内力， ΔR（ i - 1）表示当前迭代步的载荷增量。 式 （6. 2） 中的 t + ΔtK （ i - 1）表

示当前迭代步的切向刚度矩阵。 通过式 （6. 2） 可以求得下一步的位移增量 ΔU（ i）。 通过式

（6. 3） 可以求得下一步的位移。 Newton- Raphson 迭代法的求解过程如图 6-6 所示， 其典型

特征是： 每一步迭代都需要重新计算切向刚度矩阵， 因此该法又称为 Full Newton Method。
2） 改进的牛顿迭代法 （Modified Newton Method） 的求解过程如图 6-7 所示。 与牛顿法

的不同之处在于： 改进的牛顿法迭代法只在第一次迭代时计算切向刚度矩阵， 后面的迭代步

都使用该切向刚度矩阵以节省计算时间。 有些情况下采用改进的牛顿法迭代法能够使得分析

更快收敛。
3） 拟牛顿法 （BFGS Matrix Update Method） 可以作为牛顿迭代法的替代方法， 但不经

常使用。 该法逐渐更新矩阵系数以提供近似切向刚度的估计值， 计算过程中将使用线性搜索

功能。 因此， 使用这种迭代方法时， 线性搜索默认为打开状态。
上面介绍的 3 种迭代方法都可以使用线性搜索， 牛顿迭代法和改进的牛顿迭代法默
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图 6-6　 牛顿迭代法

图 6-7　 改进的牛顿迭代法

认不使用线性搜索。 对于接触问题和屈曲问题， 采用线性搜索可能会加快计算的收敛

速度。
单击菜单 Control→Solution Process 将弹出 Solution Process 对话框 （见图 6-4）， 单击 Iter-

ation Tolerance 按钮将弹出迭代容差对话框， 如图 6-8 所示， 在该对话框中可以设定收敛准

则。 ADINA 软件中包含下列收敛准则： Energy （能量）、 Energy and Force （能量和力）、
Energy and Displacement （能量和位移）、 Force （力） 和 Displacement （位移）， 默认设置为

能量收敛准则 （Energy）。 在这几种准则中， 前两种准则 （能量收敛准则、 能量和力收敛准



第 2 篇　 提　 高　 篇

144　　 　 Focused on Excellence

则） 是最常用的收敛准则。 对于某些土力学模型， 有时可能需要使用位移收敛准则才能使

模型收敛。

图 6-8　 迭代容差对话框

迭代容差对话框中的各个参数一般不需要手工改动， 将参数调大会影响计算结果的精

度。 对于某些大型的高度非线性问题， 如果模型实在难以收敛， 则可以尝试调大个别参数，
但这种处理方法的前提是 “以牺牲计算精度来保证计算收敛”。 分析结束后应该检查计算结

果是否满足精度要求。

6. 1. 6　 促进模型收敛的设置方法

本节提到的促进模型收敛的方法主要指为 ADINA 软件设置合理参数， 假定除了本节介

绍的参数之外， 其他条件 （例如， 网格、 载荷、 边界条件等） 都已设定正确， 模型无错误，
只是分析难以收敛。 为了使得模型能够收敛， 本节将详细介绍调整部分设置的方法， 这些需

要调整的设置都包含在 Control 菜单下。
1. 调整时间函数和时间步

如果分析不能收敛， 应该首先检查模型的时间函数设置是否科学合理， 大多情况下都不

要将载荷在初始增量步中全部施加， 而可以通过设置合理的时间函数让载荷一点点加上去，
即： 设置时间函数时应该尽可能符合实际加载过程。 如果时间函数设置正确， 则尝试减小时

间步长， 并打开自动时间步长， 然后重新计算。 减小时间步长往往可以达到收敛。 如果时间

步长已经非常小， 模型仍然无法收敛， 往往说明模型本身存在错误， 应该重新仔细检查模

型， 例如， 网格或边界条件等错误。
2. 调整求解过程参数

单击菜单 Control→Solution Process 将弹出求解过程对话框， 单击 Iteration Method 标签，
将弹出 Nonlinear Iteration Settings 对话框 （见图 6-5）， 可以调整该对话框的 3 个参数：

1） 可以调整 Iteration Scheme （迭代方法）， 默认算法为牛顿迭代法， 可以修改为改进
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的牛顿迭代法， 详细介绍请参见 6. 1. 5 节 “选择迭代方法和收敛准则”。
2） 可以增加迭代次数， 默认值为 15 次。 通常情况下将其修改为 30 ～ 50 次为宜。 还可

以选择是否使用线性搜索算法， 默认情况下为 No， 可以将其修改为 Yes 进行试算。
3） 可以调整求解控制对话框中的收敛准则， 一般情况下不需要修改。 而对于土力学分

析， 大多应选择 Displacement 收敛准则， 相关内容请参见 6. 1. 5 节 “选择迭代方法和收敛准

则”。
3. 调整杂项控制参数

静力学问题如果出现收敛困难， 则可以选择矩阵稳定功能。 对应的操作如下： 单击菜单

Control→Miscellaneous Options 将弹出杂项控制对话框， 将 Matrix Stabilization 选择为 Yes， 也

可以将 Stabilization Factor （默认值为 1e-10） 修改为 1e-8 等， 如图 6-9 所示。 静态接触分析

也可以选择该选项， 详细介绍请参见 4. 10 节 “设定接触”。

图 6-9　 在杂项控制对话框中设定矩阵稳定

4. 其他

1） 对于包含接触、 屈曲等的静力分析， 可以选用 Low Speed Dynamic 方法来促进收敛，
读者可以参见 4. 3. 1 节的表 4-3。 对于由于接触问题导致不收敛的处理方法， 请参见 4. 10. 4
节 “接触分析特征、 注意事项和促进接触收敛的方法”。

2） 真实结构往往都包含一定的阻尼效应。 对于动力学分析， 适当地增加阻尼可能会有

利于模型的收敛。 关于设定阻尼的详细介绍， 请参见 4. 11 节 “设定阻尼”。

6. 2　 建立结构场模型

6. 2. 1　 建模前的准备

对于非线性问题， 建模前通常需要考虑下列几个问题：
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1. 分析目的是什么？
拿到某个分析问题后， 首先应该在总体上有清晰的认识， 即： 明确分析目的。 该问

题看似非常好笑， 如果连分析目的都不清楚， 如何来进行计算机仿真？ 但是对于基础较

弱的初学者来讲， 经常会犯一些非常低级的错误， 他们对于模型的本质还没有清楚认识

就草草地开始建模， 必然会出现分析结果错误或走弯路。 对于某个工程问题， 必须搞清

楚分析的目的， 而且应该作如下思考： 为了达到该目的需要作哪些简化和假设、 需要使

用什么方法和功能、 建模的主要困难是什么、 如何解决这些困难等。 对于这些问题， 都

要事先作合理的调查分析， 只有明确分析目的并作了充分考虑之后， 才能够建立正确的

模型。
2. 影响模型结果的关键因素有哪些？
在非线性问题建模过程中， 往往会遇到影响分析收敛的许多关键设置。 例如， 接触非线

性、 大变形、 复杂加载等。 为了解决这些问题， 应该针对关键设置作合理的建模设计， 保证

关键点设置正确， 例如， 在接触处加密网格、 合理设定加载过程等。
3. 包含哪些简化因素？
实际工程问题往往是复杂的耦合问题， 模型同时受到很多因素的影响。 使用有限元方法

分析问题时不可能完全考虑所有因素， 而往往需要进行简化和假设， 此时必须抓住本质和主

要矛盾， 撇去次要矛盾。 建模时应该合理简化模型的几何形状、 边界条件、 载荷等。 简化模

型将考验 CAE 工程师的基本功， 简化结果的优劣与好坏直接体现工程师的建模水平， 好的

简化模型往往能够达到事半功倍的效果。
4. 时间的相关性怎样？
建模时还应该考虑所分析问题的时间效应： 如果与时间无关则可以采用静力分析； 如果

与时间有关， 则应该采用动力分析方法。
5. 需要使用哪些功能？
建模过程中将会使用到哪些功能？ 这个问题也比较重要。 要正确回答该问题， 需要清楚

ADINA 软件的功能， 并能够实现对应的功能。 对于不熟悉的软件功能， 应该首先查阅帮助

文档或相关学习资料， 如果没有可供查询的资料， 则应该对该项功能进行简单的模型测试，
当测试通过， 并了解其使用方法之后， 再建立详细的模型并计算。 这通常是最节省时间的建

模方法。
6. 需要多大的求解区域？
读者应该根据分析目的来确定需要求解的模型区域大小， 求解区域过小可能导致考

虑问题不全面， 甚至错误解； 求解区域过大将会浪费计算资源， 导致求解时间过长等。
对于关心区域， 则应该加密网格； 对于次关心区域则可以使用较粗的网格； 对于不关心

的区域则不必建立模型。 需要注意的是： 对于次关心区域， 如果网格过于稀疏也将影响

计算结果的精度， 因此划分网格时应该合理设置网格密度， 必要情况下应该进行网格密

度测试。
7. 模型的规模应该设置为多大？
单纯从计算精度方面考虑， 单元数量自然是越多越好； 如果从计算资源方面考虑， 单元

数量增加后所需要的计算资源也将增加。 因此， 精度与计算资源之间的关系是相互矛盾的，
读者应该根据具体问题具体分析， 最终设置合理的网格密度。
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6. 2. 2　 诊断错误模型

在求解过程中出现各种错误是使用 ADINA 软件建模分析经常遇到的情况， 出现错误就

要想办法来解决。 有些错误非常明显 （显性错误）， ADINA 软件已经明确给出错误的原因和

出现位置， 这类错误一般比较容易解决， 只要按照提示来改正即可。 但是还有一类错误非常

隐蔽 （隐性错误或假显性错误）， 这类错误不易处理， 需要读者具有一定的经验及分析判断

能力才能解决， 有些情况下可能还需要进行相关的测试工作。 本节将介绍部分常见的显性错

误和隐性错误。
1. 常见的显性错误

常见的显性错误包括：
1） 材料参数错误。 例如， 材料应力-应变关系曲线、 弯曲曲率梁曲线、 摩尔库伦材料

的膨胀角定义错误等。
2） 单元组定义错误。 例如， 使用空单元组、 单元子类型定义错误等。
3） 内存分配错误。 详细介绍请参见 3. 2 节 “内存分配与硬盘要求”。
4） 接触定义错误。 例如， 没有定义接触对、 为 contactor 节点定义了位移或定义了约束

方程等。 详细介绍请参见 4. 10 节 “设定接触”。
5） 约束方程错误。 例如， 给从点指定了约束等。 详细介绍请参见 4. 4 节 “约束方程与

刚性连接”。
6） 重启动错误。 例如， 单元组不匹配、 改变材料模式等。 详细介绍请参见 4. 12 节

“设定重启动分析”。
2. 常见的隐性错误

常见的隐性错误包括：
1） 网格设计不合理。 例如， 网格密度设定不合理、 网格与真实结构存在差异、 网格的

连续性不满足要求、 单元在计算过程中变形过大、 单元过度扭曲使计算中止等。
2） 边界条件错误。 例如， 边界条件定义不全或者定义错误。
3） 载荷定义错误。 例如， 施加载荷错误、 加载太快、 时间步设置不合理等。
4） 单位换算错误。 例如， 没有使用统一的国际单位制进行建模、 单位换算错误等， 这

类错误非常常见。
5） 接触定义错误。 例如， 接触算法、 接触方向、 接触网格、 初始穿透等。 遇到这类错

误时， 请参见 4. 10 节 “设定接触”。
与显性错误相比， 隐性错误更加难以处理。 只有查找到模型错误的原因后才能够对症下

药， 并解决问题。 但是， 有些情况下出现错误的原因很难查找到， 下面将介绍调试模型的一

些常用方法：
1） 如果计算因出现错误而中止， 则应该首先查看计算结果文件 （*. out） 和消息文件

（*. msg） 中的信息， 这是 ADINA 软件能够为读者提供的最直接的信息。 认真查看这些信

息， 并结合实际建模情况可以查找到错误原因。
2） 通过分析原因然后修改模型的相关设置 （例如， 边界条件、 载荷、 时间步、 时间函

数等）， 检查材料参数、 检查接触设置、 检查网格等， 修改完毕再重新提交计算。
3） 虽然经过多次检查和测算， 但模型仍然出现错误， 此时应该根据该错误来单独设计
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简单模型进行测试， 或者将模型中的不关心部分删除， 仅对能够反映问题的模型进行测试，
然后分析出现错误的原因。

4） 如果仍然无法解决问题， 此时可以请教 ADINA 负责技术支持的工程师， 有些情况下

可能是软件的 bug 引起的。 但是， 出现模型错误时首先不应该怀疑软件， 而应该怀疑自己，
绝大部分的错误都是读者自身原因或操作错误导致的。

5） 当模型成功计算完成后， 也应该认真查看模型的结果文件， 以确定计算结果正确

可信。



本章内容：

■ 7.1 流体基础知识

■ 7.2 流体模型和流固耦合模型的

准备和测试

■ 7.3 流体模型中的动网格

■ 7.4 流体模型中促进收敛的方法

流场建模基础
第 7章
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　 　 本章对 ADINA 软件流场建模的基础知识进行了介绍， 主要讲述了流体模型和流固耦合

模型的准备和测试， 以及促进流体模型收敛的方法， 这些知识可以帮助读者形成独立分析思

考模型的能力。 此外， 本章还对流体模型中动网格技术进行了概述。

7. 1　 流体基础知识

7. 1. 1　 流体的分类

流体是气体和液体的总称。 在人们的生活和生产活动中随时随地都会遇到流体， 例如，
大气和水就是最常见的两种流体。 按照流体的特性分为以下几类：

1. 理想流体和黏性流体

流体在静止时虽然不能够承受切向力， 但在运动时， 任意相邻两层流体之间却包含相互

作用的抵抗力， 即： 剪切力。 流体所具有的这种抵抗两层流体相对滑动速度的性质称为流体

的黏性。 黏性是流体的固有属性之一， 不论流体处于静止状态还是流动状态， 都具有黏性。
黏性是流体状态 （压力、 温度、 组成） 的函数。 气体的黏性随温度的升高而增大， 液体的

黏性则随温度的升高而减小。 自然界中存在的流体都具有黏性， 具有黏性的流体称为黏性流

体。 完全没有黏性的流体称为理想流体， 自然界中并不存在真正的理想流体， 但某些情况下

可以将流体假设为无黏性流体。
2. 牛顿流体和非牛顿流体

在介绍牛顿流体和非牛顿流体之前， 首先应该掌握牛顿内摩擦定律， 该定律表示流体内

摩擦应力和单位距离上的两层流体间的相对速度成正比， 其关系式为：

τ = μ lim
Δn→0

Δu
Δn = μ ∂u

∂n （7-1）

式中， τ 是流体内摩擦应力； Δn 是法线方向的距离增量； Δu 是与 Δn 对应的流体速度增量；
μ 是比例系数， 称为流体的动力黏度， 简称黏度。

牛顿流体指的是 μ 为常数的流体， 即： 遵循牛顿内摩擦定律的流体。 不符合上述条件的

均称为非牛顿流体。 所有气体和大多数低相对分子质量的液体均属牛顿型流体， 例如， 水、
空气等； 而某些高分子溶液、 油漆、 血液等则都属于非牛顿流体。 在 ADINA 软件中， 非牛

顿流体模型和牛顿流体模型的差别仅在于材料的定义有所不同。
3. 可压缩流体和不可压缩流体

根据密度 ρ 是否为常数， 可以将流体分为可压缩流体 （compressible） 与不可压缩流体

（incompressible） 两类。 在温度不变的情况下， 当密度 ρ 为常数时， 流体为不可压缩流体，
否则为可压缩流体。 据此可以判断： 空气为可压缩流体， 水为不可压缩流体。

水的可压缩性非常小， 压强每增加 1atm（≈0. 1MPa）， 其体积变化不到万分之一。 工程

中常用的其他工作液体 （例如， 液压油， 机械油等）， 其体积模量的数值都很大。 对于一般

的工程计算， 可以忽略其可压缩性， 将其看做是不可压缩流体。
与液体相比， 气体的可压缩性则大很多， 因此在研究气流场时， 当流速较低（ < 0. 3Ma）

时可以认为是不可压缩流体； 当流速较高时则需要考虑压强对气体密度的影响， 某些情况下

还需要考虑温度、 压强对体积和密度的影响。
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4. 定常与非定常流动

根据流体物理量 （例如， 速度、 压力、 温度等） 是否随时间变化， 可以将流动分为定

常 （steady） 与非定常 （unsteady） 两类。 如果流体的物理量不随时间变化， 即∂（ ） / ∂t = 0
时， 则为定常流动 （又称稳态流动）； 当流动的物理量随时间变化， 即∂（ ） / ∂t≠0 时， 则为

非定常流动， 也称为非稳态流动 （或瞬态流动）。
5. 层流和湍流

自然界中的流体流动状态主要分为两种形式： 层流和湍流。 层流和湍流是两种不同性质

的流态。 层流时流体流速较低， 质点受黏性制约而不能随意运动， 黏性力起主导作用； 湍流

时液体流速较高， 黏性制约作用减弱， 惯性力起主导作用。 液体流动时， 通常使用雷诺数来

判定究竟是层流还是湍流： 雷诺数约等于 2300 （临界雷诺数） 时， 流体的流动状态从层流

向湍流过渡； 雷诺数小于临界雷诺数时， 流动状态则为层流， 反之为湍流。
雷诺数 （Reynolds） 是表征流体流动特性的一个重要参数。 雷诺数的定义如下：

Re = ud
ν （7-2）

式中， u 是管内的平均流速； ν 是液体的运动黏度； d 是管径。
运动黏度 ν 与动力黏度 μ 之间的关系如下：

ν = μ
ρ （7-3）

式中， ρ 是流体的密度。
因此式 （7-2） 还可以表示为：

Re = ρud
μ （7-4）

对于非圆截面管道， 可以进行下列简单等效： 使用 R 代替上式中的 d， R 为通流截面的

水力半径。 它等于液流的有效截面积 A 与它的湿周 χ （通流截面上与液体接触的固体壁面的

周长） 之比， 即：

R = A
χ （7-5）

用 ADINA 软件计算结果得到的雷诺数指的是单元雷诺数。 雷诺数与流速、 单元长度有

关， 因此， 不同位置的雷诺数不同。

7. 1. 2　 计算流体动力学概述

计算流体动力学 （Computational Fluid Dynamics， CFD） 指的是基于计算机数值仿真技

术来研究流体的流动、 热量传递及其相关现象的计算方法学。 可以将其看做是对基本守恒方

程 （质量守恒方程、 动量守恒方程、 能量守恒方程） 控制下的流动过程的数值模拟， 以得

到复杂问题流场内各个位置的基本物理量 （例如， 速度、 压力、 温度、 浓度等） 的分布情

况， 以及它们随时间变化的情况。 随着计算机技术的不断发展， 计算流体动力学已广泛应用

于各个领域。 ADINA 软件中使用 ADINA- CFD 模块来解决流场分析以及流固耦合、 热流等

问题。
无论是气体还是液体， 都可以认为它们是连续介质体， 因此， 也应该满足下列三个基本

的物理守恒定律：
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1） 质量守恒定律： 质量的变化等于流入与流出流体微团的质量之差。 流体质量守恒反

映的是物质不生不灭的物理定律。
2） 动量守恒定律： 动量的变化率等于作用在流体微团的合力， 它反映的是牛顿第二

定律。
3） 能量守恒定律： 能量的变化率等于加热率和做功率之和， 它反映的是热力学第一

定律。
上述三个基本的物理守恒定律可以使用三个流体控制方程来表示， 详细介绍请参见

ADINA 流体理论手册 2. 1 节 “General conservative Navier- Stokes equations”。

7. 2　 流体模型和流固耦合模型的准备和测试

提交计算之前的模型状态决定了计算能否顺利进行。 合理地简化模型、 合理地设置参数

是保证计算收敛的关键。 这往往需要用户具有较好的理论基础和较多的使用经验， 可以通过

不断调试模型来积累经验。 导致分析不收敛或分析结果错误的原因大多是建模时设置错误。
本节将介绍建模之前的准备工作以及模型测试的相关知识， 建立流体模型并提交计算之前，
需要充分考虑下列 11 项内容：

1） 确定流动类型 （不可压缩流体、 微可压缩流体、 低速可压缩流体、 高速可压缩流体

或多孔介质）， 详细介绍请参见 7. 2. 1 节。
2） 确定分析类型 （稳态还是瞬态）， 详细介绍请参见 7. 2. 2 节。
3） 计算时间步 /载荷步的选取， 详细介绍请参见 7. 2. 3 节。
4） 计算模型的选取范围， 详细介绍请参见 7. 2. 4 节。
5） 选取边界条件， 详细介绍请参见 7. 2. 5 节。
6） 设定初始条件， 详细介绍请参见 7. 2. 6 节。
7） 选择单元类型， 详细介绍请参见 7. 2. 7 节。
8） 选择合适的流体材料本构模型， 详细介绍请参见 7. 2. 8 节。
9） 选择合适的求解器， 详细介绍请参见 7. 2. 9 节。
10） 流场模型的测试， 详细介绍请参见 7. 2. 10 节。
11） 流固耦合模型的准备和测试， 详细介绍请参见 7. 2. 11 节。

7. 2. 1　 确定流动类型

ADINA 软件中的流体类型包括不可压缩流体， 轻微可压缩流体， 低速可压缩流体和高

速可压缩流体。 绝大多数的实际工程问题都属于不可压缩流体问题。 如果流体空间开口或封

闭空间的壁面是刚性壁面， 通常将流体作为不可压缩流体模型来处理。 例如， 油、 水、 空气

（Ma < 0. 3） 等， 如图 7-1 所示。
如果流体区域的边界完全封闭， 则这种流体称为空间受限流 （或称为狭窄空间的流

动）。 此时， 如果需要考虑流体壁面的变形 （例如， 流固耦合问题中结构的运动或边界位移

已指定的情况）， 则该流体不能作为完全不可压缩流体进行处理。
油和水的密度对于温度的变化较小， 因此可以使用微可压缩流体来处理； 同样， 如果流

体边界的运动非常缓慢， 则空气也可以作为微可压缩流体来处理， 如图 7-2 所示。
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图 7-1　 典型的不可压缩流体模型 （incompressible）

在很多工程问题中， 必须考虑空气的压缩性。 如果希望得到准确的计算结果， 则应该准

确区分计算问题属于低速流或高速流。 例如， 如果流场的边界能够产生变形， 则应该属于典

型的低速可压缩流体， 如图 7-3 所示。

　

图 7-2　 典型的微可压缩流体

模型 （slightly compressible）
图 7-3　 典型的低速可压缩流体

模型 （low speed compressible）

如果 Ma > 1， 则必须作为高速可压缩流体来考虑。 通常情况下， 高速可压缩流体动边界

均为开口。

图 7-4　 典型的高速可压缩流体模型 （high speed compressible）

实际问题中还经常考虑多孔介质的流动， 如图7-5所示。 例如， 土壤的多孔介质流动、
带孔的空气过滤器等。 ADINA 软件中多孔介质在模型单元集的选项内进行设置， 包含不可

压缩、 微可压缩、 低可压缩流动选项。
如果模型中包含非常多的小孔， 则采用多孔介质流动模型是最佳选择， 如图 7-6 所示。

读者不必建立所有的小管模型， 而可以直接采用多孔介质的单元集来模拟， 这样得到分析结

果可能更加合理。
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图 7-5　 典型的多孔介质流动模型 （porous medium） 图 7-6　 多孔介质流动模型示意图

7. 2. 2　 确定分析类型

模拟稳态流动问题时， 既可以选用稳态分析类型， 也可以选用瞬态分析类型。 稳态流动

问题所有的材料和边界条件都与时间无关。 ADINA- CFD 模块中定义稳态流动的主要目的是

为了消除控制方程内的动力项∂（ ） / ∂t。
通过下列五种方法可以获得稳态分析的结果：
1） 进行只包含一个时间步的稳态分析。 其中， 材料和边界都与时间无关， 该方法比较

适用于某些简单的流体问题。
2） 在方法 1 中使用适当的 CFL 值 （请参见本节末尾处的介绍）。 就数值稳定性而言，

CFL 选项与瞬态分析的时间推进相同， 它们都可以得到稳态的分析结果。 此外， 采用 CFL
选项的优点在于： ADINA 软件能够自动选择时间步长， 且计算结果是稳态解， 该方法适用

于所有的流体问题。 尤其需要注意的是： 如果选用的 CFL 值非常大， 则与方法 1 的作用相

同。 选用适当的 CFL 值可以极大地改善计算的收敛性， CFL 的取值不能太小， 对于隐式方

法， 其下限值为 1。
3） 进行多个时间步的稳态分析， 材料或边界都可以与时间相关。 此时， 时间步并非指

的是真实时间， 将其看做是载荷步更合适。 每个时间步的计算结果都是对应时间条件下的稳

态结果， 前一个时间步的计算结果可以作为下一个时间步计算的初始条件。 该方法非常适用

于包含过渡阶段的流体， 例如， 自然对流、 弯管流动、 流体循环流动等。 计算过程中每个时

间步可能采用不同的载荷条件， 例如， 不同的雷诺数、 瑞利数等。 虽然该方法需要更多的时

间步， 但由于比方法 1 中的初始条件更接近实际情况， 因此其收敛性要比方法 1 更强。
4） 在方法 3 中使用适当的 CFL 值。 如果 CFL 取值合适， 则方法 4 将比方法 3 的稳定性

更好。 虽然过小的 CFL 值会造成收敛缓慢， 但该方法仍然是进行稳态分析的常用方法。
5） 也可以通过瞬态分析来逼近稳态分析的结果。 可以用将时间向前推进或必要的重启

动方法来得到稳态结果。 由于通常只关心最终的结果， 因此可以忽略瞬态分析中间过程的平

衡迭代， 这时可以将计算的收敛容差调大或者将最大的迭代次数设置为 1。 稳态分析的收敛

容差则按正常进行设置， 以保证获得正常的结果。 如果采用时间向前推进的方法仍然无法得

到稳态结果， 则可以通过查看最终的计算结果来判断是否已经达到稳态， 或将其作为重启动

的初始条件进行必要的重启动分析。
对于某些非稳态的流动问题， 则必须采用瞬态的分析类型来处理。 此时， 初始条件必须

是真实的物理条件， 时间步也必须是有物理意义的真实时间。 当时间步长比较大时， 必须进
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行包含平衡迭代的收敛计算， 以保证瞬态分析的准确性。
提示： 由于截断误差是引起误差的主要原因， 计算结果的精度将与时间步长有关， 除非〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

CFL 的值非常小 （例如， CFL 值为 1）。 一般情况下， 瞬态问题最好采用隐式动力平衡迭代〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
计算。 如果时间步长非常小， 则可以通过设置一个大的收敛容差或将最大迭代次数设置为 1〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
来忽略平衡迭代， 此时的操作流程与方法 5） 相同。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

● CFL （Courant- Friedrichs- Lewy）
在 ADINA- CFD 模块中单击图标 ， 在弹出的对话框中勾选 Automatic Time Step 选项，

单击右侧的 图标， 将弹出如图 7-7 所示的对话框， 其中的 Courant Number 即为 CFL 数。
默认情况下， 如果不使用 CFL 数， 则该值为无穷大。 对于大部分隐式计算， CFL 数的设置

区间为 （102 ～ 107）。 对于显式时间积分， CFL 数通常设置为 0. 8 ～ 0. 9。

图 7-7　 设置 CFL 数

对于瞬态分析， 合理的 CFL 数可以促进每个时间步的迭代收敛。 对于稳态分析 （时间

为无穷大）， 收敛则意味着得到最终的收敛解， 每一个平衡迭代就起到时间步的作用。
一般情况下， CFL 数越大则模型越不稳定、 越不容易收敛； CFL 数越小则模型越稳定，

越容易收敛。 但是， 减小 CFL 数将导致收敛速度变慢。 CFL 数过小则使得迭代次数显著增

加。 对于隐式分析， CFL 数的下限为 1。 合适的 CFL 数可以根据数值模拟和经验选取。 使用

适当的 CFL 数和控制每个时间步的载荷增量， 可以解决很多涉及稳定性和收敛性的问题。
关于 CFL 数的更详细介绍， 请参见 ADINA 流体理论手册 12. 1 节。

图 7-8　 设定时间积分方法

ADINA- CFD 的稳态分析中不包含时间项， 因此无需考虑时间项的积分。 但是， 瞬态分

析中必须选择积分方法。 ADINA 软件中提供了两种时间积分方法： Euler 积分和 Composite
积分， 这两种积分方法都属于隐式积分算法。 在 ADINA- CFD 模块中单击图标 ， 在弹出的

Transient Analysis 对话框中单击 Intergration Method 右侧的下三角按钮， 就可以选择不同的时

间积分方法， 默认选择为 Euler （欧拉） 积分， 如图 7-8 所示。
假设已经得到了 t 时刻的解， 现在要求 t + Δt

时刻的解。 其中， Δt 表示时间步长， 在 t = 0 时刻

初始条件定义。 下面将介绍这两种积分算法：
Euler 积分： 方程∂ u / ∂ t = f（u） 根据式 （7-6）

进行计算：
t + Δtu = tu + Δtf（ t + αΔtu） （7-6）

式中， t + αΔtu = （1 - α） tu + αt + Δtu。
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Euler 积分属于一阶精度的算法， 当
1
2 < α≤1 时， 计算结果是无条件稳定的。 当 α = 1 / 2

时， 虽然在时间上能够达到二阶精度， 但分析结果是不稳定的 （除非速度非常小）。 默认的

一阶精度算法是欧拉向后积分方法 （Euler Backward Method）， 此时 α = 1。
Composite （复合） 积分： t + Δt 时刻的解将根据式 （7-7） 和式 （7-8） 两个连续的子

时间步进行计算：
t + γΔtu = tu + γΔtf（ t + 1

2 γΔtu） （7-7）
t + Δtu = t + βγΔtu + （1 - α）Δtf（ t + Δtu） （7-8）

式中， t + βγΔtu = （1 - β） tu + β t + γΔtu； γ = 2 - 1 / α； β = α2 / （2α - 1）。

当
1
2 < α < 1 时， 该方法是二阶精度， 且无条件稳定。 α 的默认值为 1 / 2， 此时截断误

差将达到最小。 与 Euler 积分相比， 虽然每个时间步的计算代价加倍， 但 Composite 积分方

法得到的解更加精确， 并且所需的时间步减少， 占用 CPU 的时间也将减少。 Composite 积分

方法最常用于计算瞬态脉动压力问题。 例如， 漩涡脱落、 涡激流固耦合振动等。

7. 2. 3　 计算时间步 /载荷步的选取

稳态分析中的时间步没有任何物理意义， 定义时间函数的目的是用来确定各时间步下的

载荷情况。 瞬态分析中的时间步则有物理意义， 因此， 计算时间步长的大小必须设置合理。
对于隐式方法， 时间步长的大小没有任何限制， 只需方程能够迭代收敛即可， 因此， 时间步

长的选取只与感兴趣的实际物理条件有关。
许多瞬态问题都有时间周期性， 一般情况下， 该类问题最小的合理时间步长应取为时间

周期的 1 / 100 ～ 1 / 20， 如图 7-9 所示。

图 7-9　 周期性瞬态问题中时间步长的选取

某些瞬态问题的时间步长则完全由所关心

区域的波动情况决定， 即： 时间步长必须小到

足以捕捉到波的运动过程。
对于微可压缩流体， 波速 w 的表达式为：

w = k / ρ （7-9）

式中， k = ρ ∂ p
∂ ρ， 是流场体积模量； p 是压力；

ρ 是密度。
对于可压缩流体， 波速与音速相同， 表达

式为：

w = c = γp / ρ （7-10）
式中， c 是声速； γ≡cp / cV， 是比定压热容与

比定容热容的比值。
一般情况下， 如果 10 倍时间步长下波动的最小距离为 L， 则 L / 10w 就是允许的最大时

间步长。 从另一方面来看， 如果时间步长太小将造成计算时间步太多， 往往也没有必要。
L / 10w 是时间步长的上限值， Δx / w 则是时间步长的下限值 （如图 7-10 所示）， 其中， Δx 指

的是单元尺寸。
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图 7-10　 波动问题中时间步长的选取

对于比较复杂的问题， 为了捕捉到模型

在整个时间过程的响应， 时间步长应该尽量

取小值。 当步长足够小时 （CFL 值大约为 1），
则可以忽略计算的平衡迭代。 尤其对于包含

很多时间步的计算问题， 忽略平衡迭代可以

节省大量的 CPU 时间， 一般可以达到 50% ～
90% 。 　

7. 2. 4　 计算模型的选取范围

建模时应该将关心的区域包含在模型中， 而忽略那些太小的细节。 下面给出计算模型选

取范围的几个建议：
1） 从整体空间中取出来的模型， 其边界条件必须能够合理模拟整个空间的流动状

态。 例如， 如果模拟流场空间的障碍物后面将会发生回流， 则必须延长下游的流场空间；
如果模型的流场空间选取得不足够大， 则应该采用瞬态分析类型进行求解， 如图 7-11
所示。

2） 与主要的关心区域相比， 其他区域的分析结果小到足以忽略时， 建模时应不予

考虑。
3） 尽量避免采用二维或三维模型来模拟一维空间流动问题。 但是， 计算区域的某部分

可以作为一维模型来处理， 例如， 图 7-12 中的细长部分。 一维模型的压力下降可以通过数

值分析得到， 也可以将这部分取出来并施加指定流速， 然后将一维模型上对应的压力直接施

加在三维模型上。 某些情况下， 也可以使用一段很短的多孔介质单元来模拟很长的一维

单元。

图 7-11　 模型计算区域的选取 图 7-12　 避免模拟低维空间模型

4） 与整个模型相比， 如果模型中的多孔介质区域太狭小， 则可以使用较厚的多孔介质

来模拟， 但应该改变其渗透系数， 如图 7-13 所示。 该方法等同于在多孔介质区域选用不同

的单位量纲。
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图 7-13　 使用等效的物理模型

需要注意的是： 外流场问题的实际物

理边界可能远离所关心的计算区域， 而模

型又不可能取得无限大， 此时必须采用截

断模型来计算。 为了保证计算结果的准确

性， 截断模型还必须选取得足够大。

7. 2. 5　 选取边界条件

与固体分析不同， 流体分析中的边界

条件指的是广义边界。 例如， 在模型中施

加的压力、 速度等可以作为边界条件处理。 ADINA 软件将流体边界条件分为一般边界条件

（例如， 速度、 压力） 和特殊边界条件 （例如， Wall 边界、 FSI 边界等）， 相关内容的更

详细介绍， 请参见 ADINA 流体理论手册 3. 4 节、 4. 4 节、 5. 4 节、 6. 4 节、 7. 4 节和

8. 4 节。
正确设定边界条件是成功求解流场问题的关键。 在前处理阶段， ADINA 软件可以直接

在几何边界上指定边界条件， 提交计算时软件自动将这些边界条件按离散的方式分配到相应

的节点上。 边界条件的选取与流动类型相关， 实质上是与计算域的控制方程相关。 在 ADI-
NA- CFD 模块中设置边界条件时， 建议如下：

1） 在开口处施加压力边界时， 最好施加拖拽力载荷而尽量不要施加压力载荷。 拖拽力

等效于作用在边界上的外载荷， 流体速度和压力可以通过求解控制方程得到， 且在开口边界

处得到的压力结果更为合理。 如果施加的是压力边界， 则不能保证在其边界处离散方程的连

续性， 边界处将产生不合理的结果。

图 7-14　 不可压缩流体中的多拖拽力边界条件

2） 对于不可压缩流体， 开

口处可以不施加任何边界条件

（无需指定拖拽力和压力）， 即：
相当于在边界处施加零拖拽力。
但是， 如果多个开口边界所受的

压力各不相同， 则必须为每个开

口边界设定合适的拖拽力， 如图

7-14 所示。
3） 对于低速或高速可压缩

流体， 则应该施加非零的拖拽力边界条件， 如图 7-15 所示。 此时， 必须采用绝对压力值，
该边界条件对于不可压缩流体也是适用的。 而在高速可压缩流体中， 通常采用压力边界条

件， 而不需要施加拖拽力边界条件。
4） 对于封闭的不可压缩流体 （例如， 自然对流）， 则需要为各个独立区域都指定固定

的压力值， 如图 7-16 所示。
5） 在高速可压缩流体中应尽量使用特殊边界条件， 指定的边界条件总应该适用于保守

变量， 而不是原始变量。 例如， 在内流场模型中， 经常使用亚声速入口、 亚声速出口、 超声

速出口等边界； 而在外流体模型中， 则经常使用外部边界条件； 如果模型中必须指定某个方
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图 7-15　 可压缩 /不可压缩流体

中的多拖拽力边界

图 7-16　 封闭的不可压缩流体必须

指定固定的压力边界

向的速度， 一般建议如下：
① 如果边界的法线方向与速度方向一致， 则施加滑移参数 （slipc， 将 slip condition 选择

为 NO） 为零的亚声速入口边界。 可以通过指定温度或热通量来实现温度边界条件。
② 施加壁面边界条件时， 其切线 （tangential） 方向应该与速度的切线方向一致。
③ 如果密度的一阶导数为零， 则边界变量可以选择为 （θ， ρ， v）， 指定速度、 零热通

量或指定温度 （设置 slip = 0 以增强流动方向的指定）。
④ 如果压力的一阶导数为零， 则边界变量可以选择为 （p， θ， v）， 指定速度、 零热通

量或指定温度的超声速边界 （同样设置 slip = 0）。

图 7-17　 圆柱射流模型

⑤ 如果边界条件是旋转边界

（例如， wall 边界）， 则一定要选择

rotational 参数。
6） 如果计算区域的变形对结

果影响不大， 则没有必要施加移动

或可变化的边界条件， 而应当在其

固定边界上施加合适的边界条件。
例如， 某圆柱射流模型将在射流层

前面产生自由液面， 如图 7-17 所

示， 如果使用自由液面边界， 整体

区域采用 ALE 网格， 而自由液面区

域则采用拉格朗日网格， 分析将很

难收敛。 实质上， 该模型也确实很

难得到稳态解。 相反， 如果在轴对称模型上施加适当的边界条件， 则可以方便地模拟该

问题。

7. 2. 6　 设定初始条件

初始条件指的是分析开始时的流动条件。 对于非定常问题， 除了应该给定边界条件外，
还需要给出流动区域内各计算点所有流动变量的初值。 对于定常问题， 初始条件不是求解所

必需的， 施加初始条件对于计算结果没有影响， 但是设置好的初始条件将使得收敛速度
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更快。
给定初始条件时需要下列几个问题： 1） 要针对所有的计算变量， 给定整个计算域内各

单元的初始条件； 2） 初始条件要有合理的物理意义， 不能随意输入。 原因是： 在收敛之前

的迭代过程中， 中间解随时间是变化的。 虽然这些中间解不一定具有物理意义， 但合理的初

始条件往往能加快收敛速度； 3） 给定合理的初始条件， 往往需要依靠一些经验和实测

结果。
关于确定初始条件的详细介绍， 请参见本书 7. 4. 2 节 “使用重启动的方法加强初始条

件” 和 7. 4. 3 节 “使用映射文件加强初始条件”。

7. 2. 7　 选择单元类型

ADINA- CFD 模块中的单元可以分为三类： 非 FCBI 单元、 FCBI 单元和 FCBI- C 单元。
对于不同的分析问题， 应该选用不同的单元类型进行计算。 下面将详细介绍 ADINA 软件中

各种单元的特点： （更详细的介绍请参见 ADINA 流体理论手册第 10 章）。
1. 非 FCBI 单元

该类单元有多种。 其中， 二维 3 节点三角形单元和三维 4 节点四面体单元适用于低雷诺

数、 低佩克莱特数和高雷诺数、 高佩克莱特数的流动问题以及高速可压缩流体问题。 二维 9
节点四边形单元和三维 27 节点单元则适用于低雷诺数和低佩克莱特数的高黏度流动问题。 6
节点三角形单元是 9 节点四边形单元的退化形态， 可以与 9 节点四边形单元一起使用。

非 FCBI 单元包含下列特点：
1） 与 FCBI 单元相比， 计算量更大。
2） 可用于直接流固耦合算法。
3） 可用于计算高速可压缩流体。
4） 可以更准确地模拟热流问题和流固热三场耦合问题。
5） 可选用直接求解器 Sparse 或迭代求解器 Multigrid、 GMRES。
2. FCBI 单元

ADINA 软件中提供了一种基于有限体积技术的算法 flow- condition- based interpolation
（FCBI）。 FCBI 是有限体积法的一个特例， 它局部能够满足质量守恒和动量守恒， 并通过对

速度进行插值来满足迎风条件。 与其他单元算法相比， FCBI 单元通常拥有更好的稳定性和

精度。 FCBI 单元非常适用于不可压缩、 微可压缩和低可压缩流动问题， 如果单元质量很好

（与流动方向一致， 且网格尺寸变化不剧烈）， 计算结果将非常可靠。
FCBI 单元的特点是：
1） 与 FCBI- C 单元相比， 计算量更大。
2） 可用于直接流固耦合算法。
3） 可用于计算高速可压缩流体。
4） 可选用直接求解器 （Sparse） 或迭代求解器 （Multigrid、 GMRES）。
3. FCBI- C 单元

与 FCBI 单元相似， 但其所有自由度都定义在单元中心处， 适用于求解大规模问题。 计

算过程中， 认为求解变量在单元上是分段常数， 而最终解则是在后处理过程中对拐角处节点

值进行积分。 由于自由度定义在单元中心， 因此下列情况不适合使用 FCBI- C 单元： 约束方
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程条件、 斜坐标系和镜面反射。
FCBI- C 单元的特点是：
1） 提供了 Simple、 Simplec、 PISO 算法。
2） 计算量小， 因此可以划分更多的网格。
3） 适合于使用 Sliding Mesh 边界条件的模型。
4） 在瞬态分析中与复合时间积分 （Composite） 一起使用， 可以模拟涡街问题。
5） 可用于迭代流固耦合算法。
FCBI- C 单元用于不可压缩、 轻微可压缩和低速可压缩流体中。 分离法 （SIMPLE） 只适

用于 FCBI- C 单元， 它是求解非线性流体方程的一种迭代算法， 只能够使用 AMG1 或 AMG2
求解器求解。 因此， 使用 FCBI- C 单元时只能选用 AMG1 或 AMG2 求解器。

为了获得准确的分析结果， 应该划分较好的网格， 尤其在梯度变化较大的位置 （例如，
固壁边界处、 回流区和高速可压缩流体的振荡区等） 应该进行加密。 由于单元数量受到计

算机存储能力和速度的限制， 为了在有限的资源下完成计算， 单元应满足式 （7-11） 所示

的条件：
Δx Δf ≈const（常数） （7-11）

式中， Δx 为单元尺寸； f 为计算变量。 该变量既可以是高速可压缩流体冲击中的压力， 也可

以是边界层附件的流动速度等。
尺寸较大的单元应该用于结果梯度变化较平缓的区域， 结果梯度变化较剧烈的区域则应

该将单元尺寸设置得较小， 以捕捉到结果梯度的变化情况。 因此， 计算区域内需要经常使用

过渡单元， 且过渡单元的尺寸必须平顺光滑。 为了获得最佳的单元网格划分效果， 其尺寸变

化的梯度应与结果变量的二阶导数成正比。 因此， 在计算区域中经常需要使用变化网格， 在

边界层和狭窄处进行分层就是两种常用的流体单元网格划分技术。

7. 2. 8　 选择合适的流体材料本构

ADINA 软件中的流体材料分为两类： 一类为不可压缩流体、 低速可压缩流体和微可压

缩流体， 另一类为高速可压缩流体， 如图 7-18 所示。 流体材料的本构可以是常参数、 也可

以是与时间相关或与温度相关， 更详细的介绍， 请参见 ADINA 流体理论手册 3. 6 节、 4. 6
节、 5. 6 节、 6. 6 节、 7. 6 节和 8. 6 节。

图 7-18　 ADINA- CFD 材料定义对话框
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需要注意的是： 定义材料参数时一定要使用一致单位制。 ADINA- CFD 中模型的自动无

量纲化对于求解非常有帮助。 关于单位制和无量纲化的更详细介绍， 请参见 ADINA 流场理

论手册 2. 15 节。

7. 2. 9　 选择合适的求解器

ADINA 软件提供了两类求解器： 直接求解器 （Sparse、 SKYLINE） 和迭代求解器 （RP-
BCG、 RPGMRES 和 Multi- grid）。 在 ADINA- AUI 中将程序模块选择为 AIDNA- CFD， 单击菜

单 Control→Solution Process， 在弹出对话框的底部， 单击 Equation Solver 右侧的下三角按钮，
可以选择相应的求解器 （见图 7-19）， 包括： Sparse （默认求解器）、 Multigrid， GMRES，
Biconjugate Gradient， AMG （type1）， AMG （type2）， Explicit。 除 Explicit （显式） 求解器之

外， 其他求解器均为隐式算法求解器。 其中， AMG （ type1） 和 AMG （ type2） 求解器只能

够用于求解 FCBI- C 单元。 因此， 本节介绍的求解器中不包含这两个求解器。 选择求解器

时， 建议读者按照下列原则进行：

图 7-19　 选择求解器

1） 对于低雷诺数 /低佩克莱特数 /低瑞利数的流动问题， 或流固耦合中的小位移问题，
最好选择迭代求解器， 且模型的无量纲化可以增强矩阵的稳定性。 需要注意的是： 即使在物

理上是稳定的， 如果模型的单位制不合适， 采用迭代求解器将导致迭代计算不收敛。 采用迭

代求解器时， 如果方程数量小于 10 万， 合理的迭代次数一般是几百次； 当方程的数量非常

大 （50 万左右） 时， 迭代计算可能需要上千次。
2） 求解线性方程组时， 最经常使用的直接求解方法是 Gauss 消去法 （ SKYLINE），

ADINA 软件中没有提供这种求解器， 但 ADINA- CFD 模块中提供了另外一种更有效的稀疏

矩阵 （Sparse） 求解器， 它是基于 Gauss 消去的一种直接求解方法。 与传统求解器的矩阵
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存储方法不同， 它可以大大减小存储量和计算时间。 Sparse 求解器属于直接耦合求解器，
可以对代数方程进行求解。 对于病态矩阵， 计算时将提示模型计算不稳定。 如果矩阵中

的数据非常差， 即使使用直接求解器也无法得到准确解， 此时应检查并确认单位是否

合适。
3） 对于大规模问题， 建议读者采用多重网格求解器 （Multigrid solver）， 它要比稀疏矩

阵求解器 （Sparse solver） 更有效。 对于中小求解规模问题或直接的 FSI 问题， 建议采用

Sparse 求解器 （默认求解器）。

7. 2. 10　 流场模型的测试

确保建模正确和物理参数合理是复杂模型分析的难点。 模型中产生错误的可能原因多种

多样， 为了保证模型正确和合理， 模型测试是必不可少的重要环节。 好的测试方法可以节省

大量时间， 建议读者按照下列步骤进行测试：
1） 根据已有经验、 实验数据和类比等方法了解模型的本质， 解决下列问题： 模型是二

维、 轴对称还是三维流动模型； 模型是不可压缩、 微可压缩、 低速可压缩还是高速可压缩流

动状态； 是否需要考虑流体的多孔介质属性； 模拟该问题最好的方法是哪一种； 数值稳定

性、 存储容量和 CPU 效率如何； 哪些因素会引起建模或分析困难； 模型的哪些部分可以进

行简化处理等。
2） 如果可能， 最好的做法是首先建立简化模型进行测试。 例如， 可以在建立三维模型

之前首先建立简化的二维模型， 然后再按照后续步骤进行测试。
3） 使用较稀疏网格以及可以迅速得到结果的材料和载荷， 对模型进行快速测试计算

（例如， 高黏度、 小流速、 小拖拽力等）， 以检查输入数据的合理性， 其中， 材料和边界条

件的类型都应该与实际模型一致。 无论是物理意义上还是数值模拟上， 测试模型的目的是容

易理解或易于求解， 因此， 测试工作也要易于完成。 如果输入参数有误， 则这些错误也很容

易在测试模型中识别出来。 测试过程中， 读者不要希望测试结果精确度很高， 只要验证计算

结果的物理意义和趋势合理即可。 如果测试模型在计算时出现了问题， 此时可以施加一个与

结果非常接近的初始条件， 并且可以仅进行一次迭代计算 （设置一个比较大的收敛容差），
以检查模型结果的响应。 通过查看结果的*. out 和*. log 文件来查找模型的问题所在。

① 如果某个边界附近的结果不合理， 则可能该边界条件施加错误。
② 流体流入的方向通过速度矢量来显示， 如果前处理 AUI 中存在错误， 则可以通过查

看速度矢量来识别单元的连接问题。
③ 当流动方向与预期结果相反时， 则可能是边界条件的方向定义错误。 例如， 拖拽力

边界 （与几何模型的方向有关）、 反向的速度边界或没有定义需要施加的壁面边界等。
④ 检查模型计算时出现的错误或警告信息。 如果出现了很多错误或警告信息， 则应该

首先查看第一个错误或警告信息。 如果错误信息提示第一个时间步的第一次迭代三角阵的值

非常大 （大约 1020）， 则表明模型可能是病态的或不稳定的。 例如， 没有指定需要固定压力

的点、 材料的黏度和热导率为零、 可压缩流体中压力或者温度为零等， 这些都可能导致模型

出现不稳定。
⑤ 如果速度或温度的自由度出现奇异， 则表明材料参数可能输入有误。 例如， 输入了

零黏度或零热导率。
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对于某些关键参数应该逐个进行修改测试， 以查看参数对结果合理性的影响。 采用真实

材料和真实荷载进行更进一步的测试。 如果收敛困难， 则应该查找出导致该结果的关键因

素。 这些因素通常可能是： 非常大的流速、 非常小的黏度、 非常大的热膨胀系数、 非常大的

热通量载荷或温度载荷非常高的雷诺数、 佩克莱特数或瑞利数等。 除了第 3 步中材料和边界

条件的值， 其他都不要更改， 这样就不会再引入其他不收敛的因素。 由于在第 3 步中对模型

进行了测试和修正， 如果此时出现收敛问题， 则肯定不是由于输入错误造成的。 因为采用的

是稀疏网格， 计算时间应该不会很长， 所以可以对模型进行彻底测试以发现潜在的问题。 该

阶段完成后， 测试模型在数值上应该是稳定的， 分析结果的物理意义也是合理的。 由于模型

在下一步计算时将更加困难， 因此， 此处更关注模型计算的稳定性。 为了确保最终阶段的模

型是稳定的， 可在测试中多引入一些可能引起收敛困难的因素。 通过该测试， 可以确定时间

步长、 载荷增量、 CFL 值、 特征数等。
测试的最后一个阶段应该对网格进行细化， 以得到更真实的结果。 细化网格同样可以处

理很多复杂的模型， 例如， 流体循环系统、 流体冲击等。 通常情况下， 网格越细密， 模型将

更加稳定， 收敛性也将得到增强。 但在某些情况下， 求解方程数量的增加将加大截断误差，
从而导致模型的收敛性出现困难； 对于迭代求解器， 还将增大最大迭代次数 （求解方程数

量大于 25 万时）。 此时， 则应该考虑采用减小载荷增量、 减小时间步长、 减小 CFL 值等方

法来处理。

7. 2. 11　 流固耦合模型的准备和测试

流固耦合模型为组合模型， 既包含流场模型， 又包含结构场模型， 二者通过流固耦合边

界条件连接在一起。 很显然对于流固耦合问题， 如果单独的流场模型或结构场模型是不能计

算的， 那么显然两者耦合的流固耦合模型肯定也是不能进行计算的。 因此， 为了成功求解流

固耦合问题， 流场和结构场模型都应该经过测试， 确保每个单场问题都已经正确定义并输入

正确。
测试结构场模型时， 可以在流固耦合边界上施加压力条件以模拟流体应力， 这时应该将

流固耦合条件去掉， 并根据模型的实际情况来估计压力大小。 由于测试的目的在于检测模

型， 因此无需准确描述压力的大小。 通过测试， 可以检查模型中的单元、 网格、 材料等数据

是否存在问题。
测试流场模型时， 可以使用 Moving Wall 边界条件来代替 FSI 边界条件 （旋转流固耦合

边界可以使用 Wall 代替， 如果模型中再无其他载荷条件， 可以通过施加其他假定的载荷条

件， 例如， 压力、 速度等来测试模型）， 同样也应该去掉流固耦合边界条件。 根据模型的实

际情况确定移动边界的位移。 关于流场模型测试的详细介绍， 请参见 7. 2. 1 节 ～ 7. 2. 10 节

内容。 如果模型中存在大位移， 则应该特别注意动网格的设定 （详见 7. 3 节）。
只有上述的结构场和流场的单场测试模型都可以分别求解时， 流固耦合计算才能进行。

在提交耦合计算之前， 要重新修改测试模型的边界条件， 正确施加流固耦合边界。 需要注意

的是： 耦合系统的控制参数 （例如， 时间函数） 是在流体模型中给定的， 因此结构模型的

改变要尽量小。 在结构模型中， 只是使用流固耦合条件来代替压力条件； 在流体模型中， 使

用相应的流固耦合条件代替移动壁面条件。 在该阶段， 读者应该关心 “耦合” 部分， 而不

是各自模型中的条件。 因此， 除了与耦合相关的改变之外， 应该尽量避免在耦合模型中作其
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他改变。 下面给出一些设定流固耦合模型的建议：
1） 瞬态分析应该给定一个好的初始条件。 对于流固耦合分析， 初始条件要比在单场

模型中的求解更重要。 由于结构的基本未知量是位移， 而流体的基本未知量是速度等，
因此初始条件可能会不一致。 例如， 速度是位移的时间导数， 流场速度的稳态结果并不

对应于一个恒定位移。 如果第 1 个时间步就出现收敛问题， 最可能的原因是初始条件没

有取好。
2） 如果结构需要预拉伸 （如膜结构计算）， 则应该人为地增加一个时间步， 在该时间

步中对结构进行拉伸， 但是并不施加流体条件 （例如， 零入口速度， 零入口压力等）。 在这

一步里， 流体的网格必须与结构网格一起进行相应的调整。 实际的瞬态求解过程则从第 2 个

时间步开始。
3） 如果物理意义上是正确的， 则可以将求得的一个稳态解作为初始条件， 也可以通过

一个很大的第一个时间步得到。 求解过程需要分两步进行， 这样操作更清晰： 第一步是得到

一个稳态解 （可能需要很少的几个时间步）； 第二步是进行重启动分析， 在第一步的基础上

进行瞬态分析。
4） 选用相似模型的解做初始条件通常也是很有效的方法， 此时需要通过 mapping 文件

来导入。
5） 时间步的大小要适当。 在稳态分析中， 时间步的大小要与载荷和边界条件中定义的

增量相对应。 在瞬态分析中， 时间步的大小既要足够小， 使得每一步都能够收敛， 也要足够

大， 使得数值模拟在合理的时间内完成。 FSI 问题的合适时间步大小可以通过对单独结构模

型进行频域分析得到。 由于流体方程通常是非线性的， 因此不可能对流固耦合模型进行频域

分析。
6） 流固耦合分析中包含应力收敛准则和位移收敛准则， 默认选择是两个标准都应该得

到满足。 当位移很小或很大时， 位移收敛准则就不应该再使用了。 应力很小时， 应力收敛准

则也就不应该再使用了。 一般情况下， 流固耦合分析中的流体作用力都不会太小， 因此需要

使用应力收敛准则。 需要注意的是： 迭代法计算双向耦合问题时， 应力和位移的容差取值要

比单独计算流体或结构模型时大， 这样有利于计算收敛。
7） 在双向耦合问题中， 如果流固耦合没有收敛， 则可以调整应力和位移松弛因子。 首

先应该考虑调整应力松弛因子， 它通常是引起不收敛的主要原因。 应力松弛因子的取值在

0 ～ 1。 一般情况下， 因子越靠近 1， 则越不容易收敛， 但所需要的迭代数越少 （如果能收

敛）； 因子越靠近 0， 则越容易收敛， 但求解时间会更长。 最佳选择可以通过数值实验得到，
最好是在较粗糙的网格中进行测试。

8） 对于 2D 的流固耦合分析， 如果使用了梁单元， 则推荐应用单位厚度的平面应变等

参梁单元 （plane strain iso- beam）， 这是因为流体流动域对应单位厚度的缝隙 （slice）。 如果

选择了平面应力 （plane stress） 或哈密顿 （Hermitian） 梁， 则等参梁的刚度必须对应于单位

厚度。

在 ADINA- CFD 模块的工具条中， 单击图标 将弹出设定流固耦合分析参数对话框，
如图 7-20 所示， 在该对话框中可以设定流固耦合的迭代方式 （直接耦合或迭代耦合）、 收

敛准则、 最大迭代次数、 容差和松弛因子。 关于流固耦合分析的更详细介绍， 请参见ADINA
流体理论手册第 9 章的内容。
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图 7-20　 设定流固耦合分析参数对话框

7. 3　 流体模型中的动网格

7. 3. 1　 ADINA 软件的动网格技术

分析很多流体问题 （尤其是流固耦合问题） 时都需要应用动网格技术， 它是有限元方

法的一个重要发展方向。 随着动网格技术的出现， 很多难题 （例如， 旋转机械） 可以使用

CFD 来模拟。 ADINA- CFD 模块中包含强大的动网格技术， 不仅可以模拟小位移变形， 还可

以模拟大位移变形。 ADINA- CFD 主要包含三种动网格技术： 参数化动网格、 滑移网格和自

适应动网格， 下面将分别详细介绍：
1. 参数化动网格

参数化动网格可以理解为自身具有一定变形能力的网格。 欧拉网格不能用于分析移动边

界问题和流固耦合问题， 此时必须采用拉格朗日-欧拉 （ALE） 网格 （详见 ADINA 流体理论

手册 2. 14 节） 来解决。 由于参数化动网格本身就具有一定适应变形的能力， 当变形达到一

定程度时， 将可能出现过度扭曲 （overlap） 现象， 使得计算终止。 一般情况下， 小位移问

题 （位移小于单元尺寸） 的流场网格可能不需要作任何特殊处理就能完成分析； 当位移变

形较大时， 则应该事先将网格划分好。 以图 7-21 的模型为例加以说明， 将活塞两端的网格

均划分为映射规则网格， 使得网格本身可以随活塞一起运动， 从而不会发生扭曲现象。 某些

情况下， 参数化动网格还应该与 Leader- Follower （详见 4. 6. 4 节） 一起配合使用， 9. 2 节

“阀门流固耦合分析” 就是参数化动网格应用的一个实例。
2. 滑移网格

4. 6. 5 节已经介绍了滑移网格的相关内容， 本节仅作简单介绍。 对于旋转机械问题， 通

常都需要使用滑移网格， 让滑移边界一侧的网格随动， 另一侧的网格固定， 如图 7-22 所示。
为了避免网格发生扭曲， 应该与 Leader- Follower 配合使用， 9. 4 节 “风车流固耦合分析” 就

是滑移网格应用的一个实例。
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图 7-21　 参数化动网格示意图

图 7-22　 滑移网格示意图

3. 自适应动网格

对于复杂流场计算问题， 初始网格往往不能胜任整个计算过程。 自适应动网格技术指的

是： 在计算过程中， ADINA 软件可以根据变量 （压力、 速度等） 的计算结果 （或流场域间

隙、 人工操作） 自动重划分网格， 自动确定各个部位的网格密度。 该技术不仅可以节约计

算资源， 而且还能够提高计算精度。 对于如图 7-23 所示的实例， 在流场计算域中包含结构

瓣膜， 初始网格如图 7-23b 所示， 根据流场域计算结果梯度的变化情况， 网格将自动重划

分； 自适应网格划分如图 7-23c 所示。 自适应动网格技术是一个非常重要的计算技术， 详细

介绍请参见 Primer 手册第 48 题 “ Flow between cylinders using adaptive CFD”、 第 49 题

“Analysis of a parachute using adaptive CFD” 和 ADINA 流场理论手册 12. 15 节 “Adaptive mesh”。
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图 7-23　 自适应动网格示意图

图 7-24　 运动边界中的扭曲单元

7. 3. 2　 动网格的控制

流体模型中如果网格发生了运动，
无论是移动边界导致的指定节点位

移还是任意的节点位移， 都应该保

证网格具备很好的质量。 ADINA-
CFD 模块中的运动网格功能可以自

动使节点发生任意的移动， 在某些

情况下， 这将不能很好地保证网格

质量。
如图 7-24 所示， 某简单模型中
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当小球运动时， 如果外部边界没有发生相同的运动， 且当点 2 固定时， 则线 1-2 将变成倾

斜， 此时某些单元就会发生扭曲。
如果让点 2 跟随点 1 一起运动， 则线 1-2 将不会发生倾斜， 此时单元的质量和形态也都

不会改变。 如图 7-25 所示， 该图中将点 1 设置为主动点， 点 2 设置为跟随点。

图 7-25　 运动-跟随功能示意图

读者所建立的几何模型在 ALE
网格中可以起到比较重要的作用。
如果在 AUI 中建立或导入几何模型，
则由 ADINA 软件生成网格， 从而网

格与几何模型建立关联， 此时就可

以将 Leader- Follower 设 置 在 几 何

点上。
边界的任意运动可能造成网格

重叠， 但如果模型区域足够简单，
则网格不会发生重叠。 最好的几何

形状是凸域， 在凸域中的任意两点

都可以用直线相连。 对于比较复杂的区域， 则可以将其切分成几个简单的子区域， 以得到合

适的 ALE 网格。
当网格发生压缩变形时最容易导致网格重叠， 此时建议采取下列操作：
1） 尽量将面或体建成接近凸域的形状。
2） 如果某区域不适合作为子区域， 则可以通过设置 Leader- Follower 点的方法将其定义

为移动刚性体， 此时该区域内所有流体节点的位移都相同。
3） 对于规则区域， 应该尽量将其切分为砖块状的子区域， 剩下区域则让其是刚性的。

例如， 结构变形处的流体网格容易发生网格重叠， 则可以让结构周围的流体跟随结构一起运

动， 以减小结构附件处流体网格的变形。
4） 当将区域划分为几个子区域时， 最好应该考虑到计算过程中网格的所有可能运动情

况， 尤其需要考虑到可以真实反应结果的高质量网格的临界状态。

图 7-26　 在 FSI 分析中使用接触面

在某些情况下， 在结构模型中定义

接触面也可在一定程度上避免网格重

叠， 接触的唯一作用就是避免流体网格

出现重叠， 且对计算结果不产生影响。
图 7-26 中施加了两个接触面以防止可

变形结构的运动。 较低位置处的接触面

离流体模型中的壁面边界有一个比较小

的距离， 该距离应该足够小以确保结构

模型始终位于壁面边界上， 同时该边界

也应该足够大以确保流体网格始终有

效。 如果接触面的位置摆放合适， 则将不会影响到最终计算结果。 在瞬态分析中， 这种接触

碰撞也可能发生， 此时， 较高位置处的接触面将用来代表真实的结构接触面， 而较低位置的

接触面将用来代表流体的壁面边界。
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如果位移小于一个单元的尺寸则属于小位移问题。 对于小位移问题， 无须使用上述 4 条

建议， ADINA 将自动使用拉普拉斯方程来完成网格的运动控制。

7. 4　 流体模型中促进收敛的方法

大多数流体问题的有限元方程或有限体积方程都是非线性的。 非线性方程的解必须通过

对一系列线性代数方程组进行迭代求解， 此处的迭代称为外部迭代。 ADINA- CFD 模块中提

供了两种外部迭代方法： 牛顿-莱弗森 （Newton- Raphson） 法和隔断 （Segregated） 法。 牛顿

法适用于 ADINA- CFD 中除 FCBI- C 之外的所有单元类型； 隔断法仅适用于 FCBI- C 单元。
无论是牛顿法还是隔断法， 求解过程中都很容易遇到不收敛的情况。 为了得到流体模型的收

敛解， 就必须弄清楚影响模型不收敛的因素。
高斯消去法及其延伸方法是求解线性方程组的主要方法。 高斯消去法在计算过程中产生

的截断误差是造成模型不稳定的主要原因， 且收敛的困难程度通常与矩阵计算的截断误差成

正比。 如果需要求解的方程数量不是特别多， 或机器硬件配置的位数较高时 （例如， 64 位

的计算机）， 则计算产生的截断误差相对较小， 迭代计算将较容易收敛。
因此， 每个计算的时间步都要有相对较好的初始条件， 以改善矩阵的稳定性。 本节将介

绍一些常用的促进流体模型收敛的方法。

7. 4. 1　 增加求解阶段

计算是否易于收敛与初始条件相关， 当给定的初始条件与最终结果相差较大时， 计算将

很难收敛， 此时应该考虑增加几个求解阶段来加强收敛。
例如， 对于如图 7-27 所示的强迫对流问题进行稳态分析， 底部的边界将受热。 进口处

指定的流速迫使流体在整个空腔内流动， 底边受热主要通过对流传递。 如果施加图中的边界

条件， 模型将不能够收敛。

图 7-27　 强迫对流问题示意图

此时， 可以通过两个计算阶段来

求解上述问题： 1） 进行不考虑传热

的流体计算； 2） 进行考虑流体流动

的传热计算。 在每个单独的计算阶段，
都比较容易收敛。

第 1 阶段， 如图 7-28 所示。 为了

使计算更容易收敛， 还可以分两个时

间步进行： 第 1 个时间步中指定相对

较小的速度， 且施加雷诺数为 1000 的

边界条件， 这样即使在没有初始条件

的情况下也容易采用牛顿迭代法进行

求解； 第 2 个时间步将以第 1 个时间

步的计算结果作为初始条件， 并施加

全速度， 将雷诺数设置为 10000， 此时并未考虑底部的温度载荷， 即瑞利数为 0。
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图 7-28　 第 1 阶段强迫对流计算

第 2 阶段 （见图 7-29） 则保持流体边界条件不变而让底面逐渐升温， 该阶段可在 2 ～ 6
个时间步中完成： 首先， 可以在第 1 个阶段的计算结果上定义比较小的瑞利数 （例如，
10000） 来作为第 2 个阶段第 1 个时间步的初始条件， 这样做将有助于计算收敛； 此后， 每

个时间步的计算结果都将自动作为下一时间步的初始条件。 该示例的时间步长可以按表 7-1
进行设定。

图 7-29　 第 2 阶段强迫对流计算

表 7-1　 时间步长的设定

时间步 时间步长 每一步的结束时间 入口速度 底边温度

1 0. 1 t1 = 0. 1 0. 1 0

2 0. 9 t2 = 0. 1 1 0

3 0. 0001 t3 = 0. 1 1 0. 0001

︙ ︙ ︙ ︙ ︙

n 2 - tn - 1 tn = 0. 1 1 1

需要注意的是： 此时进行的是稳态计算， 每个时间步的计算结果是对应时间下的稳态

解， 时间仅是一个控制边界或载荷的参数， 没有任何物理意义。
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7. 4. 2　 使用重启动的方法加强初始条件

初始条件对于迭代计算的收敛非常重要。 模型的初始条件可以看做是对第一个时间步计

算条件的初始猜想， 好的初始条件可以增强求解矩阵的稳定性。 但是， 很多问题的初始条件

往往很难确定， 本节将介绍通过重启动来加强初始条件的方法。
如图 7-30 所示的流固耦合瞬态问题， 水管受到底部周期性激励载荷的作用， 此处假定

重力远远大于底部的激励载荷。 如果直接进行瞬态计算， 将很难收敛。

图 7-30　 受周期性激励载荷作用的水管

为了求解该问题， 可以通过两个计算阶段来完成： 1） 进行仅考虑重力的稳态流固耦合

分析； 2） 将第 1 阶段的计算结果作为初始条件进行重启动分析， 计算激励载荷作用下的瞬

态流固耦合响应。 这种计算过程与实际情况非常接近， 如果重力和激励载荷同时施加在模型

上， 则忽略激励载荷的影响。 同时， 由于瞬态计算的时间步长非常小， 水管也很难达到重力

作用下的变形。

7. 4. 3　 使用映射文件加强初始条件

与重启动加强初始条件类似， 映射文件同样可以加强初始条件。 如果当前的计算模型位

于先前计算模型的区域内， 并且计算时保存了映射文件， 则先前计算阶段的计算结果总可以

作为当前计算阶段的初始条件来使用。 如果两个计算的计算结果相似， 则可以将先前的计算

结果作为初始条件， 以减少当前模型的迭代次数。
与重启动方法不同， 使用映射文件方法的最大优点在于： 前后两个计算的单元和某些边

界条件都不具有相关性。

7. 4. 4　 使用 CFL 参数来增强矩阵稳定性

在牛顿迭代计算中， 矩阵的状态非常重要。 很多情况都会造成牛顿迭代中矩阵的病态，
例如， 高雷诺数的流动问题、 单元尺寸变化剧烈、 单位制不协调等。 加入松弛因子是牛顿迭

代法中解决矩阵病态的简单有效的方法。
在 ADINA- CFD 模块中， 调节自动时间步长下的 CFL 参数可以显著增强矩阵的稳定性。

对于显式积分方法， 它的下限值为 1； 当矩阵稳定时， 其上限值是无限大 （1e + 020， 即

1 × 1020）。 通常推荐其取值期间为 102 ～ 107。

7. 4. 5　 使用合适的单位制

使用不合适的单位制也会造成矩阵的病态。 ADINA 软件中虽然没有规定单位制， 相对
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于模型而言， 单位选取不合适同样会导致收敛困难或计算结果不准确， 设置合适的特征数对

于稳定计算非常重要。

7. 4. 6　 减小变量的松弛因子

在 ADINA- CFD 模块中单击菜单 Control→Solution Process， 在弹出的对话框中将 Flow-
Condition- Based　 Interpolation Elements 选择为 FCBI- C， 单击 Outer Iteration 按钮， 将弹出

Outer Iteration Settings 对话框， 该对话框中包含 Primary Relaxation Factors （松弛因子）， 包括

速度、 位移、 压力等， 如图 7-31 所示。

图 7-31　 设置 FCBI- C 单元算法的松弛因子

对于 FCBI- C 单元， 减小变量的松弛因子是避免收敛困难的一个有效方法。 通常情况

下， 大多数问题都不需要调整压力松弛因子。 需要注意的是： 过小的松弛因子容易导致错误

的收敛结果。

7. 4. 7　 考虑模型的物理意义

对于某个稳态分析， 如果减小松弛因子后保持既不收敛也不发散的状态， 很可能是因为

稳态结果不存在。 更准确地说， 表示没有对应输入条件下的稳态结果。 例如， 高雷诺数下的

层流分析很容易发生数值震荡。 在这种情况下， 可以使用湍流模拟或减少层流计算的雷诺

数， 如果物理上允许。

7. 4. 8　 采用瞬态分析求得稳态解

某些稳态问题由于物理或数值等原因， 很难直接求得稳态响应。 为了求得稳态响应， 瞬

态分析 （可能需要一系列计算） 也是一种有效的方法。 通过瞬态分析求得真实时间步下的

模型响应， 当计算结果趋于稳定时， 也就是读者所关心的结果。
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7. 4. 9　 采用合适的时间步

在瞬态分析中， 时间步长与计算是否收敛有直接关系 （详见 7. 2. 3 节）。 如果计算直接

发散， 通常说明设置计算的时间步过大， 应用 CFL 约等于 1 作为判据来判断时间步是否足

够小。 短波问题通常需要使用较小的时间步， 选用默认的松弛因子即可； 长波问题通常需要

使用较大时间步， 此时按照稳态分析来设定松弛因子。 为了得到准确的瞬态响应结果， 也可

以考虑使用复合时间积分 （详见 7. 2. 2 节） 技术。
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本章内容：

■ 8.1 支架接触受力和接触模态分析

■ 8.2 齿轮接触传动分析

■ 8.3 钢球撞击薄板分析

■ 8.4 周期对称结构的力学分析

机械实例分析
第 8章
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　 　 本章以机械实例为背景， 从不同的计算功能和应用出发， 选取了 4 个实例， 介绍各种典

型例题的设置及计算方法。

8. 1　 支架接触受力和接触模态分析

8. 1. 1　 问题描述

本实例将进行金属支架和螺栓的静态接触受力和接触模态分析。 采用三维实体单元建立

螺栓模型， 并形象描述螺栓与支架间的接触关系， 同时考虑螺栓的预紧力； 然后在静力分析

基础上， 通过重启动进行支架的接触模态分析。 通过学习本实例， 读者可以掌握下列几个

功能：
1） 采用 Parasolid 建模方式学习抽空、 布尔运算、 切分等操作， 并将部分几何转换为

Native建模方式。 本实例详细介绍了完整的几何建模操作步骤。
2） 合理简化螺栓的几何模型， 忽略次要的建模细节。
3） 正确设置接触， 通过接触设置施加螺栓的预紧力。
4） 设置重启动分析。
5） 通过设置 Rigid Links 和梁单元来施加螺栓预紧力。
本实例第 1 步接触受力分析的命令流文件为 M- example01a. in； 第 2 步重启动分析的命

令流文件为 M- example01b. in； 文件 M- example01c. in 为应用梁单元施加螺栓预紧力的模型，
上述文件保存于随书光盘下列文件夹 \ 8-1 \ model \ 。

8. 1. 2　 前处理

1. 定义几何

启动 ADINA- AUI， 程序模块选择 ADINA Structures。 如果不希望手动完成几何建模， 可

以单击菜单 File→Open 或图标 来打开几何命令流文件 M- example01- geo. in （保存于随书光

盘下列文件夹： \ 8-1 \ model \ ）； 如果希望手动完成几何建模过程， 则按照下列步骤操作：
1） 单击菜单 ADINA-M→Define Body 或图标 ， 将弹出 Define Body 对话框。 单击 Add

按钮， 将 Type 选择为 Block， 在 Dimension Vector 的 X 空白框处输入 0. 1， Y 空白框处输入

0. 1， Z 空白框处输入 0. 06， 单击 OK 按钮后将创建一个块体。
2） 单击菜单 ADINA-M→Body Modifier 或图标 ， 将弹出 Body Modefiers 对话框， 将

Modifier Type 选择为 Hollow， 将 Target Body 选择为 1， 在 Default Face Thickness 空白框中输

入 0. 01， 在右侧表格的第 1 行依次输入 5 和 0， 单击 OK 按钮。
3） 单击菜单 ADINA-M→Define Body 或图标 ， 将弹出 Define Body 对话框。 单击 Add

按钮， 将 Type 选择为 Block， 在 Center Position 中的 Z 空白框处输入 - 0. 035， 分别在 Dimen-
sion Vector 的 X、 Y、 Z 空白框处输入 0. 12、 0. 12、 0. 01， 单击 Save 按钮。

4） 在 Define Body 对话框中单击 Add 按钮定义第 3 个体。 将 Type 选择为 Cylinder， 在

Radius 空白框中输入 0. 005， 在 Length 空白框中输入 0. 1， 并将 Axis 选择为 Z， 单击 OK 按

钮退出 Define Body 对话框。
5） 单击菜单 ADINA-M→Boolean Operator 或图标 ， 将弹出 Boolean Body Operators 对话
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框， 将 Operator Type 选择为 Sbutract， 将 Target Body 选择为 1， 勾选 Keep the Subtracting
Bodies 选项， 并在表格的第 1 行输入 3， 单击 Save 按钮。 按照相同的操作步骤， 将 Operator
Type 选择为 Sbutract，， 将 Target Body 选择为 2， 勾选 Keep the Subtracting Bodies 选项， 并在

表格的第 1 行输入 3， 单击 OK 按钮。
6） 单击菜单 ADINA-M→Define Body 或图标 ， 将弹出 Define Body 对话框。 单击 Add

按钮， 将 Type 选择为 Pipe， 并分别在 Radius、 Thickness 和 Length 空白框中输入 0. 01、
0. 005 和 0. 01， 在 Center Position 的 Z 空白框中输入 0. 035， 将 Axis 选择为 Z， 单击 Save
按钮。

7） 单击 Add 按钮， 在 Type 下拉菜单中选择 Transformed， 然后单击 Transformation Label
右侧的 按钮， 将弹出 Define Transformation 对话框； 单击 Add 按钮， 在 Type 下拉菜单中选

择 Translation， 在 Translation Increments 中的 Z 空白框处输入 - 0. 08， 单击 OK 按钮关闭对话

框。 在 Define Body 对话框中， 在 Parent Body 中输入 4， 将 Transformation Label 选择为刚才定

义的 1， 单击 OK 按钮。
8） 单击菜单 ADINA-M→Define Section Sheet 或图标 ， 将弹出 Define Section Sheet 对话

框。 单击 Add 按钮， 将 Defined by 选择为 Origin and Normal， 将 Origin by 选择为 Point 并输入

18 （也可以单击按钮 到图形区中拾取点 18， 此时需要事先单击图标 来显示点号）， 将

Outwards Normal 中的 X 改为 0， Z 改为 1， 单击 Save 按钮。 按照相同的操作步骤， 单击 Add
按钮， 将 Defined by 选择为 Origin and Normal， 将 Outwards Normal 中的 X 改为 0， Z 改为 1，
将 Origin by 选择为 Point 并输入 9， 单击 Save； 按照相同的操作步骤， 分别将 Origin by 选择

为 Point， 并依次输入 10、 5、 39 再定义 3 个 Section Sheet， 共定义了 5 个相互平行的 Section
Sheet。

9） 单击菜单 ADINA-M→Body Modifier 或图标 ， 在弹出的对话框中将 Modifier Type 选

择为 Section， 在 Target Body 下拉菜单中选择 3， 在右侧表格的前 5 行依次输入 1、 2、 3、 4、
5， 单击 OK 按钮。

10） 单击菜单 ADINA-M→Define Body 或图标 ， 在弹出的对话框中将 Body Number 选
择为 3， 单击对话框上部的 Delete 按钮， 将弹出 “是否删除 item 3” 提示框， 选择 Yes。 也

可以单击图标 ， 然后到图形区拾取最上部的体 （Body 3）， 按 Esc 键退出删除状态即可，
两种操作方法的效果完全相同。

11） 单击菜单 ADINA-M→Define Section Sheet 或图标 ， 在弹出的对话框中单击 Add 按

钮， 将 Defined by 选择为 X- Plane， 单击 Save 按钮； 然后再次单击 Add 按钮， 为 Defined by
选择 Y- Plane， 单击 OK 按钮。

12） 单击菜单 ADINA-M→Body Modifier 或图标 ， 在弹出的对话框中将 Modifier Type
选择为 Section， 并将 Target Body 选择为 4， 勾选 Keep the Sheets After the Sectioning 选项， 在

右侧表格的前 2 行依次输入 1 和 2， 单击 Save 按钮。 按照相同的操作方法， 对 body5、
body6、 body7、 body8、 body9、 body10 进行 Sheet 切分。 需要注意的是： 在切分 body10 时，
不要勾选 Keep the Sheets After the Sectioning 选项， 单击 OK 按钮。

13） 单击菜单 Geometry→Volumes→Define 或图标 ， 将弹出 Define Volume 对话框。 单

击 Add 按钮， 将 Type 选择为 Body， 勾选 Convert All Bodies 和 Convert Curved Edges to Splines
选项， 单击 OK 按钮， 将弹出 “Body1 和 Body2 不能转化为 volume” 的提示框， 单击确定
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按钮。
14） 单击菜单 Display→Geometry / Mesh Plot→Change Zone， 在弹出的对话框中单击 Zone

Name 右侧的 按钮， 将弹出 Define Zone 对话框； 也可以单击图标 右侧的下拉菜单并选择

图标 。 单击 Add 按钮， 在弹出的对话框中输入 v （输入小写字母即可， 单击 OK 按钮后软

件会自动将其改为大写的 V）， 单击 OK 按钮。 在右侧表格的第 1 行输入 volume 1 ～ 28， 单击

OK 按钮。
提示： volume 1 ～ volume 28 指的是螺栓几何， 为了显示模型方便将其定义为一个名为 V〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

的 zone （区域）， 为后面的设定网格密度和设定接触作准备。 实际工程中的螺栓帽和螺母往〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
往是类六边形带倒圆角的复杂几何结构。 有限元分析时， 螺栓不必按照实际结构建模， 原因〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
是： 螺栓帽和螺母边缘是受力的末端部位， 它们远离应力集中区域， 因此螺栓帽和螺母的形〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
状对于分析结果几乎没有任何影响。 有限元分析时要力争做到以最小的代价获取满足需求的〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
结果。 本例中对螺栓模型进行合理简化， 已经能够满足分析的准确度要求。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

15） 单击菜单 ADINA-M→Define Body 或图标 ， 在弹出的对话框中单击 Add 按钮， 选

择 Type 为 Block， 在 Center Position 的 Z 空白框处输入 - 0. 02， 分别在 Dimension Vector 的

X、 Y 和 Z 空白框处输入 0. 1、 0. 01 和 0. 02， 单击 Save 按钮。 再次单击 Add 按钮， 将 Type
选择为 Transformed， 单击 Transformation Label 右侧的 按钮， 将弹出 Define Transformation
对话框， 单击 Add， 将 Type 选择为 Rotation， 在 Angle of Rotation 中输入 90， Axis 选择为 Z，
单击 OK 按钮关闭对话框。 在 Define Body 对话框中， 为 Parent Body 输入 3， 并将 Transforma-
tion Label 选择刚才定义的 2， 单击 OK 按钮。

16） 单击菜单 ADINA-M→Boolean Operator 或图标 ， 在弹出的对话框中将 Operator
Type 选择为 Subtract， 在 Target Body 下拉菜单中选择 1， 分别在表格的前两行输入 3 和 4，
单击 OK 按钮。

此时， 几何建模工作结束， 单击图标 和图标 ， 图形区将显示如图 8-1 所示的几何模

型， 共包含两个 body 和 28 个 volume。

图 8-1　 几何模型

2. 定义网格密度

下面将介绍定义网格密度的操作步骤， 读者也可以读

取 M- example01- sub. in （保存于随书光盘的文件夹 \ 8-1 \
model \ 中）， 单击菜单 File→Open 或图标 可以打开该

文件。
1） 为螺栓设定网格密度。 首先设定总的网格密度，

然后再进行局部修改。 单击菜单 Meshing→Mesh Desinty→
Volume （或图标 右侧的下拉菜单， 然后选择图标 ），
在弹出的 Define Volume Mesh Density 对话框中， 设置 Vol-
ume Number 为 1， 在 Number of Subdivisions 的 u、 v 和 w 空

白框处均输入 3， 单击右侧表格上部的 Auto 按钮， 将弹出 Auto Generation 对话框， 分别在

From 和 To 中输入 2 和 28， 单击 OK 按钮两次来退出对话框。
2） 单击图标 （Change Zone）， 在弹出的对话框中， 在 Zone Name 下拉菜单下选择 V，

单击 OK 按钮。 单击线框显示图标 （Wire Frame）， 单击图标 以放大螺栓帽局部。 将螺

栓径向上的网格密度从 3 调整为 2， 对应的操作如下： 单击菜单 Meshing→Mesh Desinty→
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Line （或单击图标 右侧的下拉菜单， 并选择图标 ）， 在弹出的 Define Line Mesh Density 对

话框中确认 Line Number 为 1， 确认 Method 为 Use Number of Divisions， 在 Number of Subdivi-
sion 的空白框中输入 2， 在右侧表格中依次输入 12、 57、 63、 91、 92、 28、 29、 93、 25、
26、 90、 8、 3、 59、 52、 99、 94、 34、 33、 39、 106、 101、 40、 44、 111、 108、 45、 48、
113、 112、 47、 83、 77、 24、 13、 15、 20、 79、 72， 单击 OK 按钮退出对话框。

提示： 表格中的线号也可以不使用手动输入， 最常用的做法是： 首先双击表格第 1 行的〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
绿色图框， 然后在图形区使用鼠标依次拾取螺栓径向的线； 当无法继续拾取时， 则按下 Esc〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
键返回而不关闭对话框， 单击平移图标 或放大图标 来调整图形区的显示内容， 以便能够〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
继续拾取需要的线。 在表格中继续双击第 1 个未能输入数字的绿色图框， 在图形区继续拾取〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
需要的线， 重复这一过程直至所有的线都被选中且输入到表格中。 如果选错了某条边， 可以〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
按住 Esc 键返回对话框， 用鼠标单击选错边的所在行， 再单击 Del Row 按钮来删掉该行； 然〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
后再双击第 1 个未输入数字的绿色图框， 在图形区继续用鼠标选择边。 需要注意的是： 对话〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
框上部的 Line Number 号码可以不在表格中输入， 只要保证 Line Number 的号码是需要选取〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
的线即可。 本例中 Line Number 为 1， 正好位于径向上， 因此是满足要求的线； 如果 Line〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
Number 不是 1， 则需要注意调整线号， 初学者一定要特别注意该问题。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

3） 单击菜单 Meshing→Mesh Desinty→Body （或单击图标 右侧的下拉菜单， 选择图标

）， 在弹出的对话框中确认 Body Number 为 1， 确认 Method 为 Use Length， 在 Element Edge
Length 中输入 0. 01， 在右侧表格的第 1 行输入 2， 单击 OK 按钮。

4） 单击图标 （Change Zone）， 在弹出的对话框中将 Zone Name 选择为 GB1， 单击 OK
按钮退出对话框。 确认线框显示图标 （Wire Frame） 按下， 单击图标 来放大螺栓孔局

部。 单击菜单 Meshing→Mesh Desinty→Edge （或单击图标 右侧的下拉菜单， 并选择图标

）， 在弹出的对话框中确认 Body 为 1， 单击 Edge 右侧的按钮 ， 到图形区拾取螺栓孔周

向的 1 条边即可返回对话框； 双击表格右侧的绿色框， 到图形区依次拾取剩下的 3 条边， 按

Esc 键返回。 确认这 4 条边的线号分别为 25、 26、 27、 28。 将 Method 选择为 Use Number of
Divisions， 在 Number of Subdivision 的空白框处输入 6， 单击 Save 按钮而不关闭对话框。

按照相同的操作方法， 单击图标 ， 在弹出的对话框中为 Zone Name 选择 GB2， 单击

OK 按钮退出对话框。 确认线框显示图标 按下， 单击图标 来放大螺栓孔局部。 将 Body 选

择为 2， 单击 Edge 右侧的按钮 ， 到图形区拾取螺栓孔周向的 4 条边 （4 条边的线号分别为

13、 14、 15、 17）。 将 Method 选择为 Use Number of Divisions， 并在 Number of Subdivision 空

白框处输入 6， 单击 OK 按钮退出对话框。 此时， 网格密度设定完毕。
提示： 两个 body 在螺栓孔和螺栓周向的网格密度相同 （都为 6）， 目的是能够有效减小〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

接触的初始穿透。 对于曲面接触分析， 如果接触面处的网格密度设置差距较大， 将导致非常〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
大的接触初始穿透， 不利于接触收敛。 详细介绍请参见第 4. 10 节 “设定接触”。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

3. 定义材料

本例将定义两种线弹性材料， 材料 1 是螺栓材料， 材料 2 则是支架及基座材料。
1） 单击菜单 Model→Material→Manage Material 或图标 ， 将弹出 Manager Material Defi-

nitions 对话框， 单击 Elastic 下的 Isotropic 按钮来定义线弹性材料。 在弹出的对话框中单击

Add 按钮来定义材料 1， 分别在 Young’s Modulus、 Poisson’s Ratio 和 Density 的空白框处输入

2e11、 0. 3 和 7800， 单击 Save 按钮。
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2） 单击 Add 按钮来定义材料 2， 分别在 Young’s Modulus、 Poisson’s Ratio 和 Density 的空

白框处输入 1. 5e11、 0. 3 和 7200， 单击 OK 按钮退出对话框。
3） 单击 Close 按钮退出， 材料定义完毕。
4. 定义单元组

本实例需要定义 3 个单元组， 分别表示螺栓、 支架及基座。
1） 单击菜单 Meshing→Element Groups 或图标 ， 将弹出 Define Element Group 对话框。
2） 单击 Add 按钮来定义单元组 1， 将 Type 选择为 3- D Solid， 保证默认的材料 Default

Material 选择为 1， 其余设置保持不变， 单击 Save 按钮。
3） 单击 Add 按钮来定义单元组 2， 在 Default Material 下拉菜单中选择 2， 单击 Save 按

钮； 单击 Copy 按钮， 在弹出的对话框中单击 OK 按钮， 则将单元组 2 的设置复制给单元组

3， 然后单击 Cancel 按钮退出， 单元组定义完毕。
5. 划分网格

1） 划分螺栓网格的操作如下： 单击菜单 Meshing→Create Mesh→Volume 或图标 ， 将

弹出 Mesh Volumes 对话框。 将 Element Group 选择为 1， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate 选项， 单击表格右侧上部的 Auto 按钮， 在弹出的对话框

中在 From 处输入 1， 在 To 处输入 28， 单击 OK 按钮两次退出对话框。
2） 划分支架网格的操作如下： 单击菜单 Meshing→Create Mesh→Body 或图标 ， 将弹

出 Mesh Bodies 对话框。 将 Element Group 选择为 2， 将 Nodes per Element 选择为 8， 确认

Meshing Type 为 Free- Form， 并勾选 Brick Elements on Boundary 选项。 在表格的第 1 行输入

1， 单击对话框上部的 More Option 标签， 将 Nodal Coincidence Checking 下的 Check 选择为 No
Checking， 单击 Apply 按钮， 网格划分完毕将弹出警告信息窗口， 关闭即可。

3） 划分基座网格的操作如下： 将 Element Group 选择为 3， 确认 Nodes per Element 为 8，
确认 Meshing Type 为 Free- Form， 确认勾选 Brick Elements on Boundary 选项。 在表格的第 1
行输入 2， 单击对话框上部的 More Option 标签， 确认将 Nodal Coincidence Checking 下的

Check 选择为 No Checking， 单击 OK 按钮退出对话框。

图 8-2　 图形区

提示： 对于模型中包含初始接触的几何界面， 一定要保证它的网格节点是不连续的， 即〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
节点不拟合； 生成网格时一定要设置节点重合性检查。 详细介绍请参见 4. 2 节 “划分网〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
格”。〰〰

此时， 模型的网格划分工作完毕。 依次单击图标 、 和 ， 图形区中将显示划分网

格后的模型示意图， 如图 8-2 所示。 本实例中共包含 3 个单元组， 分别用不同的颜色显示。
6. 定义接触

定义接触时应该首先定义接触组， 本实例中需要定义两

个接触组： 一个接触组用来定义正常的接触关系， 另外一

个接触组用于设置施加螺栓的初始预应力。 下面将详细介

绍操作步骤：
定义第 1 个接触组的操作如下：
1） 单击菜单 Model→Contact→Contact Group 或图标 ，

弹出定义接触组对话框。 单击 Add 按钮， 并设置接触组 1，
将 Type 选择为 3- D Contact， 在 Default Coulomb Friction
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Coefficient处输入 0. 1， 其他设置保持默认值不变， 单击 OK 按钮。
2） 单击图标 ， 在 Zone Name 中选择 V， 单击 OK 按钮。 单击图标 显示面号。 单击

菜单 Model→Contact→Contact Surface （或图标 右侧的下拉菜单， 然后选择图标 ）， 将弹

出定义接触面对话框。 单击 Add 按钮， 并定义接触面 1， 确认 Defined on 为 Surfaces， 双击表

格第 1 行的绿色图框， 并到图形区依次拾取面 70、 17、 78、 21、 86、 25、 50、 11、 75、 71、
83、 79、 91、 37、 57、 53， 按 Esc 键返回对话框， 单击 Save 按钮保存。

3） 单击图标 ， 在 Zone Name 中选择 GB1， 单击 OK 按钮。 再单击图标 来放大显示

螺栓孔局部。 单击 Add 按钮来定义接触面 2， 将 Defined on 选择为 Faces of a Body， 将 Body
选择为 1， 双击表格第 1 行的绿色图框， 到图形区依次拾取面 15、 16 （也可以手动输入），
按 Esc 键返回对话框， 单击 Save 按钮保存。

4） 单击图标 ， 在 Zone Name 中选择 GB2， 单击 OK 按钮。 单击图标 来放大显示螺

栓孔局部。 单击 Add 按钮来定义接触面 3， 将 Defined on 选择为 Faces of a Body， 将 Body 选

择为 2， 双击表格第 1 行的绿色图框， 到图形区依次拾取面 5、 7、 8 （也可以手动输入）， 按

Esc 键返回对话框， 单击 Save 按钮保存。
5） 单击图标 ， 在 Zone Name 中选择 GB1， 单击 OK 按钮。 单击 Add 按钮来定义接触

面 4， 将 Defined on 选择为 Faces of a Body， 将 Body 选择为 1， 双击表格第 1 行的绿色图框，
到图形区依次拾取面 1、 2、 3、 4， 按 Esc 键返回对话框， 单击 Save 按钮保存。

6） 单击图标 ， 在 Zone Name 中选择 GB2， 单击 OK 按钮。 单击 Add 按钮来定义接触

面 5， 将 Defined on 选择为 Faces of a Body， 将 Body 选择为 2， 双击表格第 1 行的绿色图框，
到图形区拾取面 1， 按 Esc 键返回对话框， 单击 OK 按钮。

7） 单击菜单 Model→Contact→Contact Pair （或图标 右侧的下拉菜单， 然后选择图标

）， 将弹出定义接触对对话框。 单击 Add 按钮设置接触对 1， 将 Target Surface 选择为 1，
将 Contactor Surface 选择为 2， 单击 Save 按钮。 单击 Add 按钮来设置接触对 2， 将 Target Sur-
face 选择为 1， 将 Contactor Surface 选择为 3， 单击 Save 按钮。 单击 Add 按钮来设置接触对

3， 将 Target Surface 选择为 4， 将 Contactor Surface 选择为 5， 单击 OK 按钮。
提示： 设置接触对时， 需要注意 Target　 Surface 和 Contactor　 Surface 的选取。 由于接触〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

面 1 的刚度大于接触面 2 和 3 的刚度， 因此， Target　 Surface 一定要选择接触面 1。 详细介〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
绍请参见第 4. 10 节 “设定接触”。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

定义第 2 个接触组的操作如下：
1） 单击菜单 Model→Contact→Contact Group （或图标 ）， 将弹出定义接触组对话框。

单击 Add 按钮来设置接触组 2， 确认 Type 为 3- D Contact， 在 Default Coulomb Friction Coeffi-
cient 处输入 0. 1； 单击 Advanced 标签， 将 Initial Penetration into Target 选择为 Override， 在

Initial Gap （ + ） / Penetration （ - ） Value 处输入 - 0. 0001， 其他设置保持默认不变， 单击

OK 按钮。
提示： Override 表示过盈接触， 而 - 0. 0001 则表示接触的过盈量为 0. 1 mm （本例题默〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

认的长度单位为米）， 这是通过接触来施加螺栓预紧力的一种常用方法， 过盈量越大， 表明〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
螺栓的预紧力越大。 螺栓预紧力的大小可以根据过盈量的大小通过材料力学公式计算得到近〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
似值， 也可以使用试算的方法来得到。 关于处理结果文件得到螺栓预紧力， 请参见本节的后〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
处理。〰〰
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2） 单击图标 ， 在 Zone Name 中选择 V， 单击 OK 按钮。 单击菜单 Model→Contact→
Contact Surface （或图标 右侧的下拉菜单， 然后选择图标 ）， 将弹出定义接触面对话框。
单击 Add 按钮来定义接触面 1， 确认 Defined on 选择为 Surfaces， 双击表格第 1 行的绿色图

框， 到图形区依次拾取面 3、 32、 37、 44， 按 Esc 键返回对话框， 单击 Save 按钮保存。
3） 单击图标 ， 在 Zone Name 中选择 GB1， 单击 OK 按钮。 单击 Add 按钮来定义接触

面 2， 将 Defined on 选择为 Faces of a Body， 将 Body 选择为 1， 双击表格第 1 行的绿色图框，
到图形区拾取面 5， 按 Esc 键返回对话框， 单击 OK 按钮。

4） 单击菜单 Model→Contact→Contact Pair （或图标 右侧的下拉菜单， 然后选择图标

）， 将弹出定义接触对对话框。 单击 Add 按钮来设置接触对 1， 将 Target Surface 选择为 1，
将 Contactor Surface 选择为 2， 单击 OK 按钮。

5） 单击菜单 Model→Contact→Contact Control， 在弹出的对话框中将 Default Contact
Displacement Formulation 选择为 small， 单击 OK 按钮。

提示： Default Contact Displacement Formulation 的默认设置为 large， 由于本例中未涉及到〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
大变形， 因此需要将该设置修改为 small。 读者也可以在定义每个接触组时进行设置。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

6） 接触定义完毕， 依次单击图标 和 ， 图形区中的模型将如图 8-3 所示， 图中的高

亮显示区域表示定义接触的边界。

图 8-3　 图形区

提示： 可以单击图标 ， 在 Zone Name 中选择 CG1 来〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
查看接触组 1 的设置情况， 也可以选择 CS1_CG1 来查看接〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
触组 1 中接触面 1 的设置情况。 单击图标 可以显示接触〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
面的方向。 由于本实例的接触面都是实体的外表面， 因此〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
接触面方向一定正确。 也可以通过这种方法来检查模型的〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
接触设置。〰〰〰〰

7. 定义约束

单击菜单 Model→ Boundary Conditions→ Apply Fixity
（或图标 ）， 在弹出的对话框中将 Apply to 选择为 Faces，
将 Body 选择为 2， 在表格前 4 行的第 1 列依次输入 2、 3、
4、 6， 单击 OK 按钮。 单击图标 可以在图形区中查看约束施加的位置 （基座的 4 条侧边）。

8. 1. 3　 求解

单击菜单 File→Save 或图标 ， 将文件保存为 M- example01a. idb。 单击菜单 Solution→
Data File / Run （或单击图标 ）， 在弹出的 Create the ADINA Input File 对话框中选择文件

M- example01a， 同时勾选 Run Solution 和 Automatic Memory Allocation 选项， 单击保存按钮，
等待计算结束。

8. 1. 4　 后处理

1） 程序模块选择 Post- Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

M- example01a. por。
2） 查看节点接触力： 单击图标 ， 在 Zone Name 中 选择 EG1， 单击 OK 按钮。 单击菜

单 Display→Reaction Plot→Create， 在弹出的对话框中确认 Reaction Quantity 为 CONSISTENT_
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CONTACT_FORCE， 单击 OK 按钮。 此时， 图形区将显示接触的节点力， 单击图标 并使用

鼠标旋转图形区来查看结果。
3） 查看螺栓的有效应力分布： 依次单击图标 和 ， 在 Zone Name 中选择 EG1， 单击

OK 按钮。 依次单击图标 和 ， 此时图形区将显示螺栓的有效应力结果云图， 用鼠标旋转

图形区来查看结果。 有效应力的最大值位于螺栓根部， 在该区域出现应力集中是正确的， 有

效应力的最小值位于螺母的边缘。
4） 查看螺栓轴力： 首先应该做螺栓切片： 单击图标 来清除图形区中的云图显示。 单

击图 标 ， 在弹出的对话框中将 Type 选择为 Cutting Plane， 将 Defined by 选择为 Z- Plane，
单击 OK 按钮； 然后应该定义切片积分点： 单击菜单 Defination→Model Point （ Special） →
Mesh Integration， 在弹出的对话框中单击 Add 按钮， 并输入 Model Point 的名称 （例如， 输

入 1）， 单击 OK 按钮两次来退出对话框； 最后列出螺栓轴力： 单击菜单 List→Value List→
Model Point， 在弹出的对话框中确认Model Point Name 为 1， 将 Variables to List 选择为 Stress，
STRESS- ZZ， 单击 Apply 按钮， 此时对话框的上部将列出 STRESS- ZZ 的合力值 （螺栓的轴

力值）。
5） 查看支架螺栓孔附近有效应力分布： 依次单击图标 和 ， 在 Zone Name 中选择

EG2， 单击 OK 按钮。 依次单击图标 和 ， 此时图形区将显示支架的有效应力结果云图，
使用鼠标旋转图形区、 放大显示螺栓孔局部区域来查看结果。 可以发现螺栓孔在厚度方向上

仅为 1 层单元， 有效应力计算的结果连续性不理想， 如果希望获得较好的计算结果， 应该加

密支架和基板的网格密度 （打开命令流文件， 查找设置网格密度的语句并修改， 保存后重

新读取命令流文件即可）。

8. 1. 5　 重启动计算接触模态

程序模块选择 ADINA- Structures， 将弹出是否放弃所有更改的对话框， 单击是。 单击菜

单 File→Open （或图标 ） 来打开结果文件 M- example01a. idb。
将模块工具条的分析类型修改为 Frequencies / Modes， 单击右侧的图标 ， 在弹出的对话

框中将 Number of Frequencies / Mode shapes 修改为 5， 将 Solution Method 选择为 Lanczos Itera-
tion， 单击 OK 按钮。

提示： 对于没有完全约束的模型结构， 模态结果中可能包含刚体模态， 如果希望输出刚〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
体模态， 提交计算时应该勾选 Allow Rigid Body Mode 选项， 本实例无需勾选。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

单击菜单 Control→Solution Process， 在弹出的对话框中勾选 Restart Analysis 标签， 并在

Solution Start Time 中输入 1， 单击 OK 按钮。
提交计算： 单击菜单 File→Save As， 将文件保存为 M- example01b. idb。 单击菜单 Solu-

tion→Data File / Run （或单击图标 ）， 在弹出的对话框中选择文件 M- example01b， 同时勾

选 Run Solution 和 Automatic Memory Allocation 标签， 单击保存按钮； 在弹出的对话框中选择

文件 M- example01a. res， 单击 Copy 按钮， 然后等待计算结束。
后处理过程如下：
1） 程序模块选择 Post- Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

M- example01b. por。
2） 单击图标 可以查看各阶模态的构型和固有频率值， 第 1 阶接触模态如图 8-4 所示。
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图 8-4　 接触模态

单击图标 可以制作并查看各阶模态的动画， 单击

图标 可以回看已制作的动画， 单击图标 可以退

出动画显示状态。

8. 1. 6　 应用梁单元施加螺栓预紧力

前面介绍的分析过程是通过设定接触过盈的方

法来施加螺栓预紧力， ADINA 软件中还可以应用梁

单元来模拟螺栓并施加预紧力。 关于梁单元模拟螺

栓的详细介绍， 请参见 ADINA 8. 6 版 《结构理论

手册》 11. 17 节。
应用梁单元施加螺栓预紧力时必须与 Rigid

Links 联合使用， 随书光盘下列文件夹 \ 8-1 \ model \ 提供了 M- example01c. in 文件， 可将其

复制到硬盘目录下， 然后在 ADINA- AUI 中打开。
使用梁单元施加预紧力时需要定义梁单元， 并在梁单元的两端分别设置 Rigid Links 与

螺栓实体相连， 如图 8-5 所示。 在定义梁单元组时， 为 Bolt Options 标签选择 Bolt， 并输入

螺栓预紧力 7800 N。 本书没有描述应用梁单元施加螺栓预紧力的详细建模过程， 读者可以

自行参看命令流文件。

图 8-5　 螺栓模型

需要注意的是： 模型 M- example01c 中修改了部分接触设置， 请

读者自行比对学习。
提交计算为：
单击菜单 Solution→Data File / Run （或单击图标 ）， 在弹出的对

话框中输入文件名 M- example01c， 确认同时勾选了 Run Solution 和

Automatic Memory Allocation 选项， 单击保存按钮， 并等待计算结束。
后处理过程如下：
程序模块选择 Post- Processing。 单击菜单 File→Open （或单击图

标 ） 来打开结果文件 M- example01c. por。
查看螺栓有效应力分布： 依次单击图标 和 ， 在 Zone Name 中选择 EG1， 单击 OK 按

钮。 依次单击图标 和 ， 此时图形区将显示螺栓的有效应力结果云图， 用鼠标旋转图形区

来查看结果。 将发现有效应力的最大值约为 1. 2 E + 8 Pa， 位于螺栓根部， 这与 M- exam-
ple01a. por 的计算结果基本一致。

重启动计算接触模态的设置与重启动计算的设置步骤完全相同， 此处不再赘述， 感兴趣

的读者可自行计算。

8. 1. 7　 应用推广

本实例可以推广应用到更复杂的工程结构中， 也可以计算多螺栓作用下的结构响应。 分

步施加螺栓载荷不仅能够促进收敛， 而且将使得计算结果更准确。 同时还可以重启动计算各

种复杂载荷作用下的模态响应， 考虑接触效应的模态与不考虑接触效应的模态结果差距很

大， 因此在结构分析中起着重要的作用。
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8. 2　 齿轮接触传动分析

8. 2. 1　 问题描述

本实例将对一组二维齿轮模型 （如图 8-6 所示） 进行接触传动分析， 通过 Rigid Links
将齿轮与齿轮中心点连接， 并在中心齿轮的中心点施加转动位移， 通过外侧的 3 个齿轮将载

荷传递到外环齿轮上。

图 8-6　 图形区

通过学习本实例， 读者可以掌握下列几个功能：
1） 读入 Parasolid 几何。
2） 合理设置接触分析所需的网格密度。
3） 定义接触。
4） 使用自动时间步长。
本实例完整的命令流文件为 M- example02. in， 复制此命令流

文件时一定要同时复制几何文件 M- example02. x_t， 上述文件均

保存于随书光盘下列文件夹： \ 8-2 \ model \ 。

8. 2. 2　 前处理

1. 定义几何

1） 启动 ADINA- AUI， 程序模块选择为 ADINA Structures。 单击菜单 ADINA-M→Import
Parasolid Model 或图标 ， 查找并打开文件 M- example02. x_t。

2） 单击菜单 Geometry→Lines→Define （或图标 ）， 将弹出 Define Line 对话框。 单击

Add 按钮， 将 Type 选择为 Straight， 单击 Point 1 右侧的按钮 ， 到图形区选择中间齿轮内径

上的两个点 （确认点号为 549、 550）， 单击 Save 按钮； 再次单击 Add 按钮， 将 Type 选择为

Straight， 选择其他 3 个小齿轮内径上的点， 并创建 3 条直线。 确认 3 条线所在的点号分别为

（365， 366）、 （303， 304） 和 （427， 428）。 创建完毕单击 OK 按钮退出对话框。
3） 单击菜单 Geometry→Lines→Split， 将弹出 Split Line 对话框。 在 Line Number 空白框

处输入 1， 确认 Parametric Value at with Line Split 为 0. 5， 单击 Apply 按钮； 按照相同的操作

方法， 分别在 Line Number 处依次输入 2、 3、 4， 确认 Parametric Value at with Line Split 均为

0. 5， 单击 Apply 按钮， 将线 4 分割完毕单击 OK 按钮退出对话框。
4） 依次单击图标 和 ， 此时图形区将出现齿轮的中心点。 单击图标 ， 然后删除图

形区中已创建的所有线。 需要注意的是： 删除直线后， 按下 Esc 键退出删除状态。 删掉直线

这一步也可以忽略， 因为它并不影响正常的计算， 删掉直线的目的是使图形区看上去更简洁。
5） 单击菜单 Geometry→Lines→Define （或单击图标 ）， 将弹出 Define Line 对话框。 单

击 Add 按钮， 将 Type 选择为 Extrude， 在 Initial Point 处输入 551， 在 Vector 的 X 空白框处输

入 - 0. 001， 单击 OK 按钮。
6） 依次单击图标 和 ， 单击图标 ， 然后删除图形区中已创建的线 （需要注意的

是： 删除直线后， 按下 Esc 键退出删除状态。 这步也可以忽略）。 此时， 几何定义完毕， 图

形区中的模型如图 8-6 所示。
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2. 定义网格密度

为整个模型设定网格密度的操作如下： 单击菜单 Meshing→Mesh Desinty→Complete
Model， 在弹出的对话框中将 Subdivision Mode 选择为 Use Length， 在 Element Edge Length 空

白框处输入 0. 0005， 单击 OK 按钮。 此时， 将看到整个图形区都已设定好网格密度。
调整模型局部网格密度的操作如下： 在齿轮没有发生接触的位置， 网格密度不必设置

太密。
1） 单击图标 来显示线号。 单击菜单 Meshing→Mesh Desinty→Edge （或图标 右侧的

下拉菜单， 然后选择图标 ）， 在弹出的对话框中确认 Body Number 为 1， 确认 Edge 为 1，
确认 Method 为 Use Length， 在 Element Edge Length 空白框处输入 0. 005， 在右侧表格的第 1
行输入 242， 单击 Save 按钮。

提示： 单击 Egde 右侧的下拉按钮并拖动滚动条， 将发现 body1 共包含 242 条边。 调整〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
图形区并放大显示局部， 将发现 body1 最外侧的两条线号为 1 和 242， 因此需要修改这两条〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
线的网格密度。 其他 body 也需要按照相同的方法进行观察和设置。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

2） 按照与 1） 相同的操作方法来调整 body2、 body3、 body4 和 body5 的局部网格密度。
将 Body Number 选择为 2， 将 Edge 选择为 61， 确认 Method 为 Use Length， 将 Element Edge
Length 修改为 0. 0025， 在右侧表格的第 1 行输入 62， 单击 Save 按钮； 将 Body Number 选择

为 3， 将 Edge 选择为 61， 确认 Method 为 Use Length， 将 Element Edge Length 修改为 0. 0025，
在右侧表格的第 1 行输入 62， 单击 Save 按钮； 将 Body Number 选择为 4， 将 Edge 选择为

61， 确认Method 为 Use Length， 将 Element Edge Length 修改为 0. 0025， 在右侧表格的第 1 行

输入 62， 单击 Save 按钮； 将 Body Number 选择为 5， 将 Edge 选择为 121， 确认 Method 为

Use Length， 将 Element Edge Length 修改为 0. 005， 在右侧表格的第 1 行输入 122， 单击 OK
按钮。 此时网格密度设置完毕。

提示： 严格意义上， 对于齿轮发生接触的位置， 网格密度设置的越密越好， 原因是： 渐〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
开线型齿轮在接触过程中一直是光滑连续接触， 一旦离散为网格单元后， 这种光滑连续的接〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
触运动就变成间断的接触运动， 这与实际情况不相符。 因此， 为了减少网格离散的影响， 在〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
齿轮接触处的网格密度应尽可能小。 本实例设置为 0. 0005。 对于齿轮没有发生接触的位置，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
则无须设置很小的网格密度， 因为增加单元数量将导致计算成本的增加。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

3. 定义材料

单击菜单 Model→Material→Manage Material （或图标 ）， 将弹出 Manager Material Defi-
nitions 对话框， 单击 Elastic 下的 Isotropic 按钮来定义线弹性材料。 在弹出的对话框中单击

Add 按钮来定义材料 1， 分别在 Young’s Modulus、 Poisson’s Ratio 和 Density 空白框处输入

2e11、 0. 3 和 7800， 依次单击 OK 按钮和 Close 按钮退出对话框。 此时， 材料定义完毕。
4. 定义单元组

本实例需要定义 5 个单元组， 分别用于定义 5 个齿轮。 单击菜单 Meshing→Element
Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add 按钮来定义单元组 1， 将 Type 选

择为 2- D Solid， 将 Element Sub- Type 选择为 Plane Strain， 确认 Default Material 选择为 1， 其

余设置保持不变， 单击 Save 按钮； 单击 Copy 按钮， 在弹出的对话框中单击 OK 按钮， 则将

单元组 1 的设置复制给单元组 2。 同理， 再单击 3 次 Copy 按钮来定义单元组 3、 4、 5。 单击

Cancel 按钮退出对话框。 此时， 单元组定义完毕。
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5. 划分网格

划分点网格的操作如下： 单击菜单 Meshing→Create Mesh→Point， 将弹出 Create Nodes at
Points 对话框。 单击表格右上部的 Auto 按钮， 在弹出的对话框中分别在 From 和 To 空白处输

入 551 和 555， 单击 OK 按钮两次来退出对话框。
提示： 为齿轮中心的离散点划分网格的目的是为定义 Rigid Links 作准备， ADINA 软件〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

规定必须为离散点划分网格。〰〰〰〰〰〰〰〰〰〰〰〰〰
划分齿轮网格的操作如下： 单击菜单 Meshing→Create Mesh→Face （或图标 ）， 将弹出

Mesh Faces 对话框。 分别在 Element Group、 Nodes per Element 和 Parent Body 中选择 1、 4 和

1， 在表格的第 1 行输入 1， 单击 Apply 按钮； 分别在 Element Group、 Nodes per Element 和
Parent Body 中选择 2、 4 和 2， 在表格的第 1 行输入 1， 单击对话框上部的 Nodal Options 标签

页， 在 Nodal Coincidence Checking 的 Check 下拉菜单中选择 Against Same Element Group Only
或 No Checking， 单击 Apply 按钮； 单击对话框上部的 Basic 标签页， 分别将 Element Group、
Nodes per Element 和 Parent Body 选择为 3、 4 和 3， 在表格的第 1 行输入 1， 单击对话框上部

的 Nodal Options 标签页， 确认 Nodal Coincidence Checking 的 Check 下拉菜单中选择 Against
Same Element Group Only 或 No Checking， 单击 Apply 按钮。 按照相同的操作方法使用单元组

4 划分 body4 的 face1， 单击 Apply 按钮； 使用单元组 5 划分 body5 的 face1， 单击 OK 按钮。
此时， 网格划分完毕， 单击图标 （YZ 平面）， 图形区中将显示如图 8-7 所示的模型。

图 8-7　 划分网格后的模型

6. 定义接触

定义接触组的操作如下： 单击菜单 Model→Contact→
Contact Group （或图标 ）， 将弹出 Define Contact Group
对话框。 单击 Add 按钮来设置接触组 1， 确认 Type 类型

为 2- D Contact， 在 Default Coulomb Friction Coefficient 空白

框处输入 0. 1， 其他设置保持默认不变， 单击 OK 按钮。
定义接触面的操作如下：
1） 单击菜单 Model→Contact→Contact Surface （或图

标 右侧的下拉菜单， 然后选择图标 ）， 在弹出的对话

框中单击 Add 按钮来定义接触面 1， 将 Defined on 选择为

Edges of a Body， 确认 Body 为 1； 单击表格上部的 Auto 按

钮， 分别在 From 和 To 的空白处输入 2 和 241， 单击 OK， 单击 Save 按钮保存。
2） 单击 Add 按钮来定义接触面 2， 确认 Defined on 选择为 Edges of a Body， Body 选择为

2， 单击表格上部的 Auto 按钮， 分别在 From 和 To 的空白处输入 1 和 60， 单击 OK， 单击

Save 按钮保存。
3） 单击 Add 按钮来定义接触面 3， 确认 Defined on 选择为 Edges of a Body， Body 选择为

3， 单击表格上部的 Auto 按钮， 分别在 From 和 To 的空白处输入 1 和 60， 单击 OK， 单击

Save 按钮保存。
4） 单击 Add 按钮来定义接触面 4， 确认 Defined on 选择为 Edges of a Body， Body 选择为

4， 单击表格上部的 Auto 按钮， 分别在 From 和 To 的空白处输入 1 和 60， 单击 OK， 单击

Save 按钮保存。
5） 单击 Add 按钮来定义接触面 5， 确认 Defined on 选择为 Edges of a Body， Body 选择为
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5， 单击表格上部的 Auto 按钮， 分别在 From 和 To 的空白处输入 1 和 120， 单击 OK 按钮两

次退出对话框。
定义接触对的操作如下：
1） 单击菜单 Model→Contact→Contact Pair （或图标 右侧的下拉菜单， 然后选择图标

）， 将弹出 Define Contact Pairs 对话框。
2） 单击 Add 按钮来设置接触对 1， 将 Target Surface 选择为 1， 将 Contactor Surface 选择

为 2， 单击 Save 按钮。
3） 单击 Add 按钮来设置接触对 2， 将 Target Surface 选择为 1， 将 Contactor Surface 选择

为 3， 单击 Save 按钮；
4） 单击 Add 按钮来设置接触对 3， 将 Target Surface 选择为 1， 将 Contactor Surface 选择

为 4， 单击 Save 按钮；
5） 单击 Add 按钮来设置接触对 4， 将 Target Surface 选择为 5， 将 Contactor Surface 选择

为 2， 单击 Save 按钮；
6） 单击 Add 按钮来设置接触对 5， 将 Target Surface 选择为 5， 将 Contactor Surface 选择

为 3， 单击 Save 按钮；
7） 单击 Add 按钮来设置接触对 6， 将 Target Surface 选择为 5， 将 Contactor Surface 选择

为 4， 单击 OK 按钮。 此时， 接触定义完毕。
7. 定义并施加约束

单击菜单 Control→Degrees of Freedom， 将弹出 Degree of Freedom 对话框， 退选 X- Trans-
lation、 Y- Rotation 和 Z- Rotation 选项后单击 OK 按钮。

单击菜单 Model→Boundary Conditions→Apply Fixity （或图标 ）， 将弹出 Apply Fixity 对

话框。 依次单击 Define 和 Add 按钮， 输入名字 c 后单击 OK 按钮； 勾选 Y- Translation 和

Z- Translation， 单击 OK 按钮； 确认 Apply to 选择为 Points， 单击表格上部的 Auto 按钮， 将弹

出 Auto Generation 对话框， 在 From 行空白处分别输入 551 和 C， 在 To 行分别输入 555 和 C，
单击 OK 按钮两次退出对话框。 此时， 约束定义完毕。

提示： 定义的约束 C 仅保留了绕 X 轴转动的自由度， 即这 5 个齿轮的中心点仅能绕 X〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
轴转动， 不能平动。〰〰〰〰〰〰〰〰〰

8. 定义特殊边界条件

定义 Rigid Links 边界条件的操作如下： 单击菜单 Model→Constraints→Rigid Links， 将弹

出 Define Rigid Links 对话框。 单击 Add 按钮， 确认 Master 下的 Entity Type 为 Point， 并在

Entity空白框中输入 551， 将 Slave 下的 Entity Type 选择为 Edge， 并在 Entity 空白框中输入 121，
将 Body 选择为 5， 在表格的第 1 行输入 122， 将 Displacements 选择为 Large， 单击 Save 按钮。

按照相同的操作方法， 为其他齿轮的中心点与齿轮内径定义 Rigid Links （需要注意的

是： 点 555 应该与 Body1 的外径定义 Rigid Links）， 共定义了 5 个 Rigid Links。 此处省略了详

细的定义步骤， 请读者自行查看命令流文件以确认定义无误。
9. 定义时间函数

单击菜单 Control→Time Function， 将弹出 Define Time Function 对话框。 单击 Add 按钮来

定义时间函数 2， 在表格的第 1 行依次输入 0、 0， 在表格的第 2 行依次输入 0. 01、 0， 在表

格的第 3 行依次输入 1. 01、 1， 单击 OK 按钮退出对话框。 此时， 时间函数定义完毕。
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提示： 本实例包含两种载荷： 扭矩和位移。 其中， 时间函数 1 用于控制扭矩载荷的施〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
加， 时间函数 2 用于控制位移载荷的施加。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

10. 定义并施加载荷

定义扭矩载荷的操作步骤如下：
单击菜单 Model→Loading→Apply （或图标 ）， 将弹出 Apply Load 对话框。 将 Load

Type 选择为 Moment， 依次单击 Define 按钮和 Add 按钮， 在 Magnitude 的空白框处输入 1， 单

击 OK 按钮。 确认 Apply to 为 Point， 在表格的第 1 行输入 555， 单击 Apply 按钮而不关闭对

话框。 将 Load Type 选择为 Displacment， 依次单击 Define 按钮和 Add 按钮， 在 Prescribed
Values of Rotation 的 X 空白框处输入 1， 单击 OK 按钮。 确认 Apply to 为 Point， 在表格第 1
行的 Site# 处输入 551， 在 Time Function 处输入 2， 单击 OK 按钮。

此时， 载荷定义并施加完毕。 依次单击图标 、 、 和 ， 图形区中将显示如图 8-8
所示的模型示意图。

图 8-8　 图形区中显示的模型示意图

提示： 施加扭矩时， 对于不同的问题应〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
该施加不同的扭矩值。 本实例仅作为示范，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
因此将扭矩大小定义为 1； 同时， 转动位移也〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
定义为 1， 相当于转动了 1rad （分析实际问〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
题时， 该位移值根据具体问题来设定）， 再参〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
照时间函数 2， 表明在时间 0. 01 ～ 1. 01 范围〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
内， 齿轮匀速转动了 1rad。〰〰〰〰〰〰〰〰〰〰〰〰

11. 定义时间步

单击菜单 Control → Time Step， 将弹出

Define Time Step 对话框。 将表格的第 1 行依

次改为 101、 0. 01， 单击 OK 按钮退出对话框。 时间步定义完毕。
12. 定义模型控制参数

1） 将程序模块的计算类型改为 Dynamics- Implicit， 单击右侧的 按钮， 将弹出 Implicit
Transient Dynamics 对话框， 勾选 Use Automatic Time- Stepping 选项， 将 Alpha 系数修改为

0. 5， 如图 8-9 所示， 单击 OK。

图 8-9　 定义模型控制参数
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2） 单击菜单 Control→Analysis Assumptions→Kinematics， 将弹出 Kinematics 对话框， 将

Displacements / Rotations 选择为 Large， 单击 OK 按钮。
3） 单击菜单 Control→Solution Process， 将弹出 Solution Process 对话框。 单击 Iteration

Method 按钮， 在弹出的 Nonlinear Iterations Setting 对话框中将 Maxisum Number of Iterations 修

改为 50， 在 Use of Line Searches 下拉菜单中选择 Yes， 单击 OK 按钮两次退出对话框。

8. 2. 3　 求解

单击菜单 File→Save （或图标 ）， 将文件保存为 M- example02. idb。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 M- example02， 同时勾选 Run
Solution 和 Automatic Memory Allocation 选项， 单击保存按钮并等待计算结束。

提示： 在计算过程中单击 Nonlinear Convergence， 可以查看当前步的收敛曲线。 接触问〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
题分析中， 在某些计算时间点可能出现接触振荡现象 （如图 8-10 所示）， 使得该时间步的〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
接触计算可能不收敛。 采用自动时间步长后， ADIAN 软件将自动更改时间步长的大小， 使〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
得接触分析能够收敛， 这也是非线性分析打开自动时间步长的优势所在。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

图 8-10　 查看计算收敛情况

8. 2. 4　 后处理

1） 程序模块选择为 Post- Processing。 单击菜单 File→Open （或图标 ） 来打开结果文

件 M- example02. por。
2） 查看齿轮有效应力： 依次单击图标 和 ， 并退选图标 和 ， 再依次单击图标

和 ， 此时， 图形区中将显示齿轮的有效应力结果云图。 单击图标 和 可以查看各时间步

的有效应力结果。 需要注意的是： 对于设置 Rigid Links 的边域， 有效应力的结果显示是不

准确的， 读者应该关注轮齿附近的应力。
3） 制作接触力动画： 单击图标 来清除云图显示。 单击菜单 Display→Reaction Plot→

Create， 在弹出的对话框中确认 Reaction Quantity 选择为 CONSISTENT_CONTACT_FORCE，
单击 OK 按钮。 单击图标 可以制作接触力动画， 动画制作完毕单击图标 可以播放动画，
此时动画的速度往往非常快。 单击菜单 Display→Animate， 在弹出的对话框中为 Minidelay 输
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入 20， 单击 OK 按钮。 此时， 单击图标 将发现动画播放的速度变慢了很多。 仔细观察动

画， 在齿轮转动时轮齿间不应该出现较大的穿透和回弹。
4） 查看齿轮中心点的位移时程和速度时程曲线： 单击图标 来退出动画播放状态。 首先定

义两个 modle point， 操作如下： 单击菜单 Definations→Modle Point→Node， 在弹出的对话框中单

击 Add 按钮， 然后在弹出的对话框中输入1， 单击OK 按钮， 确认 Node #为 1， 单击 Save 按钮； 再

次单击Add 按钮， 在弹出的对话框中输入5， 单击OK按钮， 在Node #中输入5， 单击OK按钮。
① 查看齿轮中心点位移时程曲线的操作如下： 单击图标 来清空图形区。 单击菜单

Graph→Response Curve （Modle Point）， 在弹出的对话框中修改 Y Coordinate 的 Variable 为

Displacement， X- Rotation， 单击 Apply 按钮； 将 X Coordinate 和 Y Coordinate 的 Modle Point 都
改为 5， 将 Graph Attributes 的 Plot Name 选择为 PREVIOUS， 单击 OK 按钮。 此时， 图形区的

显示效果如图 8-11 所示。

图 8-11　 齿轮中心点绕 X 轴转动位移的时程曲线

② 查看齿轮中心点速度时程曲线的操作如下： 单击图标 来清空图形区。 单击菜单

Graph→Response Curve （Modle Point）， 在弹出的对话框中修改 Y Coordinate 的 Variable 为

Velocity， X—ANGULAR_Rotation， 单击 Apply 按钮； 将 X Coordinate 和 Y Coordinate 的 Modle
Point 都修改为 5， 将 Graph Attributes 的 Plot Name 选择为 PREVIOUS， 单击 OK 按钮。 此时，
图形区的显示效果如图 8-12 示。

图 8-12　 齿轮中心点绕 X 轴转动速度的时程曲线
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提示： 从位移时程曲线可以看出， 外齿轮的位移振荡不大， 基本上延续线性发展； 从速度〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
时程曲线可以看出， 外齿轮绕 X 轴转动速度以 -0. 5 为中心上下振荡， 且振荡幅度较明显。 在〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
齿轮传动过程中， 出现振荡是一种正常现象， 关键是要考查计算振荡的结果是否合理。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
8. 2. 5　 应用推广

本实例为二维模型实例， 还可以将其推广到三维模型中， 读者可自行研究并计算。 ADINA
软件具有很强的接触非线性计算能力， 可以计算像齿轮、 轴承及其更复杂的工程结构等问题。

8. 3　 钢球撞击薄板分析

8. 3. 1　 问题描述

本实例为钢球撞击薄板分析， 与 8. 2 采用的隐式积分算法不同， 本实例将采用 ADINA
软件的显式积分算法。 实例中将分别计算两种不同速度冲击下的结构响应： 低速时钢球冲击

薄板并反弹回来； 高速时钢球冲击薄板使薄板发生失效破坏并穿透薄板。 通过学习本实例，
读者可以掌握下列几个功能：

1） 显式积分算法的应用。
2） 罚函数接触的应用。
3） 材料失效的应用。
本实例完整的命令流文件为 M- example03a. in 和 M- example03b. in， 其中， M- exam-

ple03a. in 为低速冲击命令流文件， M- example03b. in 为高速冲击命令流文件。 复制此命令流

文件时， 一定同时复制几何点坐标文件 M- example03- point. txt， 上述文件均保存于随书光盘

文件夹 \ 8-3 \ model \ 中。
提示： 本实例的长度建模单位为 mm， 请读者注意。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

8. 3. 2　 前处理

1. 设定模型控制参数

启动 ADINA- AUI， 程序模块选择为 ADINA Structures， 算法选择为 Dynamics- Explicit，
单击图标 ， 将弹出 Explicit Transient Dynamics 对话框， 确认 Time Step 为 Automatic （Use
Total Time Specified）， 将 Time Step Magnitude Scaling Factor 修改为 1， 其余参数保存不变，
单击 OK 按钮。

单击菜单 Control→Analysis Assumpations→Kinematics， 将弹出 Kinematics 对话框， 在

Displacements / Rotations 中选择 Large， 将 Strains 选择为 Large， 将 Large Strain Formulation 选

择为 Updated Lagrangian Jaumann （ULJ）， 将 Use Incompatible modes in Element Formulation 选

择为 No， 单击 OK 按钮。
提示： 本实例是典型的大位移、 大应变问题， 因此， 应该在运动假设中选择大位移和大〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

应变， 同时将大应变算法选择为 ULJ。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
2. 定义几何

定义几何操作步骤如下：
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1） 单击生成点图标 ， 在弹出的对话框中单击 Import 按钮来导入文件 M- example03-
point. txt， 单击 OK 按钮。

2） 单击生成面图标 ， 单击 Add 按钮， 将 Type 选择为 Vertex， 选择点 1、 2、 3 和 4 来

生成面 1， 单击 Save 按钮。 单击 Add 按钮， 将 Type 类型选择为 Transformed， 单击 Transfor-
mation 右侧的图标 ， 在弹出的对话框中单击 Add 按钮来定义 Transformation 1， 在 X 的空

白框处输入 100， 单击 OK 按钮。 将 Transformation 选择为 1， 在 Parent Surface 空白框处输入

1， 单击 Save 按钮， 生成面 2； 按照相同的操作方法来定义 Transformation 2， 在 X 处输入

- 100， 在 Parent Surface 处输入 1， 将 Transformation 选择为 2， 生成面 3； 按照相同的操作

方法来定义 Transformation 3， 在 Y 处输入 100， 在 Parent Surface 处输入 1， 在表格的前两行

输入 2 和 3 来生成面 4、 5 和 6； 按照相同的操作方法来定义 Transformation 4， 在 Y 处输入

- 100， 在 Parent Surface 处输入 1， 在表格的前两行输入 2 和 3 来生成面 7、 8 和 9。
3） 单击生成线图标 ， 在弹出的对话框中单击 Add 按钮， 将 Type 选择为 Arc， 分别在

P1、 P2 和 Center 处输入 7、 6 和 5； 单击 Add 按钮， 分别在 P1、 P2 和 Center 处输入 6、 8 和

5， 单击 OK 按钮。
4） 单击生成面图标 ， 将 Type 选择为 Revoled， 将 Axis 选择为 Z， 将 Initial Line 选择

为刚才生成的一段圆弧线， 在表格的第 1 行选择生成的另一段圆弧线， 在 Angle of Rotation
处输入 90， 单击 Save 按钮。 单击 Add 按钮， 将 Type 类型选择为 Transformed， 将 Transforma-
tion 选择为 5， 在 Parent Surface 的空白框处输入 10， 在表格的第 1 行输入 11， 将 Number of
Copies 修改为 3， 并勾选 Check Coincidence 选项， 单击 OK 按钮。 读者可以查看本实例的命

令流文件来了解此几何建模过程。 依次单击图标 和 ， 图形区将显示如图 8-13 所示的模

型示意图。

图 8-13　 图形区中显示的模型示意图

提示： 如果几何中包含许多相同的几何部件， 一定要充分利用 Transformation 功能将其〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
复制， 使得建模过程更加简单快捷。 需要注意的是： 本实例并未定义 Transformation 5， 它是〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
在生成圆弧面 10 和 11 时由系统自动生成的。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

3. 定义网格密度

定义网格密度的操作步骤如下：
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1） 单击菜单 Meshing→Mesh Density→Surface， 将弹出 Define Surface Mesh Density 对话

框， 在 Number of Subdivisions 的 u 处输入 48， 在 v 处输入 48， 单击 Save 按钮。 将 Surface
Number 选择 2， 在表格的第 1 行输入 3， 在 Number of Subdivisions 的 u 处输入 12， 在 v 处输

入 48， 单击 Save 按钮。 将 Surface Number 选择为 4， 在表格的第 1 行输入 7， 在 Number of
Subdivisions 的 u 处输入 48， 在 v 处输入 12， 单击 Save 按钮。 将 Surface Number 选择为 5，
在表格的前 3 行依次输入 6、 8、 9， 在 Number of Subdivisions 的 u 处输入 12， 在 v 处输入

12， 单击 OK 按钮。
2） 单击菜单 Meshing→Mesh Density→Line， 将弹出 Define Line Mesh Density 对话框， 将

Line Number 处选择 6， 分别在表格的前 3 行输入 25、 12、 15， 在 Number of Subdivisions 处输

入 12， 单击 OK 按钮。
3） 单击菜单 Meshing→Mesh Density→Surface， 将弹出 Define Surface Mesh Density 对话

框， 将 Surface Number 选择为 10， 在表格前 7 行分别输入 11 ～ 17 （共 7 个面）， 也可以使用

auto 功能输入， 在 Number of Subdivisions 的 u 处输入 16， 在 v 处输入 16， 单击 OK 按钮。
此时， 模型网格密度定义完毕， 图形区将显示如图 8-14 所示的模型示意图。

图 8-14　 图形区中显示的模型示意图

提示： 对于关心区域和计算核心区域， 网格密度应该设置得细密一些， 对于不关心区域〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
和计算次要区域， 网格密度可以设置得稀疏些， 这样不仅能够顺利完成计算任务， 还能够减〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
少计算代价、 提高计算效率。〰〰〰〰〰〰〰〰〰〰〰〰〰

4. 定义约束

单击施加约束图标 ， 在弹出的对话框中将 Apply to 选择为 lines， 双击表格第 1 行的绿

色图框， 选中平板四周外围的 12 条边， 单击 OK 按钮。 此时， 施加约束定义完毕。 单击图

标 ， 图形区将显示如图 8-15 所示的模型示意图。
5. 定义和施加初始条件

1） 单击菜单 Model→Initial Condition→Define， 在弹出的对话框中单击 Add 按钮， 在空

白框中输入 zv， 并单击 OK 按钮。 在表格第 1 行的 Variable 选择 Z- Velocity， 在 Value 空白框

处输入 - 800， 单击 OK 按钮。
2） 单击菜单 Model→Initial Condition→Apply， 将弹出 Apply Initial Conditions 对话框， 将
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图 8-15　 图形区显示的模型示意图

Apply to 选择为 Surfaces， 确认 Default Initial Condition 为 ZV， 单击 Auto 按钮， 将弹出对话

框， 分别在 From 和 To 空白处输入 10 和 17， 单击 OK 按钮两次退出对话框。 此时， 初始条

件定义并施加完毕。
6. 定义材料

定义材料的操作步骤如下：
1） 单击定义材料图标 ， 在弹出的对话框中单击 Plastic 下的 Bilinear 按钮， 在弹出的

对话框中定义材料 1， 分别在 Young’s Modulus 处输入 70500， 在 Poisson’s Ratio 处输入 0. 34，
在 Initial Yield Stress 处输入 180， 在 Density 处输入 2. 7e-9， 在 Strain Hardening Modulus 处输

入 141， 在 Max. Allowable Effective Plastic Strain 处输入 0. 25， 单击 Save 按钮。
2） 单击 Add 按钮来定义材料 2， 在 Young’s Modulus 处输入 2e5， 在 Poisson’s Ratio 处输

入 0. 3， 在 Initial Yield Stress 处输入 500， 在 Density 处输入 7. 8e-9， 在 Strain Hardening Mod-
ulus 处输入 200， 单击 OK 按钮。 单击 Close 按钮退出材料定义对话框， 材料定义完毕。

提示： 材料 1 中设置了失效应变， 当单元积分点的塑性应变值达到 0. 25 时， 该单元将〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
失效并死掉。 在定义材料 1 的窗口中单击 Graph 按钮， 将弹出如图 8-16 所示的材料曲线，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
易知材料在达到最大塑性应变后将失效。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

7. 定义单元组

1） 单击定义单元组图标 ， 在弹出的对话框中单击 Add 按钮来定义单元组 1， 将

Type 选择为 Shell， 确认 Default Material 为 1， 将 Default Element Thickness 修改为 2， 单击

Save 按钮。
2） 单击 Add 按钮来定义单元组 2， 将 Type 选择为 Shell， 将 Default Material 选择为 2，

将 Default Element Thickness 修改为 1. 5， 单击 OK 按钮， 单元组定义完毕。
提示： 如果单元组内所有的单元厚度都相同， 则只需设定单元组内单元厚度即可 （本〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

实例就是这样操作的）。 当单元厚度不相同时， 如果可以按照几何面来区分厚度， 则可以单〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
击菜单 Geometry→Surface→Thickness 来设定每个面的厚度； 划分了网格后， 还可以单击菜单〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
Meshing→Elements→Shell Thickness 来设定壳单元厚度， 可以通过此菜单来设置变截面壳的〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
厚度。〰〰
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图 8-16　 材料 1 的材料曲线示意图

8. 划分网格

单击划分面网格图标 ， 在弹出的对话框中确认 Element Group 为 1， 使用 Auto 按钮在

表格中输入面 1 ～ 9， 单击 Apply 按钮。
按照相同的操作方法将 Element Group 选择为 2， 使用 Auto 按钮在表格中输入面 10 ～ 17，

单击 OK 按钮。
此时， 模型网格划分完毕， 请确认网格均为映射网格。 单击分单元组显示图标 ， 图形

区将显示如图 8-17 所示的模型示意图。

图 8-17　 图形区显示的模型示意图
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9. 定义接触

1） 单击菜单Model→Contact→Contact Control， 在弹出的对话框中将 Default Contact Algo-
rithm 选择为 Penalty， 其余设置不变， 单击 OK 按钮。

2） 单击定义接触组图标 ， 在弹出的对话框中单击 Add 按钮， 将 Type 选择为 3- D
Contact， 其余设置不变， 单击 OK 按钮。

3） 单击定义接触面图标 ， 在弹出的对话框中单击 Add 按钮来定义接触面 1， 使用

Auto 功能在表格中输入面 10 ～ 17， 单击 Save 按钮。 单击接触法向图标 检查图形区球面的

接触法线方向， 正确的方向应该指向球心。
4） 单击 Add 按钮来定义接触面 2， 在表格的第 1 行输入 1， 单击 Save 按钮。 然后检

查接触法线方向， 正确的方向应为指离球面一侧向下， 单击 Cancel 退出定义接触面对

话框。
5） 单击定义接触对图标 ， 在弹出的对话框中单击 Add 按钮来定义接触对 1， 将 Con-

tactor Surface 选择为 2， 单击 OK 按钮退出对话框。 此时， 接触定义完毕。
提示： 正确的接触方向应为背对背， 如果接触法向定义错误， 则定义接触面时 Orienta-〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

tion Determined 应该选择为 From Table Input， 在表格中将 Orientation 选择为 Opposite to Geom-〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
etry， 然后再检查接触方向是否正确。 本实例中的接触面均为壳面， 由于没有定义实体几何，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
因此定义接触时需要检查接触的法线方向， 这点与前两个实例的定义接触不同， 前两个实例〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
都是实体几何之间的接触， 因此无须检查接触方向是否正确。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

10. 定义时间步

单击菜单 Control→Time Step， 将弹出 Define Time Step 对话框， 在表格的第 1 行改为 30，
0. 0005， 单击 OK 按钮退出对话框。

8. 3. 3　 求解

单击菜单 File→Save （或图标 ）， 将文件保存为 M- example03a. idb。 单击菜单 Solution→
Data File / Run （或单击图标 ）， 在弹出的对话框中输入文件名 M- example03a， 同时勾选

Run Solution 和 Automatic Memory Allocation 标签， 单击保存按钮， 等待计算结束。

8. 3. 4　 后处理

1） 程序模块选择 Post- Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

M- example03a. por。
2） 查看位移动画： 单击 YZ view 图标 ， 退选显示接触图标 ， 单击制作动画图标

等待动画制作完毕， 单击播放动画图标 可以观看动画。 如果动画播放的速度太快， 可

以单击菜单 Display→Animate， 在弹出的对话框中为 Minimum Delay 输入 10， 单击 OK 按

钮。 重新单击播放动画图标 来观看动画， 单击图标 保存动画， 单击刷新图标 退出动

画状态。
3） 查看薄板有效应力动画： 单击改变 zone 图标 来单独显示 EG1， 分别单击 XY view

图标 、 轮廓线图标 、 快速云图图标 、 光滑处理图标 和制作动画图标 ， 并等待动画

制作完毕。 单击菜单 Display→Animate， 在弹出的对话框中为 Minimum Delay 输入 10， 单击

OK 按钮。 单击图标 观看动画， 单击图标 保存动画。
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8. 3. 5　 修改初始条件及时间步

1） 程序模块选择 ADINA Structures， 打开文件 M- example03a. idb。 单击菜单 Model→
Initial Condition→Define， 在弹出的对话框中确认 Condition Name 为 zv， 并将表格第 1 行的

Value 值修改为 - 80000， 单击 OK 按钮。
2） 单击菜单 Control→Time Step， 在弹出的对话框中将表格第 1 行的 Value 值修改为 20，

0. 00025， 单击 OK 按钮退出对话框。

8. 3. 6　 求解

单击菜单 File→Save （或图标 ）， 将文件保存为 M- example03b. idb。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 M- example03b， 确认同时勾选了

Run Solution 和 Automatic Memory Allocation 标签， 单击保存按钮， 等待计算结束。

8. 3. 7　 后处理

1） 程序模块选择为 Post- Processing。 待计算结束后， 单击菜单 File→Open （或图标 ）
来打开结果文件 M- example03b. por。

2） 查看位移动画： 单击阴影显示图标 ， 退选显示接触图标 ， 单击轮廓线图标 和

分组显示图标 ， 旋转图形区中的几何至图 8-18 所示的位置。 单击制作动画图标 ， 并等

待动画制作完毕， 单击播放动画图标 观看动画， 单击保存动画图标 保存动画， 最后单击

刷新图标 退出动画状态。

图 8-18　 图形区中显示的模型结果

3） 查看薄板有效应力动画： 单击改变 zone 图标 来单独显示 EG1， 单击 XY view 图标

、 快速云图图标 、 光滑处理图标 和制作动画图标 ， 并等待动画制作完毕。 单击播放

动画图标 观看动画， 单击保存动画图标 保存动画。

8. 3. 8　 应用推广

本实例可以推广应用到冲击碰撞等问题的分析中， 例如， 鸟撞分析， 落锤分析， 保险杠



第 8 章　 机械实例分析

Focused on Excellence　 201　　

抗冲击分析等。

8. 4　 周期对称结构的力学分析

8. 4. 1　 问题描述

本实例将对周期对称结构的力学分析加以介绍。 首先对模型进行简单的静力计算， 然后

修改模型的分析类型， 进行模态计算。 对于周期对称结构的力学分析问题， ADINA 软件可

以采用简化建模方式来完成， 即： 只需在 AUI 中建立周期对称结构的单个子模型， 通过设

置周期对称来得到整个模型， 并计算整体模型的动力响应。 通过学习本实例， 读者可以掌握

下列几个功能：
1） 设置粘结网格 （Glue Mesh） 的方法。
2） 设置周期对称 （Cyclic Symmetry） 的方法。
本实例完整的命令流文件为 M- example04a. in 和 M- example04b. in， 其中， M- exam-

ple04a. in 为静力计算命令流文件， M- example04b. in 为模态计算命令流文件。 复制命令流文件

时， 一定要同时复制几何文件 M- example04s. x_t， 上述文件均保存在随书光盘文件夹 \ 8-4 \
model \ 中。

8. 4. 2　 前处理

1. 定义几何

1） 启动 ADINA- AUI， 程序模块选择 ADINA Structures。 单击菜单 ADINA-M→Import
Parasolid Model （或图标 ） 来打开文件 M- example04s. x_t。

2） 单击定义 Volume 图标 ， 然后单击 Add 按钮， 将 Type 选择为 Body， 勾选 Convert
All Bodies 和 Convert Curved Edges to Splines 选项， 单击 OK 按钮。 图形区将显示如图 8-19 所

示的模型示意图。

图 8-19　 图形区显示的模型示意图
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提示： 该操作的目的是将 5 个 Body 转换为 5 个 Volume， 以便定义网格密度。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
2. 定义网格密度

1） 单击显示 Volume 编号图标 ， 确认 Volume 的编号和方向。
2） 单击菜单 Meshing→Mesh Density→Volume， 在弹出的对话框中将 Number of Subdivi-

sions 下的 u 输入 4， v 输入 6， w 输入 4， 单击 Save 按钮。 将 Volume Number 选择为 2， 在表

格的第 1 行输入 3， 在 Number of Subdivisions 的 u 处输入 4， v 处输入 6， w 处输入 3， 单击

Save 按钮。 将 Volume Number 选择为 4， 在 Number of Subdivisions 的 u 处输入 6， v 处输入 6，
w 处输入 4， 单击 Save 按钮。 将 Volume Number 选择为 5， 在 Number of Subdivisions 的 u 处

输入 8， v 处输入 1， w 处输入 20， 单击 OK 按钮。
此时， 模型网格密度设定完毕， 图形区中将显示如图 8-20 所示的模型示意图。

图 8-20　 图形区中显示的模型示意图

3. 定义材料

单击菜单Model→Material→Manage Material （或图标 ）， 将弹出材料定义对话框， 单击

Elastic 下的 Isotropic 按钮来定义线弹性材料。 在弹出的对话框中单击 Add 按钮来定义材料

1， 在 Young’s Modulus 处输入 2 e11， 在 Poisson’s Ratio 处输入 0. 3， 在 Density 处输入 7800，
单击 OK 按钮和 Close 按钮退出对话框。 此时， 材料定义完毕。

4. 定义单元组

本实例需要定义两个单元组。 单击菜单 Meshing→Element Group （或图标 ）， 将弹出

定义单元组对话框。 单击 Add 按钮来定义单元组 1， 将 Type 选择为 3- D Solid， 确认 Default
Material 选择为 1， 其余设置保持不变， 单击 Save 按钮。 单击 Copy 按钮， 在弹出的对话框中

保持默认设置不变， 则将单元组 1 的设置复制给单元组 2， 单击 OK 按钮和 Cancel 按钮退出

对话框。 此时， 单元组定义完毕。
5. 划分网格

单击划分体网格图标 ， 在弹出的对话框中， 将 Element Group 选择为 1， Nodes Per Ele-
ment 选择为 8， 使用 Auto 按钮在表格中输入体 1 ～ 4， 单击 Apply 按钮。 将 Element Group 选

择为 2， 在表格的第 1 行输入 5， 单击对话框上部的 Nodal Coincidence 标签， 将 Check 选择

为 Against Same Element Group Only， 单击 OK 按钮。 模型网格划分完毕， 请确认网格均为映
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射网格， 依次单击图标 和 ， 图形区将显示如图 8-21 所示的模型示意图。

图 8-21　 图形区显示的模型示意图

6. 设置粘结网格

通过上面的操作可知， EG1 和 EG2 的网格并不连续， 因此， 需要设置粘结网格将两个

单元组的网格粘结在一起。 对应的操作如下：
单击菜单Meshing→Glue Mesh， 在弹出的对话框中单击 Add 按钮来设置 Glue Mesh Set 1，

将 ApplyTo 选择为 Surface / Face， 将表格第 1 行的 Type 选择为 Surface， 在 Label 处输入 3， 将

Side 选择为 Master； 将表格第 2 行的 Type 选择为 Surface， 在 Label 处输入 22， 将 Side 选择

为 Slave， 单击 OK 按钮。
提示： 该操作的目的是将面 3 处和面 22 处的网格粘结到一起， 由于面 3 的面积大于面〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

22， 因此应该设置面 3 为 Master。 如果 Master 面和 Slave 面的间隙较大， 设定粘结网格时注〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
意调整 Extension Factor （默认值为 0. 01）。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

7. 设置周期对称

1） 单击菜单 Model→Cyclic Symmetry→Control， 将弹出 Cyclic Symmetry 对话框， 在

Number of Cyclic Symmetry Parts （NC） 处输入 32， 单击 Cyclic Symmetry Axis （0 = Global X
Axis） 右侧的图标 ， 在弹出的对话框中单击 Add 按钮， 将 Axis 选择为 Z， 单击 OK 按钮，
返回到 Cyclic Symmetry 对话框， 将 Cyclic Symmetry Axis （0 = Global X Axis） 选择为 1， 单击

OK 按钮。
2） 单击菜单 Model→Cyclic Symmetry→Boundaries， 在弹出的对话框中将 Defined by 选择

为 Surfaces， 然后按照表 8-1 提供的数据输入对话框， 单击 OK 按钮。

表 8-1　 对称边界

Slave　 Surface # Master　 Surface #

19 20
9 7
4 2
12 14
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图 8-22　 Slave Surface 和 Master Surface
设置错误时的提示信息

提示： 表 8-1 中 Slave Surface 和 Master〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
Surface 的顺序不能够相互颠倒， 否则， ADINA〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
软件将弹出如图 8-22 所示的错误信息。 选取〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
Master 面和 Slave 面时， 应该按照右手螺旋定〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
则确定， 从 Master 面旋转到 Slave 面应该满足〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
右手螺旋法则， 设置时请读者注意。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

8. 定义约束

单击施加约束图标 ， 在弹出的对话框中将 Apply to 选择为 Surfaces， 在表格的第 1 行

输入 18， 单击 OK 按钮。 此时， 面 18 将施加所有约束。
9. 定义载荷

单击施加载荷图标 ， 在弹出的对话框中将 Load Type 选择为 Pressure， 单击对话框右

上角的 Define 按钮， 在弹出的对话框中单击 Add 按钮， 在 Magnitude （Force / Area） 处输入

1000， 单击 OK 按钮。 将 Apply to 选择为 Surfaces， 在表格的第 1 行的 Site #下输入 25， 单击

OK 按钮。
依次单击图标 和 ， 然后单击显示载荷图标 和约束图标 ， 图形区将显示如图 8-23

所示的模型示意图。

图 8-23　 图形区显示的模型示意图

提示： 由图 8-23 可知， 约束作用于整个模型， 而载荷仅作用在 1 个周期结构上， 如果〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
希望让整个模型都施加相同的载荷， 则应在设置周期对称时按照如下方法操作： 单击菜单〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
Model→Cyclic Symmetry→Control， 在弹出的对话框中勾选 Assume Periodic Symmetry （Har-〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
monic 0 Only） 选项。〰〰〰〰〰〰〰〰〰
8. 4. 3　 求解

单击菜单 File→Save （或图标 ）， 将文件保存为 M- example04a. idb。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 M- example04a， 同时勾选 Run
Solution 和 Automatic Memory Allocation 选项， 单击保存按钮， 等待计算结束。
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8. 4. 4　 后处理

1） 程序模块选择为 Post- Processing。 单击菜单 File→Open （或图标 ） 打开结果文件

M- example04a. por。
2） 查看结构有效应力云图： 依次单击快速云图图标 、 光滑处理图标 和缩放变形图

标 ， 图形区中将显示如图 8-24 所示的模型示意图。

图 8-24　 图形区中显示的模型示意图

8. 4. 5　 修改模型

将程序模块选择为 ADINA Structures， 然后打开文件 M- example04a. idb。 单击模型树

Loading 前面的加号， 用鼠标右键单击 Pressure 1 on Surface 25 （需要注意的是： 有些情况下

可能需要右击两次）， 再单击 Delete 按钮， 在弹出的对话框中单击 “是”， 目的是删掉压力

载荷。
将程序模块的分析类型选择为 Frequencies / Modes， 单击右侧的图标 ， 在弹出的对话框

中将 Number of Frequencies / Mode Shapes 修改为 10， 勾选 Solution Setting 下的 Allow Rigid
Body Mode 选项， 将 Solution Method 选择为 Lanczos Iteration， 单击 OK 按钮。

8. 4. 6　 求解

单击菜单 File→Save （或图标 ）， 将文件保存为 M- example04b. idb。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 M- example04b， 同时勾选 Run
Solution 和 Automatic Memory Allocation 选项， 单击保存按钮， 等待计算结束。

8. 4. 7　 后处理

1） 程序模块选择为 Post- Processing。 单击菜单 File→Open （或图标 ） 来打开结果文

件 M- example04b. por。
2） 查看结构的各阶模态： 单击图标 可以查看结构各阶模态的计算结果， 单击图标
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可以查看结构各阶模态的动画。 图 8-25 中给出了结构的第 10 阶模态计算结果。

图 8-25　 结构第 10 阶模态的计算结果

3） 单击定义 zone 图标 ， 在弹出的对话框中单击 Add 按钮， 然后输入 cyclic_part_5，
单击 OK 按钮。 将 Object 选择为 Cyclic Part， 单击 Enter 按钮， 将表格的第 1 行修改为 Cyclic
Part 5， 单击 OK 按钮。

4） 单击改变 zone 图标 ， 将 Zone Name 选择为 Cyclic_Part_5， 单击 OK 按钮。 此时，
图形区将只显示第 5 个周期体， 读者仅可以查看第 5 个周期体的计算结果。

8. 4. 8　 应用推广

本实例可以推广应用到水轮机、 飞机发动机等多叶片周期对称结构的模态分析计算。
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■ 9.1 刹车盘与闸片热力耦合分析

■ 9.2 阀门流固耦合分析
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响应分析
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耦合场实例分析
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本章将介绍耦合场的 5 个典型实例， 包括热力耦合和流固耦合计算。 其中， 9. 1 节 “刹
车盘与闸片热力耦合分析” 和 9. 3 节 “储液罐流固耦合模态及动力响应分析” 都在 ADINA-
Structures 模块中完成， 不须在其他模块中建模； 9. 2 节、 9. 4 节和 9. 5 节的实例则均属于流

固耦合问题， 需要在 ADINA- Structures 模块和 ADINA- CFD 模块中分别建模并生成求解文

件， 共同提交计算。

9. 1　 刹车盘与闸片热力耦合分析

9. 1. 1　 问题描述

本实例为刹车盘与闸片的热力耦合分析， 用来模拟刹车盘在制动过程中由于摩擦效应而

产生的热量及应力分布情况。 ADINA 8. 5 之后的版本在分析热力耦合问题时， 只需要在结构

场进行建模和设定分析过程， 而无须到热场进行设定， 给模拟工作带来了方便。 ADINA 软

件中的热力耦合算法为隐式积分算法， 能够较快收敛并得到准确的分析结果。 通过学习本实

例， 读者可以掌握下列几个功能：
1） 设定热力耦合分析 （TMC）。
2） 设定摩擦生热接触属性。
本实例完整的命令流文件为 C- example01. in， 复制此命令流文件时， 一定要同时复制时

间函数 2 所在文件 time—function2. txt， 它们均保存在随书光盘文件夹 \ 9-1 \ model \ 中。

9. 1. 2　 前处理

1. 设定模型控制参数

1） 启动 ADINA- AUI， 程序模块选择为 ADINA Structures， 算法选择为 Dynamics- Implicit，
单击右侧图标 ， 将弹出 Implicit Transient Dynamics 对话框， 将参数 Alpha 修改为 0. 5， 单击

OK 按钮。
2） 单击菜单 Control→TMC Model， 在弹出的对话框中将 Type of Solution 选择为 TMC

Iterative Coupling， 单击右侧的 按钮将弹出 Heat Transfer Analysis Control 对话框， 将 Analy-
sis Type 选择为 Transient， 将 Transient Analysis 的 Heat Capacity Matrix 选择为 Lumped， 单击

OK 按钮两次来退出对话框。
3） 单击菜单 Control→Analysis Assumptions→Kinematics， 在弹出的对话框中将 Displace-

ments / Rotations 选择为 Large， 其余参数不变， 单击 OK 按钮。
4） 单击菜单 Control→Analysis Assumptions→Default Temperature Settings， 在弹出的对话

框中在 Initial Temperature 中输入 20， 其余参数不变， 单击 OK 按钮。
5） 单击菜单 Control→Solution Process， 在弹出的对话框中单击 Iteration Method 按钮， 并

将 Maximum Number of Iteration 修改为 30， 点击 OK 按钮两次关闭对话框。
提示： 本实例为典型的大转动分析， 因此应该将运动假设选择为 Large。 模型中包含接触，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

需要将 Implicit Transient Dynamics 对话框中的参数 Alpha 修改为 0. 5。 由于环境温度为 20℃，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
因此需要在 Default Temperature Settings 对话框中的 Initial Temperature 空白框处输入 20。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

设定 TMC 分析时， Type of Solution 可以选择下列几种方式之一： Structure Only （结构〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
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场， 默认）、 TMC One-Way Coupling、 TMC Iterative Coupling 和 Heat Transfer Only。 其中，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
One-Way Coupling 的含义为单向耦合， 即热场的变化对结构场的变化无影响或影响非常小，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
可以忽略不计时才允许选用； TMC Iterative Coupling 的含义为双向耦合， 即热场和结构场相〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
互影响时才选用， 本实例属于第 2 种情况。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

2. 定义几何

1） 单击定义点的图标 ， 将弹出 Point Coordinates 对话框， 在表格第 1 行的 Point #栏输

入 1， 单击 OK 按钮， 此时将在原点处定义一个点。
2） 单击定义 Body 图标 ， 在弹出的对话框中单击 Add 按钮， Type 选择为 Pipe， 在 Ra-

dius 空白框处输入 0. 3， Thickness 处输入 0. 1， Length 处输入 0. 02， 单击 Save 按钮。 单击

Add 按钮， Type 选择为 Pipe， 在 Radius 空白框处输入 0. 29， Thickness 处输入 0. 08， Length
处输入 0. 02， 在 Pipe Center 的 Center Position 的 X 处输入 0. 02， 单击 OK 按钮。

3） 单击定义切平面图标 ， 在弹出的对话框中单击 Add 按钮， 将 Defined by 选择为

Z- Plane， 单击 Save 按钮。 单击 Add 按钮， 将 Defined by 选择为 Origin and Normal， 将

Outwards Normal 下的 X 修改为 0， Y 修改为 1， Z 修改为 - 0. 5， 单击 OK 按钮。
4） 单击修改 Body 图标 ， 在弹出的对话框中将 Modifier Type 选择为 Section， Target

Body 选择为 1， 勾选 Keep the Sheets After the Sectioning， 并在表格的第 1 行输入 1， 单击

Save 按钮； 将 Target Body 选择为 2， 在表格的前 2 行分别输入 1 和 2， 单击 OK 按钮。
5） 单击显示体编号图标 ， 然后单击删除 Body 图标 来删掉体 4、 5、 6， 删除完成后

按 Esc 键返回。
6） 单击修改 Body 图标 ， 在弹出的对话框中确认 Modifier Type 选择为 Blend， Target

Body 选择为 2， 在表格的前 4 行分别输入 3、 6、 8 和 12， 在 First Radius 处输入 0. 03， 单击

OK 按钮。
此时， 几何模型定义完毕， 依次单击图标 和 ， 图形区将给出如图 9-1 所示的模型示

意图。
提示： 将 Body1 分割为 Body1 和 Body3 的目的是便于划分映射网格， Body1 和 Body3 表〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

示刹车盘； Body2 为闸片。〰〰〰〰〰〰〰〰〰〰〰

图 9-1　 图形区
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3. 定义网格密度

1） 单击菜单 Meshing→Mesh Density→Edge， 在弹出的对话框中将 Body 选择为 1， Edge
选择为 1， 在表格的前 3 行分别输入 2、 3 和 6， 将 Method 选择为 Use Number of Division， 并

在 Number of Subdivisions 空白框处输入 32， 单击 Save 按钮； 将 Edge 选择为 7， 在表格的前 3
行分别输入 8、 9 和 10， 将 Method 选择为 Use Number of Division， 并在 Number of Subdivi-
sions 处输入 12， 单击 Save 按钮； 将 Edge 选择为 4， 在表格的前 3 行分别输入 5、 11 和

12， 将 Method 选择为 Use Number of Division， 并在 Number of Subdivisions 处输入 3， 单击

Save 按钮。
2） 将 Body 选择为 3， Edge 选择为 3， 在表格的前 3 行分别输入 5、 7 和 10， 将 Method

选择为 Use Number of Division， 并在 Number of Subdivisions 处输入 36， 单击 Save 按钮； 将

Edge 选择为 6， 在表格的前 3 行分别输入 8、 9 和 11， 将 Method 选择为 Use Number of Divi-
sion， 在 Number of Subdivisions 处输入 12， 单击 Save 按钮； 将 Edge 选择为 1， 在表格的前 3
行分别输入 2、 4 和 12， 将 Method 选择为 Use Number of Division， 在 Number of Subdivisions
处输入 3， 单击 OK 按钮。

3） 单击菜单 Meshing→Mesh Density→Face， 在弹出的对话框中将 Body 选择为 2， 将

Face 选择为 4， 确认 Method 选择为 Use Length， 并在 Element Edge Length 处输入 0. 01， 单击

OK 按钮。 此时， 图形区给出如图 9-2 所示的模型示意图。

图 9-2　 模型示意图

4. 定义单元组

本实例需要首先定义 3 个单元组， 分别用于表示刹车盘、 闸片和临时 2- D 组。 单击菜

单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add 按钮， 定义

单元组 1， 将 Type 选择 3- D Solid， 其余参数保持不变， 单击 Save 按钮； 单击 Add 按钮， 定

义单元组 2， 单击 Save 按钮； 单击 Add 按钮， 定义单元组 3， 将 Type 选择为 2- D Solid， 单

击 OK 按钮， 单元组定义完毕。
5. 划分网格

1） 单击菜单 Meshing→Create Mesh→Point， 在弹出对话框的表格第 1 行输入 1， 单击

OK 按钮。
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2） 单击菜单 Meshing→Create Mesh→Body （或图标 ）， 将弹出对话框， 将 Element
Group 选择为 1， Meshing Type 选择为 Rule- Based， 将 Nodes per Element 选择为 8， 并在表格

的前 2 行分别输入 1 和 3， 单击 OK 按钮。
3） 单击菜单 Meshing→Create Mesh→Face （或图标 ）， 在弹出的对话框中确认 Element

Group 选择为 3， Nodes per Element 选择为 4， Parent Body 选择为 2， 并在表格的第 1 行输入

4， 单击 OK 按钮。 此时将弹出 Warning 对话框， 单击是 （Y） 按钮， 再单击 Cancel 按钮。
4） 单击菜单 ADINA-M→Body Sweep （或图标 ）， 在弹出的对话框中将 Body 选择为

2， 勾选 Swept Body will Replace this Body， 并在 Face to be Swept 处输入 4， 勾选 Generate 3- D
Mesh from 2- D Mesh on Face， 将 3- D Element Group 选择为 2， 确认 Action on 2- D Mesh 选择

为 Delete elements + group， 并在 Elements in Swept Direction 处输入 3， 将 Nodal Coincidence 选

择为 No Checking， 在 Vector Magnitude 的 X 处输入 - 0. 02， 单击 OK 按钮。
5） 单击菜单 ADINA-M→Define Body （或图标 ）， 在弹出的对话框中将 Body Number

选择为 2， 单击对话框上部的 Delete 按钮， 然后单击 OK 按钮。 此时， 图形区将给出如

图 9-3 所示的模型。

图 9-3　 划分网格后的模型示意图

提示： 本实例使用 Body Sweep 功能来生成三维网格， 这是一种非常实用的网格划分方〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
法， 使用该法生成网格时需要借用二维网格。 需要注意的是： 因为要在单元组 1 和单元组 2〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
的网格之间定义接触， 因此网格一定不能连续。 网格划分完毕， Body 2 将不再起作用， 为〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
了避免干扰显示效果， 可以将其删掉。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

6. 定义接触

1） 单击菜单 Model→Contact→Contact Group （或图标 ）， 在弹出的对话框中单击 Add
按钮， 将 Type 选择为 3- D Contact， 在 Default Coulomb Friction Coefficient 处输入 0. 35， 单击

Node- to- Node， TMC 标签， 在 Heat transfer Coefficient through Contact 处输入 1， 单击 OK
按钮。

2） 单击菜单 Model→Contact→Contact Surface （或图标 ）， 在弹出的对话框中单击 Add
按钮， 将 Defined on 选择为 Surfaces and / or Faces， 在表格第 1 行的 Surf / Face 处输入 2， 在

Body 处输入 1， 在表格第 2 行的 Surf / Face 处输入 5， 在 Body 处输入 3， 单击 Save 按钮； 单
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击 Add 按钮， 将 Defined on 选择为 Faces of a Body， 并在表格第 1 行的 Surf / Face 处输入 9，
在 Body 处输入 4， 单击 OK 按钮。

3） 单击菜单 Model→Contact→Contact Pair （或图标 ）， 在弹出的对话框中单击 Add 按

钮， 将 Target Surface 选择为 1， Contact Surface 选择为 2， 单击 OK 按钮。 接触定义完毕。
提示： 摩擦生热分析中一定要定义摩擦系数， 同时还应该设置 TMC 标签的热转换系数。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
7. 定义材料

1） 单击菜单 Model→Material→Manage Material （或图标 ）， 将弹出材料定义对话框，
单击 Elastic 下的 Isotropic 按钮来定义线弹性材料。 在弹出的对话框中单击 Add 按钮来定义

材料 1， 在 Young’s Modulus 处输入 2. 06 e11， 在 Poisson’s Ratio 处输入 0. 3， 在 Density 处输

入 7800， 单击 OK 按钮退出对话框。
2） 单击 TMC Material 按钮， 在弹出的对话框中单击 k isotropic， c constant 按钮， 在弹出

的对话框中， 单击 Add 按钮， 将传热系数 k 输入 520， 将单位质量热容 c 输入 38. 2， 在密度

处输入 7800， 单击 OK 按钮， 单击 Close 按钮两次退出对话框， 材料定义完毕。
提示： 这里定义了两种材料， 一种是结构场的实体材料， 一种是热场的 TMC 材料。 在〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

定义单元组时， 需要指定这两种材料， 由于本例这两种材料的编号都是 1， 所以在之前定义〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
单元组保持默认状态即可。〰〰〰〰〰〰〰〰〰〰〰〰

8. 定义并施加约束

单击菜单 Model→Boundary Conditions→Apply Fixity （或图标 ）， 在弹出的对话框中

单击 Define 按钮， 单击 Add 按钮并输入名字 only_xr， 单击 OK 按钮， 勾选 X- Translation、
Y- Translation、 Z- Translation、 Y- Rotation 和 Z- Rotation， 单击 Save 按钮； 单击 Add 按钮并输

入名字 only_xt， 单击 OK 按钮， 勾选 Y- Translation、 Z- Translation、 X- Rotation、 Y- Rotation
和 Z- Rotation， 单击 OK 按钮。 确认 Apply to 选择为 Points， 在表格第 1 行的 Point 处输入 1，
将 Fixity 选择为 ONLY_XR， 单击 Save 按钮， 将 Apply to 选择为 Faces， 将 Body #选择为 4，
在表格第 1 行的 Face #处输入 10， 将 Fixity 选择为 ONLY_XT， 单击 OK 按钮， 约束定义完

毕。 单击显示约束图标 ， 将给出如图 9-4 所示的模型示意图。

图 9-4　 模型的约束情况示意图
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9. 定义特殊边界条件

1） 定义 Rigid Links 边界条件的操作如下： 单击菜单 Model→Constraints→Rigid Links，
在弹出的对话框中， 单击 Add 按钮， 确认 Master 的 Entity Type 选择为 Point， 在 Entity 处输

入 1， 将 Slave 下的 Entity Type 选择为 Face， 在 Entity 处输入 3， Body 选择 1， 将 Displace-
ments 选择为 Large， 单击 Save 按钮。

2） 单击 Add 按钮， 确认 Master 的 Entity Type 选择为 Point， 在 Entity 处输入 1， 将 Slave
下的 Entity Type 选择为 Face， 在 Entity 处输入 4， Body 选择 3， 将 Displacements 选择为

Large， 单击 OK 按钮。
10. 定义时间步

单击菜单 Control→Time Step， 在弹出的对话框中按照表 9-1 输入数据， 单击 OK 按钮，
时间步定义完毕。

表 9-1　 定义时间步

Number of Steps Constant Magnitude

1 500 0. 01
2 250 0. 02
3 100 0. 05
4 50 0. 1
5 5 1. 0

11. 定义时间函数

本实例需要定义两个时间函数， 时间函数 2 用来控制位移载荷， 时间函数 3 用来控制压

力载荷。 单击菜单 Control→Time Function， 在弹出的对话框中单击 Add 按钮来定义时间函数

2， 单击 Impor t 按钮， 导入光盘中的文件 time- function2. txt， 单击 Save 按钮， 再单击 Graph
按钮， 将显示如图 9-5 所示的时间函数 2 曲线。 单击 Add 按钮来定义时间函数 3， 按照

表 9-2 来输入数据， 单击 OK 按钮， 时间函数定义完毕。

图 9-5　 时间函数 2 的曲线图
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表 9-2　 时间函数 3

Time Value

1 0 0

2 0. 1 1. 0

3 1. 0E + 20 1. 0

提示： 时间函数 3 用来控制压力载荷的加载， 这里压力载荷的大小并不是直接施加的，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
而是在 0. 1s 内按线性逐渐施加， 这样做有利于模型接触计算的收敛。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

12. 定义并施加载荷

1） 定义对流传热载荷的操作如下： 单击菜单 Model→Loading→Apply （或图标 ）， 在

弹出的对话框中将 Load Type 选择为 Convection， 单击右侧的 Define 按钮， 单击 Add 按钮，
在 Environment Temperature 处输入 20， 单击 Convection Property 右侧的 按钮， 在弹出的对

话框中单击 Add 按钮， 确认 Type 选择为 CONSTANT， 在 Convection Coefficient 处输入 100，
单击 OK 按钮退出对话框。 将 Convection Property 选择为 1， 单击 OK 按钮。 将 Apply to 选择

为 Face， 并按照表 9-3 输入数据， 单击 Apply 按钮。

表 9-3　 定义载荷作用域

Site # Body # Time function

1 1 1 1

2 2 1 1

3 3 1 1

4 4 1 1

5 2 3 1

6 3 3 1

7 4 3 1

8 5 3 1

9 1 4 1

10 2 4 1

11 3 4 1

12 4 4 1

13 5 4 1

14 6 4 1

15 7 4 1

16 8 4 1

17 10 4 1

2） 定义位移载荷的操作如下： 将 Load Type 选择为 Displacement， 单击右侧的 Define 按

钮， 单击 Add 按钮， 在 Prescribed Values of Rotation 的 X 处输入 1， 其余设置保持不变， 单

击 OK 按钮。 确认 Apply to 选择为 Point， 在表格第 1 行的 Site 处输入 1， 将 Time Function 选

择为 2， 单击 Apply 按钮。
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3） 定义压力载荷的操作如下： 将 Load Type 选择为 Pressure， 单击右侧的 Define 按钮，
单击 Add 按钮， 在 Magnitude 处输入 703865， 单击 OK 按钮。 将 Apply to 选择为 Face， 在表

格第 1 行的 Site 处输入 10， 在 Body 处输入 4， 将 Time Function 选择为 3， 单击 OK 按钮。 载

荷定义完毕。
提示： 本例的位移载荷通过时间函数 2 来控制， 因此定义单位载荷即可。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
依次单击图标 和 ， 然后单击显示载荷图标 ， 图形区将给出如图 9-6 所示的模型示

意图。

图 9-6　 模型示意图

9. 1. 3　 求解

单击菜单 File→Save （或图标 ）， 将文件保存为 C- example01. idb。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 C- example01， 同时勾选 Run So-
lution 和 Automatic Memory Allocation 选项， 单击保存按钮并等待计算结束。

9. 1. 4　 后处理

1） 将程序模块选择为 Post- Processing。 单击菜单 File→Open （或图标 ） 来打开结果

文件 C- example01. por。
2） 单击图标 消去接触显示， 单击图标 消去刚性连接显示， 单击图标 在图形区显

示节点， 单击菜单 Definitions→Model Point→Node， 弹出定义 Model Point 对话框， 单击 Add
按钮， 输入名称 n125， 点击 OK 按钮。 在 Node #中输入 125， 单击 Save 按钮。

3） 单击 Add 按钮， 输入名称 n1013， 点击 OK 按钮。 在 Node #中输入 1013， 单击 OK
按钮。 这两个 Model Point 的相对位置如图 9-7 所示， N125 点在轮盘的边缘， N1013 在轮盘

的中心点。
4） 单击菜单 Graph→Response Curve （Model Point）， 在弹出的对话框中将 X Coordinate

和 Y Coordinate 下的 Model Point 选择 N125， 将 Y Coordinate 下的 Variable 选择 Temperature，
单击 Curve Depiction 右侧的 图标， 在弹出的对话框中退选 Display Curve Symbol 标签， 单
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图 9-7　 Model Point 的相对位置

击 Legend 选项， 将 Type 选择为 Custom， 单击对

话框底部表格的第 1 行， 在其内输入 node125，
单击 OK 按钮退出对话框。 在当前的对话框内单

击 Apply 按钮。
在同一对话框中， 将 X Coordinate 和 Y Coor-

dinate 下的 Model Point 选择为 N1013， 确认 Y
Coordinate 下的 Variable 选择为 Temperature， 将

Plot Name 选择为 PREVIOUS， 单击 Curve Depic-
tion 右侧的 图标， 在弹出的对话框中确认退选

Display Curve Symbol 选项， 单击 Line Attibutes 下

Color 右侧的 按钮， 将颜色选择为黑色， 单击

Legend 选项， 确认 Type 选择为 Custom， 单击对

话框底部表格的第 1 行， 在其内输入 node1013，

单击 Legend Attributes 下 Color 右侧的 按钮， 将

颜色选择为黑色， 单击 OK 按钮退出对话框。 在

刚才的对话框内单击 OK 按钮， 此时， 图形区将

如图 9-8 所示。

图 9-8　 两个 Model Point 的温度-时间历程曲线

由图 9-8 可知， 温度开始先逐渐上升， 待刹车盘停止转动后， 温度慢慢下降。 可以看出

这两条温度的变化曲线趋势一致， 都沿着锯齿型上升， 其中， node1013 的曲线锯齿变化剧

烈。 每一个锯齿都表明刹车盘转动了一圈， 每一圈 node1013 节点都要被加热一次， 然后再

冷却。 node125 点在刹车盘的边缘， 锯齿的温度变化不显著。
5） 单击图标 来清空图形区， 单击图标 ， 将弹出对话框， 在 Zone Name 中选择 EG1，

单击 OK 按钮， 图形区将单独显式 EG1。 单击图标 ， 弹出对话框， 将 Band Plot Variable 选

择为 Temperature， 单击 OK 按钮， 图形区将如图 9-9 所示。 单击图标 可以制作动画， 动画

制作完毕后， 单击图标 可以观看动画， 单击图标 可以保存动画文件。
6） 单击图标 来清空图形区， 单击图标 ， 将弹出对话框， 在 Zone Name 中选择 EG1，
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图 9-9　 刹车盘温度云图

单击 OK 按钮。 单击图标 ， 单击图标 ， 图形区将显示有效应力云图， 如图 9-10 所示。
单击图标 可以制作有效应力云图动画， 动画制作完毕， 单击图标 可以观看动画， 单击图

标 可以保存动画文件。

图 9-10　 刹车盘有效应力云图

7） 单击图标 来清空图形区， 单击图标 ， 将弹出对话框， 在 Zone Name 中选择 EG1，
单击 OK 按钮。 单击菜单 Display→Reaction Plot→Create， 将弹出对话框， 确认 Reaction
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Quantity 选择为 CONSISTENT_CONTACT_FORCE， 单击 OK 按钮， 图形区将显示刹车盘的接

触力矢量图， 如图 9-11 所示， 通过该图可以看出接触状态是否正确。 单击图标 可以制作

接触力矢量图动画， 动画制作完毕， 单击图标 可以观看动画， 单击图标 可以保存动画

文件。

图 9-11　 刹车盘接触力矢量图

9. 1. 5　 应用推广

本实例还可以推广应用到某些广义热力耦合分析中 （例如， 摩擦生热分析， 接触传热

分析等）， 也可以用于汽车、 火车的刹车盘热力耦合分析中。

9. 2　 阀门流固耦合分析

9. 2. 1　 问题描述

本实例为二维阀门流固耦合分析， ADINA 软件中提供了 Gap 边界算法， 主要用来模拟

阀门边界。 本实例的几何模型并不复杂， 其目的在于介绍 Gap 边界和流固耦合的使用方法。
通过学习本实例， 读者可以掌握下列几个功能：

1） 设定流固耦合分析。
2） 设定 Gap 边界条件。
3） 设定接触偏移。
本实例完整的命令流文件为 C- example02s. in 和 C- example02f. in， 保存在随书光盘文件

夹 \ 9-2 \ model \ 中。
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9. 2. 2　 前处理

1. 流场模型

1） 设定模型控制参数。
启动 ADINA- AUI， 程序模块选择 ADINA- CFD， 分析类型选择 Transient， 选择 FSI 分析，

单击图标 ， 弹出对话框， 并在 Maximum Number of Fluid- Structure Iterations 处输入 150，
单击 OK。 流体压缩性选择为 Slightly Compressible。

单击菜单 Model→Fluid Assumption， 在弹出的对话框中将 Flow Dimension 选择为 2D （in
YZ Plane）， 退选 Include Heat Transfer 选项， 单击 OK 按钮。

2） 定义几何及网格密度。
单击菜单 File→Open （或图标 ） 来读取命令流文件 C- example02f- geo. in （保存于随书

光盘文件夹 \ 9-2 \ model \ 中）。 单击图标 和 ， 图形区将给出如图 9-12 所示的几何模

型。 命令流中包含下列命令： ①建立了 40 个点； ②建立了 22 个面； ③设定了网格密度。 具

体的操作过程可参考命令流文件， 这里不再赘述。

图 9-12　 二维几何模型

3） 定义材料。
单击菜单Model→Material→Manage Material （或图标 ）， 将弹出材料定义对话框， 单击

Constant 按钮， 在弹出的对话框中单击 Add 按钮， 在 Viscosity 处输入 0. 001， 在 Density 处输

入 1000， 在 Thermal Conductivity 处输入 0. 0033， 在 Fluid Buck Modulus 处输入 2. 56e9， 依次

单击 OK 按钮和 Close 按钮退出对话框。 此时， 材料定义完毕。
4） 定义单元组。
单击菜单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add

按钮来定义单元组 1， 将 Type 选择为 2- D Fluid， 确认材料选择为 1， 将 Element Sub- Type 选

择为 Planar， 单击 OK 按钮， 单元组定义完毕。
5） 划分网格。
单击菜单 Meshing→Create Mesh→Surface （或图标 ）， 在弹出的对话框中， 确认 Mes-

hing Type 选择为 Rule- Based， 确认 Nodes per Element 选择为 4， 单击 Auto 按钮， 分别在
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From 和 To 处输入 1 和 22， 单击 OK 按钮两次来退出对话框。
6） 定义特殊边界条件。
① 单击菜单 Model→Special Boundary Condition （或图标 ）， 在弹出的对话框中单击

Add 按钮， 确认 Type 选择为 Wall， Apply to 选择为 Lines， 双击表格第 1 行的绿色图框， 然

后到图形区拾取外圈所在的边， 这些边的编号为： 34、 13、 16、 15、 39、 31、 48、 61、 60、
57、 64、 62、 52、 50、 49、 40、 17、 36、 1、 4、 7、 33、 21、 42、 54、 43、 27、 45、 59、 46，
单击 Save 按钮。

② 单击 Add 按钮， 确认 Type 选择为 Fliud- Structure Interface， Apply to 选择为 lines， 在

表格的前 8 行依次输入 5、 8、 11、 23、 26、 29、 37、 38， 单击 Save 按钮。
③ 单击 Add 按钮， 确认 Type 选择为 Gap， Apply to 选择为 lines， 在表格的第 1 行输入

6， 将 Gap Open- Close Condition Controlled by 选择为 Gap Size， 在 Gap- Open Value 处输入

0. 001， Gap- Close Value 处输入 0. 0005， 单击 Save 按钮； 单击 Add 按钮， 将 Type 选择为

Gap， 将 Apply to 选择为 lines， 在表格的第 1 行输入 9， 将 Gap Open- Close Condition Con-
trolled by 选择为 Gap Size， 在 Gap- Open Value 处输入 0. 001， 在 Gap- Close Value 处输入

0. 0005， 单击 OK 按钮。
7） 定义并施加载荷。
定义载荷的操作如下： 单击菜单 Model→Usual Boundary Conditions / Loads→Apply （或图

标 ）， 在弹出的对话框中确认 Load Type 选择为 Normal Traction， 单击 Define 按钮， 在弹出

的对话框中单击 Add 按钮， 在 Magnitude 处输入 1e6， 单击 OK 按钮。 将 Apply to 选择为

Line， 在表格的第 1 行的 Site #下输入 35， 单击 OK 按钮。
8） 定义时间步。
单击菜单 Control→Time Step， 将弹出 Define Time Step 对话框， 将表格的第 1 行改为

500， 0. 000005， 单击 OK 按钮。
依次单击图标 和 ， 然后单击显示载荷图标 和显示约束图标 ， 图形区将给出如

图 9-13 所示的模型。

图 9-13　 显示载荷和约束的模型示意图
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9） 设定节点跟随。
单击菜单 Meshing→ALE Mesh Constraints→Leader- Follower， 在弹出的对话框中按照表 9-4

输入数据， 然后单击 OK 按钮。

表 9-4　 设定节点跟随

Lable # Leader Point # Follower Point # Relative Disp. Factor

1 28 9 1

2 29 10 1

3 25 24 1

4 32 23 1

10） 生成求解文件。
单击菜单 File→Save （或图标 ）， 将文件保存为 C- example03f. idb。 单击菜单 Solution→

Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 C- example03f， 退选 Run Solution
标签， 单击保存按钮。

2. 结构模型

1） 设定模型控制参数。
启动 ADINA- AUI， 单击图标 ， 程序模块选择为 ADINA Structures， 算法选择为 Dynam-

ics- Implicit， 单击右侧的图标 将弹出 Implicit Transient Dynamics 对话框， 将参数 Alpha 修改

为 0. 5， 勾选 Use Automatic Time- Stepping 选项， 选择 FSI 分析， 单击 OK 按钮。
2） 定义几何。
单击菜单 File→Open （或图标 ） 来读取命令流文件 C- example02s- geo. in， 单击图标 和

， 图形区将显示如图 9-14 所示的模型。 命令流中包含下列命令： ①建立了 20 个点； ②建立了

5 个面； ③设定了网格密度。 具体的操作过程可参考命令流文件， 这里不再赘述。

图 9-14　 图形区显示的模型

3） 定义材料。
单击菜单 Model→Material→Manage Material （或图标 ）， 将弹出材料定义对话框， 单击

Elastic 下的 Isotropic 按钮来定义线弹性材料。 在弹出的对话框中单击 Add 按钮来定义材料 1，
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在 Young’s Modulus 处输入 2e11， 在 Poisson’s Ratio 处输入 0. 3， 在 Density 处输入 7800， 依次

单击 OK 按钮和 Close 按钮退出对话框。 此时， 材料定义完毕。
4） 定义单元组。
单击菜单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add

按钮来定义单元组 1， 将 Type 选择为 2- D Solid， 将 Element Sub- Type 选择为 Plane Strain，
确认 Default Material 选择为 1， 其余设置保持不变， 单击 OK 按钮。 此时， 单元组定义完毕。

5） 划分网格。
单击菜单 Meshing→Create Mesh→Surface （或图标 ）， 在弹出的对话框中为表格前 5 行

依次输入 1、 2、 3、 4、 5， 单击 OK 按钮。 网格划分完毕。
6） 定义接触。
定义接触组的操作如下： 单击菜单 Model→Contact→Contact Group （或图标 ）， 将弹出

定义接触组对话框。 单击 Add 按钮来设置接触组 1， 确认 Type 选择为 2- D Contact， 在 Offset
Distance from Defined Surface 处输入 0. 00025， 其他设置保持默认不变， 单击 OK 按钮。

提示： 如果流固耦合分析中包含接触， 设定接触时一定要设定接触偏移。 这样做的目的〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
是为了给流场预留一定空间， 该空间可以很小， 但不能为 0。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

定义接触面的操作如下： 单击菜单 Model→Contact→Contact Surface （或图标 右侧的下

拉菜单， 然后选择图标 ）， 将弹出定义接触面对话框。 单击 Add 按钮来定义接触面 1， 在

表格的第 1 行输入 13 后单击 Save 按钮保存； 单击 Add 按钮来定义接触面 2， 在表格的第 1
行输入 14， 单击 Save 按钮保存； 单击 Add 按钮来定义接触面 3， 在表格的第 1 行输入 4， 单

击 Save 按钮保存； 单击 Add 按钮来定义接触面 4， 在表格的第 1 行输入 8， 单击 Save 按钮保

存； 单击 Add 按钮来定义接触面 5， 在表格的第 1 行输入 12， 单击 Save 按钮保存； 单击

Add 按钮来定义接触面 6， 在表格的第 1 行输入 2， 单击 OK 按钮。
定义接触对的操作如下： 单击菜单 Model→Contact→Contact Pair （或图标 右侧的下拉

菜单， 然后选择图标 ）， 将弹出定义接触对对话框。 单击 Add 按钮来设置接触对 1， 将

Target Surface 选择为 1， Contactor Surface 选择为 3， 单击 Save 按钮； 单击 Add 按钮来设置接

触对 2， 将 Target Surface 选择为 2， Contactor Surface 选择为 3， 单击 Save 按钮； 单击 Add 按

钮来设置接触对 3， 将 Target Surface 选择为 4， Contactor Surface 选择为 6， 单击 Save 按钮；
单击 Add 按钮来设置接触对 4， 将 Target Surface 选择为 5， Contactor Surface 选择为 6， 单击

OK 按钮。 接触定义完毕。
7） 定义并施加约束。
单击菜单 Model→Boundary Conditions→Apply Fixity （或图标 ）， 在弹出的对话框中单

击 Define 按钮， 然后单击 Add 按钮并输入名字 y- free， 单击 OK 按钮， 勾选 X- Translation、
Z- Translation、 X- Rotation、 Y- Rotation 和 Z- Rotation， 单击 OK 按钮。 确认 Apply to 选择为

Lines， 并按照表 9-5 输入数据， 单击 OK 按钮。 约束定义完毕。

表 9-5　 施加约束

Line # Fixity

1 1 Y- FREE

2 3 Y- FREE
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（续）

Line # Fixity

3 6 ALL
4 10 ALL
5 17 ALL
6 20 ALL

8） 定义特殊边界条件。
单击菜单 Model→Boundary Conditions→FSI Boundary， 在弹出的对话框中单击 Add 按钮，

将 Apply to 选择为 Lines， 在表格的前 4 行依次输入 1、 2、 3、 4， 单击 OK 按钮。
依次单击图标 和 ， 然后单击显示约束图标 ， 图形区将给出如图 9-15 所示的模型。

图 9-15　 图形区中显示的模型示意图

9. 2. 3　 求解

单击菜单 File→Save （或图标 ）， 将文件保存为 C- example03s. in。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 C- example02s， 退选 Run Solution
标签， 单击保存按钮。

单击菜单 Solution→Run ADINA- FSI， 在弹出的对话框中单击 Start 按钮， 选择 C- exam-
ple02s 和 C- example02f， 单击 Start 按钮， 等待分析结束。

9. 2. 4　 后处理

程序模块选择为 Post- Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

C- example02f. por。
定义两个 Model Point 的操作如下： 单击菜单 Definations→Modle Point→Node， 在弹出的

对话框中单击 Add 按钮， 在弹出的对话框中输入 1， 单击 OK 按钮， 在 Node #处输入 1860，
单击 Save 按钮； 单击 Add 按钮， 在弹出的对话框中输入 2， 单击 OK 按钮， 在 Node #处输入

160， 单击 OK 按钮。 Model Point 1 为流固耦合界面上的点， Model Point 2 为靠近 Gap 边界上
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部的点。 请读者通过 Highlight 来查看节点位置 （事先单击显示节点图标 ）。
查看 Model Point 1 位移时程曲线的操作如下： 单击图标 来清空图形区。 单击菜单

Graph→Response Curve （Modle Point）， 在弹出的对话框中修改 Y Coordinate 下的 Variable 为

Displacement， Y- DISPLACEMENT， 单击 OK 按钮。 此时， 图形区将给出如图 9-16 所示的曲

线， 从图中可以看出在时间接近 0. 002s 时， 阀门的位移发生一定的回弹， 并开始振动， 据

此可以判断出已经发生接触。

图 9-16　 Model Point 1 的位移时程曲线

查看 Model Point 2 的压力随阀门位移变化曲线的操作如下： 单击图标 来清空图形区。
单击菜单 Graph→Response Curve （Modle Point）， 在弹出的对话框中修改 X Coordinate 下的

Variable 为 Displacement， Y- DISPLACEMENT， 确认 Model Point 为 1， 修改 Y Coordinate 下的

Variable 为 Stress， PRESSURE， 将 Model Point 选择为 2， 将 Smooth Technique 选择为 AVER-
AGED， 单击 Response Range 右侧的 按钮， 在弹出的对话框中为 End Time 输入 0. 0015，
单击 OK 按钮两次退出对话框。 此时， 图形区将给出如图 9-17 所示的压力曲线， 据此可以

看出在位移值为 0. 0005m 时， 阀门的 Gap 边界打开， Model Point 2 的压力迅速增大， 并发生

一定的振荡。

图 9-17　 Model Point 2 的压力随阀门位移变化曲线
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单击图标 来清空图形区， 单击图标 消去网格线， 单击图标 后图形区显示压力云

图； 单击图标 可以制作压力云图动画， 动画制作完毕， 单击图标 可以观看动画， 单击图

标 可以保存动画文件。
依次单击图标 和 来打开结果文件 C- example02s. por。 定义 Model Point 的操作如下： 单

击菜单 Definations→Modle Point→Node， 在弹出的对话框中单击 Add 按钮， 在弹出的对话框中

输入 1， 单击 OK 按钮， 在 Node #处输入 84， 单击 OK 按钮。 Model Point 1 位于流固耦合界面上，
且可以发生接触碰撞， 请读者通过 Highlight 来查看节点的位置 （事先单击显示节点图标 ）。

查看 Model Point 1 接触力时程曲线的操作如下： 单击图标 来清空图形区。 单击菜单

Graph→Response Curve （Modle Point）， 在弹出的对话框中修改 Y Coordinate 下的 Variable 为

Force， CONTACT_FORCE- Y， 单击 OK 按钮。 此时， 图形区将给出如图 9-18 所示的曲线，
从图中可以看出在 0. 002s 之前， 接触反力为 0， 在接近 0. 002s 时发生了接触， Y 方向的接

触反力也发生了很大的变化， 在接近 0. 0023s 时， 再次发生接触。

图 9-18　 Model Point 1 接触力时程曲线

单击图标 来消去网格线， 依次单击图标 和 ， 图形区将显示有效应力云图。 单击图

标 可以制作应力云图动画， 动画制作完毕， 单击图标 可以观看动画， 单击图标 可以保

存动画文件。

9. 2. 5　 应用推广

本实例为二维实例， 读者可以将其推广到三维模型。 同时还可以推广应用到某些内部发

生流固耦合的分析中 （包含 Gap 边界条件）。 例如， 液压减振器、 液压悬置装置等液体与结

构相互作用的机械结构。

9. 3　 储液罐流固耦合模态及动力响应分析

9. 3. 1　 问题描述

本实例为储液罐流固耦合模态分析及其动力响应分析。 本例题的流体为势流体， ADINA
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软件势流体的流固耦合分析仅在结构场中进行。 通过学习本实例， 读者可以掌握下列几个

功能：
1） 设定势流体流固耦合分析。
2） 流固耦合模态分析。
3） 流固耦合动力时程响应分析。
本实例完整的命令流文件为 C- example03a. in 和 C- example03b. in， 保存在随书光盘文件

夹 \ 9-3 \ model \ 中。

9. 3. 2　 流固耦合模态分析

1. 前处理

1） 设定模型控制参数。
启动 ADINA- AUI， 程序模块选择为 ADINA Structures， 分析类型选择为 Frequencies /

Modes， 单击图标 ， 在弹出的对话框中将 Number of Frequencies / Mode shapes 修改为 10， 将

Solution Method 选择为 Lanczos Iteration， 单击 OK 按钮。
单击菜单 Control→Analysis Assumpations→Kinematics， 将弹出 Kinematics 对话框， 将

Displacements / Rotations 选择为 Large， 单击 OK 按钮。
2） 定义几何及网格密度。
单击菜单 File→Open （或图标 ） 来读取命令流文件 C- example03- geo. in （保存于随书

光盘文件夹 \ 9-3 \ model \ 中）。 单击图标 和 ， 图形区将给出如图 9-19 所示的模型。 命

令流中包含下列命令： 1） 建立了 5 个体； 2） 建立了 26 个面； 3） 设定了网格密度。 具体

的操作过程请参考命令流文件。

图 9-19　 模型示意图

3） 定义并施加约束。
单击菜单 Model→Boundary Conditions→Apply Fixity （或图标 ）， 在弹出的对话框中，

将 Apply to 选择为 Surface， 单击 Auto 按钮， 分别在 From 行和 To 行输入 1 和 5， 单击 OK 按

钮两次退出对话框。 约束定义完毕。
4） 定义特殊边界条件。
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定义自由液面边界条件的操作如下： 单击菜单 Model→Boundary Conditions→Potential
Interface， 在弹出的对话框中， 单击 Add 按钮， 将 Type 选择为 Free Surface， 将 Apply to 选

择为 Surfaces， 并在表格的前 5 行依次输入 10、 14、 18、 21、 22， 单击 OK 按钮。
提示： 本实例中无须设定流固耦合边界条件， ADINA 软件能够自动找到流固耦合〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

边界。〰〰〰
5） 定义材料。
单击菜单Model→Material→Manage Material （或图标 ）， 将弹出材料定义对话框， 单击

Elastic 下的 Isotropic 按钮来定义线弹性材料。 在弹出的对话框中单击 Add 按钮来定义材料

1， 在 Young’s Modulus 处输入 2 e11， 在 Poisson’s Ratio 处输入 0. 3， 在 Density 处输入 7800，
单击 OK 按钮。 单击 Others 下的 Potential- Based Fluid 按钮， 单击 Add 按钮来定义材料 2， 在

Bulk Modulus 处输入 2. 3 e8， 在 Density 处输入 1000， 依次单击 OK 按钮和 Close 按钮来退出

对话框。 材料定义完毕。
6） 定义单元组。
单击菜单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add

按钮来定义单元组 1， 将 Type 选择为 Shell， Default Material 选择为 1， 并在 Default Element
Thickness 处输入 0. 02， 其余设置保持不变， 单击 Save 按钮； 单击 Add 按钮来定义单元组

2， 将 Type 选择为 3- D Fluid， 将 Default Material 选择为 2， 单击 OK 按钮。 单元组定义

完毕。
7） 划分网格。
划分外壳网格的操作如下： 单击菜单 Meshing→Create Mesh→Surface （或图标 ）， 在弹

出的对话框中将 Type 选择为 Shell， Element Group 选择为 1， Nodes per Element 选择为 4， 单

击表格第 1 行的绿色图框， 然后到图形区拾取储罐外层所在的面， 这些面依次为 1、 2、 3、
4、 5、 6、 11、 15、 19、 23、 24、 25、 26， 单击 OK 按钮。

划分势流体网格的操作如下： 单击菜单 Meshing→Create Mesh→Volume （或图标 ），
在弹出的对话框中将 Type 选择为 3- D Fluid， 将 Element Group 选择为 2， 将 Nodes per Ele-
ment 选择为 8， 退选Wedge Volumes Treated as Degenerate， 并在表格的前 5 行依次输入 1、 2、
3、 4、 5， 单击 Nodal Coincidence 标签， 将 Check 选择为 Against Same Element Group Only，
单击 OK 按钮。

提示： 本实例的流体网格与壳网格共节点， 但没有拟合， 因此在划分势流体网格时需要〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
注意节点检查的设置。〰〰〰〰〰〰〰〰〰〰

依次单击图标 和 ， 然后单击显示约束图标 ， 图形区将给出如图 9-20 所示的模型

示意图。
8） 定义并施加载荷。
定义重力载荷的操作如下： 单击菜单 Model→Loading→Apply （或图标 ）， 在弹出的对

话框中将 Load Type 选择为 Mass Proportional， 单击 Load Number 右侧的 Define 按钮， 单击

Add 按钮， 在 Magnitude 处输入 9. 8， 确认 Direction Vector 的 Z 处输入 - 1， 单击 OK 按钮。
并在表格的第 1 行输入 1， 单击 OK 按钮。

2. 提交计算

单击菜单 File→Save （或图标 ） 将文件保存为 C- example03a. idb。 单击菜单 Solution→
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图 9-20　 划分完网格后的模型示意图

Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 C- example03a， 确认同时勾选了

Run Solution 和 Automatic Memory Allocation 选项， 单击保存按钮， 等待分析结束。
3. 后处理

程序模块选择为 Post- Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

C- example03a. por。
单击图标 可以查看各阶模态的振型和频率， 单击图标 可以查看各阶模态的振型动

画。 图 9-21 即为 4 阶模态和 7 阶模态。

图 9-21　 4 阶模态和 7 阶模态图

单击图标 来清空图形区， 单击图标 ， 将弹出对话框， 在 Zone Name 中选择

EG1， 单击 OK 按钮， 图形区将单独显示 EG1。 单击图标 可以查看各阶模态的振型和

频率， 单击图标 可以查看各阶模态的振型动画。 图 9-22 即为 EG1 的 4 阶模态和 7 阶

模态。
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图 9-22　 EG1 的 4 阶模态和 7 阶模态图

9. 3. 3　 动力时程响应分析

1. 前处理

1） 设定模型控制参数。
单击图标 ， 确认程序模块为 ADINA Structures， 单击图标 来读取文件 C- exam-

ple03a. idb， 并将分析类型选择为 Dynamics- Implicit。
2） 定义时间步。
单击菜单 Control→Time Step， 在弹出的对话框中将表格的第 1 行修改为 100， 0. 02， 单

击 OK 按钮。
3） 定义时间函数。
单击菜单 Control→Time Function， 在弹出的对话框中单击 Add 按钮来定义时间函数 2，

单击 Import 按钮来导入 time- function2. txt （保存于随书光盘文件夹 \ 9-3 \ model \ 中）， 单

击 Graph 按钮， 则时间函数 2 将如图 9-23 所示， 单击 OK 按钮。 时间函数定义完毕。
4） 定义并施加约束。
单击菜单 Model→Boundary Conditions→Apply Fixity （或图标 ）， 在弹出的对话框中，

单击 Define 按钮， 然后在弹出的对话框中单击 Add 按钮， 输入名字 fix， 单击 OK 按钮， 勾

选 X- Translation、 Y- Translation、 Z- Translation、 X- Rotation、 Y- Rotation 和 Z- Rotation 标签，
单击 OK 按钮。 将 Apply to 选择为 Surfaces， 确认表格前 5 行的 Surface #为 1 ～ 5， 将这 5 行的

Fixity 均选择定义的 FIX 作为约束， 单击 OK 按钮。 约束定义完毕。
5） 定义并施加载荷。
定义重力载荷的操作如下： 单击菜单 Model→Loading→Apply （或图标 ）， 在弹出的对

话框中将 Load Type 选择为 Mass Proportional， 单击 Load Number 右侧的 Define 按钮， 单击

Add 按钮， 并在 Magnitude 处输入 0. 01， 在 Direction Vector 的 X 处输入 1， Z 处输入 0， 将

Interpret Loading as 选择为 Groud Acceleration， 单击 OK 按钮。 将载荷选择为 2， 并在表格的

第 1 行输入 2， 单击 OK 按钮。
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图 9-23　 时间函数 2

2. 提交计算

单击菜单 File→Save （或图标 ）， 将文件保存为 C- example04b. idb。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 C- example03b， 确认同时勾选了

Run Solution 和 Automatic Memory Allocation 选项， 单击保存按钮， 等待分析结束。
3. 后处理

程序模块选择为 Post- Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

C- example04b. por。
单击图标 可以制作动画， 动画制作完毕后， 单击图标 可以观看动画， 单击图标 可

以保存为动画文件。

9. 3. 4　 应用推广

本实例可以推广应用到某些内部发生流固耦合的分析中。 例如， 储液罐、 储油罐、 各种

水箱、 油箱等结构。

9. 4　 风车流固耦合分析

9. 4. 1　 问题描述

本实例为风车的流固耦合分析， 将模拟初始静止的风车结构在来流的驱动下， 一点点转

动起来的过程。 通过学习本实例， 读者可以掌握下列几个功能：
1） 设定流固耦合分析。
2） 应用 FCBI- C 算法。
3） 应用 Sliding Mesh。
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本实例完整的命令流文件为 C- example04s. in 和 C- example04f. in， 均保存于随书光盘文

件夹 \ 9-4 \ model \ 中。

9. 4. 2　 前处理

1. 流场模型

1） 设定模型控制参数。
① 启动 ADINA- AUI， 程序模块选择为 ADINA CFD， 分析类型选择为 Transient。
② 单击菜单 Model→Fluid Assumption， 在弹出的对话框中， 退选 Include Heat Transfer 选

项， 勾选 FSI 标签， 单击 OK 按钮。
③ 单击程序模块的图标 ， 在弹出的对话框中勾选 Automatic Time- Stepping 标签， 单击

OK 按钮。 单击图标 ， 在弹出的对话框中将 Maximum Number of Fluid- Structure Iterations 修
改为 150， 单击 OK 按钮。

④ 单击菜单 Control→Solution Process， 在弹出的对话框中将 Flow- Condition- Based Inter-
polation Elements 选择为 FCBI- C， 单击 Outer Iteration 按钮， 弹出对话框， 单击 Advanced Set-
tings 按钮， 在弹出的对话框中将 Equation Residual 下的 Tolerance 修改为 0. 001， 将 Pressure-
Veloctiy Coupling Method 选择为 SIMPLEC， 将 Solver for Moving Mesh 选择为 Sparse， 勾选 Use
Pressure- Implicit with Splitting of Operators （PISO） Scheme 选项， 单击 OK 按钮 3 次退出所有

对话框。
⑤ 单击菜单 Control→Porthole （. por）→Volume， 在弹出的对话框中退选 Save Individual El-

ement Results 选项， 单击 OK 按钮。 退选该选项后， 计算结果文件将不会很大， 但是将会丢

失单元计算结果， 建议退选。
2） 定义几何及网格密度。
单击菜单 ADINA-M→Import Parasolid Model （或图标 ） 来读取几何文件 fc- fgeo1. x_t，

然后单击图标 ， 图形区将给出如图 9-24 所示的模型示意图。

图 9-24　 几何模型示意图

提示： 几何文件 fc- fgeo1. x_t 由几何文件 fc- s. x_t 编辑加工得到， 使用 ADINA-M 菜单〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
的 Split 功能将线和面分割， 将形成很多组沿径向对应的点， 这些点将用来定义 Leader- Follo-〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
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wer 点。 命令流文件 fc- fgeo. in 记录了几何加工的全过程， 对几何加工感兴趣的读者可以查〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
看并读取命令流文件来了解几何前处理的过程， 读取完文件后， 图形区将得到两个 Body，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
分别对应于 fc- fgeo1. x_t 和 fc- fgeo2. x_t。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

单击菜单 Meshing→Mesh Density→Body， 在弹出的对话框中将 Method 选择为 Use
Length， 并在 Element Edge Length 处输入 0. 02， 单击 OK 按钮。

单击菜单 Meshing→Mesh Density→Face， 在弹出的对话框中将 Face 选择为 74， 单击表

格右侧的 Auto 按钮， 在弹出对话框的 From 行和 To 行处分别输入 32 和 62， 单击 OK 按钮；
再次单击 Auto 按钮， 在弹出对话框的 From 行和 To 行分别输入 68 和 73， 单击 OK 按钮， 确

认 Method 选择为 Use Length， 并在 Element Edge Length 处输入 0. 005， 单击 OK 按钮。
单击菜单Meshing→Mesh Density→Edge， 在弹出的对话框中将 Edge 选择为 5， 将Method

选择为 Use Number of Division， 在 Number of Subdivisions 处输入 3， 在 Length Ratio of Element
Edges 处输入 3， 单击 OK 按钮。

单击菜单 ADINA-M→Define Body （或图标 ）， 将弹出 Define Body 对话框， 单击 Add
按钮将 Type 选择为 Transformed， 单击 Transformation 右侧的按钮 ， 在弹出的对话框中单击

Add 按钮， 将 Type 选择为 Rotation， 在 Angle of Rotation 处输入 120， 将 Axis 选择为 Z， 单击

OK 按钮， 返回到定义 Body 对话框， 在 Parent Body 处输入 1， 将 Number of Copies 修改为 2，
将 Transformation 选择为 1， 单击 OK 按钮。

单击菜单 Geometry→Faces→Face Link， 在弹出的对话框中单击 Add 按钮， 将 Type 选择

为 Created for all Surfaces / Faces， 单击 OK 按钮。
单击菜单 ADINA-M→Import Parasolid Model （或图标 ） 来读取几何文件 fc- fgeo2. x_t。
提示： 把几何模型分开为两个文件 fc- fgeo1. x_t 和 fc- fgeo2. x_t 分别导入 AUI 的原因是：〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

如果仅选用一个 x_t 文件来导入， 在移动界面 （Sliding Mesh） 处将共用相同的几何点， 这样〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
就会出现移动界面连动现象， 而该现象不是读者所希望看到的。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

单击菜单Meshing→Mesh Density→Body， 在弹出的对话框中将 Body 选择为 4， 将Method
选择为 Use Length， 在 Element Edge Length 处输入 0. 02， 单击 OK 按钮。

单击菜单 Meshing→Mesh Density→Face， 在弹出的对话框中确认 Body 选择为 4， 将 Face
选择为 1， 单击表格右侧的 Auto 按钮， 在弹出对话框的 From 行和 To 行分别输入 2 和 6， 单

击 OK 按钮， 确认 Method 选择为 Use Length， 并在 Element Edge Length 处输入 0. 1， 单击 OK
按钮。

单击菜单 Meshing→Mesh Density→Edge， 在弹出的对话框中确认 Body 选择为 4， Edge
选择为 15， 在表格的第 1 行输入 23， 将Method 选择为 Use Length， 并在 Element Edge Length
处输入 0. 003， 单击 OK 按钮。

依次单击图标 和 ， 然后单击图标 ， 此时图形区将给出如图 9-25 所示的划分网格

后的模型示意图。
3） 定义材料。
单击菜单Model→Material→Manage Material （或图标 ）， 将弹出材料定义对话框， 单击

Constant 按钮， 在弹出的对话框中单击 Add 按钮， 在 Viscosity 处输入 2e-5， 在 Density 处输

入 1. 2， 在 Fluid Buck Modulus 处输入 1 e6， 依次单击 OK 按钮和 Close 按钮退出对话框。 材

料定义完毕。
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图 9-25　 划分网格后的模型示意图

4） 定义单元组。
单击菜单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add

按钮来定义单元组 1， 将 Type 选择为 3- D Fluid， 单击 Save 按钮， 单击 Copy 按钮并输入 2，
依次单击 OK 按钮和 Cancel 按钮退出对话框。 单元组定义完毕。

5） 定义特殊边界条件。
单击菜单 Model→Special Boundary Condition （或图标 ）， 在弹出的对话框中单击 Add

按钮， 确认 Type 选择为 Wall， Apply to 选择为 Faces， Body 选择为 4， 并在表格的前 4 行依

次输入 2、 3、 4、 6， 单击 Save 按钮。
单击 Add 按钮， 确认 Type 选择为 Wall， Apply to 选择为 Faces / Surfaces， 在表格前 3 行

的 Faces / Surfaces 依次输入 7、 12、 13， Body 均输入 4， 单击表格上部的 Auto 按钮， 在弹出

的对话框中， 在 From 行的 Face / Surface #处输入 32， Body #处输入 1， 在 To 行的 Face / Sur-
face #处输入 62， Body #处输入 1， 单击 OK 按钮； 再次单击表格上部的 Auto 按钮， 在弹出

的对话框中， 在 From 行的 Face / Surface #处输入 32， Body #处输入 2， 在 To 行的 Face / Sur-
face #处输入 62， Body #处输入 2， 单击 OK 按钮； 再次单击表格上部的 Auto 按钮， 在弹出

的对话框中， 在 From 行的 Face / Surface #处输入 32， Body #处输入 3， 在 To 行的 Face / Sur-
face #处输入 62， Body #处输入 3， 单击 OK 按钮； 拖动表格右侧的滑动条至表格底部， 单击

表格的第 96 行来扩展表格， 在表格的第 97、 98、 99 行的 Faces / Surfaces 处均输入 74， Body
处依次输入 1、 2、 3， 单击 Save 按钮。

单击 Add 按钮， 确认 Type 选择为 Fluid- Structure Interface， Apply to 选择为 Faces / Sur-
faces， 单击表格上部的 Auto 按钮， 在弹出的对话框中， 在 From 行的 Face / Surface #处输入

68， Body #处输入 1， 在 To 行的 Face / Surface #处输入 73， Body #处输入 1， 单击 OK 按钮；
再次单击表格上部的 Auto 按钮， 在弹出的对话框中， 在 From 行的 Face / Surface #处输入 68，
Body #处输入 2， 在 To 行的 Face / Surface #处输入 73， Body #处输入 2， 单击 OK 按钮； 再次

单击表格上部的 Auto 按钮， 在弹出的对话框中， 在 From 行的 Face / Surface #处输入 68，
Body #处输入 3， 在 To 行的 Face / Surface #处输入 73， Body #处输入 3， 单击 OK 按钮， 单击

Save 按钮。
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单击 Add 按钮， 确认 Type 选择为 Sliding Mesh， Apply to 选择为 Faces / Surfaces， 单击表

格上部的 Auto 按钮， 在弹出的对话框中， 在 From 行的 Face / Surface #处输入 1， Body #处输

入 1， 在 To 行的 Face / Surface #处输入 31， Body #处输入 1， 单击 OK 按钮； 再次单击表格上

部的 Auto 按钮， 在弹出的对话框中， 在 From 行的 Face / Surface #处输入 65， Body #处输入

1， 在 To 行的 Face / Surface #处输入 67， Body #处输入 1， 单击 OK 按钮； 再次单击表格上部

的 Auto 按钮， 在弹出的对话框中， 在 From 行的 Face / Surface #处输入 1， Body #处输入 2，
在 To 行的 Face / Surface #处输入 31， Body #处输入 2， 单击 OK 按钮； 再次单击表格上部的

Auto 按钮， 在弹出的对话框中， 在 From 行的 Face / Surface #处输入 65， Body #处输入 2， 在

To 行的 Face / Surface #处输入 67， Body #处输入 2， 单击 OK 按钮； 再次单击表格上部的 Auto
按钮， 在弹出的对话框中， 在 From 行的 Face / Surface #处输入 1， Body #处输入 3， 在 To 行

的 Face / Surface #处输入 31， Body #处输入 3， 单击 OK 按钮； 再次单击表格上部的 Auto 按

钮， 在弹出的对话框中， 在 From 行的 Face / Surface #处输入 65， Body #处输入 3， 在 To 行的

Face / Surface #处输入 67， Body #处输入 3， 单击 OK 按钮； 单击 Save 按钮。
单击 Add 按钮， 确认 Type 选择为 Sliding Mesh， Apply to 选择为 Faces， Body 选择为 4，

在表格的前 4 行依次输入 8、 9、 10、 11， 单击 Save 按钮。 单击表格下部的 Boundary Condi-
tion Pair 按钮， 在弹出的对话框中为 B. C. # 1 输入 4， 为 B. C. # 2 输入 5， 单击 OK 按钮两次

退出对话框。 特殊边界条件定义完毕。
6） 定义并施加载荷。
定义速度载荷的操作如下： 单击菜单 Model→Usual Boundary Conditions / Loads→Apply

（或图标 ）， 在弹出的对话框中确认 Load Type 选择为 Velocity， 单击右侧的 Define 按钮，
在弹出的对话框中单击 Add 按钮， 在 Z 处输入 - 5， 单击 OK 按钮。 将 Apply to 选择为 Face，
在表格第 1 行的 Site #处输入 1， Body #处输入 4， 单击 OK 按钮。

7） 设定节点跟随。
单击菜单 Meshing→ALE Mesh Constraints→Leader- Follower， 弹出对话框， 由于需要设定

的节点较多， 因此事先准备好文本文件 leader- follower. txt （保存于随书光盘文件夹 \ 9-4 \
model \ 中）， 单击 Import 按钮导入该文件， 拖动表格右侧的滑动条确认共包含 288 行， 单击

OK 按钮。
8） 划分网格。
单击菜单 Meshing→Create Mesh→Body （或图标 ）， 在弹出的对话框中将 Element

Group 选择为 1， 在表格的前 3 行依次输入 1、 2、 3， 单击 Apply 按钮； 将 Element Group 选

择为 2， 在表格的第 1 行输入 4； 单击 More Options 标签， 将 Check 选择为 No Checking， 单

击 OK 按钮， 然后等待网格划分完毕。
9） 定义时间步。
单击菜单 Control→Time Step， 将弹出 Define Time Step 对话框， 在表格的第 1 行输入

20， 0. 005； 在表格的第 2 行输入 200， 0. 01， 单击 OK 按钮。 依次单击图标 和 ， 然后单

击图标 ， 图形区将给出如图 9-26 所示的模型示意图。
10） 生成求解文件。
单击菜单 File→Save （或图标 ） 将文件保存为 C- example04f. idb。 单击菜单 Solution→

Data File / Run （或单击图标 ）， 在弹出的对话框中输入文件名 C- example04f， 确认退选
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图 9-26　 模型示意图

Run Solution 选项后， 单击保存按钮。
2. 结构模型

1） 设定模型控制参数。
启动 ADINA- AUI， 单击图标 ， 将程序模块选择为 ADINA Structures， 算法选择为

Dynamics- Implicit， 单击右侧的图标 ， 将弹出 Implicit Transient Dynamics 对话框， 勾选 Use
Automatic Time- Stepping 选项， 单击 OK 按钮， 选择 FSI 分析。

单击菜单 Control→Analysis Assumptions→Kinematics， 在弹出的对话框中将 Displace-
ments / Rotations 选择为 Large， 其余参数不变， 单击 OK 按钮。

单击菜单 Control→Solution Process， 在弹出的对话框中单击 Iteration Method 按钮， 在弹

出的对话框中将 Maximum Number of Iterations 修改为 50， 将 Use of Line Searches 选择为 Yes，
单击 OK 按钮两次退出对话框。

2） 定义几何及网格密度。
单击菜单 ADINA-M→Import Parasolid Model （或图标 ） 来读取几何文件 fc- s. x_t。
单击布尔运算图标 ， 在弹出的对话框中将 Operator Type 选择为 Subtract， 将 Target

Body 选择为 2， 在表格的第 1 行输入 1， 勾选 Keep the Subtracting Bodies 选项， 勾选 Keep the
Imprinted Edges Created by the Subtraction 选项， 单击 OK 按钮。

单击菜单 Meshing→Mesh Density→Complete Model， 在弹出的对话框中将 Subdivision
Mode 选择为 Use Length， 在 Element Edge Length 处输入 0. 005， 单击 OK 按钮。

单击菜单 Meshing→Mesh Density→Edge， 在弹出的对话框中将 Body 选择为 1， Edge 选

择为 12， 在表格的第 1 行输入 10， 将 Method 选择为 Use Number of Division， 并在 Number of
Subdivisions 处输入 12， 单击 OK 按钮。

单击菜单 Meshing→Mesh Density→Edge， 在弹出的对话框中将 Body 选择为 1， Edge 选

择为 5， 在表格的前 3 行依次输入 6、 7、 8， 将 Method 选择为 Use Number of Division， 并在

Number of Subdivisions 处输入 20， 单击 OK 按钮。
单击菜单 Meshing→Mesh Density→Edge， 在弹出的对话框中将 Body 选择为 2， Edge 选

择为 9， 在表格的第 1 行输入 7， 将 Method 选择为 Use Number of Division， 并在 Number of
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Subdivisions 处输入 12， 单击 OK 按钮。
单击菜单 ADINA-M→Define Body （或图标 ）， 将弹出 Define Body 对话框， 单击 Add

按钮， 将 Type 选择为 Transformed， 单击 Transformation 右侧的按钮 ， 在弹出的对话框中单

击 Add 按钮， 将 Type 选择为 Rotation， 在 Angle of Rotation 处输入 120， 将 Axis 选择为 Z， 单

击 OK 按钮， 返回到定义 Body 对话框， 在 Parent Body 处输入 1， 将 Number of Copies 修改为

2， 将 Transformation 选择为 1， 在表格的第 1 行输入 2， 单击 OK 按钮。
单击菜单 Geometry→Faces→Face Link， 在弹出的对话框中单击 Add 按钮， 将 Type 选择

为 Created for all Surfaces / Faces， 单击 OK 按钮。 在软件底部的信息窗口将显示： 6 face- links
are created。

单击菜单 Geometry→Lines→Define （或图标 ）， 将弹出 Define Line 对话框， 单击 Add
按钮， 将 Type 选择为 Extrude， 在 Initial Point 处输入 10， 在 Vector 中， 将 X 改为 0， Z 处输

入 - 0. 1， 单击 OK 按钮。 单击图标 并到图形区中删掉已创建的线， 删除直线后按 Esc 键

退出删除状态。 此时图形区将给出如图 9-27 所示的模型示意图。

图 9-27　 划分网格后的模型示意图

3） 定义材料。
单击菜单Model→Material→Manage Material （或图标 ）， 将弹出材料定义对话框， 单击

Elastic 下的 Isotropic 按钮来定义线弹性材料。 在弹出的对话框中单击 Add 按钮来定义材料

1， 在 Young’s Modulus 处输入 3e10， 在 Poisson’s Ratio 处输入 0. 3， 在 Density 处输入 900， 依

次单击 OK 按钮和 Close 按钮退出对话框。 材料定义完毕。
4） 定义单元组。
单击菜单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add

按钮来定义单元组 1， 将 Type 选择为 3- D Solid， 确认 Default Material 选择为 1， 其余设置保

持不变， 单击 OK 按钮。 单元组定义完毕。
5） 划分网格。
单击菜单 Meshing→Create Mesh→Point， 在弹出对话框中表格的第 1 行输入 30， 单击

OK 按钮。
单击菜单 Meshing→Create Mesh→Body （或图标 ）， 在弹出的对话框中确认 Element
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Group 选择为 1， Meshing Type 选择为 Rule- Based， Nodes per Element 选择为 8， 并在表格的

前 3 行依次输入 1、 3 和 4， 单击 Apply 按钮等待网格划分完毕； 将 Meshing Type 选择为

Free- Form， Nodes per Element 选择为 8， 并在表格的前 3 行依次输入 2、 5 和 6， 单击 OK 按

钮。 依次单击图标 和 ， 图形区将给出如图 9-28 所示的划分网格后模型示意图。

图 9-28　 划分网格后的模型示意图

6） 定义并施加约束。
单击菜单 Model→Boundary Conditions→Apply Fixity （或图标 ）， 在弹出的对话框中单

击 Define 按钮， 单击 Add 按钮并输入名字 c， 单击 OK 按钮， 勾选 X- Translation、 Y- Transla-
tion、 Z- Translation、 X- Rotation 和 Y- Rotation， 单击 OK 按钮。 确认 Apply to 选择为 Points，
并在表格第 1 行的 Point 处输入 30， 将 Fixity 选择为 C， 单击 OK 按钮。 约束定义完毕。

7） 定义特殊边界条件。
定义 Rigid Links 边界条件的操作如下： 单击菜单 Model→Constraints→Rigid Links， 在弹

出的对话框中， 单击 Add 按钮， 确认 Master 下的 Entity Type 选择为 Point， 在 Entity 处输入

30， 将 Slave 下的 Entity Type 选择为 Face， 在 Entity 处输入 2， Body 选择为 2， 将 Displace-
ments 选择为 Large， 单击 Save 按钮。 按照相同的操作方法， 继续定义新的 Rigid Links， 单击

Add 按钮， 确认 Master 下的 Entity Type 选择为 Point， 在 Entity 处输入 30， 将 Slave 下的 Entity
Type 选择为 Face， 在 Entity 处输入 2， 将 Body 选择为 5， Displacements 选择为 Large， 单击

Save 按钮。 同理， 继续定义新的 Rigid Links， 单击 Add 按钮， 确认 Master 下的 Entity Type
选择为 Point， 在 Entity 处输入 30， 将 Slave 下的 Entity Type 选择为 Face， 在 Entity 处输入 2，
Body 选择为 6， Displacements 选择为 Large， 单击 OK 按钮。

定义流固耦合边界条件的操作如下： 单击菜单 Model→Boundary Conditions→FSI Boundary，
在弹出的对话框中单击 Add 按钮， 将 Apply to 选择为 Faces / Surfaces， 单击表格上部的 Auto
按钮， 在弹出对话框中 From 行的 Face / Surface #处输入 2， Body #处输入 1， To 行的 Face /
Surface #处输入 6， Body #处输入 1， 单击 OK 按钮； 再次单击表格上部的 Auto 按钮， 在弹出

对话框中 From 行的 Face / Surface #处输入 2， Body #处输入 3， To 行的 Face / Surface # 处输入

6， Body #处输入 3， 单击 OK 按钮； 再次单击表格上部的 Auto 按钮， 在弹出对话框中 From
行的 Face / Surface # 处输入 2， Body #处输入 4， To 行的 Face / Surface #处输入 6， Body #处输
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入 4， 单击 OK 按钮。 拖动表格右侧的滑动条至表格底部， 单击表格的第 15 行来扩展表格，
将表格第 16、 17、 18 行的 Faces / Surfaces 处均输入 1， Body 处依次输入 2、 5、 6， 单击 OK
按钮。 依次单击图标 和 ， 图形区将给出如图 9-29 所示的模型示意图。

图 9-29　 显示特殊边界条件的模型示意图

8） 生成求解文件。
单击菜单 File→Save （或图标 ） 将文件保存为 C- example04s. idb。 单击菜单 Solution→

Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 C- example04s， 退选 Run Solution
选项并单击保存按钮。

9. 4. 3　 求解

单击菜单 Solution→Run ADINA- FSI， 在弹出的对话框中单击 Start 按钮， 然后选择

C- example04s 和 C- example04f， 单击 Start 按钮并等待分析结束。

9. 4. 4　 后处理

程序模块选择为 Post- Processing。 单击菜单 File→Open （或图标 ）， 打开结果文件

C- example04f. por。
单击图标 去掉网格显示， 单击图标 显示内部轮廓， 单击图标 和图标 ， 确认图

形区的左上角时间已回到 0 时刻。 单击菜单 Display→Particle Trace Plot→Create， 弹出对话

框， 单击 Trace Rake 右侧的 按钮， 弹出对话框， 将 Type 选择为 Grids， 表格的第 1 行按

表 9-6 所示的数据信息输入， 单击 OK 按钮两次退出对话框， 这时图形区将如图 9-30 所示。
单击图标 可以制作动画， 动画制作完毕后， 单击图标 可以观看动画， 单击图标 可以保

存为动画文件。

表 9-6　 Trace Rake 分布

X Y Z Plane Shape Side 1 Length NSIDE1 Side 2 Length NSIDE2

0 0 0. 2 Z- Plane Elliptical 0. 2 3 0. 2 8
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图 9-30　 Trace Rake 分布图

分别单击图标 、 、 和 ， 将时间调整到计算的最后一刻， 单击图标 ， 弹出对话

框， 将 Type 选择为 Cutting Plane， 确认 Defined by 选择为 X- Plane， 单击 OK 按钮。 单击图标

， 图形区将显示切片的压力云图， 如图 9-31 所示。 单击图标 可以制作动画， 动画制作

完毕后， 单击图标 可以观看动画， 单击图标 可以保存为动画文件。

图 9-31　 切片压力云图

单击图标 ， 再单击图标 来打开文件 C- example04s. por。 单击菜单 Definition→Model
Point→Node， 弹出对话框， 单击 Add 按钮， 输入 N1， 单击 OK 按钮。 在 Node # 处输入 1，
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单击 OK 按钮。 单击图标 清空图形区， 单击菜单 Graph→Response Curve （Model Point），
弹出对话框， 将 Y Coordinate 下的 Variable 选择为 （Displacement， Z- ROTATION）， 单击 OK
按钮， 此时图形区将如图 9-32 所示。

图 9-32　 Z- ROTATION 变化曲线

单击图标 清空图形区， 单击菜单 Graph→Response Curve （Model Point）， 弹出对话框，
将 Y Coordinate 下的 Variable 选择为 （Velocity， Z- ANGULAR_VELOCITY）， 单击 OK， 这时

图形区如图 9-33 所示。

图 9-33　 Z- ANGULAR_VELOCITY 变化曲线

9. 4. 5　 应用推广和建议

本实例可以推广应用到所有的旋转机械分析中， 例如， 风机、 水轮机、 各种旋转机械结

构等。
本实例也可以采用网格重划分技术来进行分析 （例如， Primer 手册中的例题 48、 例题

49 所采用的方法）。 在网格 overlap 后， 可以重划分网格， 再继续计算。 当然采用了重划分

网格技术后， Leader- Follower 的设置就不必再像本实例的设置这么复杂。
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9. 5　 多柱绕流流固耦合分析

9. 5. 1　 问题描述

本实例为多柱绕流流固耦合分析。 在方形管道的中心线上包含 4 根圆柱， 水流要绕过圆

柱流入管道， 在流动过程中水沿柱面将产生法向的扰动力， 促使结构发生振动。 在 ADINA
软件中， 通过设定复合积分算法来实现扰动力的求解。 通过学习本实例， 读者可以掌握下列

几个功能：
1） 设定流固耦合分析。
2） 使用 FCBI- C 算法。
3） 使用流场复合积分算法。
本实例完整的命令流文件为 C- example05s. in 和 C- example05f. in， 它们均保存在随书光

盘文件夹 \ 9-5 \ model \ 中。

9. 5. 2　 前处理

1. 流场模型

1） 设定模型控制参数。
启动 ADINA- AUI， 程序模块选择为 ADINA CFD， 分析类型选择为 Transient， 单击图标

， 在弹出的对话框中将 Integration Method 选择为 Composite， 其他参数不变， 单击 OK
按钮。

单击菜单 Model→Fluid Assumption， 在弹出的对话框中退选 Include Heat Transfer 选项，
勾选 FSI 选项， 单击 OK 按钮。

单击菜单 Control→Solution Process， 在弹出的对话框中将 Flow- Condition- Based Interpola-
tion Elements 选择为 FCBI- C， 单击 Outer Iteration 按钮， 在弹出的对话框中单击 Advanced
Settings 按钮， 在弹出的对话框中勾选 Use Pressure- Implicit with Splitting of Operators （PISO）
Scheme 选项， 单击 OK 按钮三次退出所有对话框。

单击菜单 Control→Porthole （ . por） →Volume， 在弹出的对话框中退选 Save Individual
Element Results 选项， 单击 OK 按钮。 退选该选项后， 计算结果文件将不会很大， 但会丢失

单元的计算结果， 建议退选。
2） 定义几何及网格密度。
单击菜单 File→Open （或图标 ）， 读取命令流文件 C- example05f- geo. in， 单击图标

和 ， 图形区将给出如图 9-34 所示的模型示意图。 该命令流中包含下列命令： ①定义了 1
个柱坐标系； ②建立了 25 个初始点； ③生成了基本面； ④设定了网格密度并将面拉伸为体。
详细的操作过程请参考命令流文件， 此处不再赘述。

3） 定义特殊边界条件。
单击菜单 File→Open （或图标 ） 来读取命令流文件 C- example05f- sbc. in （保存于随书

光盘的文件夹 \ 9-5 \ model \ 中）， 该命令流中定义了 1 个 wall 边界条件和 4 个流固耦合边

界条件。
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图 9-34　 模型示意图

4） 定义并施加载荷。
定义速度载荷的操作如下： 单击菜单 Model→Usual Boundary Conditions / Loads→Apply

（或图标 ）， 在弹出的对话框中确认 Load Type 选择为 Velocity， 单击右侧的 Define 按钮，
在弹出的对话框中单击 Add 按钮， 并在 X 处输入 3. 33， 单击 OK 按钮。 将 Apply to 选择为

Surface， 并在表格的前 3 行的 Site # 下依次输入 51、 47、 43， 单击 OK 按钮。
5） 定义材料。
单击菜单Model→Material→Manage Material （或图标 ）， 将弹出材料定义对话框， 单击

Constant 按钮， 在弹出的对话框中单击 Add 按钮， 在 Viscosity 处输入 0. 001， 在 Density 处输

入 1000， 在 Fluid Buck Modulus 处输入 2. 56e9， 依次单击 OK 按钮和 Close 按钮退出对话框。
材料定义完毕。

6） 定义单元组。
单击菜单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add

按钮来定义单元组 1， 将 Type 选择为 3- D Fluid， 单击 OK。 单元组定义完毕。
7） 划分网格。
单击菜单 Meshing→Create Mesh→Volume （或图标 ）， 在弹出的对话框中将 Nodes per

Element选择为 8， 退选 Wedge Volumes Treated as Degenerate 选项， 单击表格上部的 Auto 按钮，
并分别在 From 行和 To 行处输入 1 和 39， 单击 OK 按钮两次退出对话框， 等待网格划分完毕。

8） 定义时间函数。
单击菜单 Control→Time Function， 在弹出的对话框中， 按照表 9-7 修改数据修改时间函

数 1， 单击 OK 按钮， 时间函数定义完毕。

表 9-7　 定义时间函数

Time Value

1 0 0

2 0. 2 1. 0

3 1. 0E + 20 1. 0
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9） 定义时间步。
单击菜单 Control→Time Step， 在弹出对话框中表格的第 1 行输入 800， 0. 0025， 单击

OK 按钮。 依次单击图标 和 ， 然后单击图标 ， 图形区将给出如图 9-35 所示的模型示

意图。

图 9-35　 模型示意图

10） 生成求解文件。
单击菜单 File→Save （或图标 ）， 将文件保存为 C- example05f. idb 和 C- example05f. in。

单击菜单 Solution→Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 C- exam-
ple05f， 退选 Run Solution 选项并单击保存按钮。

2. 结构模型

1） 设定模型控制参数。
启动ADINA- AUI， 单击图标 ， 程序模块选择为ADINA Structures， 算法选择为Dynamics-

Implicit， 单击右侧的图标 将弹出 Implicit Transient Dynamics 对话框， 勾选 Use Automatic
Time- Stepping 选项， 单击 OK 按钮， 选择 FSI 分析。

2） 定义几何及网格密度。
单击菜单 File→Open （或图标 ）， 读取命令流文件 C- example05s- geo. in （保存于随书

光盘文件夹 \ 9-5 \ model \ 中）， 单击图标 和 ， 图形区将给出如图 9-36 所示的几何模型

示意图。 该命令流中包含下列命令： 1） 定义了 1 个柱坐标系； 2） 创建了 5 个初始点；
3） 生成了基本面； 4） 设定了网格密度， 并将面进行复制。 详细的操作过程请参考命令流

文件， 此处不再赘述。
3） 定义材料。
单击菜单Model→Material→Manage Material （或图标 ）， 将弹出定义材料对话框， 单击

Elastic 下的 Isotropic 按钮来定义线弹性材料。 在弹出的对话框中单击 Add 按钮来定义材料

1， 在 Young’s Modulus 处输入 2e11， 在 Poisson’s Ratio 处输入 0. 3， 在 Density 处输入 7800，
依次单击 OK 按钮和 Close 按钮退出对话框。 材料定义完毕。

4） 定义单元组。
单击菜单 Meshing→Element Group （或图标 ） ， 将弹出定义单元组对话框。 单击
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图 9-36　 几何模型示意图

Add 按钮来定义单元组 1， 将 Type 选择为 Shell， 确认 Default Material 选择为 1， 在

Default Element Thickness 处输入 0. 002， 其余设置保持不变， 单击 OK 按钮。 单元组定

义完毕。
5） 划分网格。
单击菜单 Meshing→Create Mesh→Surface （或图标 ）， 在弹出的对话框中确认 Element

Group 选择为 1， MeshingType 选择为 Rule- Based， Nodes per Element 选择为 4， 单击表格上

部的 Auto 按钮， 在 To 处输入 1， 在 From 处输入 16， 单击 OK 按钮两次退出对话框。 依次

单击图标 和 ， 图形区将给出如图 9-37 所示的模型示意图。

图 9-37　 划分网格后的模型示意图

6） 定义并施加约束。
单击菜单 Model→Boundary Conditions→Apply Fixity （或图标 ）， 在弹出的对话框中将

Apply to 选择为 Lines， 双击表格第 1 行的绿色图框， 并到图形区拾取 4 个圆柱上下底的 32
条边， 单击 OK 按钮。 约束定义完毕。

7） 定义特殊边界条件。
单击菜单 Model→Boundary Conditions→FSI Boundary， 在弹出的对话框中单击 Add
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按钮， 将 Apply to 选择为 Surfaces， 并在表格的前 4 行依次输入 1、 2、 3、 4， 单击 Save
按钮； 单击 Add 按钮来定义流固耦合边界 2， 在表格的前 4 行依次输入 5、 8、 11、 14，
单击 Save 按钮； 单击 Add 按钮来定义流固耦合边界 3， 在表格的前 4 行依次输入 6、 9、
12、 15， 单击 Save 按钮； 单击 Add 按钮来定义流固耦合边界 4， 在表格的前 4 行依次

输入 7、 10、 13、 16， 单击 OK 按钮， 依次单击图标 和 ， 单击图标 ， 图形区如图

9-38 所示。

图 9-38　 图形区

8） 生成求解文件。
单击菜单 File→Save （或图标 ）， 将文件保存为 C- example05s. idb。 单击菜单 Solution→

Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 C- example05s， 退选 Run Solution
选项后单击保存按钮。

9. 5. 3　 求解

单击菜单 Solution→Run ADINA- FSI， 在弹出的对话框中单击 Start 按钮， 选择 C- exam-
ple05s 和 C- example05f， 单击 Start 按钮并等待计算结束。

9. 5. 4　 后处理

程序模块选择为 Post- Processing。 单击菜单 File→Open （或图标 ）， 将文件类型选择

为 *. idb， 并打开文件 C- example05f. idb； 单击菜单 File→Open （或图标 ） 来打开结果文

件 C- example05f. por。
由几何来定义 4 个 Model Point 的操作如下： 单击菜单 Definations→Modle Point （ combi-

nation）→General， 在弹出的对话框中单击 Add 按钮， 在弹出的对话框中输入 cylinder-1， 并

单击 OK 按钮， 将 Entity 选择为 Geometry Surface， 单击 Enter 按钮， 在表格第 1 行的 Geome-
try Surface 处输入 62。 按照相同的操作步骤用鼠标单击第 2、 3、 4 行， 再单击 Enter 按钮，
在表格第 2、 3、 4 行的 Geometry Surface 后依次输入 67、 71、 73， 单击 Save 按钮； 单击 Add
按钮， 在弹出的对话框中输入 cylinder-2， 单击 OK 按钮， 与定义 cylinder-1 的方法相同， 在

表格的前 4 行依次输入 Geometry Surface103、 114、 122、 128， 单击 Save 按钮； 单击 Add 按
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钮， 在弹出的对话框中输入 cylinder-3， 单击 OK 按钮， 与定义 cylinder-1 的方法相同， 在表

格的前 4 行依次输入 Geometry Surface108、 118、 126、 130， 单击 Save 按钮； 单击 Add 按钮，
在弹出的对话框中输入 cylinder-4， 单击 OK 按钮， 与定义 cylinder-1 的方法相同， 在表格的

前 4 行依次输入 Geometry Surface 158、 164、 168、 170， 单击 OK 按钮。 此时， Model Point 定
义完毕。

分别查看 Model Point 14 的支反力 （法向扰动力） 时程曲线， 单击图标 来清空图

形区。 单击菜单 Graph→Response Curve （Modle Point） ， 在弹出的对话框中确认 X Coor-
dinate 和 Y Coordinate 下的 Model Point 选择为 CYLINDER-1， 将 Y Coordinate 下的 Varia-
ble 选择为 Reaction， Y- Reaction， 单击 Apply 按钮， 图形区如图 9-39 所示。 按照相同的

操作方法可以查看其他 3 个 Model Point 的支反力时程曲线， 分别如图 9-40、 图 9-41 和

图 9-42 所示。

图 9-39　 Y 方向反力时程曲线 （Model Point 1）

图 9-40　 Y 方向反力时程曲线 （Model Point 2）
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图 9-41　 Y 方向反力时程曲线 （Model Point 3）

图 9-42　 Y 方向反力时程曲线 （Model Point 4）

由图 9-39 ～图 9-42 可知， Cylinder-4 的扰动力最先发生， 然后是 Cylinder-3、 Cylinder-2，
最后是 Cylinder-1。 由此可以判断结构场应该是 Cylinder-4 首先发生扰动。

依次单击图标 和 ， 并退选图标 来消去几何显示功能。 再依次单击图标 和 ， 在

弹出的对话框中将 Type 选择为 Cutting Plane， 将 Defined by 选择为 Z- Plane， 在 Coordinate
Value 处输入 0. 05， 单击 OK 按钮。 单击图标 可以显示流体压力分布云图， 如图 9-43 所

示； 单击图标 可以制作压力动画。 动画制作结束， 单击图标 可以观看动画； 单击图标

可以保存动画； 单击刷新图标 可以退出动画状态。
依次单击图标 和 来打开结果文件 C- example07s. por。
查看位移动画的操作如下： 单击图标 来放大位移的变形， 图形区如图 9-44 所示。 单

击制作动画图标 ， 等动画制作完毕单击图标 来观看动画， 单击图标 来保存动画， 单击

刷新图标 来退出动画状态。
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图 9-43　 流体压力分布云图

图 9-44　 结构变形图

9. 5. 5　 应用推广

本实例可以推广应用到水下结构分析中， 例如， 水下桥墩、 各类水下结构、 管道分

析等。



本章内容：

■ 10.1 沥青心墙坝渗流分析

■ 10.2 沥青心墙坝静力施工及动

力抗震分析

■ 10.3 城市交叠隧道施工过程分析

■ 10.4 桩基挡土墙施工填土堆载

过程分析

■ 10.5 井点降水（水土耦合） 分析

■ 10.6 水下沉箱抗震及冲击 （流

固耦合） 分析

土木实例分析
第 10 章
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本章将介绍土木工程的 6 个典型应用实例， 包括： 渗流、 填筑施工及动力抗震、 开挖及

支护、 单元生死的接触问题、 水土耦合以及流固耦合。 其中， 10. 1 节 “沥青心墙坝渗流分

析” 在 ADINA- Thermal 模块中完成， 无须在其他模块中建模； 10. 2 节 “沥青心墙坝静力施

工及动力抗震分析”、 10. 3 节 “城市交叠隧道施工过程分析”、 10. 4 节 “桩基挡土墙施工填

土堆载过程分析” 和 10. 5 节 “井点降水 （水土耦合） 分析” 都在 ADINA- Structures 模块中

完成， 无须在其他模块中建模； 10. 6 节 “水下沉箱抗震及冲击 （流固耦合） 分析” 则属于

流固耦合问题， 需要在 ADINA- Structures 模块和 ADINA- CFD 模块中分别建模， 并生成求解

文件， 共同提交计算。

10. 1　 沥青心墙坝渗流分析

10. 1. 1　 问题描述

某沥青混凝土心墙坝的正常蓄水位为 1240. 00m， 相应下游水位为 1130. 00m。 本实例将

应用温度场进行渗流场计算， 读者可以参看本书 5. 5 节的内容。 分析过程中， 上、 下游堆石

体和过渡层材料均取沙砾料的计算参数。 坝体填筑料和基岩渗透系数如表 10-1 所示， 沥青

心墙坝坝体填筑及分区情况如图 10-1 所示。

表 10-1　 坝体填筑料和基岩渗透系数

分　 　 区 渗透系数 （cm / s）

砂砾料 2. 0 × 10 - 2

沥青混凝土心墙 1. 0 × 10 - 8

混凝土 7 × 10 - 6

覆盖层 17 × 10 - 2

基岩 5. 0 × 10 - 5

防渗帷幕 3. 0 × 10 - 5

图 10-1　 坝体分区图

本实例将首先进行心墙坝的 2D 渗流计算， 建模时土石坝采用 2D 实体平面单元； 然后

在 2D 模型的基础上将其扩展成为 3D 模型， 并进行 3D 渗流计算。 通过学习本实例， 读者可
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以掌握下列几个功能：
1） 将 CAD 中的 DXF 文件导入 ADINA 软件， 并从 XY 平面转换到 YZ 平面。
2） 将 2D 模型扩展为 3D 模型。
3） 后处理时查看压力水头及等值线图。
本实例第 1 步导入 DXF 文件的命令流文件为 00_loaddxf. in， 在导入模型的基础上建立

Surface 面模型的命令流文件为 01_loaddxf. in， 将导入的 DXF 模型从 XY 平面转换为 YZ 平面

的命令流文件为 02_loaddxf. in， 2D 渗流模型的命令流文件为 03_Seepage_2D. in。 将 2D 模型

扩展为 3D 模型的命令流文件为 04 _ Seepage _3D. in， 上述文件均保存在随书光盘的文

件夹 \ 10-1 \ model \ 中。

10. 1. 2　 建立 2D 渗流模型

1. 前处理

1） 导入 DXF 文件。
启动 ADINA- AUI， 程序模块选择为 ADINA Thermal。 在 ADINA 软件中导入 DXF 文件需

通过命令流来完成， 此时可创建名为 00_loaddxf. txt 的文本文件， 并输入语句 “loaddxf CAD_
Modify. dxf”， 其中， CAD_Modify. dxf 为 Autocad R12 格式的 CAD 模型文件， 通过修改扩展

名的方法将 00_loaddxf. txt 修改为 00_loaddxf. in 的命令流文件即可。
单击菜单 File→Open （或图标 ） 来打开命令流文件 00_loaddxf. in， 此时已经将 Modi-

fy. dxf 文件导入 ADINA 软件的 XY 平面， 如图 10-2 所示。

图 10-2　 导入 DXF 文件后的模型示意图 （XY 平面）

此时导入的 DXF 模型只包含点和线， 且位于 XY 平面内。 在此基础上通过导入的点来

建立几何面， 然后将点的坐标变换到 YZ 坐标系下， 则这样建立的面将自动转换为 YZ 平面。
提示： 在建立几何面的过程中， 必须由点来建立面， 而不能由线来建立面， 这样做的目〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

的是可以通过改变点的坐标来实现将面从 XY 平面转换到 YZ 平面中。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
单击菜单 Geometry→Surfaces→Define （或图标 ）， 将弹出 Define Surface 对话框。 单击

Add 按钮， 将 Type 选择为 Vertex， 并在 Vector 的 Point 1、 Point 2、 Point 3 和 Point 4 处依次
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输入 56、 21、 1 和 70， 单击 Apply 按钮来创建一个面。 按照相同的操作方法， 继续单击 Add
按钮， 并按照表 10-2 提供的信息建立其他面 （surface）， 共将生成 72 个 Surface 面。

单击菜单 File→Save As， 将所有的操作保存为命令流文件 01_loaddxf. in。

表 10-2　 由 Point 点来生成面 （Surface）

面号 点 1 点 2 点 3 点 4 面号 点 1 点 2 点 3 点 4

1 56 21 1 70 37 80 79 26 57

2 77 56 70 78 38 28 80 57 27

3 81 77 78 82 39 39 31 24 39

4 83 81 82 84 40 35 39 24 79

5 49 83 84 71 41 58 35 79 80

6 50 49 71 72 42 30 58 80 28

7 85 50 72 86 43 29 30 28 29

8 87 85 86 88 44 34 17 18 33

9 75 87 88 76 45 40 34 33 32

10 54 75 76 73 46 40 32 31 39

11 55 54 73 74 47 36 40 39 35

12 3 55 74 2 48 62 36 35 58

13 22 20 21 56 49 41 62 58 30

14 23 22 56 77 50 41 30 29 43

15 24 23 77 81 51 9 41 43 9

16 25 24 81 83 52 9 43 44 8

17 26 25 83 49 53 51 17 34 51

18 57 26 49 50 54 52 51 34 40

19 27 57 50 85 55 64 52 40 36

20 28 27 85 87 56 65 64 36 62

21 48 28 87 75 57 63 65 62 41

22 46 48 75 54 58 10 63 41 9

23 47 46 54 55 59 67 16 51 52

24 61 47 55 3 60 66 67 52 64

25 18 19 20 22 61 38 66 64 65

26 33 18 22 23 62 53 38 65 63

27 32 33 23 31 63 11 53 63 10

28 31 23 24 31 64 15 16 67 15

29 29 28 48 29 65 42 15 67 66

30 44 43 29 48 66 59 42 66 38

31 45 44 48 46 67 60 59 38 53

32 5 45 46 47 68 12 60 53 11

33 4 5 47 61 69 68 14 15 42

34 7 8 44 45 70 37 68 42 59

35 6 7 45 5 71 69 37 59 60

36 79 24 25 26 72 13 69 60 12
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2） 将模型从 XY 平面转换到 YZ 平面。
对于二维分析问题， 2D 模型必须位于 YZ 平面内， 因此需要将刚才建立的面 Surface 模

型从 XY 平面转换到 YZ 平面。 对应的操作如下：
复制刚才保存的命令流文件 01_loaddxf. in， 并将其重新命名为 02_loaddxf. in。 使用文本

编辑软件打开命令流文件 02_loaddxf. in， 将其中的命令流语句 “loaddxf CAD_Modify. dxf” 删

除掉， 然后添加两行命令流 “COORDINATES POINT” 和 “entries name y z”， 该命令流的含

义是： 仅通过点号、 Y 坐标和 Z 坐标来创建 Point 点。
单击图标 ， 在弹出的 Point Coordinates 对话框中选中前 3 列 （见图 10-3）， 同时按下

Ctrl + V 键进行复制， 然后返回到已创建的 02_loaddxf. in 命令流文件， 将复制的 3 列内容粘

贴至已添加的命令流 “entries name y z” 后面， 保存并关闭命令流文件 02_loaddxf. in。

图 10-3　 将 Point 点的部分信息复制到命令流文件中

单击图标 来清除原来的模型并创建一个新模型； 单击图标 来打开命令流文件

02_loaddxf. in； 单击图标 进行阴影查看， 可以看出： 模型面 （Surface） 已经通过 DXF 文件

内点的信息建立起来， 且所建面在 YZ 平面内， 如图 10-4 所示。
3） 定义水头载荷。
ADINA 软件内的水头指的是总水头， 其值是压力水头与高度水头之和。 因此， 施加的

水头载荷与几何建模时的 Z 坐标有关。
本模型按照真实水位来创建， 因此在 Z = 0 处的总水头为零， 读者可以通过查看零水头

是否位于 Z = 0 处或通过查看顶部的 Z 坐标来确认。 由于正常蓄水位为 1240. 00m， 相应的下

游水位为 1130. 00m， 因此需要定义两个水头载荷。 在 ADINA- Thermal 温度模块内， 水头自

由度对应的就是温度的自由度， 界面操作如下：
单击施加载荷图标 ， 在弹出的对话框中将 Load Type 选择为 Temperature， 单击对话框

右上角的 Define 按钮， 在弹出的对话框中单击 Add 按钮， 此时 Temperature Number 为 1， 在
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图 10-4　 模型的面 （Surface） 已经转换到 YZ 平面内

Magnitude 处输入 1240， 单击 Save 按钮； 再次单击 Add 按钮， 此时 Temperature Number 为 2，
在 Magnitude 处输入 1130， 单击 OK 按钮。

将 Load Number 设置为 1， 将 Apply to 选择为 Line， 在表格的第 1 列依次输入 141、 131、
118、 103、 63， 单击 Apply 按钮， 此时将 1240m 水头施加在上游水位线上。

将 Load Number 设置为 2， 将 Apply to 选择为 Line， 在表格的第 1 列依次输入 82、 62、
37， 单击 OK 按钮， 此时将 1130m 水头施加在下游水位线上。

依次单击图标 和 ， 然后单击显示载荷图标 ， 图形区将给出如图 10-5 所示的模型

示意图。

图 10-5　 定义水头载荷后的模型示意图

4） 定义网格密度。
设定网格密度时可以先为坝体指定大致的网格密度， 然后在心墙处进行局部加密。 对于

初次试算， 在心墙处没有进行加密。
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单击菜单 Meshing→Mesh Desinty→Complete Model， 在弹出的对话框中确认 Subdivision
Mode 选择为 Use Length， 在 Element Edge Length 处输入 5， 单击 OK 按钮退出对话框。

5） 定义材料。
单击菜单 Model→Material→Manage Material （或图标 ）， 将弹出材料定义对话框， 单

击 Others 下的 Seepage 按钮来定义渗流材料属性。 在弹出的对话框中单击 Add 按钮来定义材

料 1， 在 Permeability 处输入 7 e-9， 在 Weight Density 处输入 9800， 在 Description 处输入

“concrete”， 单击 Save 按钮。
与上述操作方法类似， 按照表 10-3 提供的属性来定义其余材料。

表 10-3　 坝体填筑料和基岩渗透属性

材　 料　 号 Permeability DENSITY MDESCRIP

1 7. 00E-09 9800 concrete

2 0. 00017 9800 fugai ceng

3 5. 00E-08 9800 ji yan

4 1. 00E-11 9800 li qin concrete

5 2. 00E-05 9800 sha li liao

6 3. 00E-08 9800 fang shen qiang

6） 定义单元组。
对于定义的 6 个材料需要定义 6 个单元组， 对应的操作如下： 单击菜单 Meshing→

Element Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add 按钮来定义单元组 1， 将

Type 选择为 2D Conduction， 将 Element Sub- Type 选择为 Planar， 将 Default Material 选择为 1，
其余设置保持不变， 单击 Save 按钮； 单击 Add 按钮来定义单元组 2， 将 Type 选择为 2D Con-
duction， 将 Element Sub- Type 选择为 Planar， 将 Default Material 选择为 2， 单击 Save 按钮；
单击 Add 按钮来定义单元组 3， 将 Type 选择为 2D Conduction， 将 Element Sub- Type 选择为

Planar， 将 Default Material 选择为 3， 单击 Save 按钮； 单击 Add 按钮来定义单元组 4， 将

Type 选择为 2D Conduction， 将 Element Sub- Type 选择为 Planar， 将 Default Material 选择为 4，
单击 Save 按钮； 单击 Add 按钮来定义单元组 5， 将 Type 选择为 2D Conduction， 将 Element
Sub- Type 选择为 Planar， 将 Default Material 选择为 5， 单击 Save 按钮； 单击 Add 按钮来定义

单元组 6， 将 Type 选择为 2D Conduction， 将 Element Sub- Type 选择为 Planar， 将 Default
Material选择为 6， 单击 OK 按钮退出对话框。

7） 划分网格。
划分混凝土网格的操作如下： 单击菜单 Meshing→Create Mesh→Surface （或图标 ）， 在

弹出的对话框中将 Element Group 选择为 1， 将 Nodes per Element 选择为 4， 双击表格进入图

形区来选择混凝土的面 （Surface）， 也可以在表格中直接输入混凝土的面号： 32、 35、 36、
37、 38、 39、 40、 41、 42、 43， 单击 Apply 按钮。

划分覆盖层网格的操作如下： 将 Element Group 选择为 2， Nodes per Element 仍保持选择

4， 双击表格进入图形区来选择覆盖层所在的面， 也可以在表格中直接输入覆盖层的： 25、
26、 27、 28、 29、 30、 31、 33， 单击 Apply 按钮。

划分基岩网格的操作如下： 将 Element Group 选择为 3， Nodes per Element 仍保持选择 4， 双
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击表格进入图形区来选择基岩所在的面， 也可以在表格中直接输入基岩的面号： 1、 2、 3、 4、 5、
6、 7、 8、 9、 10、 11、 12、 13、 14、 15、 16、 17、 19、 20、 21、 22、 23、 24， 单击 Apply 按钮。

划分沥青混凝土心墙网格的操作如下： 将 Element Group 选择为 4， Nodes per Element 仍
保持选择 4， 双击表格进入图形区来选择沥青混凝土心墙所在的面， 也可以在表格中直接输

入沥青混凝土心墙的面号： 48、 56、 61、 66、 70， 单击 Apply 按钮。
划分沙砾料网格的操作如下： 将 Element Group 选择为 5， Nodes per Element 仍保持选择

4， 双击表格进入图形区来选择沙砾料所在的面， 也可以在表格中直接输入沙砾料的面号：
34、 44、 45、 46、 47、 49、 50、 51、 52、 53、 54、 55、 57、 58、 59、 60、 62、 63、 64、 65、
67、 68、 69、 71、 72， 单击 Apply 按钮。

划分防渗帷幕网格的操作如下： 将 Element Group 选择为 6， Nodes per Element 仍保持选

择 4， 双击表格进入图形区来选择防渗帷幕所在的面， 也可以在表格中直接输入防渗帷幕的

面号： 18， 单击 OK 按钮。 模型网格划分工作完毕。
依次单击图标 和 ， 然后单击图标 ， 图形区将给出如图 10-6 所示的划分网格后的模

型示意图。 图中共包含 6 个单元组， 分别使用不同的颜色来表示 （在计算机界面中可见）。

图 10-6　 划分网格后的模型图

图 10-7　 设置初始水头条件

8） 设置初始水头条件。
渗流分析中必须设置初始水头条件， 否则， 计算结果可能只是局部发生渗流。 设置初始

水头条件的操作如下：
单击菜单 Control→Analysis Assumptions→Default Temperature Settings， 此处输入的数值只

要比模型 Z 坐标的最大值稍大一些即可， 因此输入 1250 （如图 10-7 所示）， 单击 OK 按钮

退出对话框。
2. 提交计算

单击菜单 File→Save （或图标 ）， 将文件

保存为 2D_seepage. in。 单击菜单 Solution→Data
File / Run （或图标 ）， 在弹出的对话框中输入

文件名 2D_seepage， 同时勾选 Run Solution 和
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Automatic Memory Allocation 选项， 单击保存按钮并等待分析结束。
3. 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

2D_seepage. por。
查看总水头云图的操作如下： 依次单击图标 和 ， 然后单击图标 仅显示单元组的网

格轮廓线。 单击图标 （Create Band Plot）， 将 Band Plot Variable 设置为 （Fluid Variable：
TOTAL_HEAD）， 单击 OK 按钮。 图形区将给出如图 10-8 所示的总水头云图。

图 10-8　 总水头云图

查看总水头等值线图的操作如下： 单击图标 （Modify Band Plot）， 单击 Band Render-
ing. . . 进入 Define Band Rendering Depiction 菜单， 将左侧的 Type 修改为 Line Contours， 点击

OK 两次退出对话框， 图形区将给出如图 10-9 所示的总水头等值线图。

图 10-9　 总水头等值线图

查看压力水头云图的操作如下： ADINA 软件中的水头指的是总水头， 因此如果需要获

得压力水头， 只需要从总水头中将高度水头的 Z 坐标减去即可。



第 3 篇　 实　 例　 篇

258　　 　 Focused on Excellence

单击菜单 Definitions→Variable→Resultant， 单击 Add 来增加变量名 PP_HEAD， 输入变量

的定义为 < TOTAL_HEAD > - < Z- COORDINATE > ， 单击 OK 按钮。 其中， < TOTAL_HEAD >
变量表示 ADINA 软件中的总水头， 可以在窗口中单击 Variable 下面的 T 按钮， 然后从 T 开

头的变量列表中选择， 单击 Enter 按钮就可以输入到窗口中。 此时， 后处理中将包含新的变

量名， 在绘制云图、 曲线图、 列表时， 这个变量同其他所有变量的使用方法完全相同。
依次单击图标 和 ， 然后单击图标 仅显示单元组的网格轮廓线。 单击图标

（Create Band Plot）， 将 Band Plot Variable 设置为 （User Defined： PP_HEAD）， 单击 OK 按钮。
再去掉压力水头小于零的值： 单击图标 （Modify Band Plot）， 单击 Band Table. . . 进

入 Define Band Table Depiction 菜单， 在左侧 Value Range 下的Minimum 中输入 0， 单击 OK 按

钮。 此时， 图形区将给出如图 10-10 所示的压力水头云图。

图 10-10　 压力水头云图

按照 “查看总水头等值线图的操作” 类似的操作方法对云图进行修改， 得到压力水头

等值线图， 如图 10-11 所示。

图 10-11　 压力水头等值线图
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查看压力云图的操作如下： 依次单击图标 和 ， 然后单击图标 仅显示单元组的

网格轮廓线。 单击图标 （ Create Band Plot） ， 将 Band Plot Variable 设置为 （ Stress：
FE_PRESSURE） ， 单击 OK 按钮。 单击图标 将压力结果按节点输出应力进行光滑

处理。
再去掉压力小于零的值： 单击图标 （Modify Band Plot）， 单击 Band Table. . . 进入

Define Band Table Depiction 菜单， 在左侧 Value Range 下的 Minimum 处输入 0， 单击 OK 按

钮。 此时， 图形区将给出如图 10-12 所示的压力云图。

图 10-12　 压力云图

某些时情况下读者希望将渗流力导入到结构模型中， 然后进行渗流与结构的水土耦合分

析， 此时可以将水压力按照列表的形式输出， 以方便导入结构模块中进行分析。 输出压力值

列表的操作如下：
单击菜单 List→Value List→Zone. . . →List Zone Values， 在右侧变量名处定义为 <

Stress： FE_PRESSURE > ， 将左侧的 Smoothing Technique 选择为 AVERAGED （表示变量值

按节点平均的方式输出）， 单击 Apply 按钮， 然后单击 Export 输入节点压力列表的名字， 就

可以输出为由节点压力列表构成的 . txt 文件， 如图 10-13 所示。

10. 1. 3　 建立 3D 渗流模型

1. 前处理

删除 2D 网格并建立 3D 网格：
单击图标 来清除原来的信息并创建新模型。 单击图标 来打开命令流文件 03 _

Seepage_2D. in。
单击菜单 Meshing→Delete F. E Model， 单击 Y （是） 将 2D 网格全部删除。 在目录树的

Loading 下单击鼠标右键， 单击 Delete 删除所有的水头压力载荷条件， 如图 10-14 所示。
提示： 如果开始时就希望进行 3D 模型的渗流分析， 则初始导入 DXF 模型后就没有必要〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

再把其转换到 YZ 平面去。〰〰〰〰〰〰〰〰〰〰〰
建立体的操作如下： 单击图标 （Define Volumes）， 将 Type 设置为 Extruded， 在 Vector
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图 10-13　 压力值列表

图 10-14　 删除 2D 模型的载荷条件

中的 X、 Y、 Z 处分别输入 20、 0、 0， 将 Number of
Subdivisions 设置为 4， 单击表格上部的 Auto 按钮， 在

弹出对话框中的 From 行输入 1， To 行输入 72， 单击

OK 按钮两次退出对话框， 即可通过拉伸的方式建立了

72 个 Volume 体。
施加水头压力载荷的操作如下： 单击图标 来施加

载荷， 在弹出的对话框中将 Load Number 设置为 1， 将

Apply to 选择为 Surface， 在表格内依次输入 276、 261、
242、 218、 159， 单击 Apply 按钮。 该操作将 1240m 水

头施加在上游水位面上。
按照相同的操作步骤， 将 Load Number 设置为 2， 将 Apply to 选择为 Surface， 在表格内

依次输入 186、 157、 120， 单击 OK 按钮。 该操作将 1130m 水头施加在下游水位面上。
对于 6 个材料需要定义 6 个 3D 单元组， 定义单元组的操作如下： 单击图标 ， 将弹出

定义单元组对话框。 单击 Add 按钮来定义单元组 1， 将 Type 选择为 3D Conduction， 将 De-
fault Material 选择为 1， 其余设置保持不变， 单击 Save 按钮。 按照类似的操作方法定义其他

5 个不同材料的单元组。
划分混凝土网格的操作如下： 单击菜单 Meshing→Create Mesh→Volume （或图标 ），

在弹出的对话框中将 Element Group 选择为 1， 将 Nodes per Element 选择为 8， 退选 Wedge
Volumes Treated as Degenerate 选项， 双击表格进入图形区来选择混凝土所在的体， 也可以在

表格中直接输入混凝土的体号： 32、 35、 36、 37、 38、 39、 40、 41、 42、 43， 单击 Apply
按钮。

划分覆盖层网格的操作如下： 将 Element Group 选择为 2， Nodes per Element 仍保持选择
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8， 退选 Wedge Volumes Treated as Degenerate 选项， 双击表格进入图形区来选择覆盖层所做

的体， 也可以在表格中直接输入覆盖层的体号： 25、 26、 27、 28、 29、 30、 31、 33， 单击

Apply 按钮。
划分基岩网格的操作如下： 将 Element Group 选择为 3， Nodes per Element 仍保持选择 8，

退选 Wedge Volumes Treated as Degenerate 选项， 双击表格进入图形区来选择基岩所在的体，
也可以在表格中直接输入基岩的体号： 1、 2、 3、 4、 5、 6、 7、 8、 9、 10、 11、 12、 13、 14、
15、 16、 17、 19、 20、 21、 22、 23、 24， 单击 Apply 按钮。

划分沥青混凝土心墙网格的操作如下： 将 Element Group 选择为 4， Nodes per Element 仍
保持选择 8， 退选 Wedge Volumes Treated as Degenerate 选项， 双击表格进入图形区来选择沥

青混凝土心墙所在的体， 也可以在表格中直接输入沥青混凝土心墙的体号： 48、 56、 61、
66、 70， 单击 Apply 按钮。

划分沙砾料网格的操作如下： 将 Element Group 选择为 5， Nodes per Element 仍保持选择

8， 退选 Wedge Volumes Treated as Degenerate 选项， 双击表格进入图形区来选择沙砾料所在

的体， 也可以在表格中直接输入沙砾料的体号： 34、 44、 45、 46、 47、 49、 50、 51、 52、
53、 54、 55、 57、 58、 59、 60、 62、 63、 64、 65、 67、 68、 69、 71、 72， 单击 Apply 按钮。

划分防渗帷幕网格的操作如下： 将 Element Group 选择为 6， Nodes per Element 仍保持选

择 8， 退选 Wedge Volumes Treated as Degenerate 选项， 双击表格进入图形区来选择防渗帷幕

所在的体， 也可以在表格中直接输入防渗帷幕的体号： 18， 单击 OK 按钮。 网格划分工作完

毕。 依次单击图标 和 ， 然后单击图标 ， 此时图形区将给出如图 10-15 所示的模型图，
该图中共包含 6 个单元组， 分别使用不同的颜色来表示。

图 10-15　 三维网格模型图

2. 提交计算

单击菜单 File→Save （或图标 ）， 将文件保存为 3D_seepage. in。 单击菜单 Solution→Data
File / Run （或图标 ）， 在弹出的对话框中输入文件名 3D_seepage， 同时勾选 Run Solution和
Automatic Memory Allocation 选项， 单击保存按钮并等待分析结束。
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3. 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

3D_seepage. por。
查看总水头云图的操作如下： 依次单击图标 和 ， 然后单击图标 仅显示单元组的网

格轮廓线。 单击图标 （Create Band Plot）， 将 Band Plot Variable 设置为 （Fluid Variable：
TOTAL_HEAD）， 单击 OK 按钮。 此时， 图形区中将给出如图 10-16 所示的总水头云图。

图 10-16　 总水头云图

绘制其他压力水头云图及等值线图的操作与 2D 模型的后处理操作完全相同， 此处不再

赘述。

10. 1. 4　 应用推广

本实例还可以推广应用到更加复杂的实际工程渗流分析中， 分析完毕后还可以将渗流计

算所得的水压力导出， 这也为将渗流力导入结构模型进行水土耦合分析提供了一条新的

思路。

10. 2　 沥青心墙坝静力施工及动力抗震分析

10. 2. 1　 问题描述

本实例对上节的沥青心墙坝模型继续进行分析， 对该沥青混凝土心墙坝进行静力施工分

析和动力抗震分析。 将首先对心墙坝模型按照施工过程进行单元生死的静力分析， 然后在静

力施工的基础上进行重启动的动力抗震分析。
为了考虑坝基岩体对心墙坝应力及应变的影响， 计算时同时考虑了整个沥青混凝土心墙

坝和大坝基础， 以消除边界对计算结果的影响。 计算域范围为： 上游 1. 5 倍坝高， 下游 2 倍

坝高， 基础 1. 5 倍坝高。
本实例中采用的约束情况为基岩底部边界约束其竖直方向位移， 基岩上下游边界约束其
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水平方向位移。
载荷及施加方式： 计算中所考虑的载荷主要包括自重、 水压载荷和地震载荷。
沥青心墙坝坝体填筑及分区图如图 10-17 所示， 坝体填筑料有限元计算参数请参见表

10-4 和表 10-5。

图 10-17　 坝体填筑及分区图

表 10-4　 沥青混凝土心墙坝 E - v 模型计算参数

名称和对应的材料 Rf K n G F D Kur Ф0 ΔФ C / kPa
密度

/ （g / cm3）

　 覆盖层 （材料 9） 0. 74 700 0. 72 0. 34 0. 004 4. 8 1500 30 0 0 2

　 基岩 （材料 10） 0. 6 1200 0. 74 0. 38 - 0. 035 5. 8 2300 35 0 25 2. 31

　 沥青混凝土心墙 （材料 4） 0. 76 850 0. 33 0. 38 0. 05 15 1200 27 0 200 2. 43

　 下游过渡层 I （材料 5） 0. 68 1200 0. 52 0. 34 0. 08 6 2400 35 5 19 2. 2

　 上游过渡层 I （湿态） （材料6） 0. 68 1080 0. 52 0. 32 0. 06 5 2100 33 5 17 2. 2

　 上游堆石体 I （湿态） （材料7） 0. 72 900 0. 5 0. 33 0. 06 6 1600 36 5 20 2. 2

　 下游堆石体 I （材料 3） 0. 72 1000 0. 5 0. 33 0. 06 6 1800 38 5 25 2. 2

　 上游围堰 （材料 2） 0. 75 800 0. 4 0. 28 0. 05 3 1600 35 3 19 2. 2

　 防渗墙底的 （帷幕灌浆区）
土体单元 （材料 8）

0. 65 2200 0. 63 0. 35 - 0. 023 3. 5 4400 40 0 70 2. 42

　 　 注： Rf： 破坏比； K： 弹性模量数； n： 弹性模量指数； C 和 Ф0： 坝体强度指标； G、 F、 D： 试验参数； Kur： 试验

参数； ΔФ： 应力对内摩擦角的影响。

表 10-5　 混凝土计算参数

名　 　 称 弹模 / MPa 泊　 松　 比 密度 / （kN / m3）

混凝土 （材料 6） 2. 20e4 0. 167 24

老坝混凝土 （假定透水） （材料 11） 2. 20e4 0. 167 24
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通过学习本实例， 读者将掌握在 ADINA 软件内使用邓肯-张本构模型的方法。
邓肯-张模型是一种非线性弹性模型， 它的理论简单， 可以反映土体变形的主要特点。

目前 ADINA 软件自带的材料模型不包括邓肯-张模型， 邓肯-张模型的应用需通过二次开发

来实现。 此例仅涉及 ADINA 软件对二次开发材料的使用方法， 而不对岩土算法进行过多探

讨， 故本例进行动力计算时仍采用静态的邓肯-张模型。
本实例第 1 步读入模型的命令流文件为 01_model. in， 在其基础上进行静力施工分析的

命令流文件为 02_Construction. in， 在静力施工分析结果的基础上进行动力抗震分析的命令流

文件为 03_Dynamic. in， 上述文件均保存在随书光盘的文件夹 \ 10-2 \ model \ 中。

10. 2. 2　 建立静力施工模型

1. 前处理

1） 定义几何及网格密度。
考虑沥青心墙坝的施工过程， 选择在 CAD 模型中按照施工顺序对模型进行切割， 然后

按照 10. 1 节将 CAD 模型导入 ADINA 软件， 并转换为 YZ 坐标的方法来建立该模型， 对应的

命令流文件为 01_model. in。
启动 ADINA- AUI， 程序模块选择为 ADINA Structures。
单击菜单 File→Open （或图标 ）， 读取命令流文件 01_model. in。 该文件中包含下列命

令： ①建立了 219 个点； ②建立了 187 个面； ③设定了网格密度。 详细的建模过程请读者自

行参看命令流文件。
2） 定义材料。
沥青混凝土心墙坝采用的是邓肯-张 E- v 材料模型， 该模型在 ADINA 软件中需要通过二

次开发所得到的 DLL 文件才能够实现。
提示： 将 adusr. dll 文件 （保存于随书光盘的文件夹 \ 10-2 \ ADINA8. 6 版本 DLL 二次〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

开发链接文件 \ adusr. dll 中） 替换 ADIAN 软件安装路径下 \ ADINA86 \ x32 内相同的 dll 文〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
件即可 （替换前可将 adusr. dll 文件复制）。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

定义混凝土弹性材料属性的操作如下： 单击菜单 Model→Material→Manage Material （或
图标 ）， 将弹出材料定义对话框， 单击 Elastic 下的 Isotropic 按钮来定义混凝土弹性材料属

性。 在弹出的对话框中单击 Add 按钮来定义材料 1， 在 Young’s Modulus 处输入 2. 2 E10， 在

Poisson’s Ratio 处输入 0. 167， 在 Density 处输入 2400， 在 Description 处输入 “concrete”， 单

击 OK 按钮。
定义上游围堰的邓肯-张 E- v 材料模型的操作如下： 单击图标 ， 将弹出材料定义对话

框， 单击 Others 下的 User- Coded 按钮来定义上游围堰的邓肯-张 E- v 材料。 在弹出的对话框

中单击 Add 按钮来定义材料 2， 在 Density 处输入 2400， 在 Description 处输入 “shang you wei
yan”， 在 Constant Propertie Count （CTI 值） 处输入 22， 在 Solution Control Count （ SCP 值）
处输入 2 （如图 10-18a 所示）， 并按照表 10-6 提供的数据分别输入 CTI 值和 SCP 值。 单击

Advanced 标签页， 并勾选 Size of Arrays 下的 Set in user coding， 在 Temperature- Dependent
Properties Count 处输入 2， 然后按照下图输入 0、 0、 0、 0、 100、 0、 0、 0 （如图 10-18b 所

示）， 单击 Save 按钮。
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表 10-6　 坝体填筑料邓肯-张 E- v 材料输入列表

邓肯-张
参数

上游围堰

（M2）
下游堆石体

（M3）
沥青混凝土心墙

（M4）
下游过渡层

（M5）
上游过渡层

（M6）
上游堆石体

（M7）

DENSITY 2200 2200 2430 2200 2200 2200

CTI1 800 1000 850 1200 1080 900

CTI2 0. 4 0. 5 0. 33 0. 52 0. 52 0. 5

CTI3 0. 75 0. 72 0. 76 0. 68 0. 68 0. 72

CTI4 1600 1800 1200 2400 2100 1600

CTI5 35 38 27 35 33 36

CTI6 3 5 0 5 5 5

CTI7 19000 25000 200000 19000 17000 20000

CTI8 100000 100000 100000 100000 100000 100000

CTI9 0. 28 0. 33 0. 38 0. 34 0. 32 0. 33

CTI10 0. 05 0. 06 0. 05 0. 08 0. 06 0. 06

CTI11 3 6 15 6 5 6

CTI12 0 0 0 0 0 0

CTI13 0 0 0 0 0 0

CTI14 0 0 0 0 0 0

CTI15 0 0 0 0 0 0

CTI16 0 0 0 0 0 0

CTI17 0 0 0 0 0 0

CTI18 0 0 0 0 0 0

CTI19 22000 22000 24300 22000 22000 22000

CTI20 0 0 0 0 0 0

CTI21 0 0 0 0 0 0

CTI22 0 0 0 0 0 0

SCP1 0 0 0 0 0 0

SCP2 0 0 0 0 0 0

定义坝底覆盖层、 帷幕灌浆区和基岩弹性材料属性的操作如下： 单击图标 ， 将弹出材

料定义对话框， 单击 Elastic 下的 Isotropic 按钮来定义基岩弹性材料。 在弹出的对话框中单击

Add 按钮来定义材料 8， 在 Young’s Modulus 处输入 2. 8 E10， 在 Poisson’s Ratio 处输入 0. 167，
在 Density 处输入 0， 在 Description 处输入 “ji yan”， 单击 OK 按钮。

提示： 将密度设置为零主要基于两方面的考虑： 1） 实际工程中用户关注的是心墙坝填〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
筑时所产生的附加沉降， 对于坝底处基岩等由于自重引起的沉降位移并不关心， 因此将密度〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
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图 10-18　 上游围堰的邓肯-张 E- v 材料模型

设置为 0， 即： 不考虑自重引起的沉降位移； 2） 后续进行重启动的动力抗震分析时， 需通〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
过无质量地基的方法来处理地震加速度波来回反射所产生的附加惯性力。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
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3） 定义约束。
删除多余自由度： 单击菜单 Control→Degrees of Freedom. . . ， 将弹出对话框 Degrees of

Freedom， 只勾选 Y- translation 和 Z- translation， 删除其他多余的自由度。
单击施加约束图标 ， 在弹出的对话框中单击 Define. . . 按钮。 单击 Add. . . 按钮， 在

Define Fixity 对话框中输入约束名 YF， 勾选 Y- Translation 按钮， 单击 Save 按钮； 单击

Add. . . 按钮， 输入约束名 ZF， 勾选 Z- Translation 按钮， 单击 OK 按钮。
将 Apply Fixity 对话框中的 “Apply to” 区域设置为 Lines， 将 Default Fixity 设置为 YF，

并在左侧表 Lines #中输入线号： 1、 36、 38、 61、 63、 77、 79、 93， 单击 Save 按钮； 将

Default Fixity 设置为 ZF， 并在左侧表 Lines#内输入线号： 2、 5、 8、 11、 14、 17、 20、 23、
26、 29、 32、 35， 单击 OK 按钮。

4） 施加重力载荷。
施加重力载荷的操作如下： 单击图标 ， 并选择载荷类型为 Mass Proportion， 单击

Define. . . 按钮， 在 Magnitude 处输入重力加速度数值 10. 0， 在 Direction Vector 处输入输入方

向 0、 0、 - 1， 单击 OK 按钮返回上一级窗口。
需要注意的是： 本实例包含静力分析和地震响应的动力时程分析两部分， 因此 Interpret

loads as 选项中应选择 Body Force， 原因是： Body Force 方式既可以用于静力分析， 也可用于

动力分析， 而 Gound Acceleration 方式只能用于动力分析中。
输入重力作用的时间函数 1 （默认的时间函数）， 载荷比例因子在 0 ～ 1e21 时间内保持

为 1， 用来表示： 重力从 0 时刻完全施加， 并永远保持不变。
5） 施加水压力。
由于水压力呈线性分布， 因此需要首先定义空间函数。 定义空间函数的操作如下： 单击

菜单 Geometry→Spatial Function→Line. . . ， 单击 Add. . . 按钮， 在弹出的对话框中将 Type 选

择为 Linear， 在 u = 0 输入 0， 在 u = 1 输入 3. 8565。 类似地， 按照表 10-7 定义其他的空间

函数。

表 10-7　 空间函数列表

空间函数名 方　 　 式 U =0 的值 U =1 的值

1 LINEAR 0 3. 8565

2 LINEAR 3. 8565 7. 713

3 LINEAR 7. 713 11. 569

4 LINEAR 11. 569 15. 426

5 LINEAR 15. 426 19. 282

6 LINEAR 19. 282 23. 139

7 LINEAR 23. 139 26. 995

8 LINEAR 26. 995 30. 852

9 LINEAR 30. 852 36. 352

10 LINEAR 36. 352 41. 852

11 LINEAR 41. 852 47. 352

12 LINEAR 47. 352 52. 852
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（续）

空间函数名 方　 　 式 U =0 的值 U =1 的值

13 LINEAR 52. 852 58. 852

14 LINEAR 58. 852 64. 852

15 LINEAR 64. 852 70. 096

16 LINEAR 70. 096 75. 34

17 LINEAR 75. 34 80. 585

18 LINEAR 80. 585 85. 829

19 LINEAR 85. 829 80. 54

定义水压力作用的时间函数 2 见表 10-8， 从表中可以看出： 水压力在时刻 0 ～ 100 之间

线性增大， 然后保持不变。

表 10-8　 时间函数 2

Time Value

1 0 0

2 100 1. 0

3 500 1. 0

单击图标 ， 并选择载荷类型为 Pressure， 单击 Define 按钮， 在 Magnitude 处输入为

9800， 单击 OK 按钮返回上一级窗口。 将 Apply to 选择为 Line， 在绿色窗口中输入 386， 在

Arrival Time 处输入 270 （表示载荷在时刻 270 时才开始起作用）， 在 Time Function. . . 处输入

2 （表示载荷按照时间函数 2 来施加）， 在 Spatial Function. . . 处输入 1 （表示载荷按照空间

函数 1 分布）。
同理， 根据如下列表定义剩下的水压载荷。

表 10-9　 载荷输入表

线　 　 号 时 间 函 数 到 达 时 间 空 间 函 数

386 2 270 1

373 2 270 2

358 2 270 3

343 2 270 4

328 2 270 5

313 2 270 6

298 2 270 7

283 2 270 8

268 2 270 9

253 2 270 10

238 2 270 11

223 2 270 12
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（续）

线　 　 号 时 间 函 数 到 达 时 间 空 间 函 数

207 2 270 13

190 2 270 14

104 2 270 15

101 2 270 16

98 2 270 17

95 2 270 18

81 2 270 19

依次单击图标 和 ， 然后单击显示载荷图标 和显示约束图标 ， 图形区将给出如图

10-19 所示的约束及载荷图。

图 10-19　 约束及载荷图

6） 定义单元组。
8 种材料需要定义 8 个单元组， 对应的操作如下： 单击菜单 Meshing→Element Group

（或图标 ）， 将弹出定义单元组对话框。 单击 Add 按钮来定义单元组 1， 将 Type 选择为 2D
Solid， 将 Element Sub- Type 选择为 Plane Strain， 将 Default Material 选择为 1， 其余设置保持

不变， 单击 Save 按钮； 单击 Add 按钮来定义单元组 2， 将 Element Sub- Type 选择为 Plane
Strain， 将 Default Material 选择为 2， 单击 Save 按钮； 单击 Add 按钮来定义单元组 3， 将

Element Sub- Type 选择为 Plane Strain， 将 Default Material 选择为 3， 单击 Save 按钮； 单击

Add 按钮来定义单元组 4， 将 Element Sub- Type 选择为 Plane Strain， 将 Default Material 选择

为 4， 单击 Save 按钮； 单击 Add 按钮来定义单元组 5， 将 Element Sub- Type 选择为 Plane
Strain， 将 Default Material 选择为 5， 单击 Save 按钮； 单击 Add 按钮来定义单元组 6， 将

Element Sub- Type 选择为 Plane Strain， 将 Default Material 选择为 6， 单击 Save 按钮； 单击

Add 按钮来定义单元组 7， 将 Element Sub- Type 选择为 Plane Strain， 将 Default Material 选择

为 7， 单击 Save 按钮； 单击 Add 按钮来定义单元组 8， 将 Element Sub- Type 选择为 Plane
Strain， 将 Default Material 选择为 8， 单击 OK 按钮退出对话框。
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7） 划分网格。
① 划分混凝土网格的操作如下： 单击菜单 Meshing→Create Mesh→Surface （或图标 ），

在弹出的对话框中将 Element Group 选择为 1， 将 Nodes per Element 选择为 4， 双击表格进入

图形区选择混凝土所在的面， 也可以在表格中直接输入混凝土的面号： 30、 37、 43 ～ 50
（建议应用 Auto 方法输入）、 64， 单击 Apply 按钮。

② 划分上游围堰网格的操作如下： 将 Element Group 选择为 2， Nodes per Element 仍保

持选择 4， 双击表格进入图形区选择上游围堰所在的面， 也可以在表格中直接输入上游围堰

的面号： 39 ～ 42， 单击 Apply 按钮。
③ 划分下游堆石体网格的操作如下： 将 Element Group 选择为 3， Nodes per Element 仍

保持选择 4， 双击表格进入图形区选择下游堆石体所在的面， 也可以在表格中直接输入下游

堆石体的面号： 55、 61、 62、 63、 70、 71、 77、 78、 84、 85、 92、 93、 100、 101、 107、
108、 114、 115、 121、 122、 128、 129、 135、 136、 142、 143、 149、 150、 156、 157、 163、
164、 170、 171、 177、 178、 183、 187， 单击 Apply 按钮。

④ 划分沥青混凝土心墙网格的操作如下： 将 Element Group 选择为 4， Nodes per Element
仍保持选择 4， 双击表格进入图形区选择沥青混凝土心墙所在的面， 也可以在表格中直接输

入沥青混凝土心墙的面号： 53、 59、 68、 75、 82、 90、 98、 105、 112、 119、 126、 133、
140、 147、 154、 161、 168、 175、 181、 185， 单击 Apply 按钮。

⑤ 划分下游过渡层网格的操作如下： 将 Element Group 选择为 5， Nodes per Element 仍
保持选择 4， 双击表格进入图形区选择下游过渡层所在的面， 也可以在表格中直接输入下游

过渡层的面号： 54、 60、 69、 76、 83、 91、 99、 106、 113、 120、 127、 134、 141、 148、
155、 162、 169、 176、 182、 186， 单击 Apply 按钮。

⑥ 划分上游过渡层网格的操作如下： 将 Element Group 选择为 6， Nodes per Element 仍
保持选择 4， 双击表格进入图形区选择上游过渡层所在的面， 也可以在表格中直接输入上游

过渡层的面号： 52、 58、 67、 74、 81、 89、 97、 104、 111、 118、 125、 132、 139、 146、
153、 160、 167、 174、 180、 184， 单击 Apply 按钮。

⑦ 划分上游堆石体网格的操作如下： 将 Element Group 选择为 7， Nodes per Element 仍
保持选择 4， 双击表格进入图形区来选择上游堆石体所在的面， 也可以在表格中直接输入上

游堆石体的面号： 51、 56、 57、 65、 66、 72、 73、 79、 80、 86、 87、 88、 94、 95、 96、 102、
103、 109、 110、 116、 117、 123、 124、 130、 131、 137、 138、 144、 145、 151、 152、 158、
159、 165、 166、 172、 173、 179， 单击 Apply 按钮。

⑧ 划分坝底基岩、 帷幕灌浆区和覆盖层网格的操作如下： 将 Element Group 选择为 8，
Nodes per Element 仍保持选择 4， 双击表格进入图形区来选择坝底基岩、 帷幕灌浆区和覆盖

层所在的面， 也可以在表格中直接输入坝底基岩、 帷幕灌浆区和覆盖层的面号： 1 ～ 29、
31 ～ 36、 38， 单击 OK 按钮退出对话框。 网格划分工作完毕。

依次单击图标 、 和 ， 然后单击显示载荷图标 ， 此时图形区将给出如图 10-20 所

示的模型网格图， 图中共包含 8 个单元组， 分别使用不同的颜色来表示。
8） 定义单元生死时间。
由于心墙坝的填筑过程中涉及的结构材料逐渐增多， 因此需要采用单元生死 （Element

Birth / Death） 功能， 选用单元生 （Active） 来模拟填筑过程。 本实例需要设定心墙坝所在面
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图 10-20　 模型网格图

的 Birth Time， 时间顺序是实际的施工顺序。 详细的操作步骤如下：
单击菜单 Model→Element Properties→2- D Solid. . . ， 在弹出的对话框中按照表 10-10 来

定义单元生成时间。

表 10-10　 单元生成时间

面　 　 号 Birth Time 面　 　 号 Birth Time

S1 ～ S38 0 S102 ～ S108 140

S39 10 S109 ～ S115 150

S40 20 S116 ～ S122 160

S41 30 S123 ～ S129 170

S42 40 S130 ～ S136 180

S43 ～ S45 50 S137 ～ S143 190

S46 ～ S50 60 S144 ～ S150 200

S51 ～ S55 70 S151 ～ S157 210

S56 ～ S64 80 S158 ～ S164 220

S65 ～ S71 90 S165 ～ S171 230

S72 ～ S78 100 S172 ～ S178 240

S79 ～ S85 110 S179 ～ S183 250

S86 ～ S93 120 S184 ～ S187 260

S94 ～ S101 130

9） 关闭非协调单元算法。
单击菜单 Control→Analysis Assumptions→Kinematic. . . ， 在弹出的对话框中将 Use Incom-

patible Modes in Element Formulation 设置为 No， 单击 OK 按钮关闭对话框。
10） 打开线性搜索功能并增加迭代次数。
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单击菜单 Control→Solution Process. . . ， 在弹出的对话框中选择 Iteration Method . . . ， 并

将 Use ofLine Searches 设置为 YES， 将 Maximun Number of Iterations 设置为 100， 单击 OK 按

钮退出对话框。
11） 定义时间步和步数。
单击菜单 Control→Time Step， 在弹出的对话框中定义时间步长为 10， 共 37 步， 总分析

时间为 10 × 37 = 370。
2. 提交计算

单击菜单 File→Save （或图标 ）， 将文件保存为 02_Construction. in。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 02_Construction， 同时勾选 Run
Solution 和 Automatic Memory Allocation 选项， 单击保存按钮并等待分析结束。

3. 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ）， 打开结果文件02_
Construction. por。

查看整体模型 Z 方向位移云图的操作如下： 依次单击图标 和 ， 然后单击图标 仅显

示单元组的网格轮廓线。 单击图标 （ Create Band Plot）， 将 Band Plot Variable 设置为

（Displacement：Z- DISPLACEMENT）， 单击 OK 按钮。 图形区将给出如图 10-21 所示的 Z 方向

位移云图。

图 10-21　 整体模型 Z 方向位移云图

查看整体模型 Y 方向位移云图的操作如下： 单击图标 （Modify Band Plot） 进入Modify
BandPlot 菜单， 将 Band Plot Variable 设置为 （Displacement： Y- DISPLACEMENT）， 单击 OK
按钮。 图形区将给出如图 10-22 所示的 Y 方向位移云图。

查看整体模型最大主压应力云图的操作如下： 依次单击图标 和 ， 然后单击图标 仅

显示单元组的网格轮廓线。 单击图标 （Create Band Plot）， 将 Band Plot Variable 设置为

（Stress： SIGMA- P3）， 单击 OK 按钮。 图形区将给出如图 10-23 所示的最大主压应力云图。
查看整体模型最小主压应力云图的操作如下： 单击图标 （ Modify Band Plot） 进入

Modify BandPlot 菜单， 将 Band Plot Variable 设置为 （Stress： SIGMA- P1）， 单击 OK 按钮。 图
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图 10-22　 整体模型 Y 方向位移云图

图 10-23　 整体模型最大主压应力云图

形区将给出如图 10-24 所示的最小主压应力云图。
将单元组 1 ～ 7 定义到 Zone DAM 中： 单击菜单 Display→Geometry / Mesh Plot→Change

Zone， 在弹出的对话框中单击 Zone Name 右侧的 按钮， 将弹出 Define Zone 对话框 （或单击

图标 右侧的下拉菜单， 然后选择图标 ）。 单击 Add 按钮， 在弹出的对话框中输入 DAM
（小写亦可）， 单击 OK 按钮。 在表格的第 1 行输入 ELEMENT GROUP 1 to 7， 单击 OK 按钮。

查看心墙坝模型 Z 方向位移云图的操作如下： 依次单击图标 和 ， 选择 DAM， 单击

OK 按钮来显示 ZONE DAM， 然后单击图标 仅显示单元组的网格轮廓线。 单击图标

（Create Band Plot）， 将 Band Plot Variable 设置为 （Displacement： Z- DISPLACEMENT）， 单击

OK 按钮。 图形区将给出如图 10-25 所示的 Z 方向位移云图。
查看心墙坝 Y 方向位移云图的操作如下： 单击图标 （Modify Band Plot） 进入 Modify

BandPlot 菜单， 将 Band Plot Variable 设置为 （Displacement： Y- DISPLACEMENT）， 单击 OK
按钮。 图形区将给出如图 10-26 所示的 Y 方向位移云图。
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图 10-24　 整体模型最小主压应力云图

图 10-25　 心墙坝模型 Z 方向位移云图

图 10-26　 心墙坝模型 Y 方向位移云图
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查看心墙坝最大主压应力云图的操作如下： 依次单击图标 和 ， 选择 DAM 并单击 OK
按钮来显示 ZONE DAM， 然后单击图标 仅显示单元组的网格轮廓线。 单击图标 （Create
Band Plot）， 将 Band Plot Variable 设置为 （Stress： SIGMA- P3）， 单击 OK 按钮。 图形区将给

出如图 10-27 所示的最大主压应力云图。

图 10-27　 心墙坝模型最大主压应力云图

查看心墙坝最小主压应力云图的操作如下： 单击图标 （Modify Band Plot） 进入 Modify
Band Plot 菜单， 将 Band Plot Variable 设置为 （Stress： SIGMA- P1）， 单击 OK 按钮。 图形区

将给出如图 10-28 所示的最小主压应力云图。

图 10-28　 心墙坝模型最小主压应力云图

10. 2. 3　 建立瞬态动力分析模型

静力分析的结果是动态地震分析的初始状态。 打开原命令流文件来准备地震响应分析的

计算模型。
1. 前处理

单击图标 来清除掉原来的信息并创建一个新模型。 单击图标 打开命令流文件
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02_Construction. in （文件保存在随书光盘的文件夹 \ 10-2 \ model \ 中）。
设置 求 解 控 制： 选 择 分 析 类 型 为 Dynamics- Implicit； 单 击 菜 单 Control → Solution

Process. . . 来定义重启动分析， 勾选 Restart Analysis 并输入前面分析的终止时刻 370。
打开自动时间步： 单击图标 ， 在弹出的对话框中勾选 Use Automatic Time- Stepping；

单击右侧的 按钮将弹出 Automatic Time- Stepping 对话框， 将 Maximun Subdivisions Allowed
设置为 1000。

定义时间步： 单击菜单 Control→Time Step， 在弹出的对话框中定义时间步长0. 01， 共1000 步。
定义地震波的时间函数： ADINA 软件中不同方向的地震加速度均以时间函数曲线的方

式输入。 需要注意的是： 时间函数中的 Value 指的是比例因子， 对不同时刻后面加速度载荷

定义中的 Magnitude 进行放大或缩小。 首先输入不同方向的 Time Function （时间函数）， 对

应的操作如下： 单击菜单 Control→Time Function. . . ， 在弹出的对话框中单击 Add. . . 按钮来

定义两个时间函数， 单击 Import 选择随书光盘下列文件夹 \ 10-2 \ model \ 的 TXT 文件 Earth-
quake_Y. txt 和 Earthquake_Z. txt， 以输入 Y 方向和 Z 方向的地震加速度曲线， 如图 10-29 和

图 10-30 所示。

图 10-29　 输入 Y 方向的地震加速度曲线

图 10-30　 输入 Z 方向的地震加速度曲线
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定义地震载荷的操作如下： 单击图标 并选择载荷类型为 Mass Proportion， 单击 Define
按钮来分别定义 Y 向和 Z 向的重力加速度及方向， 如图 10-31 所示。 需要注意的是： 此时

应该选择为 Ground Acceleration， 而非施加重力载荷的 Body Force。

图 10-31　 分别定义 Y 方向和 Z 方向的加速度载荷

当返回到窗口时， 将 Load Number 选择 2， 在表格第一行选择 3， 单击 Apply 按钮； 将

Load Number 选择 3， 在表格第一行选择 4， 单击 OK， 如图 10-32 所示。

图 10-32　 分别施加 Y 方向和 Z 方向的加速度载荷

2. 提交计算

单击菜单 File→Save （或图标 ）， 将文件保存为 03_Dynamic. in。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 03 _ Dynamic， 同时勾选 Run
Solution和 Automatic Memory Allocation 选项， 单击保存按钮。

窗口中将弹出提示选择重启动文件的对话框， 此时选择 2D_Construction. res （此文件由

上次正常求解自动生成）， 程序将自动进行求解。
3. 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件
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2D_Dynamic. por。
查看坝顶某点 Y 方向位移时程曲线的操作如下： 单击图标 来清除图形区中的显示信

息。 单击菜单 Definitions→Model Point→Node， 在弹出的窗口中单击 Add 按钮， 并输入点的

名字 Node 480， 在窗口的 Node # 中输入 480， 单击 OK 按钮。 单击菜单 Graph→Response
curve （model point）， 在弹出的窗口中， 将 X Coordinate 和 Y Coordinate 下的 Model Point 选择

Node 480， 将 Y Coordinate 下的 Variable 选择 Displacement、 Y- DISPLACEMENT， 单击 OK 按

钮。 此时， 图形区中将给出如图 10-33 所示的 Y 方向位移时程曲线。

图 10-33　 坝顶节点 480Y 方向位移时程曲线

10. 2. 4　 应用推广

本实例除了可以应用于邓肯-张的 E- v 材料本构模型外， 也可以应用于到邓肯-张的 E- B
材料中， 且该实例为静、 动力结合分析提供了合理及有效的解决途径。

本实例采用了工程中应用极为广泛的无质量地基法来消除地震时边界反射造成的附加惯

性力。 此外， 在 ADINA 软件中还可以通过在边界上添加势流体单元的无限远边界、 使用黏

弹性的接地弹簧， 以及施加黏性阻尼器等多种方式来处理边界的吸波消能问题 （读者可参

看第 5. 3 节的内容）。

10. 3　 城市交叠隧道施工过程分析

10. 3. 1　 问题描述

本实例为某城市上下交叠隧道施工过程分析。 整个土层共分 3 层， 从上到下依次为砂质

粉土、 黏土夹粉土和粉质黏土。 如图 10-34 所示， P1 为地面点， P2 为第一层土与第二层土

交界处所在点， P3 是第二层土与第三层土交界处所在点。
通过学习本实例， 读者可以掌握为多层土根据输入公式法来施加初始地应力场。
本实例第 1 步将根据命令流文件 01_model. in 来建立几何模型， 然后定义施工过程的单
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图 10-34　 某城市上下交叠隧道模型示意图

元生死， 对应的命令流文件为 02_birth + death. in， 整个模型施工阶段计算的命令流文件为

03_Construction. in， 它们均保存在随书光盘的文件夹 \ 10-3 \ model \ 中。

10. 3. 2　 前处理

1. 定义几何及网格密度

启动 ADINA- AUI， 程序模块选择为 ADINA Structures。
单击菜单 File→Open （或图标 ）， 读取命令流文件 01_ model. in， 此时图形区将给出如

图 10-35 所示的几何模型示意图。 命令流中包含下列命令： 1） 建立几何模型， 并设定网格密

度； 2） 定义了边界约束条件和自重载荷。 详细的建模过程请读者自行参看命令流文件。

图 10-35　 上下交叠隧道的几何模型

2. 定义单元生死时间

由于隧道施工中涉及开挖和衬砌支护， 因此需要采用单元生死 （Element Birth / Death）
功能， 并使用单元死 （Death） 来模拟其开挖过程， 使用单元生 （Active） 来模拟衬砌支护
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过程。 定义单元生死时间的操作如下：
单击菜单 File→Open （或图标 ） 来读取命令流文件 02_birth + death. in。 命令流中包含

下列命令： 对体 （Volume） 定义土体的开挖时间、 对面 （Surface） 定义衬砌支护的时间。
详细的命令请参见命令流文件。

3. 定义材料

1） 定义砂质粉土摩尔-库伦 （Mohr- Coulomb） 材料属性： 单击图标 将弹出材料定义

对话框， 单击 Mohr- Coulomb 按钮， 在 Define Mohr- Coulomb Material 对话框中单击 Add. . . 按

钮来定义材料 1， 在 Young’s Modulus 处输入 4. 89 E6， 在 Poisson’s ratio 处输入 0. 35， 在 Den-
sity 处输入 1900， 在 Friction Angle 处输入 27， 在 Cohesion 处输入 1. 5 E7， 退选 Use Specified
Dilation Angle 选项， 然后单击 Save 按钮。

2） 定义黏土夹粉土摩尔-库伦材料属性： 在 Define Mohr- Coulomb Material 对话框中单击

Add. . . 按钮来定义材料 2， 在 Young’s Modulus 处输入 5. 12 E6， 在 Poisson’s ratio 处输入

0. 33， 在 Density 处输入 1900， 在 Friction Angle 处输入 32， 在 Cohesion 处输入 1. 2 E7， 退选

Use Specified Dilation Angle 选项， 然后单击 Save 按钮。
3） 定义粉质黏土摩尔-库伦材料属性： 在 Define Mohr- Coulomb Material 对话框中单击

Add. . . 按钮来定义材料 3， 在 Young’s Modulus 处输入 8. 56 E6， 在 Poisson’s ratio 处输入

0. 34， 在 Density 处输入 1980， 在 Friction Angle 处输入 45， 在 Cohesion 处输入 1. 7E7， 退选

Use Specified Dilation Angle 选项， 然后单击 OK 按钮。
4） 定义上衬砌弹性材料属性： 单击 Elastic Isotropic 按钮， 在 Define Isotropic Linear

Elastic Material 对话框中单击 Add. . . 按钮来定义材料 4， 在 Young’s Modulus 处输入 1. 75
E10， 在 Poisson’s ratio 处输入 0. 2， 在 Density 处输入 2300， 然后单击 Save 按钮。

5） 定义下衬砌弹性材料属性： 在 Define Isotropic Linear Elastic Material 对话框中单击

Add. . . 按钮来定义材料 5， 在 Young’s Modulus 处输入 2. 95 E10， 在 Poisson’s ratio 处输入

0. 2， 在 Density 处输入 2500， 然后单击 OK 按钮。 单击 Close 按钮关闭 Manage Material
Definitions对话框。

4. 设置初始地应力场

如果不设置初始地应力场， 则可以通过重力加载来得到开挖前的地应力分布， 但重力引

起的变形依然存在， 由于初始衬的单元与围岩边界共节点， 围岩变形将导致支护边界单元出

现零应力变形而改变衬砌形状。 如果模型中施加了初始地应力场， 由于初始应力场和重力平

衡， 则计算的平衡状态无变形出现 （为零）， 因此可以彻底消除支护单元出现前的扰动变

形。 因此， 在很多涉及开挖的分析中需要输入初始应力场 （用来平衡重力场）。 ADINA 软件

中提供了多种处理初始地应力场问题的方法， 本实例中的地应力场采用 ADINA 软件提供的

Initial Geological Stress 方式， 按照公式直接输入。
设定初始地应力场参数时按照下面公式来推导 （读者参看第 5. 6 节的内容）：

e33 = A + B × z； e11 = C × e33 + D； e22 = E × e33 + F
式中， z 为整体坐标中的 z 坐标值； B = ρ × g， 为材料的堆密度； C 和 E 为侧压力系数， 可

按弹性力学公式来计算侧压力系数 K0 = μ / （1- μ）， 其中 μ 为泊松比。 A 为竖向应力的修正

数， 可由地表面点的 z 坐标来确定； D 和 F 为侧向应力的修正数， 可根据地层之间应力连续

的原则来确定。
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提示： 该应力输入法只能应用于地基水平分层， 且地表面也是水平的情况。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
对于第一层土： B1 = 19000， C1 = E1 = 0. 538， D1 = F1 = 0； 对于地面点 P1， z 坐标为

0， 根据地面 P1 点处的 e33 = A1 + B1 × z 可推出 A1 =0。
对于第二层土： B2 = 19000， C2 = E2 = 0. 493； 对与第一层土与第二层土的交界点 P2，

其 z 坐标为 - 12. 5， 根据 e33 = A1 + B1 × z = A2 + B2 × z 可推出 A2 = 0； 根据 e11 = C1 ×
e33 + D1 = C2 × e33 + D2 可推出 D2 = - 10687. 5； 同理， 根据 e22 = E1 × e33 + F1 = E2 ×
e33 + F2 可推出 F2 = - 10687. 5。

对于第三层土： B3 = 19800， C3 = E3 = 0. 515； 对与第二层土与第三层土的交界点 P3，
其 z 坐标为 - 27， 则根据 e33 = A2 + B2 × z = A3 + B3 × z 可推出 A3 = 21600； 根据 e11 = C2 ×
e33 + D2 = C3 × e33 + D3 可推出 D3 = -21973. 5； 同理， 根据 e22 = E2 × e33 + F2 = E3 × e33 + F3
可推出 F3 = -21973. 5。

单击菜单 Model→Initial Conditions→Geological Strain Field， 在弹出的对话框中分别按照

表 10-11 来输入三个初始地应力场参数， 如图 10-36 所示。

表 10-11　 初始地应力参数

土层 A B C D E F

土层一 0 19000 0. 538 0 0. 538 0

土层二 0 19000 0. 493 - 10687. 5 0. 493 - 10687. 5

土层三 21600 19800 0. 515 - 21973. 5 0. 515 - 21973. 5

图 10-36　 定义初始地应力场

图 10-37　 定义应力场的整体坐标系

由于初始地应力场是基于单元坐标系

加载的， 而给定的应力是基于整体坐标系

的， 故在此还需要定义一个局部的用户坐标

系， 然后将单元应力转换到整体坐标系下。
对应的操作如下： 单击菜单 Model→Ortho-
tropic Axes Systems→Define来定义坐标系 1，
如图 10-37 所示。

单击菜单 Model→Orthotropic Axes Sys-
tems→Assign （Initial Strain） 并对 61 个体

（Volume） 指定局部坐标系， 如图 10-38 所
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示， 输入时要应用Auto。 对于3D模型采用默认值， a- direction 为 Local X， b- direction 为 Local Y。

图 10-38　 将应力场转换为整体坐标系

5. 定义单元组

5 种材料需要可以定义 7 个单元组， 将上下隧道土体从土层的单元组中取出来再单独定

义两个单元组。 将相同材料定义为两个或多个单元组将为后处理时按照单元组进行查看提供

极大方便。 定义单元组的操作如下：
单击菜单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击 Add. . .

按钮来定义单元组 1， 将 Type 选择为 3DSolid， 将 Default Material 选择为 1； 单击 Advance 标签

页， 单元组 1 表示第一层土， 需要设置初始地应力的引入， 将 Initial Strain 设置为 Element
Only， 并给定地应力场 Element Strain Field 的标号为 1， 如图 10-39 所示， 单击 Save 按钮。

单击 Add. . . 按钮来定义单元组 2， 将 Default Material 选择为 2； 单击 Advanced 标签页，
单元组 2 表示第二层土， 需要设置初始地应力的引入， 将 Initial Strains 设置为 Element Only，
并给定地应力场 Element Strain Field 的标号为 2， 如图 10-39 所示， 单击 Save 按钮。

图 10-39　 对三个土层输入不同的地应力场
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单击 Add. . . 按钮来定义单元组 3， 将 Default Material 选择为 3； 单击 Advanced 标

签页， 单元组 3 表示第三层土， 需要设置初始地应力的引入， 将 Initial Strains 设置为

Element Only， 并给定地应力场 Element Strain Field 的标号为 3， 如图 10-39 所示， 单击

Save 按钮。
单击 Add. . . 按钮来定义单元组 4， 将 Default Material 选择为 1； 单击 Advanced 标签页，

单元组 4 表示第一层土的上部隧道， 需要设置初始地应力的引入， 将 Initial Strains 设置为

Element Only， 并给定地应力场 Element Strain Field 的标号为 1 （如图 10-40 所示）， 单击

Save 按钮。
单击 Add. . . 按钮来定义单元组 5， 将 Default Material 选择为 2； 单击 Advanced 标签页，

单元组 5 表示第二层土的下部隧道， 需要设置初始地应力的引入， 将 Initial Strains 设置为

Element Only， 并给定地应力场 Element Strain Field 的标号为 2 （如图 10-40 所示）， 单击

Save 按钮。

图 10-40　 对上下隧道开挖土体输入不同的地应力场

单击 Add. . . 按钮来定义单元组 6， 将 Type 选择为 Shell， 将 Default Material 选择为 4，
在 Default Element Thickness 处输入 0. 3， 定义上部的隧道衬砌支护为壳单元组 6。

单击 Add. . . 按钮来定义单元组 7， 将 Type 选择为 Shell， 将 Default Material 选择为 5，
在 Default Element Thickness 处输入 0. 3， 定义下部的隧道衬砌支护为壳单元组 7， 单击 OK
按钮退出对话框。

6. 划分网格

为第一层土划分网格： 单击菜单 Meshing→Create Mesh→Volume （或图标 ）， 在弹出

的对话框中将 Type 选择为 3- D Solid， 将 Element Group 选择为 1， 将 Nodes per Element 选择

为 8， 退选 Wedge Volumes Treated as Degenerate 选项， 并在表格的前 4 行依次输入 5 ～ 8， 单

击 Apply 按钮。
为第二层土划分网格： 将 Element Group 选择为 2， 将 Nodes per Element 选择为 8， 退选
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Wedge Volumes Treated as Degenerate 选项， 并在表格的前 4 行依次输入 9 ～ 12， 单击 Apply
按钮。

为第三层土划分网格： 将 Element Group 选择为 3， 将 Nodes per Element 选择为 8，
退选 Wedge Volumes Treated as Degenerate 选项， 并在表格的第 1 行输入 13， 单击 Apply
按钮。

为上层隧道划分网格： 将 Element Group 选择为 4， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate 选项， 并在表格的前 4 行依次输入 1 ～ 4 共 4 个体， 单击

Apply 按钮。
为下层隧道划分网格： 将 Element Group 选择为 5， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate 选项， 并在表格的第 1 列依次输入 14 ～ 61 共 48 个体，
单击 OK 按钮。

为上层隧道衬砌划分网格的操作如下： 单击菜单 Meshing→Create Mesh→Surface （或图

标 ）， 在弹出的对话框中将 Element Group 选择为 6， 将 Meshing Type 设置为 Rule- Based，
将 Nodes per Element 选择为 4， 将 Check 设置为 All Generated Nodes， 在表格的第 1 列依次

输入 Surface 26、 30、 33、 36 共 4 个面， 单击 Apply 按钮。
为下层隧道衬砌划分网格的操作如下： 将 Element Group 选择为 7， 将 Meshing Type

设置为 Rule- Based， 将 Nodes per Element 选 择 为 4， 将 Check 设 置 为 All Generated
Nodes， 在表格的第 1 列依次输入下列面号： 70、 74、 77、 80、 82、 86、 89、 92、 94、
98、 101、 104、 106、 110、 113、 116、 118、 122、 125、 128、 130、 134、 137、 140、
142、 146、 149、 152、 154、 158、 161、 164、 166、 170、 173、 176、 178、 182、 185、
188、 190、 194、 197、 200、 202、 206、 209、 212 共 48 个面， 单击 OK 按钮退出对话

框。 网格划分工作完毕。
依次单击图标 、 和 ， 此时， 图形区将给出如图 10-41 所示的模型示意图， 该图中

共包含 7 个单元组， 分别使用不同的颜色来表示。

图 10-41　 划分网格后的模型示意图
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7. 设置初始应力场

通过初始应力场来平衡重力场所引起的变形， 单击菜单 Control→Miscellaneous Options，
在弹出的对话框中选择 Initial Sresses that Cause Deformation， 单击 OK。

8. 定义时间步

单击菜单 Control→Time Step， 在弹出的对话框中， 在表格的第 1 行输入 1、 0. 1， 第 2
行输入 27、 1。 如图 10-42 所示。

需要注意的是： 此时在施工过程之前定义了 1 个 0. 1 的时间。 这样做有两个作用： 一方

面在施工之前增加一个小的时间步来试算并查看初始应力场是否定义正确； 另一方面则可避

免单元生死时间与时间步之间的舍入误差。

图 10-42　 定义时间步对话框

10. 3. 3　 求解

单击菜单 File→Save （或图标 ）， 将文件保存为 03_Construction. in。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 03_Construction， 同时勾选 Run
Solution 和 Automatic Memory Allocation 选项， 单击保存按钮并等待分析结束。

10. 3. 4　 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

03_Construction. por。
查看模型在 0. 1 时刻最大主压应力和 Z 方向位移云图： 依次单击图标 和 ， 单击图标

回到 0. 1 时刻， 然后单击图标 仅显示单元组的网格轮廓线。 单击图标 （Create Band
Plot）， 将 Band Plot Variable 设置成 （Stress： SIGMA- P3）， 单击 OK 按钮。 并将鼠标将云图

移动到左侧。
单击图标 ， 单击图标 回到 0. 1 时刻， 单击图标 仅显示单元组的网格轮廓线。 单击

图标 （ Create Band Plot ） 将 Band Plot Variable 设置为 （ Displacement： Z- DISPLACE-
MENT）， 单击 OK 按钮。 将鼠标将云图移动到右侧。 此时， 图形区将给出如图 10-43 所示的

最大主压应力和 Z 方向位移云图。
从图 10-43 中可以看出： 在 0. 1 时刻存在应力场， 但位移场最大值远小于 1mm， 此在误

差允许的范围之内， 故据此可判断初始地应力场的设置是正确的。
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图 10-43　 0. 1 时刻的最大主压应力及 Z 方向位移云图

查看模型在最终时刻 27. 1 的竖直 Z 方向位移云图： 依次单击图标 和 ， 单击

图标 回到 27. 1 时刻， 单击图标 仅显示单元组的网格轮廓线， 单击图标 在

X- Plane 为 - 18 处进行切面查看。 单击图标 （ Create Band Plot） 将 Band Plot Varia-
ble 设置为 （ Displacement： Z- DISPLACEMENT） ， 单击 OK 按钮。 使用鼠标将云图移

动到左侧。
单击图标 ， 单击图标 回到 27. 1 时刻， 单击图标 仅显示单元组的网格轮廓线， 单

击图标 在 Y- Plane 为 18 处进行切面查看。 单击图标 （Create Band Plot） 将 Band Plot
Variable 设置为 （Displacement： Z- DISPLACEMENT）， 单击 OK 按钮。 使用鼠标将云图移动

到右侧， 图形区将给出如图 10-44 所示的位移云图。

图 10-44　 施工完毕时间步为 27. 1 时刻 Z 方向位移云图

查看地面中点、 上隧道顶 /底点和下隧道顶 /底点的 Z 方向位移时程曲线： 单击菜单

Definitions→Model Point→Node， 在弹出的窗口中单击 Add 按钮， 然后输入点的名字

Node1021， 并在窗口的 Node#中输入 1021， 单击 OK 按钮。 按照相同的操作步骤定义图
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10-45 中的其他点， 这些点的节点号分别为： 1177、 5227、 9198、 13170。

图 10-45　 时程曲线图中选取的点

单击图标 来清除当前屏幕中的显示信息， 单击菜单 Graph→Response curve （model
point）， 在弹出的窗口中选择纵坐标为 Node 1021 点 Displacement 中的 Z- DISPLACEMENT，
单击 Apply 按钮。 按照相同的操作步骤可以定义其他点的 Z 方向位移时程曲线。 需要注意的

是： 定义过程中右侧的 Plot Name 应选择为 PREVIOUS。

图 10-46　 各参考点 Z 方向位移时程曲线图

10. 3. 5　 应用推广

本实例可以推广应用到某些开挖支护结构的施工分析中。 对于包含多层土的模型， 使用
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公式输入法来定义初始地应力非常方便、 有效， 本实例为多层土开挖问题提供了一种简便

方法。

10. 3. 6　 注意事项

平衡地应力的目的是为了真实的模拟土体的初始状态： 初始状态是在当前模型下， 模型

在自重或构造应力作用下只有自重或构造应力场而没有位移场， 一些专业的岩土软件都具备

位移清零的功能， 但对于通用软件来说则只能通过一些其他方法来处理。
地应力一般有两种处理方法： 地应力平衡法和采用相对位移的相减法， 它们的适用性肯

定是不同的。 地应力平衡适用于所有的岩土类问题， 而相减法仅适用于堆填类问题。 例如对

于开挖问题， 在地平衡法下其开挖和支护是在当前没有位移变形的网格下进行开挖及支护计

算的； 而如果是相减法的话， 则模型在自重作用下先沉降， 即存在网格变形， 然后再在此变

形网格的基础上进行开挖及支护， 这显然不符合真实情况。
此外， 在 ADINA 软件内地应力平衡法又分为两种： 直接输入公式法和直接导入地应力

法。 直接输入公式法就是通过确定高度 Z 的坐标来实现的， 故这类问题只适用于地表及土

层是水平的情况； 而直接导入地应力法则没有任何模型方面的限制。
故对于该三种地应力的处理方法可简述如下：
1） 直接输入公式法适用类型广 （堆填和开挖问题都可以）， 但对模型有限制， 仅限于

地表及土层是水平的情况。
2） 直接导入地应力法适用类型最广， 且对模型也没有任何限制。
3） 采用相对位移的相减法仅适用于堆填类问题， 且自重沉降最好不要太大， 不适用于

开挖问题。
故做模型时， 如果模型地表及土层是水平的话， 则最先应该考虑的是直接输入公式法，

这种方法是最简单也是最有效的； 其次再考虑直接导入地应力法， 对于地表或土层倾斜的就

只能采用这种方法； 最后才考虑采用相对位移的相减法， 毕竟对于堆填类问题， 这种方法相

对来说要比较简单一些。

10. 4　 桩基挡土墙施工填土堆载过程分析

10. 4. 1　 问题描述

本实例将对某桩基挡土墙进行墙后填土堆载分析。 通过学习本实例， 读者将掌握下列几

个功能：
1） 使用直接导入地应力法施加初始地应力场。
2） 对不规则模型进行自动六面体网格划分。
3） 应用单元生死模拟施工阶段中接触问题的处理方法。
本实例将首先建立几何模型， 对应的命令流文件为 01_model. in， 进行初始地应力计算

的命令流文件为 02_dam- initial. in， 然后考虑包含接触的施工过程分析， 对应的命令流文件

为 03_dam- construction. in， 上述文件均保存在随书光盘的文件夹 \10-4 \model \中。
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10. 4. 2　 建立初始地应力模型

1. 前处理

1） 定义几何和网格密度。
启动 ADINA- AUI， 程序模块选择为 ADINA Structures。
单击菜单 File→Open （或图标 ） 来读取命令流文件 01_model. in， 此时， 图形区将给

出如图 10-47 所示的几何模型示意图。 命令流文件中包含下列命令： ①建立几何模型并设定

网格密度； ②定义边界约束条件及自重载荷。 具体的操作步骤可参看命令流文件。

图 10-47　 挡土墙几何模型示意图

2） 定义材料。
定义基岩弹性材料属性： 单击图标 将弹出材料定义对话框， 单击 Elastic Isotropic 按

钮， 在 Define Isotropic Linear Elastic Material 对话框中单击 Add. . . 按钮来定义材料 1， 在

Young’s Modulus 处输入 1. 4E9， 在 Poisson’s ratio 处输入 0. 3， 在 Density 处输入 2300， 单击

Save 按钮。
定义混凝土弹性材料属性： 在 Define Isotropic Linear Elastic Material 对话框中单击

Add. . . 按钮来定义材料 2， 在 Young’s Modulus 处输入 3. 0E10， 在 Poisson’s ratio 处输入

0. 25， 在 Density 处输入 2400， 单击 OK 按钮和 Close 按钮退出 Manage Material Definitions 对

话框。
定义基岩上填土摩尔-库伦材料属性： 单击图标 将弹出材料定义对话框， 单击 Mohr-

Coulomb 按钮， 在 Define Mohr- Coulomb Material 对话框中单击 Add. . . 按钮来定义材料 3， 在

Young’s Modulus 处输入 2. 0E8， 在 Poisson’s ratio 处输入 0. 35， 在 Density 处输入 2000， 在

Friction Angle 处输入 28， 在 Cohesion 处输入 1. 0E5， 退选 Use Specified Dilation Angle 选项，
单击 Save 按钮。

定义挡土墙后填土摩尔-库伦材料属性： 在 Define Mohr- Coulomb Material 对话框中单击

Add. . . 按钮来定义材料 4， 在 Young’s Modulus 处输入 1. 0E8， 在 Poisson’s ratio 处输入 0. 40，
在 Density 处输入 1900， 在 Friction Angle 处输入 35， 在 Cohesion 处输入 2. 0E5， 退选 Use
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Specified Dilation Angle 选项， 单击 OK 按钮退出对话框。
3） 定义单元组。
首先定义基岩的单元组： 单击菜单 Meshing→Element Group （或图标 ） 将弹出定义单

元组对话框。 单击 Add. . . 按钮来定义单元组 1， 将 Type 选择为 3D Solid， 将 Default Material
选择 1， 单击 OK 按钮退出对话框。

4） 定义 Face Link。
在 ADINA 软件中， 相同空间位置的两个相邻面需要通过 Face Link 强制连接的方式来保

证相邻面的网格节点连续。
定义 FaceLink 关系的操作如下： 单击菜单 Geometry→Faces→Face Link 将弹出 Define

Face Link 对话框， 将 Type 设置为 Create for All Faces / Surfaces， 表明 FaceLink 对模型所有的

Face 和 Surface 面进行连接检查， 如果同一几何位置的两个面的面积之差小于图 10-48 所示

的容差值， ADIAN 软件则认为在相同位置存在两个以上的面， 并将自动设置 Face Link 使相

邻两面的网格密度保持一致。
5） 划分网格。
首先对开挖桩基所在处的基岩进行映射网格划分： 单击菜单 Meshing→Create Mesh→

Body （或图标 ）， 在弹出的对话框中将 Type 选择为 3- D Solid， 将 Element Group 选择为 1，
将 Meshing- Type 选择为映射网格划分 （Rule- Based）， 将 Nodes per Element 选择为 8， 在表

格的前两行依次输入 2、 3 （如图 10-49 所示）， 单击 Apply 按钮。 映射网格划分完毕后的模

型示意图如图 10-50 所示。

图 10-48　 定义 Face Link 对话框

　 　

图 10-49　 为开挖桩基所在的基岩划分映射网格

对剩余基岩进行自动六面体网格划分： 将 Type 选择为 3- D Solid， 将 Element Group 选择

为 1， 将 Meshing- Type 选择为 Free- Form 的自由网格划分， 将 Nodes per Element 选择为 8，
勾选 Brick Elements on Boundary 选项使边界处的网格均为 8 节点六面体单元， 将 Pyramid
Elements 选择为 No （表明划分网格时不生成金字塔类型的过渡单元； 对于复杂模型， 如果

自动六面体网格划分不成功则可适当放宽该条件）， 在右侧表格的第 1 行输入 1 （如图 10-51
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图 10-50　 为基岩划分映射网格后的模型图

所示）， 单击 OK 按钮退出对话框。 为剩余基岩进行自动六面体网格划分后的模型如图 10-52
所示。

图 10-51　 进行剩余基岩的自动六面体网格划分

查看网格的连续性： 依次单击图标 和 ， 单击图标 来关闭几何模型显示功能； 单击

图标 和 对模型进行阴影并透视显示， 然后单击图标 不显示网格线， 图形区将给出如图

10-53 所示的模型示意图。
从图 10-53 中可以看出： 模型可以直接透视过去， 表明模型中不存在不连续的面， 网格

模型的所有节点都是连续的。
6） 关闭多余自由度。
单击菜单 Control→Degrees of Freedom， 在弹出的对话框中退选 X- Rotation、 Y- Rotation、

Z- Rotation 选项 （如图 10-54 所示）， 单击 OK 按钮退出对话框。
7） 打开线性搜索功能、 增大迭代次数， 并将收敛准则修改为位移准则。
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图 10-52　 为剩余基岩划分自动六面体网格的模型图

图 10-53　 网格连续性检查

图 10-54　 关闭多余自由度对话框

单击菜单 Control→Solution Process. . . ，
在 弹 出 的 对 话 框 中 选 择 Iteration
Method. . . ， 将 Use of Line Searches 设置为

YES， 将 Maximun Number of Iterations 设置

为 50， 单击 OK 退出对话框。
单击 Iteration Tolerance. . . ， 将 Con-

vergence Criteria 设置为 Displacement， 单

击 OK 按钮退出对话框。
2. 提交计算

单击菜单 File→Save （或图标 ）， 将文件保存为 02_dam- initial. in。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 02_dam- initial， 同时勾选 Run
Solution 和 Automatic Memory Allocation 选项， 单击保存按钮等待分析结束。
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3. 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ）， 打开结果文件 02_
dam- initial. por。

单击菜单 List→Value List→Zone. . . ， 并按照图 10-55 进行设置， 将初始计算得到的地

应力保存为文件 initial- stress. txt， 单击 OK 按钮退出对话框。

图 10-55　 导出初始地应力场的文本文件

提示： initial- stress. txt 作为初始地应力文件导入施工模型之前还需要使用 Excel 进行编〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
辑整理， 详细的操作步骤请参见本书 5. 6 节的内容。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
10. 4. 3　 建立施工阶段的分析模型

上一步分析得到的结果是初始地应力的状态。 打开原命令流文件来准备施工阶段的计算

模型。 单击图标 清除掉原来的信息， 并创建一个新模型。 单击图标 打开命令流文件 02_
dam- initial. in。

1） 删除桩基处的基岩网格。
单击图标 ， 确认 Delete Mesh from 为 Body， 在右侧表格中依次输入 2、 3， 单击 OK 按

钮。 此时， 图形区将给出如图 10-56 所示的模型示意图。
2） 设置初始地应力场。
本实例将通过直接导入地应力法来施加初始地应力场， 详细的操作步骤如下：
单击菜单 Model→Initial Conditions→Apply On Nodes. . . ， 在弹出的对话框中将 Initial

Condition Type 选择为 Strain， 单击 Import 按钮选择上一步计算所输出并整理好的 initial-
stress. txt 文件 （如图 10-57 所示）， 单击 OK 按钮退出对话框。

提示： 由于之前已经删除了桩基所在处的基岩网格， 同时也删除了桩基处的节点。 因〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
此， 在导入过程中将弹出警告信息提示某些节点不存在， 直接单击确认按钮即可。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
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图 10-56　 删除桩基处的基岩网格

图 10-57　 直接输入初始地应力场所在文件

图 10-58　 定义应力场的整体坐标系

　 　 定义并指定初始应力场的应力主

轴： 单击菜单 Model→Orthotropic Axes
Systems→Define， 在弹出的对话框中，
定义坐标系 1， 单击 Add. . . 按钮， 确

认 Vector Aligned with Local X- Axis 下

的 X 输入 1， Vector Lying in the Local
XY- Plane 的 Y 为 1， 如图 10-58 所示，
单击 OK。

单击菜单 Model→Orthotropic Axes
Systems→Assign （ Initial Strain）， 在弹

出的对话框中对 Body 1 指定局部坐标
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系。 将 Assign to 选择为 Bodies， 在表格的第 1 行输入 1、 1、 LocalX、 LocalY， 如图 10-59 所

示 （对于 3D 模型则采用默认值， 指定 a- direction 为 Local X， b- direction 为 Local Y）。

图 10-59　 将应力场转换为整体坐标系

3） 修改并添加单元组。
修改单元组 1： 单元组 1 为基岩网格， 需要引入初始地应力场。 单击菜单 Meshing→Ele-

ment Group （或图标 ）， 将弹出定义单元组对话框。 单击 Advanced 标签页， 将 Initial
Strains 设置为 Nodal Only， 如图 10-60 所示， 单击 Save 按钮。

图 10-60　 修改单元组 1 以考虑初始地应力

定义混凝土挡土墙单元组： 单击 Add. . . 按钮来定义单元组 2， 将 Default Material 选择

为 2， 单击 Save 按钮。
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定义基岩上填土单元组： 单击 Add. . . 按钮来定义单元组 3， 将 Default Material 选择为

3， 单击 Save 按钮。
定义挡土墙后填土单元组： 单击 Add. . . 按钮来定义单元组 4， 将 Default Material 选择

为 4， 单击 OK 按钮。
4） 为施工阶段的模型划分网格。
首先对挡土墙后的填土进行网格划分： 单击菜单 Meshing→Create Mesh→Body （或图标

）， 在弹出的对话框中将 Type 选择为 3- D Solid， 将 Element Group 选择为 4， 将 Meshing-
Type 选择为映射网格划分 （Rule- Based）， 将 Nodes per Element 选择为 8， 并在表格中依次

输入 8、 9、 11、 13、 15， 单击 Apply 按钮。
再将 Meshing- Type 选择为 Free- Form， 将 Nodes per Element 选择为 8， 勾选 Brick Ele-

ments on Boundary 选项， 将 Pyramid Elements 设置为 No， 在右侧表格中依次输入 10、 12、
14， 单击 Apply 按钮。

对基岩上填土进行网格划分： 将 Element Group 选择为 3， 将 Meshing- Type 选择为 Free-
Form， 将 Nodes per Element 选择为 8， 勾选 Brick Elements on Boundary 选项， 将 Pyramid Ele-
ments 设置为 No， 在右侧表格中输入 7， 单击 Apply 按钮。

对混凝土挡土墙进行网格划分： 将 Element Group 选择为 2， 将 Meshing- Type 选择为映

射网格划分 （Rule- Based）， 将 Nodes per Element 选择为 8， 在表格中依次输入 2、 3、 4、 6，
单击 More Options 标签页， 将 Check 设置为 Against Same Element Group Only （如图 10-61 所

示）， 单击 Apply 按钮。

图 10-61　 节点耦合控制对话框

再将 Meshing- Type 选择为 Free- Form， 将 Nodes per Element 选择为 8， 勾选 Brick Ele-
ments on Boundary 选项， 将 Pyramid Elements 设置为 No； 仍然将 More Options 标签页下的

Check 项设置为 Against Same Element Group Only， 在右侧表格中输入 5， 单击 OK 按钮。
提示： 将 Check 项设置为 Against Same Element Group Only 后， 对混凝土挡土墙划分网〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

格时将只对自身单元组进行节点耦合检查， 而不会对其他单元组进行节点耦合检查， 这样可〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
以保证在定义挡土墙接触时， 混凝土挡土墙和周围基岩及墙后填土的节点不耦合。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
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查看网格连续性： 单击图标 和 ， 单击图标 关闭显示几何模型功能； 单击图标 和

对模型进行阴影和透视显示， 然后单击图标 不显示网格线， 图形区将给出如图 10-62 所

示的模型示意图。

图 10-62　 网格连续性检查

图 10-63　 设置接触控制对话框

由图 10-62 可以看出： 模型不能够

直接透视过去， 表明模型中存在不连

续的面， 即桩基与基岩之间、 挡土墙

与填土之间的节点都不连续。
5） 定义接触。
定义接触控制： 单击菜单 Model→

Contact→Contact Control， 在弹出的对

话框中勾选 Apply Post- Impact Correc-
tions 选项， 并 将 Default Contact Dis-
placement Formulation 设置为 Small 以加

速接触计算， 如图 10-63 所示。
定义桩基与基岩之间接触组 1： 单

击菜单 Model→Contact→Contact Group
（或图标 ）， 在弹出的对话框中单击

Add. . . 按钮， 将 Type 选择为 3- D Con-
tact， 在 Default Coulomb Friction Coeffi-
cient 处输入 0. 4 （如图 10-64 左图所示）； 单击 Advanced 标签页， 在 Birth Time 处输入 10，
在 Death Time 处输入 10000， 在 Time to Eliminate Initial Penetration 处输入 10 （如图 10-64 右

图所示）， 单击 OK 按钮。
提示： 在定义接触时的网格模型均按照初始模型来建立， 即模型刚好发生接触但没有发〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

生穿透。 由于考虑接触的同时还需要考虑施工过程， 这必然会引起网格的位移变形与穿透，〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
因此需要在接触发生时消除初始穿透。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
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图 10-64　 设置接触组 1 对话框

定义桩基接触面 1： 单击菜单 Model→Contact→Contact Surface （或图标 ）， 在弹出的

对话框中单击 Add. . . 按钮来定义接触面 1， 将 Defined on 选择为 Surfaces and / or Faces， 并按

照图 10-65 所示进行设置， 单击 Save 按钮。

图 10-65　 设置接触组 1 的接触面 1

定义基岩接触面 2 的操作如下： 单击 Add. . . 按钮来定义接触面 2， 将 Defined on 选择为

Surfaces and / or Faces， 并按照图 10-66 所示进行设置， 单击 OK 按钮退出对话框。
定义接触对 1 的操作如下： 单击菜单Model→Contact→Contact Pair （或图标 ）， 在弹出

的对话框中单击 Add. . . 按钮， 将 Target Surface 选择为 1， 将 Contact Surface 选择为 2， 单击

OK 按钮。 接触对 1 定义完毕。
与上述的操作步骤相同， 按照下表 10-12 定义其他接触组、 接触面、 接触对、 接触的生

死时间和消除穿透时间。
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图 10-66　 设置接触组 1 的接触面 2

表 10-12　 接触组、 接触面、 接触对以及接触的生死时间和消除穿透时间

接触组
接触面 1 接触面 2 接触对 1 摩擦

系数

单元生

时间

单元死

时间

消除穿

透时间面号 体号 面号 体号 目标面 接触面

1

1
5
3
4
5
2
6
2
6
3
4
5
3
4
5

4
4
5
5
5
2
2
3
3
2
2
2
3
3
3

8
7
6
16
17
11
12
20
18
19
14
15
13
4
3

1
1
1
1
1
1
1
1
1
1
1
1
1
7
7

1 2 0. 4 10 10000 10

2 3 6 2 7 1 2 0. 2 20 10000 20

3 3 6 2 8 1 2 0. 2 30 10000 30

4 3 6 2 9 1 2 0. 2 40 10000 40

5 3 6 2 10 1 2 0. 2 50 10000 50

6 3 6 2 11 1 2 0. 2 60 10000 60

7 3 6 2 12 1 2 0. 2 70 10000 70

8 3 6 2 13 1 2 0. 2 80 10000 80

9 3 6 2 14 1 2 0. 2 90 10000 90

10 3 6 2 15 1 2 0. 2 100 10000 100
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　 　 6） 定义单元生死时间。
由于填土施工中涉及单元生死， 因此需要使用单元生死 （Element Birth / Death） 功能，

并借助于单元生 （Active） 来模拟填土过程。
单击菜单 Model→Element Properties→3- D Solid， 并按照图 10-67 来定义施工过程。

图 10-67　 定义单元生死时间

7） 施加挡土墙后顶面堆载。
挡土墙后顶面堆载在填土施工完成后施加， 因此需要定义时间函数来确定载荷随时间的

变化情况。
按照表 10-13 （ADINA 中生成） 来定义顶面堆载作用的时间函数 2。 从表中可以看出：

顶面堆载在时刻 111 才施加， 此后将保持不变。

表 10-13　 时间函数 2

Time Value

1 0 0

2 110 0

3 111 1. 0

4 200 1. 0

单击图标 并选择载荷类型为 Pressure， 单击 Define. . . 按钮在 Magnitude 处输入 20000，
单击 OK 按钮返回上一级窗口， 在 Apply to 中选择 Face， 并在绿色窗口中输入 Body 15 的

Face 1， 在 Time Function. . . 处输入 2 （表示时载荷按照时间函数 2 施加）。
依次单击图标 和 ， 单击显示载荷图标 和不同单元组颜色图标 ， 图形区将给出如

图 10-68 所示的模型载荷施加图。
8） 设置初始应力场的使用。
单击菜单 Control→Miscellaneous Options， 在弹出的窗口中选择 Initial Sresses that Cause

Deformation， 以通过初始应力场来平衡重力场导致的变形。
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图 10-68　 模型载荷图

　 　 9） 定义时间步。

图 10-69　 定义时间步对话框

单击菜单 Control→Time Step，
在弹出的对话框中按照图 10-69 进

行设置。
需要注意的是： 此时在施工

过程之前定义了 1 个 1. 0 的时间。
这样做有两个作用： 一方面在施

工之前增加一个小的时间步来试

算并查看初始应力场是否定义正

确； 另一方面则可避免单元生死

时间与时间步之间的舍入误差。

10. 4. 4　 求解

单击菜单 File→Save （或图标 ） 将文件保存为 03_dam- construction. in。 单击菜单 Solu-
tion→Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 03_dam- construction， 同时

勾选 Run Solution 和 Automatic Memory Allocation 选项， 单击保存按钮并等待分析结束。 求解

过程中将给出如图 10-70 所示的求解信息， 通过查看这些信息可以实时掌握分析过程。
由图 10-70 可以看出： 随着施工过程的进行， 接触的位置将出现接触网格穿透的问题，

这是由于单元生死和接触共同引起的， 因此必须在接触计算之前把穿透消除掉。

10. 4. 5　 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

03_dam- construction. por。
查看模型在 1. 0 时刻最大主压应力及 Z 方向位移云图： 单击图标 和 ， 单击图标 返

回到 1. 0 时刻， 然后单击图标 仅显示单元组的网格轮廓线。 单击图标 （Create Band
Plot）， 将 Band Plot Variable 设置为 （Stress： SIGMA- P3）， 单击 OK 按钮。 使用鼠标将云图
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图 10-70　 求解过程中的提示信息

移动到左侧。
单击图标 ， 单击图标 返回到 1. 0 时刻， 单击图标 并将 Band Plot Variable 设置为

（Displacement： Z- DISPLACEMENT）， 单击 OK 按钮。 用鼠标将云图移动到右侧。 图形区将

给出如图 10-71 所示的最大主压应力和 Z 方向位移云图。

图 10-71　 1. 0 时刻最大主压应力及 Z 方向位移云图

由图 10-71 可以看出： 在 1. 0 时刻存在应力场， 但位移场的最大位移远小于 1mm， 故认

为其在误差所允许的范围内， 因此可以判断初始地应力场的设置是正确的。
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查看模型在最终时刻 111 的 Y 方向和 Z 方向位移云图： 单击图标 和 ， 单击图标 返

回到 111 时刻， 单击图标 仅显示单元组的网格轮廓线， 然后单击图标 ， 并将 Band Plot Var-
iable 设置为 （Displacement： Y- DISPLACEMENT）， 单击 OK 按钮。 用鼠标将云图移动到左侧。

单击图标 ， 单击图标 返回到 111 时刻， 单击图标 仅显示单元组的网格轮廓线， 然后

单击图标 并将 Band Plot Variable 设置为 （Displacement： Z- DISPLACEMENT）， 单击 OK 按

钮。 用鼠标将云图移动到右侧。 图形区将给出如图 10-72 所示的 Y 方向和 Z 方向位移云图。

图 10-72　 111 时刻的 Y 方向及 Z 方向位移云图

查看挡土墙接触力： 单击图标 和 ， 选择 EG2 并单击 OK 按钮来单独显示挡土墙模

型。 单击菜单 Display→Reaction Plot→Create， 在弹出的窗口中将 Reaction Quantity 设置为

CONSISTENT_CONTACT_FORCE， 单击 OK 按钮。

图 10-73　 挡土墙接触力
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10. 4. 6　 应用推广

本实例中所使用的直接导入地应力法对所有的问题类型及模型均有效。 此外， 本实例还

为施工阶段与接触联合作用时的网格穿透问题提供了处理方法， 在处理该类问题时可以进行

借鉴和参考。

10. 5　 井点降水 （水土耦合） 分析

图 10-74　 抽水井地层分布图

10. 5. 1　 问题描述

ADINA 软件中提供的岩土材料模型中， 不仅可以考

虑土体骨架的弹塑性变形， 而且还可以通过多孔介质的

属性来模拟水土耦合时超静孔隙压力的消散过程。 如果

采用 ADINA 软件中的多孔介质算法表征岩土材料时， 求

解自由度中多了一个表示孔隙压力的自由度。
ADINA 软件中孔隙介质应用的基本假设： 孔隙中的

流体是不可压缩或者轻微可压缩的， 默认状态下假设为

不可压缩的， 若用微压缩流体， 则需要通过 porous peo-
perty 设置流体的体积模量以及孔隙介质骨架的孔隙率；
孔隙实体骨架是充满孔隙流体的， 即孔隙介质处于一种

饱和状态， 没有 “三相” 的共同存在， 只有固相、 水相；
穿过孔隙骨架的孔隙流体流动符合达西定律， 即流体流

动是一种层流状态。
本实例将模拟某中心站的抽水过程， 计算模型将模

拟 6 天的抽水过程， 抽水井地层分布图如图 10-74 所示。
抽水井地层的土层材料属性如表 10-14 所示。

表 10-14　 土层材料属性表

层号 厚度 / m
重度 /

kN / m3

弹性

模量 / MPa
泊松比

粘聚

力 / kPa
摩擦角 / °

垂直渗透

系数 / KV ×

10E - 5 cm / s

水平渗透

系数 / KH ×

10E - 5 cm / s

1. 人工填土 3 18. 9 4. 826 0. 35 26. 6 15. 7

2. 粉质黏土 4. 5 17. 9 3. 001 0. 339 19. 3 21. 1

3. 粉土 6. 1 18. 9 9. 531 0. 28 27. 2 27. 7

4. 粉砂 12. 24 18. 7 10. 555 0. 277 11 28. 6 254 349

5. 粉细砂 12. 66 18. 9 11. 666 0. 249 8. 52 32. 1 326 292

6. 粉质黏土 3. 2 17. 9 3. 001 0. 339 19. 3 21. 1

7. 中砂 8. 1 19. 1 14. 375 0. 43 8. 87 33 896 659
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通过学习本实例， 读者可以掌握下列几个功能：
1） 如何处理水土耦合多孔介质的问题。
2） 如何定义单元面 Element- Face 并施加载荷。
本实例中首先将建立几何模型， 对应的命令流文件为 01_model. in， 整个模型抽水施工

阶段计算的命令流文件为 02 _well- point. in， 上述文件均保存在随书光盘的文件夹 \ 10-
5 \model \中。

10. 5. 2　 前处理

1. 定义几何及网格密度

启动 ADINA- AUI， 程序模块选择为 ADINA Structures。
单击菜单 File→Open （或图标 ）， 读取命令流文件 01_model. in， 此时图形区将给出如

图 10-75 所示的几何模型。 命令流文件中包含下列命令： ①建立几何模型； ②设定了网格密

度。 详细的建模过程读者可自行参看命令流文件。

图 10-75　 几何模型示意图

2. 定义材料

定义人工填土摩尔-库伦材料属性： 单击图标 ， 在弹出的对话框中单击 Mohr- Coulomb
按钮。 在 Define Mohr- Coulomb Material 对话框中单击 Add. . . 按钮来定义材料 1， 在 Young’s
Modulus 处输入 4. 826 E6， 在 Poisson’s ratio 处输入 0. 35， 在 Density 处输入 1890， 在 Friction
Angle 处输入 15. 7， 在 Cohesion 处输入 26. 6 E3， 退选 Use Specified Dilation Angle 选项， 单

击 Save 按钮。
定义粉质黏土摩尔-库伦材料属性： 在 Define Mohr- Coulomb Material 对话框中单击

Add. . . 按钮来定义材料 2， 在 Young’s Modulus 处输入 3. 001E6， 在 Poisson’s ratio 处输入

0. 339， 在 Density 处输入 1790， 在 Friction Angle 处输入 21. 1， 在 Cohesion 处输入 19. 3 E3，
退选 Use Specified Dilation Angle 选项， 单击 Save 按钮。

定义粉土摩尔-库伦材料属性： 在 Define Mohr- Coulomb Material 对话框中单击 Add. . . 按

钮来定义材料 3， 在 Young’s Modulus 处输入 9. 531 E6， 在 Poisson’s ratio 处输入 0. 28， 在

Density 处输入 1890， 在 Friction Angle 处输入 27. 7， 在 Cohesion 处输入 27. 2 E3， 退选 Use



第 3 篇　 实　 例　 篇

306　　 　 Focused on Excellence

Specified Dilation Angle 选项， 单击 Save 按钮。
定义粉砂摩尔-库伦材料属性： 在 Define Mohr- Coulomb Material 对话框中单击 Add. . . 按

钮来定义材料 4， 在 Young’s Modulus 处输入 10. 555 E6， 在 Poisson’s ratio 处输入 0. 277， 在

Density 处输入 1870， 在 Friction Angle 处输入 28. 6， 在 Cohesion 处输入 11 E3， 退选 Use
Specified Dilation Angle 选项， 单击 Save 按钮。

定义粉细砂摩尔-库伦材料属性： 在 Define Mohr- Coulomb Material 对话框中单击 Add. . .
按钮来定义材料 5， 在 Young’s Modulus 处输入 11. 666 E6， 在 Poisson’s ratio 处输入 0. 249，
在 Density 处输入 1890， 在 Friction Angle 处输入 32. 1， 在 Cohesion 处输入 8. 52 E3， 退选

Use Specified Dilation Angle 选项， 单击 Save 按钮。
再次定义粉质黏土的摩尔-库伦材料属性： 为了直观的让材料与单元组一一相对应起来，

则对于粉质黏土再定义一次。 切换到材料 2 并单击 Copy. . . 按钮， 将材料 2 的属性复制给材

料 6， 单击 Save 按钮。
定义中砂摩尔-库伦材料属性： 在 Define Mohr- Coulomb Material 对话框中单击 Add. . . 按

钮来定义材料 7， 在 Young’s Modulus 处输入 14. 375 E6， 在 Poisson’s ratio 处输入 0. 43， 在

Density 处输入 1910， 在 Friction Angle 处输入 33， 在 Cohesion 处输入 8. 87 E3， 退选 Use
Specified Dilation Angle 选项， 单击 OK 按钮退出对话框。

3. 定义单元组

对于上述 7 个土层需要分别定义 7 个单元组与之一一对应。 定义单元组的操作如下：
单击菜单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击

Add. . . 按钮来定义单元组 1， 将 Type 选择为 3D Solid， 将 Default Material 选择为 1， 单击

Save 按钮； 单击 Add. . . 按钮来定义单元组 2， 将 Default Material 选择为 2， 单击 Save 按钮；
单击 Add. . . 按钮来定义单元组 3， 将 Default Material 选择为 3， 单击 Save 按钮； 单击

Add. . . 按钮来定义单元组 4， 将 Default Material 选择为 4， 将 Element Option 设置为 Porous
Media （如图 10-76 所示）， 即： 对土层 4 的粉砂考虑水土耦合时的孔隙压力作用， 单击 Save
按钮； 单击 Add. . . 按钮来定义单元组 5， 将 Default Material 选择为 5， 将 Element Option 设

置为 Porous Media （如图 10-76 所示）， 即： 对土层 5 的粉细砂考虑水土耦合时的孔隙压力

作用， 单击 Save 按钮； 单击 Add. . . 按钮来定义单元组 6， 将 Default Material 选择为 6， 单击

Save 按钮； 单击 Add. . . 按钮来定义单元组 7， 将 Default Material 选择为 7， 将 Element
Option 设置为 Porous Media （如图 10-76 所示）， 即： 对土层 7 的中砂考虑水土耦合时的孔隙

压力作用， 单击 OK 按钮退出对话框。
4. 定义多孔介质属性

定义单元组时如果 Element Option 中选择为 Porous Media， ADINA 软件才允许读者定义

多孔介质属性。 需要注意的是： 本实例中的时间按天数 （day） 来考虑。
单击菜单 Model→Materials→Porous Media Property， 在弹出的菜单中分别输入粉砂、 粉

细砂以及中砂的渗透系数， 如图 10-77 所示。
将 Material Number 选择为 4， 在 In X Direction 处输入 3. 0769 E-4， 在 In Y Direction 处

输入 3. 0769 E-4， 在 In Z Direction 处输入 2. 23935 E-4。
将 Material Number 选择为 5， 在 In X Direction 处输入 2. 57437 E-4， 在 In Y Direction 处

输入 2. 57437 E-4， 在 In Z Direction 处输入 2. 87412 E-4。
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图 10-76　 设置单元组的多孔介质属性

图 10-77　 设置渗透系数对话框

将 Material Number 选择为 7， 在 In X Direction 处输入 5. 80996 E-4， 在 In Y Direction 处

输入 5. 80996 E-4， 在 In Z Direction 处输入 7. 89943 E-4。
提示： ADINA 软件中渗透系数采用的有效渗透系数， 在国际标准单位制下 （m、 s、 kg）〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰

渗透系数 （单位： m / s） 除以水的重度 9800 （单位： m3·s / kg） 作为有效渗透系数值输入〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
即可。〰〰

5. 划分网格

为第一层土划分网格： 单击菜单 Meshing→Create Mesh→Volume （或图标 ）， 在弹出

的对话框中将 Type 选择为 3- D Solid， 将 Element Group 选择为 1， 将 Nodes per Element 选择

为 8， 退选 Wedge Volumes Treated as Degenerate 选项， 并在表格中输入 Volume 25 ～ Volume
36 的所有体号， 单击 Apply 按钮。
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为第二层土划分网格： 将 Element Group 选择为 2， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate 选项， 并在表格中输入 Volume 13 ～ Volume 24 的所有体

号， 单击 Apply 按钮。
为第三层土划分网格： 将 Element Group 选择为 3， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate 选项， 在表格中输入 Volume 1 ～ Volume 12 的所有体号，
单击 Apply 按钮。

为第四层土划分网格： 将 Element Group 选择为 4， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate 选项， 在表格中输入 Volume 37 ～ Volume 44 的所有体

号， 单击 Apply 按钮。
为第五层土划分网格： 将 Element Group 选择为 5， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate 选项， 在表格中输入 Volume 45 ～ Volume 52 的所有体

号， 单击 Apply 按钮。
为第六层土划分网格： 将 Element Group 选择为 6， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate 选项， 在表格中输入 Volume 53 ～ Volume 60 的所有体

号， 单击 Apply 按钮。
为第七层土划分网格： 将 Element Group 选择为 7， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate 选项， 在表格中输入 Volume 61 ～ Volume 68 的所有体

号， 单击 OK 按钮。 网格划分工作完毕。
单击图标 、 和 ， 此时图形区将给出如图 10-78 所示的模型网格图， 图中共包含 7

个单元组， 分别使用不同的颜色来表示。

图 10-78　 模型网格图

6. 定义并施加边界条件

将土层左右两端设置为透水边界， 底部基岩则设置为不透水边界。 对于透水边界条件，
则应该将超孔隙水压力设置为零； 由于不透水边界的边界条件与内部节点相同， 因此可以不

设置边界条件。
ADINA 软件中默认的边界就是不透水边界。 对于孔压边界， 透水是约束边界， 不透水

则是自由边界。 有两种施加透水边界条件的方法：
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1） 通过约束边界的形式施加。 如果勾选 “pore fluid pressure”， 施加的孔压约束则为透

水边界。
2） 利用载荷边界中的 “pore pressure” 来定义孔压边界， 孔压为零则表示透水边界。
单击图标 ， 在弹出的对话框中单击 Define. . . 按钮， 并按照如图 10-79 所示的设置来

定义 XF、 YF 的透水边界条件和 ZF 的不透水边界条件。 请读者按照表 10-15 来定义模型的

其他边界条件。

图 10-79　 边界条件设置对话框

表 10-15　 边界约束表

面　 　 号 约 束 条 件 面　 　 号 约 束 条 件 面　 　 号 约 束 条 件

42 X- F 45 Y- F 209 Z- F

47 X- F 56 Y- F 213 Z- F

52 X- F 63 Y- F 217 Z- F

60 X- F 114 Y- F 220 Z- F

111 X- F 119 Y- F 224 Z- F

117 X- F 128 Y- F 227 Z- F

124 X- F 135 Y- F 230 Z- F

132 X- F 156 Y- F 232 Z- F

152 X- F 163 Y- F

160 X- F 184 Y- F

180 X- F 191 Y- F

188 X- F 212 Y- F

208 X- F 219 Y- F

216 X- F

7. 定义并施加抽水载荷

定义抽水载荷时， 既可以直接将抽水载荷施加在第 4、 5、 7 层砂土的 12 个面 （Surface）
上， 也可以直接施加在这 12 个面 （Surface） 所对应的单元面 （Element- Face） 上。 这两种

方法中， 就界面操作而言， 直接施加在单元面上的操作要更加方便一些。
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定义 Element- Face 面： 单击菜单Meshing→Elements→Element Face Set， 在弹出的对话框

中单击 Add. . . 按钮来定义单元面组 1， 选择 Auto- Chain Element Faces 方法， 在 Face Angle
处输入 20， 任意选取抽水井面附近的某一单元面， 如图 10-80 所示， 单击 Save 按钮后，
ADINA 自动将相邻的单元面 Auto- Chain 到 Element- Face 添加到单元面组 1 中， 如图 10-81
所示。

图 10-80　 Element- Face 单元组 （面 Auto- Chain 之前）

图 10-81　 Element- Face 单元组 （面 Auto- Chain 之后）

对于第 6 层粉质黏土的某些单元面 （Element- Face）， 用户需要在单元面组 1 中进行删

除。 按下 Shift 键选中属于单元组 6 的所有单元面， 单击 Del Row 删除即可， 如图 10-82
所示。
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图 10-82　 在 Element- Face 单元面组 1 中删除多余单元面

ADINA 软件中规定： 如果孔隙水压力为负， 则表示单元向外排水； 如果孔隙水压力为

正， 则表示单元向内吸水。 在 ADINA 软件中可以通过施加抽水孔压 （pore pressure） 或施加

孔隙流速 （Pore Flow） 来模拟抽水过程。
本实例将通过输入 Pore Flow 来模拟抽水过程， 抽水流量 Q =938. 63m3 / d， 则 Pore Flow =

938. 63 / {2 × 3. 14 × 0. 4 × （12. 24 + 12. 66 + 8. 1）} = 11. 323m / d。
单击图标 ， 在弹出的对话框中选择载荷类型为 Pore Flow。 单击 Define 按钮， 在 Mag-

nitude 处输入 - 11. 323， 单击 OK 按钮返回上一级窗口。 在 Apply to 窗口中选择 Element-
Face Set 并输入单元面 1 的号， 如图 10-83 所示。

图 10-83　 施加抽水载荷
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依次单击图标 和 ， 然后单击图标 来关闭显示几何模型功能， 单击图标 在 YZ 平

面显示网格模型， 单击图标 来透视显示模型， 单击显示载荷图标 ， 图形区将给出如图

10-84 所示的模型载荷图。

图 10-84　 模型载荷图

图 10-85　 关闭刚度矩阵特征值检查

8. 关闭刚度矩阵特征值检查

单击菜单 Control→Solution， 在弹

出的对话 框 中， 勾 选 Continue Even
When Non- Positive Definite Stiffness Ma-
trix Encountered， 如图 10-85 所示， 设

置刚度特征值非正定后， 继续进行计

算， 这样做的原因是： 在多孔介质分

析中， 由于孔隙水压力的存在， 刚度

矩阵特征值一般将出现负值。
9. 定义时间步和步数

单击菜单 Control→Time Step， 在

弹出的对话框中定义时间步长为 0. 2d，
共计算 30 步， 则总计算时间为 6d。

10. 5. 3　 求解

单击菜单 File→Save （或图标 ）， 将文件保存为 02_well- point. in。 单击菜单 Solution→
Data File / Run （或图标 ）， 在弹出的对话框中输入文件名 02 _well- point， 同时勾选 Run
Solution 和 Automatic Memory Allocation 选项， 单击保存按钮， 并等待分析结束。

10. 5. 4　 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

02_well- point. por。
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查看模型 Z 方向位移云图： 单击图标 和 ， 然后单击图标 不显示单元组的网格轮廓

线。 单击图标 ， 并将 Band Plot Variable 设置为 （Displacement： Z- DISPLACEMENT）， 单击

OK 按钮。 Z 方向位移表示抽水 6d 所引起的附加变形， 图形区将给出如图 10-86 所示的 Z 方

向位移云图。

图 10-86　 整体模型 Z 方向位移云图

单击图标 ， 并将 Type 设置为 Cutting Plane， 将 Type 选择为 Cutting Plane， 确认 Defined
by 选择为 X- Plane， 将 Below the Cutplane 设置为 Display as Usual 来进行切面查看， 单击 OK
按钮。 切片结果如图 10-87 所示。

图 10-87　 模型 Z 方向位移云图的切面查看结果

单击图标 ， 并将 Below the Cutplane 设置为 Do not Display， 将 Above the Cutplane 设置

为 Do not Display， 退选 Display the Plane （s） 进行切片查看。 单击图标 在 YZ 平面显示结

果， 如图 10-88 所示。
查看孔压云图： 单击图标 进入 Modify BandPlot 对话框， 将 Band Plot Variable 设置为
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图 10-88　 模型 Z 方向位移云图的切片查看结果 （YZ 平面）

（Stress： PORE- PRESSURE）， 单击 OK 按钮。 图形区将给处如图 10-89 所示的孔压云图的切

片查看结果。

图 10-89　 模型孔压云图的切片查看结果

提示： ADINA 软件中的 Pore Pressure 指的是超静孔隙压力。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
查看地面沉降路径曲线： 单击菜单 Definitions→Model Line→Node， 在弹出的对话框中

单击 Add. . . 按钮， 在右侧表格中选择下图虚线包围区内路径上的所有节点 Node 127、
331、 313、 295、 277、 259、 241、 1084 ～ 1095、 1948 ～ 1959 （如图 10-90 所示）， 单击

OK 按钮。
单击图标 来清除当前屏幕显示， 再单击菜单 Graph→Response curve （model Line）， 在

弹出的窗口中选择纵坐标 Displacement 中的 Z- DISPLACEMENT， 单击 OK 按钮。 此时， 图形

区中将给出如图 10-91 所示的沉降路径曲线图。
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图 10-90　 定义节点的路径线

图 10-91　 地面 Z 方向沉降路径曲线图

10. 5. 5　 应用推广

本实例是 ADINA 软件对岩土类多孔介质材料的一种应用。 只要实际工程问题中包含了

多孔介质属性， 则对于固结沉降、 水土耦合等岩土类问题都可以直接在 ADINA 软件的结构

模块 （Structures） 中进行分析。

10. 5. 6　 注意事项

ADINA 软件中的孔隙介质属性能够用于固结分析， 并且其理论依据包含了 Biot 固结理

论。 另外， 在 ADINA 软件中用孔隙介质问题时应注意以下几点：
1） 孔隙介质可应用于不排水分析 （即静态孔隙流动）、 静力固结分析、 动力固结分析

或膨胀分析， 但不能在显式动力分析中运用。
2） 在用孔隙介质进行固结分析时， 默认状态下边界为不排水边界， 排水边界条件可通

过 pore pressure 载荷来定义。
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3） 孔隙介质属性只能用在 2D 和 3D 实体单元分析上， 在这些单元的角节点处含有孔隙

水压力， 对于高阶单元的孔隙水压力值通过插值计算求得， 在结果后处理中可在 STRESS 项

下的 PORE_PRESSURE 输出。
4） 由 ADINA 软件中的本构方程及几何方程可知： 孔隙介质属性不仅可用于线弹性模型

材料分析， 也可用于其他非线弹性材料、 弹塑性材料模型分析。
5） ADINA 软件中的孔隙介质属性不仅可应用于小变形分析， 也可应用于大变形分析，

在对大位移 /小应变问题分析时一般采用 TL （total lagrangian） 公式求解， 在对大位移 /大应

变问题分析时一般采用 ULH （updated lagrangian hencky） 公式求解。
6） 在孔隙介质的分析中， 由于整体刚度矩阵不再是正定的， 因此， 需要在求解过程中

设定刚度矩阵非正定后仍继续进行计算。
7） 孔隙介质在用于固结问题分析中， 合理的时间步选择很重要， 建议参考一些相关文

献对时间步选择的说明。
8） ADINA 软件中渗透系数采用的有效渗透系数， 在国际标准单位制下 （m、 s、 kg） 渗

透系数 （单位： m / s） 除以水的重度 9800 （单位： m3·s / kg） 作为有效渗透系数值输入即可。

10. 6　 水下沉箱抗震及冲击 （流固耦合） 分析

图 10-92　 方形沉箱示意图

10. 6. 1　 问题描述

本实例将对某水下方形沉箱进行抗震及波浪冲击

分析， 模型示意图如图 10-92 所示。
通过学习本实例， 读者可以掌握下列功能：
1） 如何处理流固耦合 FSI 类型问题。
2） 如何模拟波浪冲击过程。
本实例第 1 步将建立几何模型， 对应的命令流文

件为 010_model. in； 建立结构模型边界条件、 施加载

荷以及定义接触的命令流文件为 011 _model _str- ini-
tial. in； 建立流体模型边界条件的命令流文件为 012_
model_cfd- initial. in。 第 2 步分别建立结构和流体的抗

震模型， 对应的命令流文件分别为 021 _Earthquake_
str. in 和 022_Earthquake_cfd. in。 第 3 步则分别建立结构和流体的波浪冲击模型， 对应的命

令流文件分别为 031_Wavequake_str. in 和 032_Wavequake_cfd. in。 文本文件 a050_002_0050_
01. txt 提供了抗震分析所需要的地震加速度时程数据。 上述文件均保存在随书光盘的文件夹 \
10-6 \ in_model \中。

10. 6. 2　 流固耦合抗震分析

1. 前处理

1） 进入结构分析模块。
启动 ADINA- AUI， 从程序模块的下拉式菜单中选择 ADINA Structures。
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单击图标 来清除图形区中的信息并创建一个新模型。 单击图标 来打开命令流文件

011_model_str- initial. in。
2） 设置求解控制。
求解控制： 将分析类型选择为 Dynamics- Implicit 分析。
打开流固耦合 FSI： 在类型栏内打开 FSI 选项。
打开自动时间步： 单击图标 ， 在弹出的对话框中勾选 Use Automatic Time- Stepping 选

项， 单击右侧的 按钮， 将弹出 Automatic Time- Stepping 对话框， 将 Maximun Subdivisions
Allowed 设置为 100。

打开线性搜索选项： 单击菜单 Control→Solution Process， 在弹出的对话框中单击 Iteration
Method， 将 Use of Line Searches 设置为 Yes， 并在 Maximun Number of Iterations 处输入 30。

定义时间步： 单击菜单 Control→Time Step 来定义时间步长 0. 02， 共计算 2000 步。
设置结果输出控制： 单击菜单 Control→Porthole （. por） →Time Steps （Nodal Results），

在弹出的对话框中依次输入 1、 1、 2000、 10， 并将 Copy Time Step Blocks To Element Results
设置为 Copy over if it is Empty。

3） 定义并施加地震波。
定义地震波的时间函数： ADINA 软件中不同方向的地震加速度均通过时间函数曲线的

方式来输入。 需要注意的是： 时间函数中的 Value 指的是比例因子， 在不同时刻对加速度载

荷定义中的 Magnitude 进行放大或缩小。 首先输入不同方向的 Time Function， 对应的操作如

下： 单击 Control→Time Function. . . ， 在弹出的对话框中单击 Add. . . 按钮， 然后单击 Import
选择地震波文件 a050 _002 _0050 _01. txt， 以输入 X 方向的地震加速度曲线， 如图 10-93
所示。

图 10-93　 输入 X 方向地震加速度曲线

定义地震载荷： 单击图标 ， 在弹出的对话框中将载荷类型选择为 Mass Proportion， 单

击 Define 按钮， 在弹出的对话框中， 将 Magnitude 输入 0. 01， 确认 Direction Vector 下的 X 为

1， Y 与 Z 为 0， 将 Interpret Loading as （ for potential- based fluid element only） 选择 Groud
Acceleration， 如图 10-94 所示。

当返回到 Apply Load 窗口时， 将 Load Number 选择为 2， 在表格第一行输入 2， 载荷数
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图 10-94　 定义 X 方向的地震加速度载荷

与时间函数的对应关系如图 10-95
所示。

4） 对结构施加 FSI 边界。
单击菜单 Model→Boundary Con-

ditions→FSI Boundary. . . ， 在弹出的

对话框中单击 Add. . . 按钮来定义

Boundary Number 1， 将 Type 设置为

Surfaces， 单击 Import. . . 来导入文件

fsi- boundary- str_01. txt （保存于随书

光盘的文件夹 \ 10-6 \ in_model \中），
如图 10-96 左 图 所 示， 单 击 Save
按钮。

单击 Add. . . 按钮来定义 Boundary
Number 2， 将 Type 设置为 Surfaces， 单击 Import. . . 按钮来导入文件 fsi- boundary- str_02. txt （保
存于随书光盘的文件夹 \10-6 \in_model \中）， 如图 10-96 右图所示， 单击 OK 按钮退出对话框。

图 10-95　 载荷数与时间函数的对应关系

图 10-96　 为结构施加 FSI 边界
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5） 定义材料。
定义混凝土弹性材料属性： 单击图标 ， 在弹出的对话框中单击 Elastic Isotropic 按钮，

在 Define Isotropic Linear Elastic Material 对话框中单击 Add. . . 按钮来定义材料 1， 在 Young’s
Modulus 处输入 3. 25 E10， 在 Poisson’s ratio 处输入 0. 167， 在 Density 处输入 1500， 单击 Save
按钮。

定义坝基弹性材料属性： 在 Define Isotropic Linear Elastic Material 对话框中单击 Add. . .
按钮来定义材料 2， 在 Young’s Modulus 处输入 2. 5 E10， 在 Poisson’s ratio 处输入 0. 167， 在

Density 处输入 1000， 单击 Save 按钮。
定义基岩 （石头） 弹性材料属性： 在 Define Isotropic Linear Elastic Material 对话框中单

击 Add. . . 按钮来定义材料 3， 在 Young’s Modulus 处输入 3. 0 E10， 在 Poisson’s ratio 处输入

0. 167， 在 Density 处输入 1000， 单击 OK 按钮和 Close 按钮退出对话框。
提示： 对于水下结构需按照浮容重来考虑。〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
6） 定义单元组。
对于刚才定义的 3 种材料可以定义 6 个单元组， 分别为箱底、 箱体、 箱内抛石、 箱盖、

坝基、 基岩。 将相同材料定义成两个或多个单元组， 这样做的优点是便于在后处理时对不同

部位可以按照不同单元组进行显示查看。
定义箱底单元组： 单击菜单 Meshing→Element Group （或图标 ）， 在弹出的定义单元

组对话框中单击 Add. . . 按钮， 定义单元组 1， 将 Type 选择为 3D Solid， 将 Default Material
选择为 1， 单击 Save 按钮。

定义箱体单元组： 单击 Add. . . 按钮， 定义单元组 2， 将 Default Material 选择为 1， 单击

Save 按钮。
定义箱内抛石单元组： 单击 Add. . . 按钮， 定义单元组 3， 将 Default Material 选择为 3，

单击 Save 按钮。
定义箱盖单元组： 单击 Add. . . 按钮， 定义单元组 4， 将 Default Material 选择为 1， 单击

Save 按钮。
定义坝基单元组： 单击 Add. . . 按钮， 定义单元组 5， 将 Default Material 选择为 2， 单击

Save 按钮。
定义基岩单元组： 单击 Add. . . 按钮， 定义单元组 6， 将 Default Material 选择为 3， 单击

OK 按钮。
7） 划分网格。
划分箱底的网格： 单击菜单 Meshing→Create Mesh→Volume （或图标 ）， 在弹出的对

话框中将 Type 选择为 3- D Solid， 将 Element Group 选择为 1， 将 Nodes per Element 选择为 8，
退选 Wedge Volumes Treated as Degenerate， 并在表格中输入 Volume 1 ～ Volume 86 （应用 Auto
功能）， 单击 Apply 按钮。

划分箱体的网格： 将 Element Group 选择为 2， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate， 在表格中输入 Volume 87 ～ Volume 107 （应用 Auto 功

能）， 单击 Apply 按钮。
划分箱内抛石的网格： 将 Element Group 选择为 3， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate， 在表格中输入 Volume 108 ～ Volume 115 （应用 Auto 功
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能）， 单击 Apply 按钮。
划分箱盖的网格： 将 Element Group 选择为 4， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate， 在表格中输入 Volume 116 ～ Volume 164 （应用 Auto 功

能）， 单击 Apply 按钮。
划分坝基的网格： 将 Element Group 选择为 5， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate， 在表格中输入 Volume 65； 将 Nodal Coincidence 选择为

No Checking， 单击 Apply 按钮。
划分基岩的网格： 将 Element Group 选择为 6， 将 Nodes per Element 选择为 8， 退选

Wedge Volumes Treated as Degenerate， 在表格中输入 Volume 166； 将 Nodal Coincidence 选择

为 All Generated Nodes， 单击 OK 按钮退出对话框。
8） 生成 ADINA 结构求解文件。
单击图标 ， 将数据库保存到文件 021_Earthquake_str. idb 中。 生成 ADINA 结构求解文

件的操作如下： 单击图标 ， 在弹出的对话框中将文件名设置为 021_Earthquake_str， 确认

没有勾选 Run Solution 选项后单击 Save 按钮。
9） 进入流体分析模块。
启动 ADINA- AUI， 从程序模块的下拉式菜单中选择 ADINA CFD。
单击图标 清除图形区中的信息， 并创建一个新模型； 单击图标 打开命令流文件 012_

model_cfd- initial. in。
10） 设置求解控制。
求解控制： 将分析类型选择为 Transient。
打开流固耦合 FSI： 在类型栏中打开 FSI 选项。
选择 3D 分析但不进行传热分析： 单击菜单 Model→Flow Assumptions， 在弹出的对话框

中将 Flow Dimension 选择为 3D， 退选 Includes Heat Transfer。
打开自动时间步： 单击图标 ， 在弹出的对话框中勾选 Use Automatic Time- Stepping。
选择 FCBI- C 单元算法： 单击菜单 Control→Solution Process， 将 Flow- Condition- Based

Interpolation Element 设置为 FCBI- C； 单击 Outer Iteration， 再单击 Advanced Settings， 勾选

Use Pressure- Implicit with Splitting of Operators （PISO） Scheme 选项。
定义时间步： 单击菜单 Control→Time Step， 在弹出的对话框中定义时间步长 0. 02， 共

计算 2000 步。
结果输出控制： 单击菜单 Control→Porthole （. por） →Time Steps （Nodal Results）， 在弹

出的对话框表格的第 1 行依次输入 1、 1、 2000、 10， 并将 Copy Time Step Blocks To Element
Results 设置为 Copy over if it is Empty。

11） 对流体施加 FSI 边界。
单击菜单 Model→Special Boundary Conditions （或图标 ）， 在弹出的对话框中单击

Add. . . 按钮来定义 Boundary Number 1， 将 Type 设置为 Fluid- Structure Interface， 将 Apply to
设置为 Surfaces， 确认 Fluid- Structure Boundary #处为 1， 在表格中依次输入 Surface 的面号：
607、 608、 609、 610、 677、 679、 683、 673 （如图 10-97 所示）， 单击 OK 按钮。

单击 Add. . . 按钮来定义 Boundary Number 2， 将 Type 设置为 Fluid- Structure Interface，
将 Apply to 设置为 Surfaces， 在 Fluid- Structure Boundary #处输入 2， 在表格中依次输入 Sur-
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图 10-97　 定义 FSI 边界 1

face 的面号： 622、 623、 631、 636、 672、 676、 684、 678， 如图 10-98 所示， 单击 OK 按钮。

图 10-98　 定义 FSI 边界 2
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12） 对流体施加自由液面边界。
单击 Add. . . 按钮来定义 Boundary Number 3， 将 Type 设置为 Free Surface， 将 Apply to 设

置为 Surfaces， 在表格中依次输入 Surface 的面号： 628、 626、 635、 620、 652、 648、 642、
637、 668、 653、 658、 662， 单击 OK 按钮退出对话框。

13） 定义流体材料。
定义流体材料： 单击 Manage Materials 图标 ， 再单击 Constant 按钮， 增加流体材料 1，

把 Viscosity 设置为 0. 001， 把 Density 设置为 1000， 在 Acceleration due to Gravity 的 Y 栏输入

- 10， 单击 OK。

图 10-99　 定义流体材料属性

14） 定义流体单元组。
定义流体单元组的操作如下： 单击菜单 Meshing→Element Group （或图标 ）， 将弹出

定义单元组对话框。 单击 Add. . . 按钮来定义单元组 1， 将 Type 选择为 3D Fluid， 将 Default
Material 选择为 1， 单击 OK 按钮。

15） 划分流体网格。
划分流体的网格： 单击菜单 Meshing→Create Mesh→Volume （或图标 ）， 在弹出的对

话框中将 Type 选择为 3- D Fluid， 将 Element Group 选择为 1， 将 Nodes per Element 选择为 8，
退选 Wedge Volumes Treated as Degenerate， 并在表格中输入 Volume 167 ～ Volume 186 （应用

Auto 功能）， 单击 OK 按钮。
16） 生成 ADINA 流体求解文件。
单击图标 ， 将数据库保存到文件 022_Earthquake_cfd. idb 中。 生成 ADINA 流体求解文

件的操作如下： 单击图标 ， 并将文件名设置为 022_Earthquake_cfd， 确认没有勾选 Run
Solution， 并单击 Save 按钮。

2. 求解

进行流固耦合 FSI 求解： 单击菜单 Solution→Run ADINA- FSI. . . ， 在弹出的 ADINA- FSI
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对话框中单击 Start. . . 按钮， 并选中前两次生成的求解文件 021_Earthquake_str. dat 和 022_
Earthquake_cfd. dat， 再次单击 Start 按钮即可进行 FSI 求解， 如图 10-100 所示。

图 10-100　 设置 FSI 计算对话框

3. 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ）， 依次打开结果文

件 021_Earthquake_str. por 和 022_Earthquake_cfd. por， 这样做可以在后处理时同时查看结构

和流体的分析结果。 例如， 图 10-101 为结构和流体网格的变形情况， 图 10-102 为只包含结

构场的最大主压应力云图， 图 10-103 为只包含流体场速度矢量图。 此外， 还可以单击制作

动画图标 ， 通过动画来查看整个抗震过程， 结果图片和动画保存于随书光盘的文件夹 \10-6 \
结果图片及动画 \Earthquake \中。

10. 6. 3　 流固耦合波浪冲击分析

1. 前处理

1） 进入结构分析模块。
启动 ADINA- AUI， 从程序模块的下拉式菜单中选择 ADINA Structures。
单击图标 来清除图形区中的所有信息并创建一个新模型； 单击图标 ， 打开命令流文

件 021_Earthquake_str. in。
2） 删除地震载荷。
对目录树中 Loading 的载荷 2 单击鼠标右键， 单击 Delete. . . 删除地震载荷， 如图 10-

104 所示。
3） 设置造波。
ADINA 软件中可使用多种制造波浪的方法。 目前， 常用的方法是通过在流体开口区施
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图 10-101　 查看网格变形情况 （放大了 800 倍）

图 10-102　 结构最大主压应力云图

加周期性变化的速度来制造波浪； 此外， 波浪还可以看做是流体开口区的结构周期性压缩运

动所造成的， 此处将使用后一种方法进行造波。 此相当于在流体最左端包含一周期运行的结

构进行压缩造波， 因此需要在流体最左端再建立结构的模型。
对线 856 沿 Y 方向拉伸 40 米来生成面 Surface 702， 并将其网格划分的份数设置为 1 份。

此处将通过该面板的周期转动压缩波浪来造波， 由于该面板仅起造波的作用， 故其网格可以

划分得比较粗。
单击菜单 Control→Time Function， 弹出对话框， 单击 Add. . . 按钮， 定义时间函数 3， 对

话框的表格按照表 10-16 来定义。
单击图标 ， 在弹出的对话框中， 将载荷类型选择为 Displacement， 单击 Define 按钮，

在弹出的对话框中， 单击 Load Number 右侧的 Define 按钮， 弹出对话框， 将 Prescribed Val-
ues of Rotation 下的 Z 输入 - 0. 45， 单击 OK。 将 Apply to 选择 Line， 在表格的第 1 行， 将
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图 10-103　 流体的速度矢量图

图 10-104　 删除地震载荷

Site #输入 856， Time Function 选择 3 （表示载荷按

照时间函数 3 来施加）， 过程如图 10-105 所示。
4） 定义面板弹性材料属性。
单击图标 ， 在弹出的对话框中单击 Elastic

Isotropic 按 钮， 在 Define Isotropic Linear Elastic
Material 对话框中单击 Add. . . 按钮来定义材料 4，
在 Young’s Modulus 处输入 2. 0 E15， 单击 OK 按钮。

表 10-16　 时间函数 3

Time Value

1 0 0

2 4. 25 1. 0

3 8. 5 0

4 12. 75 1

5 17 0

6 21. 75 1

7 25. 5 0

提示： 此处将该面板材料的弹性模量设置为钢材的 10000 倍， 故可以将该面板当做〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰〰
刚体。〰〰

5） 定义面板的单元组。
单击菜单 Meshing→Element Group （或图标 ）， 将弹出定义单元组对话框。 单击

Add. . . 按钮， 定义单元组 7， 将 Type 选择为 Shell， 将 Default Material 选择为 4， 将 Kinematic
Formulation 的 Displacement 设置为 Large （如图 10-106 所示）， 单击 OK 按钮。

6） 划分面板的网格。
单击菜单 Meshing→Create Mesh→Surface （或图标 ）， 在弹出的对话框中将 Type 设置



第 3 篇　 实　 例　 篇

326　　 　 Focused on Excellence

图 10-105　 施加面板转动载荷

图 10-106　 定义面板单元组对话框

为 Shell， 将 Element Group 选择为 7， 将 Nodes per Element 选择为 4， 双击表格进入图形区来

选择混凝土所在的面 （Surface）， 也可以在表格中直接输入该面板的面号： 702， 单击 OK 按

钮退出对话框。
对该面板施加 FSI 边界： 单击菜单 Model→Boundary Conditions→FSI Boundary. . . ， 在弹

出的对话框中单击 Add. . . 按钮来定义 Boundary Number 3， 将 Type 设置为 Surfaces， 并输入

Surface 面号 702， 单击 OK 按钮退出对话框。
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7） 修改时间步。
单击菜单 Control→Time Step， 在弹出的对话框中修改时间步长为 0. 1， 共计算 255 步。
8） 生成 ADINA 结构求解文件。
单击图标 ， 将数据库保存到文件 031_Wavequake_str. idb 中。 生成 ADINA 结构求解文

件的操作如下： 单击图标 并将文件名设置为 031_Wavequake_str， 确认没有勾选 Run Solu-
tion 后， 单击 Save 按钮。

9） 进入流体分析模块。
启动 AIDNA- AUI， 从程序模块的下拉式菜单中选择 ADINA CFD。
单击图标 来清除图形区中的信息并创建一个新模型； 单击图标 来打开命令流文件

022_Earthquake_cfd. in。
10） 修改流体模型的边界条件。
对于波浪冲击， 按照上一步流固耦合的抗震分析所采用流体模型的范围显然是过小的，

因此需要沿着波浪冲击方向对模型进行拉伸加长。 在建立几何模型的 010_model. in 命令流

文件中已经考虑了该情况， 用户仅需把加长的几何模型部分划分为流体网格即可。
此外， 由于流体计算模型的改变还需要对该模型的边界约束条件进行修改， 修改后的边

界约束条件如表 10-17 所示。

表 10-17　 需要修改的边界约束条件

面　 　 号 约 束 条 件 面　 　 号 约 束 条 件

654 ′ZF ′ 694 ′ZF ′

659 ′XF ′ 696 ′ZF ′

663 ′ZF ′ 698 ′ZF ′

688 ′ZF ′ 701 ′ZF ′

690 ′XF ′ 700 ′ZF ′

692 ′ZF ′

修改自由液面： 将 Surface 693 添加到特殊边界 3 的 Free Surface 中， 如图 10-107 所示。
为流体施加 FSI 边界的操作如下： 单击菜单 Model→Special Boundary Conditions （或图标

）， 在弹出的对话框中单击 Add. . . 按钮来定义 Boundary Number 4， 将 Type 设置为 Fluid-
Structure Interface， 将 Apply to 设置为 Surfaces， 在 Fluid- Structure Boundary #处输入 3， 在表

格中依次输入 Surface 的面号： 695、 699， 设置完的对话框如图 10-108 所示， 单击 OK 按钮。
11） 定义流体单元组。
定义增加部分流体的单元组： 单击菜单 Meshing→Element Group （或图标 ）， 将弹出

定义单元组对话框。 单击 Add. . . 按钮来定义单元组 2， 将 Type 选择为 3D Fluid， 将 Default
Material 选择为 1， 单击 OK 按钮退出对话框。

12） 划分流体网格。
划分流体的网格： 单击菜单 Meshing→Create Mesh→Volume （或图标 ）， 在弹出的对

话框中将 Type 选择为 3- D Fluid， 将 Element Group 选择为 2， 将 Nodes per Element 选择为 8，
退选 Wedge Volumes Treated as Degenerate， 并在表格内输入 Volume 187、 188， 单击 OK
按钮。
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图 10-107　 修改自由液面对话框

图 10-108　 定义 FSI 边界 4

13） 修改时间步。
单击菜单 Control→Time Step， 在弹出的对话框中修改时间步长为 0. 1， 共计算 255 步。
14） 生成 ADINA 流体求解文件。
单击图标 将数据库保存到文件 032_Wavequake_cfd. idb 中。 生成 ADINA 流体求解文件

的操作如下： 单击图标 并将文件名设置成 032_Wavequake_cfd， 确认没有勾选 Run Solu-
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tion， 并单击 Save 按钮。
2. 求解

进行流固耦合 FSI 求解： 单击菜单 Solution→Run ADINA- FSI. . . ， 在 ADINA- FSI 对话框

中单击 Start. . . 按钮， 同时选中生成的求解文件 031_Wavequake_str. dat 和 032_Wavequake_
cfd. dat， 再次单击 Start 按钮即可开始 FSI 求解， 如图 10-109 所示。

图 10-109　 进行 FSI 求解

3. 后处理

程序模块选择为 Post→Processing。 单击菜单 File→Open （或图标 ） 来打开结果文件

031_Wavequake_str. por， 然后打开结果文件 032_Wavequake_cfd. por， 在后处理时可以同时查

看结构和流体分析结果。 例如， 图 10-110 中给出了结构及流体网格的变形图， 图 10-111 中

只给出结构最大主压应力云图， 图 10-112 中只给出流体的速度矢量图， 图 10-113 中则同时

给出结构的最大主压应力以及流体的速度矢量图。
此外， 读者还可以单击制作动画图标 查看抗波浪冲击的过程， 生成的结果图片和动画

保存于随书光盘的文件夹 \ 10-6 \ 结果图片及动画 \ Wave- impact 中。

10. 6. 4　 应用推广

本实例对水下沉箱进行了抗震及抗波浪分析， 还可以推广应用到其他水下结构、 水下航

行结构、 水下平台、 海洋平台等问题， 可以直接在 ADINA 软件的 FSI 流固耦合模块下完成

模拟。
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图 10-110　 网格变形图

图 10-111　 结构最大主压应力云图

图 10-112　 流体的速度矢量图
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图 10-113　 结构最大主压应力以及流体的速度矢量图
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附 录

附录 A　 ADINA 建议单位制

质　 　 量 长　 　 度 时　 　 间 力 应　 　 力 能　 　 量 密度 （钢） 弹性模量 （钢）

kg m s N Pa J 7. 83e + 03 2. 07e + 11

kg cm s 1e - 02N 1e + 02Pa 1e - 04J 7. 83e - 03 2. 07e + 09

kg cm ms 1e + 04N 1e + 08Pa 1e + 02J 7. 83e - 03 2. 07e + 03

kg cm μs 1e + 10N 1e + 14Pa 1e + 08J 7. 83e - 03 2. 07e - 03

kg mm ms kN GPa J 7. 83e - 06 2. 07e + 02

g cm s dyne dyne / cm2 erg 7. 83e + 00 2. 07e + 12

g cm μs 1e + 07N Mbar 1e + 05J 7. 83e + 00 2. 07e + 00

g mm s 1e - 06N Pa 1e - 09J 7. 83e - 03 2. 07e + 11

g mm ms N MPa N·mm 7. 83e - 03 2. 07e - 06

ton mm s N MPa N·mm 7. 83e - 09 2. 07e + 05

lb in s lbf psi lbf·in 2. 83e - 01 3. 00e + 07

slug ft s lbf psf lbf·ft 1. 52e + 01 4. 32e + 09

　 　 注： 1N = 105 dyne = 1lbf / 4. 45， 1J = 107 erg， 1bar = 105Pa， 1in = 2. 54cm， 1kg = 2. 205lb， 1slug = 14. 5939kg， 1ft =
12in = 0. 3048m

附录 B　 2D、 3D 邓肯-张 E- μ及 E- B 模型的参数说明

标准 E-μ 及 E- B 模型材料参数输入

　 K = CTI （1） 　 加载时弹模基数

　 N = CTI （2） 　 加载时、 卸载时的弹模指数

　 Rf = CTI （3） 　 破坏比

　 Kur = CTI （4） 　 卸载时弹模基数

　 φ = CTI （5） *PI / 180. 0 　 摩擦角

　 Δφ = CTI （6） *PI / 180. 0 　 摩擦角变化

　 C = CTI （7） 　 凝聚力

　 Pa = CTI （8） 　 大气压力
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（续）

　 G = CTI （9） 或 Kb = CTI （9） 　 E- μ 模型中的泊松比计算参数 G 或 E- B 模型中的体积模量基数

　 F = CTI （10） 或 m = CTI （9） 　 E- μ 模型中的泊松比计算参数 F 或 E- B 模型中的体积模量指数

　 D = CTI （11） 　 E- μ 模型中的泊松比计算参数 D， 若为 E- B 模型则不必输入数值

　 CTI （12） 　 预留变量， 默认值为零

　 参数限值及施工参数输入

　 x2D_fact = CTI （13）
　 2D 模型的修正系数， 相当于 Xi （6）； 默认值为 0. 65； 为经验数， 处理 2D
单元结果偏大的问题， 其相关阐述参考田博士的资料； 后来再 3D 模型中， 对

方要求可以控制变形的参数， 默认值为 0. 75

　 xComp_l_lim = CTI （14） 　 土体最小围压值相对于大气压力的倍数， 默认值为 1. 001

　 xSL_u_lim = CTI （15） 　 应力水平的最大值， 默认值为 0. 99

　 xSL_l_lim = CTI （16） 　 应力水平最小值， 默认值为 0. 01

　 xPR_u_lim = CTI （17） 　 泊松比最大值， 默认值为 0. 49

　 xPR_l_lim = CTI （18） 　 泊松比最小值， 默认值为 0. 15

　 xWeig = CTI （19） 　 土体堆密度， 无堆密度值

　 xBirth_pf = CTI （20）
　 新生土体单元 （零时刻以后 Birth 的单元） 的碾压压力相对于大气压力的倍

数， 默认值为 0. 0， 无碾压

　 xZ_0 = CTI （21）
　 坝基地表的评价高度坐标 Z 的数值； 默认值为 0. 0； （要求高度方向永远在 Z
方向， 无论 2D 或者 3D 模型。 这主要是用来计算零时刻就存在的所有单元在重

力作用下的初始应力场。）

　 xP_xy = CTI （22） 　 坝基地应力的侧向土压力系数， 默认值为 0. 3

　 土体单元特性控制参数输入 （整数）

　 I_Flag_Weight = SCP （1）
　 初始单元 （零时刻模型中就存在的单元） 是否考虑重力作用下的地应力：
0- - - -不考虑， 1- - - -考虑

　 I_Flag_Type = SCP （2）
　 用于判断所使用的材料类型： 0- - - - - E-Mu 材料模型； 1 或其他非零整

数- - - - - E- B 材料模型。 一旦选择了材料类型， 则相应的材料参数输入必须按

照相应的材料模式给定， 不能混淆

　 特殊结果输出 （后处理直接查看， 顺序有可能会调整）

　 User_Vriable_11 　 切线模量

　 User_Vriable_12 　 泊松比

　 User_Vriable_16 　 围压

　 User_Vriable_17 　 最大最小主应力差

　 User_Vriable_31 　 应力水平
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